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Preface


This document defines the Flight Operations Segment (FOS) Integration and Acceptance Test

Procedures for Release B Version 2.01.00. It covers CDRL item #055 (DID 322/DV3) and

CDRL item #070 (DID 411/VE1), as deliverable under the Earth Observing System Data and

Information System (EOSDIS) Core System (ECS), Contract NAS5-60000.


This document is a contract deliverable with an approval code 2. As such, it does not require

formal Government approval, however, the Government reserves the right to request changes

within 45 days of the initial submittal. Once approved, contractor changes to this document are

handled in accordance with Class I and Class II change control requirements described in the

EOS Configuration Management Plan, and changes to this document shall be made by document

change notice (DCN) or by complete revision.


Once approved, this document shall be under the ECS Configuration Control Board. Any

questions or proposed changes should be addressed to:


Data Management Office

The ECS Project Office

Raytheon Systems Company

1616 McCormick Dr.

Upper Marlboro, MD 20774-5372
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Abstract


The FOS Release B Version 2.01.00 Integration and Acceptance Test Procedures document 
defines the set of test procedures that FOS will execute to verify its Level 3 and Level 4 
requirements. 

This document covers CDRL item #055 (DID 322/DV2) and CDRL item #070 (DID 411/VE1), 
as deliverable under the Earth Observing System Data and Information System (EOSDIS) Core 
System (ECS), Contract NAS5-60000. This document specifies the FOS Test Procedures for 
Release B Version 2.01.00. 

Keywords: I&T, Integration, NCR, FOS, Test, Requirements, Procedures, RBR, ECL, Threads 
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1. Introduction 

1.1 Identification 

This document is the FOS Integration and Acceptance Test (AT) Procedures for the ECS Project, 
which are CDRL item #055 and #070 on the Contract Data Requirements List (CDRL) and 
defined by Data Item Description (DID 322/DV2 and DID 411/VE1) under contract NAS5
60000. 

1.2 Scope 

This document defines the FOS integration and AT procedures for Release B Version 2.01.00. It 
focuses on delineating the approach that will be taken to incrementally integrate and test the 
FOS. In particular, the FOS Integration and Test Procedures for the ECS project details the 
approach for integrating and testing the FOS segment and verifying that the segment complies 
with the Release B requirements as specified in the Functional and Performance Requirements 
Specification (#423-41-02), as specified in the RTM database. This document is under the ECS 
Configuration Control Board (CCB) for the January final release B submittal. Changes to these 
volumes must be approved by this CCB prior to inclusion in the document. 

This document reflects the February 7, 1996, Technical Baseline maintained by the contractor 
configuration control board in accordance with ECS Technical Direction No. 11, dated 
December 6, 1994. 

1.3 Purpose 

This document defines individual test case procedures for FOS Release B Version 2.01.00. It 
focuses on delineating the procedural steps necessary for the verification of Release B Level 3 
and Level 4 requirements. In addition, the document describes the responsible organizations that 
are involved in the FOS integration and test including their roles and responsibilities and 
schedules for testing during the Release B time period. It provides the program manager and test 
personnel with a systematic approach to verify that all of the Level 3 and Level 4 requirements 
mapped to the Release B Delivery have been satisfied by the integrated FOS subsystems. 

1.4 Status and Schedule 

The submittal of DID 322/DV2 and DID 411/VE1 meets the milestone specified in CDRL of 
NASA contract NAS5-60000. This submittal is the final version of this document submitted at 
30 days after RRR. 
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1.5 Deviations from the FOS Test Plan 

The majority of deviations made from the test plan involve the reshaping of test cases (i.e. 
merging test cases, adding additional cases, deleting test cases and rescoping test cases). This 
was necessary due to the implementation of Configuration Change Requests (CCRs) affecting 
Level 4 requirements and Requirements by Release (RBRs), and a more mature understanding of 
the FOS functionality by the FOS Test Team. Additionally, associated requirement mapping 
matrices in appendices B, C, D, E (i.e. L4 Requirements to Test Case, Test Case to L4 
Requirements, Release B RBRs to Test Case and Test Case to Release B RBRs) have been 
updated based on the RTM Baseline dated December 1997. Current requirement mappings 
delineated in these matrices coincide with the latest set of test procedures as defined in this 
document. 

Minor revisions to the document were also made in the following areas: 

•	 Section 3.6 (Test Data & Test Data Sources) has been updated to reflect the most current 
test data sources. 

•	 Section 3.7 (Test Tools) has been updated to reflect the additional tools necessary to 
verify command and table load content. 

•	 Section 3.8 has been updated to include the execution of a designed confidence test 
following emergency patch deliveries. 

•	 Table 3-10.1 (The FOS Integration and Test Schedule) has been updated to reflect the 
latest Earth Science Data and Information System (ESDIS) and independent verification 
and validation (IV&V) test schedules. 

1.6 Document Organization 

This document is organized in the following manner: 

Section 1.0 provides the scope and document organization. 

Section 2.0 provides a list of applicable documents, which were used directly or indirectly in the 
preparation of this document. 

Section 3.0 defines the FOS integration and test process. The section includes defining the 
responsible organizations involved in the FOS segment test; defining the approach to integrating 
and testing the FOS and supporting interfaces; identification of a reference to the schedule for 
performing integration and test of FOS functional components; identification of resources that 
are required for the system/segment test (i.e. FOS hardware, simulators, data drivers, instrument 
resources, etc.); and any software/hardware dependencies required for test execution. 

Section 4.0 identifies the Release B Version 2.01.00 test cases and includes the following for 
each test case: test number, test title, applicable software/hardware test configuration, test 
support data items, test abstract, success criteria, and detailed test procedure steps. 
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Appendix A identifies the FOS Datasets needed for FOS testing, and the timeframe of need for 
each dataset type. 

Appendix B identifies the Release B Level 4 Requirements to Test Case matrix. 

Appendix C identifies the Test Case to Release B Level 4 Requirements Matrix. 

Appendix D identifies RBR to Test Case matrix. 

Appendix E identifies the Test Case to RBR Matrix. 

Appendix F identifies the Test Configuration Tables. 

The section Abbreviations and Acronyms contains an alphabetized list of the definitions for 
abbreviations and acronyms used in this volume. 
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2. Related Documentation 

2.1 Parent Documents 

The parent documents are the documents from which this FOS Integration and Test Plan's scope 
and content are derived. 

304-CD-001-003	 Flight Operations Segment (FOS) Requirements Specification for the 
ECS Project, Volume 1: General Requirements 

304-CD-004-003	 Flight Operations Segment (FOS) Requirements Specification for the 
ECS Project, Volume 2: AM-1 Mission Specific 

423-41-02	 Goddard Space Flight Center, Functional and Performance 
Requirements Specification for the Earth Observing System Data and 
Information System (EOSDIS) Core System 

2.2 Applicable Documents 

The following documents are referenced within this document, or are directly applicable, or 
contain policies or other directive matters that are binding upon the content of this volume. 

307-CD-001-003 Flight Operations Segment (FOS) Release Plan and Development 
329-CD-001-003 Plan for the ECS Project 

402-CD-002-002	 System Integration and Test Plan for the ECS Project, Volume 2: 
Release A 

2.3 Information Documents 

2.3.1 Information Documents Referenced 

The following documents are referenced herein and, amplify or clarify the information presented 
in this document. These documents are not binding on the content of the FOS Integration and 
Acceptance Test Procedures for the ECS Project. 

194-201-SE1-001 Systems Engineering Plan for the ECS Project 

194-202-SE1-001 Standards and Procedures for the ECS Project 

193-208-SE1-001 Methodology for Definition of External Interfaces for the ECS Project 

308-CD-001-006 Software Development Plan for the ECS Project 

194-401-VE1-002 Verification Plan for the ECS Project 

Acceptance Testing Management Plan for the ECS Project194-415-VE1-002 
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501-CD-001-004 Performance Assurance Implementation Plan for the ECS Project 

194-502-PA1-001	 Contractor's Practices & Procedures Referenced in the PAIP for the 
ECS Project 

604-CD-001-004 Operations Concept for the ECS Project, Part 1--ECS Overview 

604-CD-002-003 Operations Concept for the ECS Project, Part 2B--Release B 

604-CD-003-002 Operations Concept for the ECS Project, Part 2A--Release A 

2.3.2 Information Documents Not Referenced 

The following documents, although not referenced herein and/or not directly applicable, do 
amplify or clarify the information presented in this document. These documents are not binding 
on the content of the FOS Integration and Test Plan for the ECS Project. 

104-CD-001-003 Data Management Plan for the ECS Project 

193-105-MG3-001 Data Management Procedures for the ECS Project 
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3. FOS Integration and Test Plan 

This section contains an overview of the approach taken to ensure complete and thorough testing 
by the FOS. Included is information concerning the FOS I&T approach, phases, environment, 
relationships with other test organizations, test schedules, test responsibilities and specific 
verification activities performed by the FOS Test and support organizations. 

3.1 FOS Context 

The Earth Observing System Data and Information System (EOSDIS) Core System (ECS) 
involves the collection and distribution of earth science data from space and ground based 
measurement systems. The FOS is one of two segments, which when combined with the Science 
and Communications Development Organization (SCDO) makes up the development portion of 
the ECS. The FOS provides a set of functions in support of the EOS AM-1 spacecraft and its 
complement of instruments and includes mission planning and scheduling, spacecraft 
commanding, instrument command support, health and safety monitoring, data analysis and 
overall mission operations. 

3.2 FOS Integration and Test Overview 

The FOS integration effort begins with the allocation of functions to internal builds and releases 
and organizing the phasing of the development effort. In particular, internal and external 
dependencies are identified, resulting in a logical progression of development activities 
matching the internal/external dependency needs of FOS and its external interfaces.  During this 
phase, the FOS Test Team designs its test procedures. 

During the Integration Phase of each release, the segment development organization performs 
unit testing of newly developed and heritage software, as well as those Commercial Off-The-
Shelf (COTS) software products incorporated into segment software.  As components are 
integrated at the EDF, they are made available to the FOS Test Team to perform checkout of test 
procedures. 

Following, the software is migrated to the EOS Operations Center (EOC) facility at Goddard 
Space Flight Center (GSFC) (building 32) and made available for dry-run testing. Following a 
successful dry run, the formal test period begins. Formal test activity includes the execution of 
functional tests and end-to-end tests designed to ensure concurrent operational functionality. 

In conjunction with the ECS Acceptance Test Organization (ATO), the FOS Test Team performs 
formal testing at the EOC (GSFC-building 32). This includes a dry run test period, in which all 
previously designed test procedures provided in this document are executed against the aggregate 
set of FOS software. During dry run testing, time is allocated to the Development Organization 
for providing necessary software fixes. Following the successful completion of dry-run testing, 
formal testing begins. During this period, test procedures are executed by the FOS and ATO 
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Test Organizations and is witnessed by cognizant National Aeronautics and Space 
Administration (NASA) representatives. 

Prior to the dry run test period, the Maintenance & Operations (M&O) Organization performs 
verification of COTS hardware and those COTS software products used in the hardware support 
environment, such as operating systems. M&O personnel support the efforts of other 
verification organizations and maintain the operational system by verifying changes during the 
M&O phase. Additionally, the M&O organization provides a high level of operational support in 
generating end-to-end test scenarios and provides support during end-to-end test execution. 

The Quality Office monitors and witnesses tests and ensures that test procedures are followed 
and non conformances are correctly documented. The Configuration Management (CM) and 
Data Management (DM) organizations provide baselined items for accomplishing all levels of 
testing, and they support configuration audits. The IV&V contractor performs an independent 
assessment of the functionality and performance of ECS releases. 

The Flight Operations Team (FOT) provides support to the test team during the development of 
test plans and procedures by identifying operational scenario candidates for incorporation into 
test case scenarios, and identifying data set needs for those tests. 

Table 3.2-1 depicts the verification role of each organization during the development and 
integration and test stages of ECS. The organizations are mapped to the verification levels which 
correspond to an increase in scope from unit testing of individual modules to final operational 
testing leading up to launch. 

Table 3.2-1. Primary Verification Roles 
Organization Development Phase I&T Phase 

Phase Review 
Milestone 

TRR CSR/RRR 

Software Developers Code & Unit Test Fix Software Bugs 

Integration Team Integration Planning 
Integration Plans 

Build System 
Integrate FOS Functions 

FOS Test Team Test Planning 
Monitor Development 

Dry Run FOS Tests 
Execute Formal FOS Tests 

Quality Office Attend Walkthroughs 
Review Test Plans/Proc. 

Monitor Integration 
Witness FOS Tests 

M&O Planning & Scheduling, 
Tools, Training 

Provide S/W Libraries 
Control Test Environment 

FOT Member of Integration Team 
Review End-to-end Tests 

Member of Integration 
Team 
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3.3 FOS Integration Approach 

The integration team, comprised of FOS systems engineering, development, and test personnel 
heads the FOS integration effort. The FOS test team provides support to the integration team. 

Upon successful completion of unit testing, software is merged to the subsystem group branch 
within Clearcase, and a subsystem build is performed. The software is then turned over to the 
integration team and migrated to the Integration Environment. Executables are copied from the 
release branch to the /net/beeper/fosb/dev/am1/bin directory for functional integration and 
interface checkout. 

For software that completes unit testing with known problems and is turned over to the 
integration team, group level, Internal Non-conformance Reports (INCRs) will be entered into 
the “subsystem projects” of the Distributed Defect Tracking System (DDTS) to track the defects. 
Software problems/discrepancies that arise during the integration phase will also be tracked via 
INCRs and entered into the integration project of DDTS. 

3.3.1 Test Procedure Walk-through & Checkout 

During development and integration, applicable test procedures are reviewed by subsystem(s) 
developers, integration, the FOT, system engineering and QA representatives in order to ensure 
applicability of procedures to system functionality and assure requirements mapping is complete 
and accurate. The Test Team conducts the procedure walk-through while the development team 
provides support on an as-needed basis. QA monitors procedure walk-through progress. 

As software components are successfully integrated, test procedures are checked against the 
software components that have been successfully integrated. Procedure checkout against the 
incremental threads will be conducted from the net/beeper/fosb/int/am1/bin directory. Any 
problems/discrepancies that arise during procedure checkout are entered into the DDTS as 
INCRs. The Test Team will conduct procedure check-out while the integration team provides 
support on an as needed basis. QA will monitor procedure checkout progress. 

3.3.2 Preparation for Test Readiness 

Upon successful completion of procedure check-out activities, a software turnover form (STF) is 
submitted requesting that the aggregate set of software be merged and built at the MAIN level. 
The STF requests that CM perform a build of the FOS software and executables from the build 
and that the software be made available for migration to GSFC. Executables are then copied to 
the EOC facility at GSFC (building 32) for dry run and formal test. Following migration to 
GSFC, a brief checkout is made by the Development, Integration and Test Organizations to 
ensure that the complete set of FOS software is migrated successfully and ready for test. This 
includes invoking all of the FOS Startup Scripts to ensure no data integrity loss of the FOS 
Software during the migration process. 
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3.4 FOS Test Approach 

For each FOS internal build and formal release, the FOS Segment Development Organization 
performs unit testing of newly developed and heritage FOS software. During unit testing, the 
FOS Test Organization provides a test support role which includes monitoring software 
integration activity and supporting test execution. Following integration and unit testing, the 
FOS Test Organization and the ATO verify that the FOS integrated software meets Level 3 
requirements as specified in the Functional and Performance Requirements Specification (#423
41-02), and also meets Level 4 requirements as specified in the RTM database 

The FOS test approach focuses on three levels of testing. Level 1 testing focuses on the 
infrastructure testing ensuring the foundation of the system is robust. Level 2 testing emphasizes 
testing at the FOS subsystem level. Level 3 tests are end-to-end tests which emphasize the 
testing of the FOS as a whole, where previously tested functionality is exercised concurrently in 
a controlled test environment. 

3.4.1 FOS Test Organization Responsibilities 

The FOS Test Organization roles and responsibilities include the following: 

•	 Develop test plans and test procedures in accordance with the FOS Test Organization's 
Build/Thread Plan, associated requirements documentation and FOT use case definition 

• Accept unit-tested software from the Segment Development organizations. 

•	 Conduct testing of threads and components following internal builds and incremental 
deliveries. 

•	 Perform end-to-end testing as components are added to system configurations with a 
focus on internal and external interfaces. 

• Conduct intra-segment interface verification. 

• Report formal test results. 

• Generate non conformance reports. 

• Re-verify software fixes resulting from non conformance reports via regression testing. 

•	 Work with the M&O and ESDIS organizations in support of operational ground system 
testing. 

• Work with the IV&V contractor in support of interface tests. 

3.4.2 FOS Test Phases 

The following sections define FOS test activities performed during the FOS I&T phase. 
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3.4.2.1 Test Planning Phase 

During the SDR-PDR timeframe, FOS Segment/System Integration & Test Plan (#319/DV1 and 
#402/VE1) outlines are developed by the FOS Test Organization utilizing high-level operations 
concepts developed by the Segment Development Organization in conjunction with the FOS 
build/thread plan and requirements allocation. During the PDR-CDR timeframe, the 
system/segment test plan descriptions are completed and the FOS Segment/System Integration & 
Test Plan (# 319/DV1 and #402/VE1) is made available for CCB approval. Also during this 
time frame, test data drivers, test dependencies, test configuration, and test location support 
needs are identified by a combined effort of the FOS Segment Development and FOS Test 
Organizations. 

During the CDR-TRR time frame, the FOS Integration and Acceptance Test Procedures 
document (#322/DV2 and 411/VE1) is developed by the FOS System/Segment Test 
Organization using the FOS System and Segment Integration & Test Plan (#319/DV1 and 
#402/VE1) as an outline for test procedures. 

3.4.2.2 Test Execution & Analysis Phase 

The formal installation of Release B includes custom code and COTS software, executables, load 
modules, test data sets, test tools, and documentation at the EOC facility at GSFC (building 32). 
The formal installation at the operational sites is performed by the FOS Integration Team, 
supported by CMO and the M&O organizations. 

Dry run and formal testing is performed at the EOC facility following successful migration of 
software from the EDF to the EOC. Test activities for Release B, are based on Release B 
Version 2.01.00 associated test cases and regression testing of test Release B Version 2.0.0 test 
cases. This philosophy provides a complete comprehensive testing of the entire FOS system. As 
the FOS system and the knowledge of the system matures, test cases may be reconstructed, 
merged, added or deleted based on a more current understanding of the system. These updated 
procedures form the basis for all FOS dry run and formal testing, and become an integral part of 
the FOS Integration and Acceptance Test Procedures document (#322/DV2 and 411/VE1). 

The FOS Test Organization is responsible for test execution, with support from the FOS 
Segment Development Organization and ATO organization. All FOS segment test activity is 
performed using the FOS Integration and Acceptance Test Procedures document (#322/DV2 and 
411/VE1). Non conformance software reports are written by the segment test engineer, test 
conductor or designee and delivered to the FOS Segment Development Organization. 

All test analysis activity associated with the execution of test procedures (i.e. command data bit
busting, decommutation calculation analysis, etc.) is identified in the FOS Integration and 
Acceptance Test Procedures Document (#322/DV2 and 411/VE1) on a test by test basis. 
Analysis methods, analysis results, test data logs, event logs and Non-Conformance Reports 
(NCRs) written as a result of analysis activity are identified in the FOS Test Report Document 
(#324/DV3 and 412VE2). 
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3.4.2.3 Test Reporting Phase 

FOS segment test reporting activity is performed by the FOS Test Organization for each formal 
release. All testing activity performed during the FOS test execution phase is logged by the test 
engineer and/or test conductor, with support from the NASA Technical Officer or representative, 
and the QA representative.  These test logs (see Figure 3.4.3.3-1 below) along with data analysis 
results performed during the test analysis phase are used by the FOS Test Organization in 
developing the FOS Test Report Document (#324/DV3 and 412/VE2). These logs reside in the 
controlled EDHS Project Forms Area. Reporting information includes the results of each test, 
deviations was from the test procedures, data analysis methods and results, and NCRs 
identification. 

Sequence: 
Test Procedure 
Name: 
Test Procedure ID: 

Test Location: 
S/W Config./ 
Version: 
H/W Config./ 
Host Names: 
Test Data: 

Test Tools/ 
Scripts: 
Test Date: 
Witness(es): 

Comments: Test Time: 

NCRs Written: 
NCRs Verified: 
NCRs Un-Verified: 

Pass 
1st Run 
Tester Signature(s) 

__________________________ 

__________________________ 

__________________________ 

Site: 

Partial Pass/Fail Fail 
Release Retest Formal Run 

Witness Signature(s): 

__________________________ 

__________________________ 

__________________________ 

Figure 3.4.3.3-1. Test Log Form 
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3.4.3 FOS Test Roles and Responsibilities 

The following FOS Test personnel shall be responsible for the execution of FOS tests in the 
following manner: 

•	 Test Engineer - The FOS segment test engineer, or appointed representative shall be 
responsible for the generation and publication of all FOS test plans and procedures. 

•	 Test Conductor - The FOS test conductor, or appointed representative is responsible for 
establishing test configuration and ensuring test prerequisites are satisfied. The test 
conductor is also responsible for scheduling and coordinating the time and resources 
needed for specific tests, rescheduling tests following test failure, collecting test outputs 
and test logs, writing NCRs, and recording test results. The test conductor is also 
responsible for writing the segment test report following test completion. 

•	 Test Participants - The FOS Segment Development Organization may assist the test 
conductor/engineer(s) in the performance of the test procedures. Other supporting 
organizations may include ATO, Maintenance and Operations (M&O) and Configuration 
and Data Management (CM). M&O will be responsible for reconfiguring the system as 
needed to control testing; CM will provide a controlled environment for the storing and 
maintaining of information about the test environment including hardware, software and 
test tool environments. 

•	 Test Witnesses - Individuals invited to directly observe test conduct. This may include 
members from the M&O, or ESDIS organizations. 

•	 Quality Assurance - During the segment test planning phase, the QA organization 
reviews the FOS I&T Plan for the traceability of FOS level 4 and level 3 requirements to 
the planned test cases. During the test procedure generation phase, QA reviews test 
procedures for test and requirements consistency between the FOS I&T Plan and FOS 
I&T Procedures. During the formal segment test execution phase, QA verifies the 
configuration of the software prior to the performance of the tests. QA also witnesses the 
tests to monitor that procedures are tested as written, and that problems and deviations 
are noted. During the test analysis and reporting phase, QA reviews the test report for 
accuracy and verifies that NCRs are written for all validated problems and entered into 
the non conformance tracking system. 

3.4.4 Verification Methods 

The four verification methods used during the FOS segment test period include inspection, 
analysis, demonstration, and test as defined below: 

•	 Inspection - The visual, manual examination of the verification item and comparison to 
the applicable requirement or other compliance documentation, such as engineering 
drawings. 
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•	 Analysis - Technical or mathematical evaluation based on calculation, interpolation, or 
other analytical methods. 

•	 Demonstration - Observation of the functional operation of the verification item in a 
controlled environment to yield qualitative results without the use of elaborate 
instrumentation, procedure, or special test equipment. 

•	 Test - A procedure or action taken to determine under real or simulated conditions the 
capabilities, limitations, characteristics, effectiveness, reliability, or suitability of a 
material, device, system, or method. 

Each requirement is verified by one or more of these methods. Verification method(s) are 
specified in the ECS Verification Plan (#194-401-VE1-002). 

3.5 Test Resources 

The following paragraphs in this section identify and describe the resources necessary to 
accomplish FOS testing. Included are identification of test facilities and hardware 
configurations. 

3.5.1 Testing Facilities 

The ECS Development Facility (EDF) located at the ECS facility in Upper Marlboro, Md. and 
the EOC facility at GSFC (building 32) are both utilized by the FOS Test Organization. Test 
procedure checkout, and early testing is performed in the EDF for integrated FOS software 
components. The developed software is migrated to the GSFC EOC Facility (building 32). 
Following software installation at the EOC, dry run and formal testing is performed by the FOS 
Test Team with support from the ATO organization. 

3.5.2 Hardware Configuration 

Figure 3.5.2-1 below provides the basic FOS hardware configuration used in support of FOS 
Test at the EDF and at the EOC. Additionally, for test cases requiring additional hardware not 
shown in the figure, specific hardware is listed under the associated test case's "Test Support" 
heading as described in this FOS Integration and Acceptance Test Procedures Document 
(#322/DV2 and 411/VE1 ). 
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Figure 3.5.2-1. FOS Test Configuration 

3.6 Test Data & Test Data Sources 

In support of FOS Release B segment testing the following test data sources have been 
identified: 

•	 EOSDIS Test System (ETS): The ETS will be used in the Release B timeframe for the 
transfer of “test” telemetry and spacecraft recorder data to the EOC by emulating EDOS 
or the AM-1 spacecraft. It will also be used for the transfer and acceptance of AM-1 
spacecraft and instrument commands. 

•	 Software Data Drivers: Provided in-house, data drivers will be provided by the FOS 
Development and Test Organizations when specific test data/interface simulation is not 
available via any other source. The aggregate set of data drivers will reside on a 
designated test user station which is accessed and controlled by the FOS Test 
Organization (see Appendix A for the aggregate set of test datasets).  Software drivers 
utilized for the Release A timeframe include: 

- NCC GCMR acknowledgment/disposition message generator 

- Test Data Generator for real-time telemetry streams 

- Real-time Event Message Generator 
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- CODA Generator 

- CLCW Generator 

- SCS Summary Report 

3.7 Test Tools 

The FOS Development and Test Organizations utilize the following ECS selected COTS tools in 
support of the test effort: 

•	 Requirements and Traceability Management Tool (RTM) - CASE tool which provides 
the means for creating, populating, and maintaining a data base containing requirements, 
verification, and design information. RTM provides the means for mapping Level 4 and 
Level 3 requirements to FOS test cases. 

•	 ClearCase Configuration Management Tool - CM tool used to support configuration 
management for developing, testing and maintaining software. 

•	 Distributed Defect Tracking System (DDTS) - discrepancy tracking tool used to record, 
track and report non conformances encountered during a test session. 

• tcpdump utility - prints out the headers of packets on a network interface 

3.8 Regression Testing 

Regression testing (i.e. supplemental testing performed to ensure that existing software is not 
adversely affected by newly integrated software components) is performed following patch 
deliveries. As a general rule, the regression test case REG-3000FPB, designed to test critical 
functions from all nine FOS subsystems is performed during the regression test period, followed 
by selected test cases chosen by the test team. Cases chosen for regression test activity are those 
existing test cases which encompass the most functional paths related to software components 
modified as part of the patch. During the I&T phase, the FOS Test Organization, with the 
coordination of FOS development, system engineering and QA organizations is responsible for 
choosing the suite of tests performed for regression to ensure the chosen test suite provides 
adequate coverage of affected software. Regression test results for “patch” deliveries are 
documented in test reports delivered to NASA no later than one month following the completion 
of testing. 

3.9 Discrepancy Reporting and Resolution 

The Non conformance Reporting and Corrective Action (NRCA) system is the process for 
identifying, investigating, and resolving problems with the ECS during development, integration, 
installation, and formal test. To facilitate disposition and resolution of problems, the NRCA 
system and its processes emphasize tracking of responsibility, effective communication and 
delegation of authority. The NRCA system utilizes the DDTS to record and track software non 
conformances. DDTS is customized by ECS to accurately reflect the progress of Non 

3-10 322-CD-100-001/ 
411-CD-100-001 



conformance Reports (NCRs) through resolution and captures necessary information to 
document that progress. Through the production of management reports, DDTS provides 
management visibility and metrics to insure that NCRs are being worked in a timely and 
effective manner. 

During the execution and analysis phases of testing, all non conformance reports (NCRs) are 
written by the test engineer, test conductor, NASA Technical Officer/representative, or the QA 
representative. 

The FOS Test organization uses the DDTS non conformance tracking and reporting software 
tool for tracking non conformances. Individual NCR information tracked includes the date the 
NCR was received, the subsystem the NCR is written against, the priority of the NCR, current 
resolution status of the NCR, and problem description. 

3.10  FOS Integration and Test Schedule Overview 

Table 3.10-1 identifies all tests and FOS integration milestones. The table includes both FOS 
internal milestones and ground tests planned by the ESDIS organization which require support 
from the FOS. The purpose of this table is to delineate the functionality required by the FOS to 
support these tests and to emphasize internal dependency milestone dates in which the FOS 
needs to have integrated this functionality. 
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Table 3.10-1. FOS Composite Test ScheduleÄ
TIME FROM 

LAUNCH 
(Months) 

TEST NAME TEST 
DATES 

TEST DESCRIPTION FOS 
REQUIREMENTS 

Launch (L) 

L-22 Months ASTER ICC 
Data Flow 
Test 

9/5/96 

9/10/96 

ASTER access to 
EOC Planning & 
Scheduling 
information 

ASTER-ICC land lines 
to the EDF 
operational; or 
ASTER ICC at EDF 

L-20 IST 2-Way 
Data Flow 
Test 

11/25/96 

11/28/96 

Basic EOC/IST 
communications; IST 
access to EOC 
Planning & 
Scheduling data. 

Support Planning & 
Scheduling data flows 
of timelines and 
activities; Partial IST 
toolkits. 

L-19 AM-1 
spacecraft 
Bus Comp. 
Performance 
Test 

12/6/96 

12/20/96 

EDOS/ETS IF; EBnet 
I/F; FOS User 
Interface (FUI), ODBs 
to support R/T TLM & 
SCC dump 
processing at EOC, 
ISTs , R/T telemetry 
processing and 
display, command 
procedures and script 
execution. 

L-18 EOC Compat. 
Test #1 

1/14/97

1/17/97 

TBD TBD 

L-16 Comp. 
Performance 
Test #1 

3/20/97 

3/24/97 

Spacecraft 
housekeeping tlm 
processing by the 
EOC; spacecraft and 
instrument dump 
processing by the 
EOC. 

All forward and return 
links in the RF ICD; 
FUI 

L-15 Command 
Management 
Test 

4/8/97 

4/11/97 

CMD Load built at 
EOC. CMD 
verification following 
transmission to 
ETS/EDOS 

R/T command uplink 
at all supported rates 
to either ETS or 
EDOS, depending on 
EDOS availability. 

L-15  AM-1 
Spacecraft RF 
Compat.  Test 

4/15/97 

5/15/97 

Multiple tests with 
TDRSS; demonstrate 
RF compatibility 

All forward and return 
links in the RF ICD; 
FUI. 
TDRSS scheduling 
through NCC 
interface. 
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TIME FROM 
LAUNCH 
(Months) 

TEST NAME TEST 
DATES 

TEST DESCRIPTION FOS 
REQUIREMENTS 

L-13 IST 2-Way 
Data Flow 

6/2/97 

6/6/97 

Tailored telemetry 
processing at IST, 
receipt of command 
requests from IST; 
IST Toolkits, FUI 

L-12 Mission SIM 
Readiness 
Test 

7/7/97 

7/11/97 

Verify functional 
capability of s/c data 
base, perform 
spacecraft 
maneuvers, mission 
simulations. 

All forward and return 
links required for 
support. real-time and 
contingency 
commanding. 
Not intended for 
verification of ground 
system. 

L-12 EOC Compat. 
Test # 2 

7/15/97 

7/18/97 

CMD RATES: 125 
BPS, KBPS, 2KBPS, 
10 KBPS. TLM 
Rates: 1/1, 16/16, 
16/256, 16/516 KBPS 
R/T SCC Data, SSR 
Buffer Dump. EOC, 
EDOS, EBnet, WSGT, 
TDRSS support. 

All forward and return 
links in the RF ICD; 
Comprehensive EOS 
Command and 
Telemetry demo. Test 
completed between L

13 months and L-3 
months; completed 
prior to spacecraft end 
to end test. 

L-11 AM-1 
Spacecraft 
Thermal 
Vacuum Test 

8/20/97 

9/15/97 

Activate S/C and 
instruments in 
vacuum; acquire live 
instrument data 

real-time processing 
of TLM at rates: 1/1, 
16/16, 16/256, 16/516 
kbps. EOC sends 
commands to AM-1. 

L-8 Comp. 
Performance 
Test #2 

11/15/97 

11/19/97 

AM-1 sends R/T and 
SCC dump & HK TLM 
to SN; EDOS/DIF 
send data to EOC 

Process all real-time 
data at all rates; 
process SCC dumps. 

L-7 EDOS/ETS/ 
EBnet 

12/15/97 

2/10/97 

Real-time and 
Contingency 
Commanding; real

time telemetry receipt; 
dump data receipt 

command uplink at all 
supported rates; real

time telemetry receipt 
- all formats at all 
supported data rates. 
Dump receipt at 
256/512 kbps. 

L-6 EOC Compat. 
Test # 3 

1/2/98 

1/6/98 

Demonstrate S/C 
compatibility to EOC 
command & TLM 
database 

EOC use of validated 
command, telemetry, 
activity and constraint 
database. 
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TIME FROM 
LAUNCH 
(Months) 

TEST NAME TEST 
DATES 

TEST DESCRIPTION FOS 
REQUIREMENTS 

L-4 AM-1 End-to 
End Test 

3/3/98 

3/8/98 

Demonstrate 
integrated S/C and 
ground system 
compatibility 

All forward and return 
links required for 
support; EOC sends 
commands and SCC 
& SI microprocessor 
loads; send 
commands 

L-4 Mission OPS 
Simulation 

3/9/98 

3/20/98 

Validate subset of 
nominal, contingency 
mission OPS 
procedures 

100 hours of 
scheduling operations 
including contingency 
situations. 

L-2 Comp. 
Performance 
Test #3 

5/13/98

5/17/98 

AM-1 send H/K TLM 
to EOC and EDOS via 
GSE & SN . EOC 
sends commands to 
AM-1 at VAFB via SN 
& GSE. 

Real-time and SSR 
data processing. R/T 
command uplink at all 
supported rates via 
SN & GSE. 

L-2 Ground Data 
System Test 

5/18/98 

5/31/98 

All Command 
interfaces checked. 
All Scheduling 
Functions and 
interfaces checked. 
All S/C Data and 
Types checked. 

All forward and return 
links required for 
support at VAFB. 
Includes DSN, GN & 
WOTS. 

L-1 AM-1 Launch 
Site 
Readiness 
Test 

6/2/98 

6/5/98 

SCS Provides data 
from VAFB to EDOS. 
EDOS sends Data to 
EOC. EOC sends 
attitude data to FDF & 
CMDS to VAFB via 
EDOS. 

All forward and return 
links required for 
support at VAFB. 

LAUNCH 6/30/98 
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4. FOS Release B Version 2.01.00 Test Cases 

Table 4-1. Release B Version 2.01.00 Test Cases 

Analysis: 

·ANA-2020B Spacecraft Clock Correlation Based on RDD Method 

·ANA-2040B Special Processing Algorithms 

·ANA-2060B Time Order Downlink Report 

·ANA-2120B Analysis Request Manager 

EDOS: 

·EDOS-2002B Test Command Echo Exchange 

·EDOS-2010B SCS Summary Report Processing 

IST: 

·IST-2000B IST Pool Management 

REG: 

·REG-3000FPB EOC Regression Test 

TLM: 

·TLM-2020B Decom - Context Dependent Telemetry 

·TLM-2060B Derived Parameter Processing 

CONT: 

·CONT-2030B SSR Monitoring 

DBS: 

·DBS-3100FPB Database Management via Web Pages 

FDF: 

·FDF-3100FPB Disk Cleaner 

FUI: 

·FUI-3000FPB Roles Usability 

SYS: 

·SYS-3050FPB Generic String Management 

·SYS-3060FPB Tivoli 
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Spacecraft Clock Correlation Based on RDD Method


Test Case No: ANA-2020B 

Test Configuration:  See Appendix G 

Test Support: Manufacturing specifications for equipment in the EOC. 

Test Case Description: 

This test is designed to calculate the S/C clock error by use of the RDD algorithm. This value is given by the difference 
between the S/C time stamp and a UTC estimate of spacecraft time which is based on the ground receipt time. The input 
comes from simulated housekeeping telemetry, RCT measurements, and FDF predicts of the range stored in a file. The FDF 
range driver is run on the day of the test. Two cases are considered. The first case is for clock errors of 0 and 100 
milliseconds with the telemetry data runs at 1 kb per second and the second case is with 16 kb per second. 

Following sign-on, the RCTD measurements are entered using the tool FaCcClockFileDriver and stored in a file. The FDF 
predicts are generated using the tool FaCcFdfRangeDriver and also stored in a file. The Packet Generator starts generating 
telemetry data at 1 kb per second. The FDF predicts file is read and S/C clock error is calculated. An event message is 
displayed once per minute during simulated S/C contact giving the error of the S/C clock. For the first part of the test, the 
clock error is zero. This test runs at telemetry data rates of 1 kb and 16 kb per second. Snaps of the event messages are 
taken when an event occurs. An average RCTD value from this contact is stored in a file for the next contact. The file is 
browsed and verified that it is correct from the knowledge of the starting value (it should change). At the end of S/C contact, 
a final event message is generated giving the average clock bias for the entire contact. A snap is taken for comparison with 
the report that is to be generated. Finally, an ASCII report giving the average clock bias is generated. 
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Success Criteria: 

This test is considered successful when the S/C clock error can be calculated by use of the RDD algorithm, the predicted S/C 
ranging data and RCTD measurements can be used as inputs to the RDD algorithm, and the predicted S/C ranging data can 
be calculated by interpolating or extrapolating to the nearest millisecond. 
notified once per minute. 
successful when a report is generated for each real-time pass during which clock correlation is performed and that the report 
contains: a) The start and stop times of the pass during which the correlation was performed, b) The S/C ID, c) The type of 
calculation used (RDD). 
and the S/C time associated with the results. 
millisecond and 100 milliseconds. 
comparison with starting data and noticing that they have changed. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Login to an EOC User Station by entering a valid 
user name and password: 

Username: fostest2 

Password: ******** 

The Data Server and Real-time Server must be 
running. 

The login is accepted and a blank desktop area 
appears. 

2. Bring up an xterm window: 

openwin 

A console window and an xterm window are opened. 

3. Set the environment variables: 

setenv SCRIPT UserStation 

The environment variables are set. 

4. Go to the setup directory: 

test 

The current directory is /fosb/test/am1/scripts/setup. 

5. Source the FosEnvVars file: 

source FosEnvVars 

More environment variables are set. 

Success is verified when the average clock bias is 
The test is It is successful when the capability to turn the process on/off can be demonstrated. 

It is successful when included in the report are the results from the clock correlation calculation, 
The test should be capable of generating a clock correlation bias of 0 

The average RCTD values that are stored for the next pass for two tests are verified by 
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6. Bring up the User Station: 

FOS_LOGIN 

FOS Login screen appears with the user name. 

7. Enter a valid password: 

Password: ******** 

The password is accepted. 

8. Click on the Environment toggle button and select 

‘Operational’. 

** Do not select ‘Standalone Mode’ **. 

‘Operational’ is selected. 

9. Click on ‘OK’. The FOS Login screen closes and the User Roles 
window pops up with a list of user roles displayed. 

10. Click on the Spacecraft toggle button and select 
‘AM1’. 

‘AM1’ is selected. 

11. Click on the Site toggle button and select ‘EOC’. ‘EOC’ is selected. 

12. Select ‘Command Activity Controller’ by 
highlighting it. 

‘Command Activity Controller’ is selected. 

13. Click on ‘OK’. A working dialog box opens with the message 
‘Starting User Station. Please wait’, indicating that 
the User Station startup script has not yet completed. 

The User Station startup is complete when Control 
Window comes up with the ‘User Logged in’ 
message. 

14. Bring up the Event Display: 

From Control Window, click on ‘Tools’. 

The Tool Selection Box window pops up. 

15. Select ‘Event Display-Global’ from the Tools 
menu. 

‘Event Display-Global’ appears in the Selection box. 
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16. Click on ‘OK’. The Tool Selection Box window closes and the 
Event Display window pops up. 

17. Bring up a new xterm. 

18. Set the environment variables for the User Station: 

setenv SCRIPT UserStation 

The environment variables are set. 

19. Go to the setup directory: 

test 

The current directory is /fosb/test/am1/scripts/setup. 

20. Set the environment variables: 

source FosEnvVars 

More environment variables are set. 

21. Change to the bin directory: 

bin 

T h e  c u r r e n t  d i r e c t o r y  i s  
/fosb/test/am1/bin/sun_sparc_5-5. 

22. Enter RCTD values for the Clock Correlation 
constant container 

23. Execute the FaCcClockFileDriver tool: 

FaCcClockFileDriver 

Clock Config File Menu displayed. 

Prompts for the selection. 

24. Your selection: 

Enter 3 

25. New value: 

Enter 1.15741e-11 

3) displays 1.15741e-11. 

26. Your selection: 

Enter 4 

27. New value: 

Enter 1.15741e-11 

4) displays 1.15741e-11. 
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28. Your selection: 

Enter 5 

29. New value: 

Enter 1.15741e-11 

5) displays 1.15741e-11. 

30. Your selection: 

Enter 6 

31. New value: 

Enter 1.15741e-11 

6) displays 1.15741e-11. 

32. Your selection: 

Enter 7 

33. New value: 

Enter 1.15741e-11 

7) displays 1.15741e-11. 

34. Your selection: 

Enter 8 

35. New value: 

Enter 1.15741e-11 

8) displays 1.15741e-11. 

36. Your selection: 

Enter 9 

37. New value: 

Enter 1.15741e-11 

9) displays 1.15741e-11. 

38. Your selection: 

Enter 10 
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39. New value: 

Enter 1.15741e-11 

10) displays 1.15741e-11. 

40. Your selection: 

Enter 11 

41. New value: 

Enter 1.15741e-11 

11) displays 1.15741e-11. 

42. Your selection: 

Enter 12 

43. New value: 

Enter 1.15741e-11 

12) displays 1.15741e-11. 

44. Your selection: 

Enter 13 

45. New value: 

Enter 4 

13) displays 4. 

46. Your selection: 

Enter 14 

47. New value: 

Enter 3.47222e-11 

14) displays 3.47222e-11. 

48. Your selection: 

Enter 15 

49. New value: 

Enter 5.78704e-10 

15) displays 5.78704e-10. 
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50. Your selection: 

Enter 16 

51. New value: 

Enter 8.10185e-11 

16) displays 8.10185e-11. 

52. Your selection: 

Enter 17 

53. New value: 

Enter 2.31481e-07 

17) displays 2.31481e-07. 

54. Your selection: 

Enter 18 

55. New value: 

Enter 2.99792e+08 

18) displays 2.99792e+08. 

56. Your selection: 

Enter 19 

57. New value: 

Enter CLOCK_ADJUST 

19) displays CLOCK_ADJUST. 

58. Your selection: 

Enter 20 

59. New value: 

Enter VALUE 

20) displays VALUE. 

60. Your selection: 

Enter 23 
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61. New value: 

Enter -778.869 

23) displays -778.869. 

62. Your selection: 

Enter 29 

Two menus are displayed. 

63. Your selection: 

Enter 2 

29) displays Error Sample Menu. 

64. Your selection: 

Enter 0 

The following messages displayed on the xterm: 

“Quitting 

Saving ODF file” 

The ClockOdf file is generated in the 
/fosb/test/am1/odf directory. 

65. Take a snap for later comparison with its future
value: 

snap 

66. Verify the file: 

cd /fosb/test/am1/odf 

ls ClockOdf 
The current directory is /fosb/test/am1/odf. 

The file is listed. 

67. View the file: 

more ClockOdf 

The file is viewed. 

68. Generate a day’s worth of FDF Range Predicts 
using the FaCcFdfRangeDriver tool 
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69. Execute the FDF Range Driver tool: 

FaCcFdfRangeDriver 

The following messages appear on xterm: 

“Welcome to the FDF Range File Driver 

Writing FDF header 

Writer FDF entries 

file successfully generated” 

The file by the name of 
FdFClock_1997.current_date is generated in the 
/fosb/test/am1/fdf directory. 

70. Verify the file: 

cd /fosb/test/am1/fdf 

ls FdFClock* 

The current directory is /fosb/test/am1/fdf. 

The file is listed. 

71. View the file: 

more FdFClock_1997.current_date 

The file is viewed. 

72. Invoke the EDOS telemetry driver for the 
multicast of housekeeping telemetry packets 
containing timing information for processing 

73. Find the host and port numbers to configure: 

cd /fosb/test/am1/config 

The current directory is /fosb/test/am1/config. 

74. more FoSwConfigData.cnfg The host and port are listed. 
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75. Connect to the default real-time operational string 
by entering the following ECL directive in Control 
Window: 

ECL: STRING CONNECT STRING = 
100 CONFIG = MIRROR 

(Wait for string connection to complete before 
going to the next step) 

The ECL directive disappears and the following 
messages appeared on Event Display and Control 
Window within several minutes of entering the 
‘CONNECT’ directive: 

“Establishing FoPsParameterServer service … 

FoPsParameterServer process successfully 
configured 

Establishing FtDcDecom service … 

FtDcDecom process successfully configured 

Successfully connected to String 100 as Mirrored” 

76. ECL: TAKE GROUNDCONTROL 
STRING = 100 

The following messages appeared on Event Display 
and Control Window: 

“StringMgr process successfully configured 

Ground Control Authority has changed from 
<user_id> to <user_id>” 

77. ECL: LIMITS OFF STRING = 100 Alarms and messages are turned off. 

78. Start the Clock Correlation process: 

ECL: CC START STRING = 100 

The ECL directive disappears and the following 
message appears on Event Display and Control 
Window: 

“Clock Correlation is starting for string 100” 

79. Change to the bin directory on an xterm: 

bin 

T h e  c u r r e n t  d i r e c t o r y  i s  
/fosb/test/am1/bin/sun_sparc_5-5. 
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80. Start the Packet Generator: 

FtPgPackGen 

The following messages appear on xterm where 
FtPgPackGen is running: 

“Packet Generator 

Restoring Tlm Streams 

Restoring Pids 

Setting packet and pid links 

Packet Generator is ready to receive directives” 

81. Receive data thru I channel with data rate at 1 
kbps 

82. Enter the following ECL directive to the Control 
Window: 

ECL: PG CONFIG HOST = 225.2.7.0 
PORT = 20101 APID = 1 

The host and port are configured. 

83. ECL: PG DELAY MILLS = 16384 APID 
= 1 

The delay between H/K packets is set to 16*1024 
ms. 
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84. ECL: PG STARTDATA APID = 1 
COUNT = -1 

The following message appears on xterm: 

“FtPgPackGen STARTDATA: 

Sending continuous packets for Apids: 1 

sending packet #0, ccsds seq #0, master cycle 0, 
apid 1 

sending packet #1, ccsds seq #1, master cycle 0, 
apid 1 

sending packet #2, ccsds seq #2, master cycle 0, 
apid 1 

: 

85. Take snapshots every minute at the user station: 

snap 

View the Events Display window to see one minute
worth of data. The snaps are printed at the system
printer. Collect the printouts for off-line analysis. 

86. ECL: PG STOPDATA APID = 1 The following message appears on xterm: 

“FtPgPackGen STOPDATA: 

Data has stopped for apid 1” 

87. ECL: CLOCK END CC starts calculations. 

At the end of the run (LOS), an event message with
the average clock correlation time is generated. 

At the end of a run (LOS), a report is also generated. 

88. Browse the report that contains the average 
RCTD value written at the end of the pass using 
the report browser 

89. From Control Window, click on ‘Tools’. The Tool Selection Box window pops up. 
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90. Select ‘Report_Browser’ from the Tools menu. Report_Browser appears in the Selection box. 

91. Click on ‘OK’. The Tools Selection Box closes and the Netscape: 
Directory listing of /fosb/int/am1/reports window
opens. 

92. Select the ‘rddclock’ directory. A list of reports appear. 

93. Select the report to browse. The report is browsed. 

Verify that the Clock Correlation report contains the 
start and stop times of the pass during which the
correlation was performed, the S/C ID, the type of
calculation used (RDD). The report should also 
contain the average clock correlation value and the 
S/C time associated with the results. 

94. Take a snap: 

snap 

The screen is snapped. 

95. Click on ‘File’ and select ‘Exit’ from the pull- 
down menu. 

The Report_Browser exits out. 

96. Receive data thru Q channel with data rate at 16 
kbps 

97. Start the Clock Correlation process: 

ECL: CC START STRING = 100 

The ECL directive disappears and the following 
message appears on Event Display and Control 
Window: 

“Clock Correlation is starting for string 100” 

98. Enter the following ECL directive to the Control 
Window: 

ECL: PG CONFIG HOST = 225.2.7.0 
PORT = 20110 APID = 1 

The host and port are configured. 
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99. ECL: DELAY MILLS = 1024 APID = 1 The delay between H/K packets is set to 1024 ms. 

100. ECL: PG STARTDATA APID = 1 
COUNT = -1 

The flow of continuous H/K data has started. 

101. Take snapshots every minute at the user station: 

snap 

View the events display window to see one minute
worth of data. The snaps are printed at the system
printer. Collect the printouts for off-line analysis. 

102. ECL: PG STOPDATA APID = 1 The flow of H/K data has stopped. 

103. ECL: CLOCK END CC starts calculations. 

At the end of the run (LOS), an event message with
the average clock time is generated. 

At the end of a run (LOS), a report is also generated. 

104. Take a snap: 

snap 

105. Browse the report that contains the average 
RCTD value written at the end of the pass using 
the report browser 

106. From Control Window, click on ‘Tools’. The Tool Selection Box window pops up. 

107. Select ‘Report_Browser’ from the Tools menu. Report_Browser appears in the Selection box. 

108. Click on ‘OK’. The Tools Selection Box closes and the Netscape: 
Directory listing of /net/beeper/fosb/int/AM1/reports
window opens. 

109. Select the ‘rddclock’ directory. A list of reports appear. 
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110. Select the report to browse. Verify that the Clock Correlation report contains the 
start and stop times of the pass during which the
correlation was performed, the S/C ID, the type of
calculation used (RDD). The report should also 
contain the average clock correlation value and the 
S/C time associated with the results. 

111. Take a snap: 

snap 

The screen is snapped. 

112. Click on ‘File’ and select ‘Exit’ from the pull- 
down menu. 

The Report_Browser exits out. 

113. End of test. 
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Special Processing Algorithms Test Procedure


Test Case No: ANA-2040B 

Test Configuration: See Appendix G 

Test Support: None 

Test Dependencies: Previously created user algorithm written in C or C++ code. 

Test Case Description: 

This test is designed to verify the ability to take user supplied algorithms and system algorithms (curve fit, Fast Fourier 
Transform, smooth fit and compute the root mean square). 
algorithm will be registered with 20 inputs and 20 outputs defined and assigned to telemetry mnemonics. 
will be built with the same 20 input parameters selected. 
executed and a dataset will be generated. 
algorithms are performed on the resulting dataset. 

Success Criteria: 

This test is considered successful when all of the user interface menus supporting special processing algorithms include the 
proper fields (parameter name, triggers, and symbols); User supplied algorithms uses 20 input and 20 output parameters and a 
dataset is generated; System algorithms (curve fit, Fast Fourier Transform, smoothing and computin root mean square) are 
performed on the dataset. 
can be used as input to an analysis request that uses the user algorithm. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Start the Data Server. 

Reference Test Case SYS-2000B -- FOS Server 
Startup. 

Data Server processes are running. 

The The user supplied algorithms are written in C or C++ code. 
An analysis request 

will be The analysis request will be submitted, the algorithm 
System The results of the dataset are displayed in a Time Order Downlink Report. 

The output of the analysis request is generated into a Time Order Downlink report and the dataset 
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2. Start the Real-Time Server. 

Reference Test Case SYS-2000B -- FOS Server 
Startup. 

Real-Time Server processes are running. 

3. Start the User Station. 

Reference Test Case SYS-2010B -- User Station 
Startup and Authentication. 

The FOT User Station is running and the Control 
Window is displayed. 

4. Invoke the Event Display. 

Click on ‘Tools’ from the control window 

The Tools Dialog window is displayed 

5. Select ‘Event_Display_Global’ from the control 
window tools menu. 

Click on the ‘OK’ button 

The Event Display is displayed on the FOT User 
Station. 

6. Click on ‘Filter’ from the pull down menu 

Select ‘Event Type’ 

Click ‘Bold’ button next to ANL & SYS 

Click ‘Apply’ 

Click ‘Close’ 

The Event_Display_Global will now display all 
ANA & SYS subsystem activities in bold. 

7. Register the User Algorithm 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 
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8. Select ‘Algorithm_Registration’ 

Click on ‘OK’ button. 

The toplevelShell Window is displayed and it 
contains the following fields: 

Source File Name 

Algorithm Description 

Registration results 

Status field 

9. Click on ‘Select File’ button The file selecyion box is displayed. The default 
directory path will be /fosb/test/am1/useralagrs/src. 

10. From the Files list 

Select ‘TwentyIO.C’ 

Click on ‘OK’ 

The selected file will be displayed in the Source File 
name text box of the toplevelShell window. 

11. Enter into the Algorithm Information text box: 

‘This will do 20 input and 20 output parameters’ 

Click on the ‘Register’ button. 

The algorithm is registered. The information will 
appear in the Algorithm Information text box. The 
Status field will display TwentyIO.C registration 
successfully completed. 

12. Click on the File pull down menu 

Select ‘QUIT’ 

The toplevelShell window will close. 

13. Invoke the Analysis_Request_Builder 

Click on the ‘Tools’ button 

The Tools Dialog window and a list of tools is 
displayed to the user. 

14. Select ‘Analysis_Request_Builder’. 

Click on ‘OK’ button. 

The Analysis_Request_Builder window is displayed. 
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15. Click on the Algorithm box. The algorithmWinSHELL window appears. It 
contains the following fields and buttons: 

Available Algorithms 

Algorithm Description 

Select Algorithms 

Assign Input Tlm 

Assign Output Tlm 

16. From the Available Algorithms selection box, select 
‘TwentyIO’ registered algorithm. 

Click on the ‘Assign Input Tlm…’ button 

The fuAnAlgInputSHELL Window is displayed. 
Symbols associated witht he code of the registered 
algorithm will be displayed in the Input Symbols 
text box. 

17. Note:  Fields are displayed as the user selects a 
filter criteria. 

Invoke the Selection Filter Screen: 

Click on the ‘Filter…’ button. 

The selection Filter Screen is displayed and it 
contains the following fields and user interface 
menus: 

Spacecraft text area 

Instrument text area 

Sample Type text area 

Selected subsystem text area. 

18. Select ‘AM1’ in the Spacecraft text area. Instruments associated with AM1 are displayed in 
the Instrument text area. 

19. Select ‘EPS’ in the Instrument text area. Sample Types associated with EPS are displayed in 
the Sample Type text area. 
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20. Select ‘V’ in the sample type text area 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_EPS_V is displayed 
in the Selected text area. 

21. Click the ‘OK’ button. The filter list is displayed in the Subsystems section 
of the fuAnAlgInputSHELL. 

22. Click on the ‘AM1_EPS_V’ toggle button in the 
subsystem area. 

A list of mnemonics associated AM1_EPS_V are 
displayed in the Available Parameters text area. 

23. Select ‘EPS_VR_BBAT_CELL01A’ in the 
available parameters text area. 

Select ‘mpsemisa1’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL01A and mpsemisa1 will be 
displayed in the Input Assignments area. 

24. Click ‘OK’ button A dialog box will appear indicating that 20 input 
parameters need to be selected. 

25. In the dialog box 

Click ‘Close’ button. 

The dialog box will close. 

26. Select ‘EPS_VR_BBAT_CELL01B’ in the 
available parameters text area. 

Select ‘mpsemisa2’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL01B and mpsemisa2 will be 
displayed in the Input Assignments area. 
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27. Select ‘EPS_VR_BBAT_CELL02A’ in the 
available parameters text area. 

Select ‘mpsemisa3’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL02A and mpsemisa3 will be 
displayed in the Input Assignments area. 

28. Select ‘EPS_VR_BBAT_CELL02B’ in the 
available parameters text area. 

Select ‘mpsemisa4’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL02B and mpsemisa4 will be 
displayed in the Input Assignments area. 

29. Select ‘EPS_VR_BBAT_CELL03A’ in the 
available parameters text area. 

Select ‘mpsemisa5’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL03A and mpsemisa5 will be 
displayed in the Input Assignments area. 

30. Select ‘EPS_VR_BBAT_CELL03B’ in the 
available parameters text area. 

Select ‘mpsemisa6’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL03B and mpsemisa6 will be 
displayed in the Input Assignments area. 
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31. Select ‘EPS_VR_BBAT_CELL04A’ in the 
available parameters text area. 

Select ‘mpsemisa7’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL04A and mpsemisa7 will be 
displayed in the Input Assignments area. 

32. Select ‘EPS_VR_BBAT_CELL04B’ in the 
available parameters text area. 

Select ‘mpsemisa8’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL04B and mpsemisa8 will be 
displayed in the Input Assignments area. 

33. Select ‘EPS_VR_BBAT_CELL05A’ in the 
available parameters text area. 

Select ‘mpsemisa9’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL05A and mpsemisa9 will be 
displayed in the Input Assignments area. 

34. Select ‘EPS_VR_BBAT_CELL05B’ in the 
available parameters text area. 

Select ‘mpsemisa10’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL05B and mpsemisa10 will 
be displayed in the Input Assignments area. 
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35. Select ‘EPS_VR_BBAT_CELL06A’ in the 
available parameters text area. 

Select ‘mpsemisa11’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL06A and mpsemisa11 will 
be displayed in the Input Assignments area. 

36. Select ‘EPS_VR_BBAT_CELL06B’ in the 
available parameters text area. 

Select ‘mpsemisa12’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL06B and mpsemisa12 will 
be displayed in the Input Assignments area. 

37. Select ‘EPS_VR_BBAT_CELL07A’ in the 
available parameters text area. 

Select ‘mpsemisa13’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL07A and mpsemisa13 will 
be displayed in the Input Assignments area. 

38. Select ‘EPS_VR_BBAT_CELL07B’ in the 
available parameters text area. 

Select ‘mpsemisa14’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL07B and mpsemisa14 will 
be displayed in the Input Assignments area. 
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39. Select ‘EPS_VR_BBAT_CELL08A’ in the 
available parameters text area. 

Select ‘mpsemisa15’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL08A and mpsemisa15 will 
be displayed in the Input Assignments area. 

40. Select ‘EPS_VR_BBAT_CELL08B’ in the 
available parameters text area. 

Select ‘mpsemisa16’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL08B and mpsemisa16 will 
be displayed in the Input Assignments area. 

41. Select ‘EPS_VR_BBAT_CELL09A’ in the 
available parameters text area. 

Select ‘mpsemisa17’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL09A and mpsemisa17 will 
be displayed in the Input Assignments area. 

42. Select ‘EPS_VR_BBAT_CELL09B’ in the 
available parameters text area. 

Select ‘mpsemisa18’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL09B and mpsemisa18 will 
be displayed in the Input Assignments area. 
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43. Select ‘EPS_VR_BBAT_CELL10A’ in the 
available parameters text area. 

Select ‘mpsemisa19’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL10A and mpsemisa19 will 
be displayed in the Input Assignments area. 

44. Select ‘EPS_VR_BBAT_CELL10B’ in the 
available parameters text area. 

Select ‘mpsemisa20’ Input Symbol from the Input 
Symbol selection box 

Click on the ‘Assign’ button. 

EPS_VR_BBAT_CELL10B and mpsemisa20 will 
be displayed in the Input Assignments area. 

45. Click on the ‘AM1_EPS_V’ toggle button. The list of mnemonics in the Available Parameters 
text area removed. 

46. Click the ‘Set Timer Every’ button 

Enter: 

10 secs 

Click the ‘Apply’ button. 

Every 10 secs the algorithm will be executed on the 
mnemonic. 

47. Click on ‘OK’ button. The fuAnAlgInputSHELL window is closed and the 
algorithmWinSHELL window is displayed. 

48. Click on the ‘Assign Output Tlm…’ button The fuAnAlgOutputSHELL Window is displayed. 
Symbols associated with the code of the registered 
algorithm will be displayed in the Input Symbols test 
box. 
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49. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM1’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

50. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM2’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

51. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM3’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 
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52. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM4’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

53. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM5’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

54. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM6’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 
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55. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM7’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

56. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM8’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

57. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM9’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 
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58. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM10’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

59. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM11’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

60. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM12’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 
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61. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM13’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

62. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM14’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

63. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM15’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 
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64. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM16’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

65. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM17’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

66. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM18’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

4-32
 322-CD-100-001/ 
411-CD-100-001 



67. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM19’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

68. In the New Parameter text box, enter a new 
parameter name. 

‘AM1_OUT_PARM20’ 

From the Output Symbols box, select an associated 
output symbol. 

Click on ‘Assign’ button. 

Output parameters and Output Symbols appear in 
the Output assignments box. 

69. Click on ‘OK’ button. The fuAnAlgOutputSHELL window is closed and 
the algorithmWinSHELL window is displayed. 

70. Click on ‘Apply’ button The algorithm will appear in the selected algorithm 
area. 

71. Click on ‘OK’ button. The algorithmWinSHELL window is closed and the 
Analysis_Request_Builder window is displayed. 

72. Create an Analysis Request 

Enter into the request name field. 

Algo1 

Algo1 appears in the Request Name field. 

73. Click the mouse on the ‘Process On This User 
Station’ icon to select data to be processed on that 
work station. 

Process On This User Station icon should show 
selected. 
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74. Click the mouse on the ‘All Data’ button in the Data 
Quality box. 

The ‘All Data’ button should show selected 

75. Selecting Telemetry Mnemonics 

Click on the ‘Select Telemetry…’ button. 

The Telemetry Selector window is displayed. 

76. Note:  Fields are displayed as the user selects a 
filter criteria. 

Invoke the Selection Filter Screen: 

Click on the ‘Filter…’ button. 

The Selection Filter Screen is displayed 

77. Select ‘AM1’ in the Spacecraft text area. Instruments associated with AM1 are displayed in 
the Instrument text area. 

78. Select ‘EPS’ in the Instrument text area. Sample Types associated EPS are displayed in the 
Sample Type text area. 

79. Select ‘V’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_EPS_V is displaye 
din the Selected text area. 

80. Click on the ‘OK’ button The filter list is displayed in the Analysis Telemetry 
Selector window in the Subsystems section. 

81. Click on the ‘AM1_EPS_V’ toggle button. The list of mnemonics associated with AM1_EPS_V 
are displayed in the Available Parameters text area 
of the Analysis Telemetry Selector window. 
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82. Select: 

‘EPS_VR_BBAT_CELL01A’ 

‘EPS_VR_BBAT_CELL01B’ 

‘EPS_VR_BBAT_CELL02A’ 

‘EPS_VR_BBAT_CELL02B’ 

‘EPS_VR_BBAT_CELL03A’ 

‘EPS_VR_BBAT_CELL03B’ 

‘EPS_VR_BBAT_CELL04A’ 

‘EPS_VR_BBAT_CELL04B’ 

‘EPS_VR_BBAT_CELL05A’ 

‘EPS_VR_BBAT_CELL05B’ 

‘EPS_VR_BBAT_CELL06A’ 

‘EPS_VR_BBAT_CELL06B’ 

‘EPS_VR_BBAT_CELL07A’ 

‘EPS_VR_BBAT_CELL07B’ 

‘EPS_VR_BBAT_CELL08A’ 

‘EPS_VR_BBAT_CELL08B’ 

‘EPS_VR_BBAT_CELL09A’ 

‘EPS_VR_BBAT_CELL09B’ 

‘EPS_VR_BBAT_CELL10A’ 

‘EPS_VR_BBAT_CELL10B’ 

Select a sampling rate. 

Click the ‘All Data’ button 

Click the ‘Select’ button 

Mnemonics 

EPS_VR_BBAT_CELL01A 

EPS_VR_BBAT_CELL01B 

EPS_VR_BBAT_CELL02A 

EPS_VR_BBAT_CELL02B 

EPS_VR_BBAT_CELL03A 

EPS_VR_BBAT_CELL03B 

EPS_VR_BBAT_CELL04A 

EPS_VR_BBAT_CELL04B 

EPS_VR_BBAT_CELL05A 

EPS_VR_BBAT_CELL05B 

EPS_VR_BBAT_CELL06A 

EPS_VR_BBAT_CELL06B 

EPS_VR_BBAT_CELL07A 

EPS_VR_BBAT_CELL07B 

EPS_VR_BBAT_CELL08A 

EPS_VR_BBAT_CELL08B 

EPS_VR_BBAT_CELL09A 

EPS_VR_BBAT_CELL09B 

EPS_VR_BBAT_CELL10A 

EPS_VR_BBAT_CELL10B 

along with the selected sampling rates are displayes 
in the Selected Parameters field. 
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83. Selecting Start and Stop Times 

Click on the ‘Select Time’ button 

The Selected Pair Times window is displayed. 

84. Click the ‘Select’ button The Pair Time Selector window is displayed 

85. Click the ‘Absolute’ button The Absolute button is selected 

86. Click the ‘Time’ button The Time button is selected 

87. Click the ‘Specify End Time’ button The Specify End Time button is selected 

88. Enter into the start date field: 

1997/348 

1997/348 is displayed in start date field 

89. Enter into the start time field: 

17:00:00.000 

17:00:00.000 is displayed in start time field 

90. Enter into the stop date field: 

1997/348 

1997/348 is displayed in stop date field 

91. Enter into the stop time field: 

18:00:00.000 

18:00:00.000 is displayed in stop time field 

92. Click the ‘OK’ button The selected start and stop times match the start and 
stop times in the Selected Pair Times window. 

93. Select an output dataset name for the analysis 
request 

Click the output dataset name toggle button. 

Enter the name of the output dataset (request name): 

Algo1 

Algo1 will be displayed in the Output Dataset Name 
box. 
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94. Save the analysis request 

Click on the File pull down menu 

A list of options appears. 

95. Select ‘Save as …’ A File Selection window is displayed with a default 
directory path in the selection field. The default 
directory path will be 
/fosb/test/am1/data/FUI/requests/. 

96. Enter the name of the request: 

A1ATAlgs_Base 

Click the ‘OK’ button 

A dialog box informing the user that the file was 
saved. 

97. Save the analysis request 

Click on the File pull down menu 

A list of options appears. 

98. Select ‘Save as …’ A File Selection window is displayed with a default 
directory path in the selection field. The default 
directory path will be 
/fosb/test/am1/data/FUI/requests/. 

99. Enter the name of the request: 

A1ATAlgs 

Click the ‘OK’ button 

A dialog box informing the user that the file was 
saved. 

100. Click the ‘Close’ button in the information dialog 
box. 

The dialog box will close 

101. Click the ‘OK’ button in the Analysis Request 
Builder window 

A dataset for the given options selected has been 
submitted for generation. 
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102. Monitor the Event Display for the message Analysis 
Request X has started on host N. 

Where X = the number of the request and N = the 
Name of the Host machine that started the request. 

Wait for an event message indicating that the 
analysis request is complete. In the Events Display 
window a message will be displayed ‘Analysis 
Request X completed on Host N. 

103. Invoke the Analysis_Request_Builder 

Click on the ‘Tools’ button 

The Tools Dialog window and a list of tools is 
displayed to the user. 

104. Select ‘Analysis_Request_Builder’. 

Click on ‘OK’ button. 

The Analysis_Request_Builder window is displayed. 

105. Click on the File pull down menu A list of options appear 

106. Select ‘Open’ A File Selection window is displayed 

107. Select ‘A1ATAlgs_Base’ 

Click the ‘OK’ button 

The Analysis Request named A1ATAlgs_Base is 
displayed and the request status will indicate 
Read/Edit. 

108. Click on the Algorithm box The algorithmWinSHELL window appears. 

109. From the Select Algorithms selection box 

Select TwentyIO 

Click on ‘Assign Input Tlm…’ button 

The fuAnAlgInputSHELL window is displayed 

110. In the fuAnAlgInputSHELL window 

Deselect Timer trigger 

The Timer trigger button will be deselected. 

111. Invoke the Selection Filter Screen: 

Click on the ‘Filter…’ button. 

The selection Filter Screen is displayed. 
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112. Select ‘AM1’ in the Spacecraft text area. Instruments associated with AM1 are displayed in 
the Instrument text area. 

113. Select ‘EPS’ in the Instrument text area. Sample Types associated with EPS are displayed in 
the Sample Type text area. 

114. Select ‘V’ in the sample type text area 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_EPS_V is displayed 
in the Selected text area. 

115. Click the ‘OK’ button. The filter list is displayed in the Subsystems section 
of the fuAnAlgInputSHELL. 

116. Click on the ‘AM1_EPS_V’ toggle button in the 
subsystem area. 

A list of mnemonics associated AM1_EPS_V are 
displayed in the Available Parameters text area. 

117. Select ‘EPS_VR_BBAT_CELL01A’ in the 
available parameters text area. 

Click the ‘Use Parameter’ button 

Click the ‘Apply’ button. 

EPS_VR_BBAT_CELL01A will appear in the 
Selected Triggers box. 

118. Click the ‘OK’ button The fuAnAlgInputSHELL window is closed and the 
algorithmWinSHELL is displayed. 

119. Click the ‘OK’ button. The algorithmWinSHELL is closed and the 
Analysis_Request_Builder Window is displayed. 

120. Create an Analysis Request 

Enter into the request name field: 

Algo2 

Algo2 appears in the Request Name field. 
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121. Ensure the start and stop times are correct The start and stop times should reflect: 

1997/348 17:00:00.000 

1997/348 18:00:00.000 

122. Select an output dataset name for the analysis 
request. 

Click the output dataset name and toggle buton. 

Enter the name of the output dataset (request name): 

Algo2 

Algo2 will be displayed in the Output Dataset Name 
box. 

123. Save the analysis request 

Click on the File pull down menu. 

A list of options will appear. 

124. Select ‘Save as …’ A File Selection window is displayed 

125. Enter the name of the request: 

Algo2 

Click the ‘OK’ button 

A dialog box informing the user the file was saved 
will appear. 

126. Click the ‘Close’ button in the information dialog 
box. 

The dialog box will close. 

127. Click the ‘OK’ button in the Analysis Request 
Builder window 

A dataset for the given options selected has been 
submitted for generation. 
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128. Monitor the Event Display for the message Analysis 
Request X has started on host N. 

Where X = the number of the request and N = the 
Name of the Host machine that started the request. 

Wait for an event message indicating that the 
analysis request is complete. In the Events Display 
window a message will be displayed ‘Analysis 
Request X completed on Host N. 

129. Invoke the Analysis_Request_Builder 

Click on the ‘Tools’ button 

The Tools Dialog window and a list of tools is 
displayed to the user. 

130. Select ‘Analysis_Request_Builder’. 

Click on ‘OK’ button. 

The Analysis_Request_Builder window is displayed. 

131. Click on the File pull down menu A list of options appear 

132. Select ‘Open’ A File Selection window is displayed 

133. Select ‘A1ATAlgs_Base’ 

Click the ‘OK’ button 

The Analysis Request named A1ATAlgs_Base is 
displayed and the request status will indicate 
Read/Edit. 

134. Click on the Algorithm box The algorithmWinSHELL window appears. 

135. From the Select Algorithms selection box 

Select TwentyIO 

Click on ‘Assign Input Tlm…’ button 

The fuAnAlgInputSHELL window is displayed 
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136. In the fuAnAlgInputSHELL window 

Select EPS_VR_BBAT_CELL01A in the Selected 
Triggers box. 

Click ‘Remove’ button 

Click the ‘Use Parameter’ button 

The parameter will be deselected. 

137. Click the ‘Set Timer Every’ button 

Enter: 

10 secs 

Click the ‘Apply’ button. 

Every 10 secs the algorithm will be executed on the 
mnemonic. 

138. Click the ‘OK’ button The fuAnAlgInputSHELL window is closed and the 
algorithmWinSHELL is displayed. 

139. Click the ‘OK’ button. The algorithmWinSHELL is closed and the 
Analysis_Request_Builder Window is displayed. 

140. Create an Analysis Request 

Enter into the request name field: 

Algo3 

Algo3 appears in the Request Name field. 

141. Ensure the start and stop times are correct The start and stop times should reflect: 

1997/348 17:00:00.000 

1997/348 18:00:00.000 

4-42
 322-CD-100-001/ 
411-CD-100-001 



142. Select an output dataset name for the analysis 
request. 

Click the output dataset name and toggle buton. 

Enter the name of the output dataset (request name): 

Algo3 

Algo3 will be displayed in the Output Dataset Name 
box. 

143. Select an input dataset name for the analysis 
request. 

Click the input dataset name and toggle buton. 

Enter the name of the input dataset (request name): 

A1ATAlgs_filename 

The A1ATAlgs_filename is displayed in the 
datsetset as input text box. 

144. Save the analysis request 

Click on the File pull down menu. 

A list of options will appear. 

145. Select ‘Save as …’ A File Selection window is displayed 

146. Enter the name of the request: 

Algo3 

Click the ‘OK’ button 

A dialog box informing the user the file was saved 
will appear. 

147. Click the ‘Close’ button in the information dialog 
box. 

The dialog box will close. 

148. Click the ‘OK’ button in the Analysis Request 
Builder window 

A dataset for the given options selected has been 
submitted for generation. 
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149. Monitor the Event Display for the message Analysis 
Request X has started on host N. 

Where X = the number of the request and N = the 
Name of the Host machine that started the request. 

Wait for an event message indicating that the 
analysis request is complete. In the Events Display 
window a message will be displayed ‘Analysis 
Request X completed on Host N. 

150. Place the mouse pointer on the screen and activate 
the pull down menu by pressing the right most 
mouse button. 

Select Programs 

Select X-term 

An X-term window will open. 

151. Go to the “datasets” directory and do a long listing 
for the A1ATAlgs dataset. 

%:cd /fosb/test/am1/datasets 

%:ll -ltr 

The A1ATAlgs dataset will appear in the datasets 
directory. 

152. Go to the “setup” directory and source FosEnvVars 

%:cd /fosb/test/am1/scripts/setup 

%:setenv SCRIPT UserStation 

%:source FosEnvVars 

The environment is configured to run the 
FaDrReaderDriver. 

153. Execute the FaDrReaderDriver 

$BIN_DIR/FaDrReaderDriver 

The driver is executed. 
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154. Follow the menu prompts: 

Enter: 

1 

for Telemetry 

The ReaderDriver will respond with a prompt 

155. Enter the TLM dataset name: 

A1ATAlgs _YYYYDOYHHMMSS_NN 

The ReaderDriver will execute and read the TLM 
file. Another menu will appear 

156. Enter: 

6 

to generate a report. 

The ReaderDriver prompt for a new for the report. 

157. Enter: 

A1ATAlgs 

The FaDrReaderDriver will generate the report. 

158. Enter: 

0 

to quit the FaDrReaderDriver 

The FaDrReaderDriver will quit. 

159. Go to the “reports” directory and do a long listing 
for the A1ATAlgs. 

%:cd /fosb/test/am1/reports 

%:ll -ltr 

The A1ATAlgs will be displayed as 

A1ATAlgs.report 

160. Print a Time Order Downlink Report 

%:lp A1ATAlgs.report 

The report will print. Via off line analysis the report 
will display the results of the algorithm executed 
every 10 secs. 
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161. Go to the “datasets” directory and do a long listing 
for the Algo2 dataset. 

%:cd /fosb/test/am1/datasets 

%:ll -ltr 

The Algo2 dataset will appear in the datasets 
directory. 

162. Go to the “setup” directory and source FosEnvVars 

%:cd /fosb/test/am1/scripts/setup 

%:setenv SCRIPT UserStation 

%:source FosEnvVars 

The environment is configured to run the 
FaDrReaderDriver. 

163. Execute the FaDrReaderDriver 

$BIN_DIR/FaDrReaderDriver 

The driver is executed. 

164. Follow the menu prompts: 

Enter: 

1 

for Telemetry 

The ReaderDriver will respond with a prompt 

165. Enter the TLM dataset name: 

Algo2 _YYYYDOYHHMMSS_NN 

The ReaderDriver will execute and read the TLM 
file. Another menu will appear 

166. Enter: 

6 

to generate a report. 

The ReaderDriver prompt for a new for the report. 

167. Enter: 

Algo2 

The FaDrReaderDriver will generate the report. 
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168. Enter: 

0 

to quit the FaDrReaderDriver 

The FaDrReaderDriver will quit. 

169. Go to the “reports” directory and do a long listing 
for the Algo2. 

%:cd /fosb/test/am1/reports 

%:ll -ltr 

The Algo2 will be displayed as 

Algo2.report 

170. Print a Time Order Downlink Report 

%:lp Algo2.report 

The report will print. Via off line analysis the report 
will display the results of the algorithm executed 
every time EPS_VR_BBAT_CELL01A appears. 

171. Go to the “datasets” directory and do a long listing 
for the Algo3 dataset. 

%:cd /fosb/test/am1/datasets 

%:ll -ltr 

The Algo3 dataset will appear in the datasets 
directory. 

172. Go to the “setup” directory and source FosEnvVars 

%:cd /fosb/test/am1/scripts/setup 

%:setenv SCRIPT UserStation 

%:source FosEnvVars 

The environment is configured to run the 
FaDrReaderDriver. 

173. Execute the FaDrReaderDriver 

$BIN_DIR/FaDrReaderDriver 

The driver is executed. 
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174. Follow the menu prompts: 

Enter: 

1 

for Telemetry 

The ReaderDriver will respond with a prompt 

175. Enter the TLM dataset name: 

Algo3 _YYYYDOYHHMMSS_NN 

The ReaderDriver will execute and read the TLM 
file. Another menu will appear 

176. Enter: 

6 

to generate a report. 

The ReaderDriver prompt for a new for the report. 

177. Enter: 

Algo3 

The FaDrReaderDriver will generate the report. 

178. Enter: 

0 

to quit the FaDrReaderDriver 

The FaDrReaderDriver will quit. 

179. Go to the “reports” directory and do a long listing 
for the Algo2. 

%:cd /fosb/test/am1/reports 

%:ll -ltr 

The Algo3 will be displayed as 

Algo3.report 

180. Print a Time Order Downlink Report 

%:lp Algo3.report 

The report will print. Via off line analysis the report 
will display the results of the algorithm executed 
using A1ATAlgs as input to the request. 
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181. System Algorithms 

Fast Fourier Transform 

Execute the FaDrReaderDriver 

$BIN_DIR/FaDrReaderDriver 

The driver is executed. 

182. Follow the menu prompts: 

Enter: 

1 

for Telemetry 

The ReaderDriver will respond with a prompt 

183. Enter the TLM dataset name: 

A1ATAlgs _YYYYDOYHHMMSS_NN 

The ReaderDriver will execute and read the TLM 
file. Another menu will appear 

184. Enter: 

8 

to perform Fast Fourier Transform. 

The ReaderDriver prompt for a PID to be 
transformed. 

185. Enter: 

1766 

The FaDrReaderDriver will execute Fast Fourier 
Transform on PID 1766 and display the results on in 
the window. 

186. Enter: 

0 

to quit the FaDrReaderDriver 

The FaDrReaderDriver will quit. 
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187. System Algorithms 

Data Smoothing 

Execute the FaDrReaderDriver 

$BIN_DIR/FaDrReaderDriver 

The driver is executed. 

188. Follow the menu prompts: 

Enter: 

1 

for Telemetry 

The ReaderDriver will respond with a prompt 

189. Enter the TLM dataset name: 

A1ATAlgs _YYYYDOYHHMMSS_NN 

The ReaderDriver will execute and read the TLM 
file. Another menu will appear 

190. Enter: 

9 

to perform Data Smoothing. 

The ReaderDriver prompt for a PID to be smoothed. 

191. Enter: 

1766 

The ReaderDriver prompt for a rate to be smoothed - 
greater than 0. 

192. Enter: 

7 

as a smoothing rate 

The FaDrReaderDriver will execute Data Smoothing 
on PID 1766 and display the results on in the 
window. 

4-50
 322-CD-100-001/ 
411-CD-100-001 



193. Enter: 

0 

to quit the FaDrReaderDriver 

The FaDrReaderDriver will quit. 

194. System Algorithms 

Curve Fit 

Execute the FaDrReaderDriver 

$BIN_DIR/FaDrReaderDriver 

The driver is executed. 

195. Follow the menu prompts: 

Enter: 

1 

for Telemetry 

The ReaderDriver will respond with a prompt 

196. Enter the TLM dataset name: 

A1ATAlgs _YYYYDOYHHMMSS_NN 

The ReaderDriver will execute and read the TLM 
file. Another menu will appear 

197. Enter: 

10 

to perform Curve Fitting. 

The ReaderDriver prompt for an independent PID to 
be regressed. Use zero if time is the independent 
PID. 

198. Enter: 

0 

The ReaderDriver prompt for a degree of 
polynomial to be fitted. 

199. Enter: 

9 

The FaDrReaderDriver will execute cure fitting on 
PID 1766 and display the results on in the window. 
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200. Enter: 

0 

to quit the FaDrReaderDriver 

The FaDrReaderDriver will quit. 

201. End of test. 
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Time Order Downlink Report Test Procedure


Test Case No: ANA-2060B 

Test Configuration: See Appendix G 

Test Support: None 

Test Dependencies: Previously created dataset that contains one EU conversion and one raw value. 

Test Case Description: 

This test is designed to verify the ability to a generate and print a Time Order Downlink Report based on information 
selected from a combination of user interface and analysis tool options from a previously defined dataset. 

The test begins with the initialization of the EOC to support off-line analysis processing. A previously created Analysis 
Request is retrieved to verify that request processing has been completed. A Time Order Downlink Report is generated from 
the previously created analysis request, with selected options including request name and start/stop time interval and desired 
parameters (parameter selection will include at least one EU conversion value and one raw value) . The Time Order 
Downlink Report is saved and submitted. The next portion of the test reflects the ability to create a Custom Report. A 
custom report is created using ASCII files, off-line products, screen snaps and other products in to a report. Margins and 
fonts will be changed and existing templates used. The last portion of the test will reflect the ability to display the results of 
analysis requests in the form of graphs and tables. 

Success Criteria: 

Via off-line analysis, it is determined that the Time Order Downlink Report content matches dataset values, and report 
values match database definitions for a sample of the displayed parameters. The report output matches the start/stop time 
specified in the Time Order Downlink Report request. All mnemonics resident on the report are displayed in the order in 
which they are sampled by the spacecraft. Output from analysis requests can be displayed in the form of graphs and tables. 
Custom reports can be generated and these reports use ASCII files, off-line products, screen snaps and other products in to a 
report. Margins and fonts will be changed and existing templates used. Not Tested this release. 
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Step Id Action Expected Result/Output Pass/ 
Fail 

1. Start the Data Server. 

Reference Test Case SYS-2000B -- FOS Server 
Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. 

Reference Test Case SYS-2000B -- FOS Server 
Startup. 

Real-Time Server processes are running. 

3. Start the User Station. 

Reference Test Case SYS-2010B -- User Station 
Startup and Authentication. 

The FOT User Station is running and the Control 
Window is displayed. 

4. Invoke the Event Display. 

Click on ‘Tools’ from the control window 

The Tools Dialog window is displayed 

5. Select ‘Event_Display_Global’ from the control 
window tools menu. 

Click on the ‘OK’ button 

The Event Display is displayed on the FOT User 
Station. 

6. Invoke a previously saved Analysis Request 

Select ‘Tools’ from the control window 

The Tools Dialog window is displayed 

7. Select ‘Analysis Request Builder’ 

Click on the ‘OK’ button 

The Analysis Request Builder is displayed 

8. Click on the File pull down menu 

Select ‘Open’ 

The File Selection window is displayed 
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9. Select ‘Time_Ordered_Downlink’ 

Click on ‘OK’ button 

Analysis Request Time_Ordered_Downlink is 
displayed 

A dialog box will appear indicating that the request 
has already been sent and modifying the request is 
not allowed. 

10. Click the ‘Close’ button The dialog box will disappear. The request status 
will be “submitted”. 

11. Click on ‘Cancel’ button. The Analysis Request window will close. 

12. Place the mouse pointer on the screen and activate 
the pull down menu by pressing the right most 
mouse button. 

Select Programs 

Select X-term 

An X-term window will open. 

13. Go to the “datasets” directory and do a long listing 
for the Time_Ordered_Downlink dataset. 

%:cd /fosb/test/am1/datasets 

%:ll -ltr 

The Time_Ordered dataset will appear in the 
datasets directory. 

14. Go to the “setup” directory and source FosEnvVars 

%:cd /fosb/test/am1/scripts/setup 

%:setenv SCRIPT UserStation 

%:source FosEnvVars 

The environment is configured to run the 
FaDrReaderDriver. 

15. Execute the FaDrReaderDriver 

$BIN_DIR/FaDrReaderDriver 

The driver is executed. 
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16. Follow the menu prompts: 

Enter: 

1 

for Telemetry 

The ReaderDriver will respond with a prompt 

17. Enter the TLM dataset name: 

Time_Ordered_Downlink_YYYYDOYH 
HMMSS_NN 

The ReaderDriver will execute and read the TLM 
file. 

18. Enter: 

6 

to generate a report. 

The ReaderDriver prompt for a new for the report. 

19. Enter: 

TimeOrderReport 

The FaDrReaderDriver will generate the report. 

20. Enter: 

0 

to quit the FaDrReaderDriver 

The FaDrReaderDriver will quit. 

21. Go to the “reports” directory and do a long listing 
for the TimeOrderReport. 

%:cd /fosb/test/am1/reports 

%:ll -ltr 

The TimeOrderReport will be displayed as 

TimeOrderReport.report 

22. Print a Time Order Downlink Report 

%:lp TimeOrderReport.report 

The report will print. 

Another menu will appear 
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23. Print a Time Order Downlink Report 

Functionality unavailable at this time. 

Select ‘Report Generator’ from the control window 
tools menu. 

The Report Generator window is displayed 

24. Click the On-Demand toggle button 

Select Spacecraft type ‘AM1’ 

Select Report Category ‘ANA’ 

Select from Available Reports text area ‘Time 
Order Downlink Report’ 

Click ‘OK’ button 

The On-Demand Report Specification window is 
displayed. 

25. Click on ‘Retrieve Report’ A dialog box will appear indicating no report will 
has been generated yet. 

26. Click on ‘Close’ button The dialog box will close. 

27. Click on ‘New Report’ button. The On-Demand Specification window is displayed. 

28. Enter Start Time: 

TBD 

Report Start Time is displayed 

29. Enter Stop Time: 

TBD 

(less than 1) 

An error dialog box is displayed indicating the time 
selection is invalid 

30. Click the mouse on ‘Close’ button in the dialog 
box 

Dialog box will close 
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31. Enter Start Time: 

TBD 

Report Start Time is displayed 

32. Enter Stop Time: 

TBD 

Report Stop Time is displayed 

33. Enter Data Set: 

filename 

The Dataset to be used to create the report will be 
displayed along with all the mnemonics in that 
dataset. 

34. Select parameters used in the report: 

Click on ‘Filter’ button 

The Selection Filter Window is displayed. 

35. Select the Spacecraft type 

‘AM1’ 

The Instruments associated with AM1 the will be 
displayed in the Instrument text area 

36. Select ‘SDU’ in the Instrument text area. 

Click on ‘Select’ button. 

The subsystem mnemonic AM1_SDU is displayed 
in the Selected text area. 

37. Select ‘CHD’ in the Instrument text area. Sample Types associated with CDH are displayed in 
the Sample Type text area. 

38. Select ‘C’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_CDH_C is 
displayed in the Selected text area. 

39. Select ‘T’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_CDH_T is 
displayed in the Selected text area. 

40. Select ‘EPS’ in the Instrument text area. Sample Types associated with EPS are displayed in 
the Sample Type text area. 
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41. Select ‘I’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_EPS_I is displayed 
in the Selected text area. 

42. Select ‘GNC’ in the Instrument text area. Sample Types associated with GNC are displayed in 
the Sample Type text area. 

43. Select ‘S’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_GNC_S is 
displayed in the Selected text area. 

44. Select ‘MOD’ in the Instrument text area. Sample Types associated with MOD are displayed 
in the Sample Type text area. 

45. Select ‘T’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_MOD_T is 
displayed in the Selected text area. 

46. Select ‘PMS’ in the Instrument text area. Sample Types associated with PMS are displayed in 
the Sample Type text area. 

47. Select ‘B’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_PMS_B is 
displayed in the Selected text area. 

48. Click “OK” button The Display Item Parameter Selector window is 
displayed. 

49. Click on the ‘AM1_SDU’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_SDU are 
displayed in the text area. 

50. Select ‘SDU_SCTIME’ in the available parameter 
text area 

Click on the ‚ button 

SDU_SCTIME is displayed in the Selected text 
area. 

51. Click on the ‘AM1_SDU’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 
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52. Click on the ‘AM1_CDH_C’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_CDH_C are 
displayed in the text area. 

53. Select ‘CDH_CR_SSR1_RECPBUS’ 

in the available parameter text area 

Click on the ‚ button 

CDH_CR_SSR1_RECPBUS is displayed in the 
Selected text area. 

54. Click on the ‘AM1_CDH_C’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

55. Click on the ‘AM1_CDH_T’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_CDH_T are 
displayed in the text area. 

56. Select ‘CDH_TR_MOD_BDU_EPCB’ 

in the available parameter text area 

Click on the ‚ button 

CDH_TR_MOD_BDU_EPCB is displayed in the 
Selected text area. 

57. Click on the ‘AM1_CDH_T’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

58. Click on the ‘AM1_EPS_I’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_EPS_I are 
displayed in the text area. 

59. Select ‘EPS_IR_QLTY1’ 

in the available parameter text area 

Click on the ‚ button 

EPS_IR_QLTY1 is displayed in the Selected text 
area. 

60. Click on the ‘AM1_EPS_I’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

61. Click on the ‘AM1_GNC_S’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_GNC_S are 
displayed in the text area. 
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62. Select ‘GNC_SR_DPARM1’ in the available 
parameter text area 

Click on the ‚ button 

GNC_SR_DPARM1 is displayed in the Selected 
text area. 

63. Click on the ‘AM1_GNC_S’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

64. Click on the ‘AM1_MOD_T’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_MOD_T 
are displayed in the text area. 

65. Select ‘MOD_TP_BB_TEMP10H’ 

in the available parameter text area 

Click on the ‚ button 

MOD_TP_BB_TEMP10H is displayed in the 
Selected text area. 

66. Click on the ‘AM1_MOD_T’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

67. Click on the ‘AM1_PMS_B’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_PMS_B are 
displayed in the text area. 

68. Select ‘PMS_BR_LATCHVLV2_OPN’ 

in the available parameter text area 

Click on the ‚ button 

PMS_BR_LATCHVLV2_OPN is displayed in the 
Selected text area. 

69. Click on the ‘AM1_PMS_B’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

70. Click ‘Apply’ button The report will generate 

71. Click on ‘Retrieve Report’ Netscape is activated and the Report Browser 
appears. 
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72. In the Reports Browser window, scroll down to the 
Time Order Down Link reports folder. 

Double click on the folder. 

The folder will open and display a list of Time 
Order Down Link Reports. 

73. Double click on filename. The file will open and be displayed in the Time 
Ordered format. 

74. Select filename 

Click on the File pull down menu on Netscape. 

A list of options will appear. 

75. Select Print A dialog box will open asking what printer to use. 

76. Enter printername in the text box. The report will print 

77. Retrieve the report Via off line analysis verify the report contains the 
following information: 

The date and time of the report 

The starting spacecraft time of the data 

The ending spacecraft time of the data 

Telemetry mnemonics are either of EU conversion 
or raw value 

The telemetry parameters are in order in which they 
are sampled by the spacecraft 

Spacecraft time for each telemetry mnemonic is 
provided in the report. 
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78. Custom Report 

Functionality unavailable at this time. 

Select ‘Report Generator’ from the control window 
tools menu. 

The Report Selector window will be displayed. 

79. Click on ‘Custom’ button The custom Report Specification window will open. 

80. Custom Report Template 

Functionality unavailable at this time. 

Select ‘Custom Report’ from the control window 
tools menu. 

The Custom Report window will be displayed. 
Verify that it contains the following field and user 
interfaces: 

ASCII files 

off-line analysis products 

screen snaps 

descriptive text 

other routine reports 

Margins 

Fonts 

Existing templates 

81. Click on ‘Margins’ The Margin Selector window will appear 
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82. Enter into the TOP text field 

1 

Enter into the BOTTOM text field 

1 

Enter into the LEFT text field 

1 

Enter into the RIGHT text field 

1 

The margins will be set and the Margin Selector 
window will close. 

83. Click on ‘Font’ pull down menu A listing of the available fonts will be displayed. 

84. Click on ‘Insert ASCII files’ The ASCII files selector window will open. 

85. Select the TBD file to be inserted into the report 
and Click on ‘Apply’ 

The TBD file will be inserted into the report. 

86. Click on ‘Insert Snap’ A listing of screen snaps will be displayed. 

87. Select TBD screen snap 

Click on ‘Apply’ 

The TBD screen snap will be inserted into the 
report. 

88. From the File pull down menu 

Select ‘Save As…’ 

A message dialog box will be displayed. 

89. Enter CustomReport1 

Press Return 

CustomReport1 will be saved. 

90. Verify the report was saved 

Select ‘Open’ from the file pull down menu. 

A list of file options will be displayed. 
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91. Select CustomReport1 file 

Click on ‘Open’ 

CustomReport1 will open and will look like the 
orginal. 

92. Click on ‘Cancel’ The file will close. 

93. Select ‘Report Generator’ from the control window 
tools menu. 

The Report Selector window will be displayed. 

94. Click on ‘Custom’ button The custom Report Specification window will open. 

95. Click on ‘Modify’ A list of reports will be displayed 

96. Select a report to modify. The selected report will be hightlighted. 

97. Click on ‘Open’ The selected report will be displayed. 

98. Select ‘Analysis Product’ 

Click on ‘Apply’ 

A list of Analysis Products will be displayed 

99. Select TBD product 

Click on ‘Insert’ 

Click on ‘Apply’ 

The selected analysis product will be inserted into 
the custom report. 

100. Click on ‘Modify’ A list of reports will be displayed 

101. Select a TBD report to Modify 

Click on ‘Open’ 

The selected report will be displayed. 

102. Select ‘Text’ 

Click on ‘Apply’ 

A list of predefined text will be displayed. 
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103. Select a TBD text option. 

Click on ‘Insert’ 

Click on ‘Apply’ 

The selected text will be inserted into the report. 

104. From the File pull down menu 

Select ‘Save As…’ 

A message dialog box will be displayed. 

105. Enter TBD file name 

Press Return 

The TBD file will be saved. 

106. Click on ‘Print’ The report will print. Verify the information 
contained in the report is correct. 

107. Select ‘Custom Report’ from the control window 
tools menu. 

The Custom Report window will be displayed. 

108. Click on ‘Report Templates’ A list of the report templates will be displayed. 

109. Select TBD 

Click on ‘Delete’ 

A message dialog box will be displayed. 

110. Click on ‘Yes’ The report template will be deleted. 

111. Graph - Telemetry Values vs Time 

Invoke the Analysis Request Builder 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

112. Select ‘Analysis_Request_Builder’. 

Click on ‘OK’ button. 

The Analysis Request Builder window is displayed 

113. Click the File pull down menu. A list of options appears. 
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114. Select ‘Open’. The File Selection window is displayed. 

115. Select ‘Time_Order_Downlink’. 

Click the ‘OK’ button. 

An Analysis Request Information dialog box will 
appear stating: 

This request was already sent… 

Modifying or resending this request will not 
be permitted. 

116. Click the ‘Close’ button in the dialog box. The request is displayed. 

117. Check the Request Status text area in the Analysis 
Request Builder window. 

The Request Status will indicate Submitted. 

118. Click the ‘Cancel’ button. The Analysis Request Builder window will close. 

119. Plot a Graph 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

120. Select ‘Display_Builder’. 

Click on ‘OK’ button. 

The Display_Builder windows are displayed 

121. In the Display Builder Pallette window tool bar, 
Select ‘Page’ 

A list of options appear. 

122. Select ‘Logical String Management’ The Dynamic Page Logical String Management 
window appears. 
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123. In the Dynamic Page Logical String Management 
window: 

From the Source button pull down menu, 

Select ‘Offline’ 

Click ‘ADD’ button. 

A filter window appears displaying a listing of the 
available datasets. 

124. In the filter window: 

Select 
Time_Order_downlink_1997348174647_2.meta 

Click ‘OK’ 

The selected file will appear in the Dynamic Page 
Logical String Management window. 

125. In the Dynamic Page Logical String Management 
window 

Click “OK” 

The Dynamic Page Logical String Management 
window will disappear. 

126. In the Display Builder Pallette window, 

Click ‘2D’ button 

Move the mouse to the Dynamic Page and click 
the mouse. 

A graph display page appears. 

127. In the Display Item Data Sources window 

Click ‘ADD’ 

The Display Item Parameter Selector window 
appears. 

128. In the Display Item Parameter Selector window 

Click ‘Filter’ 

The Selection Filter window appears. 

129. Select the Spacecraft type 

‘AM1’ 

The Instruments associated with AM1 the will be 
displayed in the Instrument text area 
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130. Select ‘SDU’ in the Instrument text area. 

Click on ‘Select’ button. 

The subsystem mnemonic AM1_SDU is displayed 
in the Selected text area. 

131. Select ‘CHD’ in the Instrument text area. Sample Types associated with CDH are displayed in 
the Sample Type text area. 

132. Select ‘C’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_CDH_C is 
displayed in the Selected text area. 

133. Select ‘T’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_CDH_T is 
displayed in the Selected text area. 

134. Select ‘EPS’ in the Instrument text area. Sample Types associated with EPS are displayed in 
the Sample Type text area. 

135. Select ‘I’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_EPS_I is displayed 
in the Selected text area. 

136. Select ‘GNC’ in the Instrument text area. Sample Types associated with GNC are displayed in 
the Sample Type text area. 

137. Select ‘S’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_GNC_S is 
displayed in the Selected text area. 

138. Select ‘MOD’ in the Instrument text area. Sample Types associated with MOD are displayed 
in the Sample Type text area. 

139. Select ‘T’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_MOD_T is 
displayed in the Selected text area. 

140. Select ‘PMS’ in the Instrument text area. Sample Types associated with PMS are displayed in 
the Sample Type text area. 
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141. Select ‘B’ in the sample type text area 

Click on the ‘Select’ button 

The subsystem mnemonic AM1_PMS_B is 
displayed in the Selected text area. 

142. Click “OK” button The Display Item Parameter Selector window is 
displayed. 

143. Click on the ‘AM1_SDU’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_SDU are 
displayed in the text area. 

144. Select ‘SDU_SCTIME’ in the available parameter 
text area 

Click on the ‚ button 

SDU_SCTIME is displayed in the Selected text 
area. 

145. Click on the ‘AM1_SDU’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

146. Click on the ‘AM1_CDH_C’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_CDH_C are 
displayed in the text area. 

147. Select ‘CDH_CR_SSR1_RECPBUS’ 

in the available parameter text area 

Click on the ‚ button 

CDH_CR_SSR1_RECPBUS is displayed in the 
Selected text area. 

148. Click on the ‘AM1_CDH_C’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

149. Click on the ‘AM1_CDH_T’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_CDH_T are 
displayed in the text area. 

150. Select ‘CDH_TR_MOD_BDU_EPCB’ 

in the available parameter text area 

Click on the ‚ button 

CDH_TR_MOD_BDU_EPCB is displayed in the 
Selected text area. 
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151. Click on the ‘AM1_CDH_T’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

152. Click on the ‘AM1_EPS_I’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_EPS_I are 
displayed in the text area. 

153. Select ‘EPS_IR_QLTY1’ 

in the available parameter text area 

Click on the ‚ button 

EPS_IR_QLTY1 is displayed in the Selected text 
area. 

154. Click on the ‘AM1_EPS_I’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

155. Click on the ‘AM1_GNC_S’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_GNC_S are 
displayed in the text area. 

156. Select ‘GNC_SR_DPARM1’ in the available 
parameter text area 

Click on the ‚ button 

GNC_SR_DPARM1 is displayed in the Selected 
text area. 

157. Click on the ‘AM1_GNC_S’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

158. Click on the ‘AM1_MOD_T’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_MOD_T 
are displayed in the text area. 

159. Select ‘MOD_TP_BB_TEMP10H’ 

in the available parameter text area 

Click on the ‚ button 

MOD_TP_BB_TEMP10H is displayed in the 
Selected text area. 

160. Click on the ‘AM1_MOD_T’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 
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161. Click on the ‘AM1_PMS_B’ toggle button in the 
Selection Filter area. 

A list mnemonics associated with AM1_PMS_B are 
displayed in the text area. 

162. Select ‘PMS_BR_LATCHVLV2_OPN’ 

in the available parameter text area 

Click on the ‚ button 

PMS_BR_LATCHVLV2_OPN is displayed in the 
Selected text area. 

163. Click on the ‘AM1_PMS_B’ toggle button in the 
Selection Filter area. 

The list of mnemonics in the available text area are 
removed. 

164. Click “OK” button The list of select mnemonics will be displayed in the 
Display Items Parameter Selector window. 

165. In the Display Item Format window: 

Select the ‘Axes’, ‘Legend’, ‘Grid’, ‘Footer’ toggle 
buttons 

The selected toggles button will be selected. 

166. Select ‘Axes’ from the Edit pull down menu Axes will be displayed 

167. Select the X Axis Parameter 

SDU_SCTIME 

SDU_SCTIME will be displayed in the X Axis 
Parameter Label text area. 

168. Enter the X Axis Display Min 

‘-747.8477’ 

The dataset start time in J2000 format will be 
displayed in the X Axis Display Min text area. 

169. Enter the X Axis Display Max 

‘-747.8352’ 

The dataset stop time in J2000 format will be 
displayed in the X Axis Display Max text area. 

170. Enter the Y Axis Display Max 

‘10’ 

1000 will be displayed in the Y Axis Display Max 
text area. 
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171. Enter the graph title in the ‘Title’ box 

Graphin 

The title will be displayed in the Title text box. 

172. Enter the X Axis Label 

‘SpaceCraft Time’ 

SpaceCraft Time will be displayed in the X Axis 
Label text area. 

173. Enter the Y Axis Label 

‘Mnemonics’ 

Mnemonics will be displayed in the Y Axis Label 
text area. 

174. Enter the X Axis Display Interval 

‘5’ 

5 sec will be displayed in the X Axis Display 
Interval text area. 

175. Enter the X Axis Grid Granularity 

‘1’ 

1 will be displayed in the X Axis Grid Granularity 
text area. 

176. Enter the Y Axis Display Min 

‘5’ 

5 will be displayed in the Y Axis Display Min text 
area. 

177. Enter the Y Axis Grid Granularity 

‘1’ 

1 will be displayed in the Y Axis Grid Granularity 
text area. 

178. Click on ‘Apply’ button The desired attributes are saved 

179. Select ‘Legend’ from Edit pull down menu Settings for Legend will be displayed 

180. Select from the Positional toggle area 

‘East’ 

South toggle button will be selected 

181. Select from the Border Type toggle area 

‘Shadow’ 

Shadow toggle button will be selected 
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182. Click on ‘Apply’ button The desired attributes are saved 

183. Select ‘Footer’ from Edit pull down menu Settings for Footer will be displayed 

184. Enter into the Footer text box: 

This is a graph called Graphin. 

The text will appear in the footer text area. 

185. Select from the Border Type toggle area 

‘Shadow’ 

Shadow toggle button will be selected 

186. Click on ‘Apply’ button The desired attributes are saved 

187. Select ‘Color and Line Style’ from Edit pull down 
menu 

Settings for Color and Line Style will be displayed 

188. Select CDH_TR_MOD_BDU_EPCB in the 
parameter box 

CDH_TR_MOD_BDU_EPCB is highlighted 

189. Select from the Line Attributes pull down menu 

‘Dotted’ 

Dotted will be displayed. 

190. Select from the Point Attributes pull down menu 

‘Circle’ 

Circle will be displayed. 

191. Select from the Color Attributes pull down menu 

‘Red’ 

Red will be displayed. 

192. Select from the Limit Line Attributes pull down 
menu 

‘Dotted’ 

Dotted will be displayed. 

193. Click on ‘Apply’ button The desired attributes are applied. 
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194. Select CDH_CR_SSR1_RECVPBBUS parameter 
in the parameter box 

CDH_CR_SSR1_RECVPBBUS is highlighted 

195. Select from the Line Attributes pull down menu 

‘Long Dash’ 

Long Dash will be displayed. 

196. Select from the Point Attributes pull down menu 

‘Square’ 

Square will be displayed. 

197. Select from the Color Attributes pull down menu 

‘Yellow’ 

Yellow will be displayed. 

198. Select from the Limit Line Attributes pull down 
menu 

‘Dashed’ 

Dashed will be displayed. 

199. Click on ‘Apply’ button The desired attributes are applied. 

200. Select EPS_IR_QLTY1 parameter in the 
parameter box 

EPS_IR_QLTY1 is highlighted 

201. Select from the Line Attributes pull down menu 

‘Solid’ 

Solid will be displayed. 

202. Select from the Point Attributes pull down menu 

‘Triangle’ 

Triangle will be displayed. 

203. Select from the Color Attributes pull down menu 

‘Cyan’ 

Cyan will be displayed. 
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204. Select from the Limit Line Attributes pull down 
menu 

‘Solid’ 

Solid will be displayed. 

205. Click on ‘Apply’ button The desired attributes are applied. 

206. Select GNC_SR_DPRAM1 parameter in the 
parameter box 

GNC_SR_DPRAM1 is highlighted 

207. Select from the Line Attributes pull down menu 

‘Long Short Dash’ 

Long Short Dash will be displayed. 

208. Select from the Point Attributes pull down menu 

‘Star’ 

Star will be displayed. 

209. Select from the Color Attributes pull down menu 

‘Green’ 

Green will be displayed. 

210. Select from the Limit Line Attributes pull down 
menu 

‘Solid’ 

Solid will be displayed. 

211. Select MOD_TP_BB_TEMP10H parameter in 
the parameter box 

MOD_TP_BB_TEMP10H is highlighted 

212. Select from the Line Attributes pull down menu 

‘Short Dash’ 

Short Dash will be displayed. 

213. Select from the Point Attributes pull down menu 

‘Cross’ 

Cross will be displayed. 
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214. Select from the Color Attributes pull down menu 

‘White’ 

White will be displayed. 

215. Select from the Limit Line Attributes pull down 
menu 

‘Solid’ 

Solid will be displayed. 

216. Select PMS_BR_LATCHVLV2_OPN parameter 
in the parameter box 

PMS_BR_LATCHVLV2_OPN is highlighted 

217. Select from the Line Attributes pull down menu 

‘Dash Dot’ 

Dash Dot will be displayed. 

218. Select from the Point Attributes pull down menu 

‘Diamond’ 

Diamond will be displayed. 

219. Select from the Color Attributes pull down menu 

‘Magenta’ 

Magenta will be displayed. 

220. Select from the Limit Line Attributes pull down 
menu 

‘Solid’ 

Solid will be displayed. 

221. Click on ‘Apply’ button The desired attributes are applied. 

222. In the Display Builder Pallette window 

From the Tool Bar 

Select ‘File’ 

A pull down menu with options will apppear. 

223. Select ‘Save As …’ A filter window will appear. 
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224. In the Filter window 

Click on ‘System’ button 

Enter the ‘ANAGraph’ in the bottom filter text 
bar. 

Click the ‘OK’ button. 

The directory structure will change to reflect the 
system directory and the file will be saved there. 

225. In the Display Builder Pallette window 

From the Tool Bar 

Select ‘Build to CM’ 

In the Display Control Window the message Build 
to CM complete will be displayed. 

226. In the Display Builder Pallette window 

From the Tool Bar 

Select ‘File’ 

A pull down menu with options will appear. 

227. Select ‘Save As …’ A filter window will appear. 

228. In the Filter window 

Click on ‘Local’ button 

Enter the ‘ANAGraph’ in the bottom filter text 
bar. 

Click the ‘OK’ button. 

The directory structure will change to reflect the 
local directory and the file will be saved there. 

229. In the Display Builder Pallette window 

From the Tool Bar 

Select ‘Build to Local’ 

In the Display Control Window the message Build 
to Local complete will be displayed. 
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230. In the Control Window 

Click on the ‘Tlm Wins’ button 

A list of tlm pages are displayed to the user 

231. Select ‘ANAGraph’ ANAGraph page will be displayed. 

232. In a terminal window enter snapframe 

Place the mouse on the graph and click. 

The graph will print out. 
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233. Verify the selected criteria match displayed 
information. 

In the Display page: 

The display legend will be located in the East corner 

CDH_TR_MOD_BDU_EPCB will be Dotted, 
Circle, Red 

CDH_CR_SSR1_RECPBBUS will be Long Dash, 
Square, Yellow, & Dotted limit lines 

EPS_IR_QLTY1 will be Solid, Triangle, Cyan, & 
Dashed limit lines 

GNC_SR_DPARM1 will be Long Short Dash, Star, 
Green, & Solid limit lines 

MOD_TP_BB_TEMP10H will be Dotted, Cross, 
White, & Solid limit lines 

PMS_BR_LATCHVLV2_OPN is not in the graph. 

The X axis is labeled SpaceCraft Time 

The Y axis is labeled Mnemonics 

The graph is titled Graphin 

The Footer is: This is a graph called graphin 

The Footer & Legend box are shadowed. 

234. Click on a mnemonic and verify the minimum, 
current, and maximum values for a selected 
telemetry parameter are displayed. 

The values will be displayed in the value boxes. 
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235. To Print the Graph 

Display the graph on the screen 

Using the mouse pulldown menu 

Select ‘snapshot” 

Select sideways (Landscape) or upright (Portrait). 

The graph will be printed. 

236. Click on ‘Zoom In’ button A selected area of the graph will be enlarged 
(Zoomed in on). 

237. Click on ‘Zoom Out’ button The graph will return to it’s original state. 

238. Bring up Graphin four times 

In a terminal window enter snapframe 

This will print the whole screen of four graphs. 

239. Telemetry Value vs Telemetry 

Functionality unavailable at this time. 

240. Tables 

Functionality unavailable at this time. 

Invoke a previously saved Analysis Request 

Select ‘Tools’ from the control window 

The Tools Dialog window is displayed 

241. Select ‘Analysis_Request_Builder’. 

Click on ‘OK’ button. 

The Analysis Request Builder window is displayed 

242. Click the File pull down menu. A list of options appears. 

243. Select ‘Open’. The File Selection window is displayed. 
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244. Check the Request Status text area in the Analysis 
Request Builder window. 

The Request Status will indicate Read/Edit Request. 

245. Click on the ‘Tlm Wins’ button A list of tlm pages are displayed to the user 

246. Select ‘Tablein’ Tablein page will be displayed. 

247. Save a Table 

Click on File pull down Menu 

Select ‘Save As…’ 

A dialog box will appear 

248. Enter ‘Tablein’ in the dialog box 

Click ‘OK’ button 

The dialog box will close and the Table will be 
saved. 

249. Print the Table 

Display the Table on the screen 

In a terminal window enter screen snap 

The Table will be printed. 

Verify the table contains: 

50 Parameters 

associated time at each interval 

the mnemonic of each telemetry value 

title 

current range of time is displayed. 

250. Invoke a previously saved Analysis Request 

Select ‘Tools’ from the control window 

The Tools Dialog window is displayed 

251. Select ‘Analysis_Request_Builder’. 

Click on ‘OK’ button. 

The Analysis Request Builder window is displayed 

252. Click the File pull down menu. A list of options appears. 
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253. Select ‘Open’. The File Selection window is displayed. 

254. Select ‘TableARTemp’. 

Click the ‘OK’ button. 

The Analysis Request named TableARTemp is 
displayed 

255. Check the Request Status text area in the Analysis 
Request Builder window. 

The Request Status will indicate Read/Edit Request. 

256. Select an output dataset name for the analysis 
request. 

Click the output dataset name toggle button. 

Enter the name of the output dataset (request 
name): 

Tablein2 

Tablein2 will be displayed in the Output Dataset 
Name box. 

257. Click on ‘Table’ toggle button 

Click ‘Format’ button 

The ‘Table Format’ window is displayed 

258. Select Parameters 

Select ‘All’ parameters from the Available text 
area. 

Click on the ‚ button 

The selected parameters will be displayed in the 
Selected text area 

259. Enter ‘Tablein2’ in the Title text area Tablein2 will be displayed 

260. Select Column Names 

Click on ‘Descriptor’ button 

The Column Names will be displayed by 
Descriptor. 
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261. Save the analysis request 

Save the analysis request. 

Click on the File pull down menu. 

A list of options appears. 

262. Select ‘Save as…’. A File Selection window is displayed with a default 
directory path in the selection field. The default 
directory path will be 
/fosb/test/am1/data/FUI/requests/. 

263. Enter the name of the request: 

Tablein2 

Click the ‘OK’ button. 

A dialog box informing the user that the file was 
saved. 

264. Click the ‘Close’ button in the information dialog 
box. 

The dialog box will close. 

265. Click the ‘OK’ button. The Analysis Request has been resubmitted 

266. Click on the ‘Tlm Wins’ button A list of tlm pages are displayed to the user 

267. Select ‘Tablein2’ Tablein2 page will be displayed. 

268. End of test. 
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Analysis Request Manager Test Procedure


Test Case No: ANA-2120B 

Test Configuration: See Appendix G 

Test Support: Twenty (20) previously saved analysis requests. These previously saved requests will be built using various 
options (Local only, EOC only, good data only, all data). At least one request will be built as a user specified statistics 
request. 

Test Dependencies: Previously archived telemetry files. 

Test Case Description: 

This test is designed to verify the ability to manage all requests for data analysis. This includes simultaneous processing of 
multiple requests as well as a queue of requests waiting to be processed. This test will also verify selection filter capabilities 
and user-specified statistics report content. The test begins with the initialization of the EOC. The Analysis Request Builder 
tool is invoked and a historical request is generated, with selected options including request name, start/stop time interval, 
parameter names, and sampling rates. During the mnemonic selection portion of the request, all selection filter capabilities 
are verified. Previously built analysis requests are submitted for generation in order to fill the queue. The queue is checked 
to ensure the accuracy of the status of each request submitted. Various options will be tested on the queue (change a priority 
of a request, delete a request select products). At least one of the requests will be a user-specified statistics request. After 
the request has completed, an ASCII report is generated and checked. This report will be checked for correct header 
information as well as data accuracy. Another request will be built and submitted using a dataset from a prviously 
completed request as input. Following completion of this request, an ASCII report is generated and checked. 
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Success Criteria: 

This test is considered successful when the system processes 20 request simultaneously and the queue is able to hold/display 
10 requests; Each request displays the request name, a status, and percentage complete Not tested this release; When 
selecting a parameter for analysis, the user is able to filter according to spacecraft IDs, subsystems, instruments, and ground 
systems; One or more instruments and spacecraft subsystems may be selected for each spacecraft as a filter criteria; The 
user is provided with the capability to generate an ASCII report from a user-specified statistics request; The statistics report 
contains header information consisting of a date and time of the report, a spacecraft start and stop time, and an interval type 
for the statistic; For each parameter, the statistics report contains a mnemonic name, minimum value, maximum value, mean 
value, standard deviation, number of samples, and spacecraft time for the minimum and maximum values. The request 
queue will allow the user to assign a priority to a pending request, delete a request, and select output products for a 
completed request Not tested this release.  The user can submit an Analysis Request using a previously saved dataset as 
input and generate it’s own dataset output. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Start the Data Server. 

Reference Test Case SYS-2000B -- FOS Server 
Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. 

Reference Test Case SYS-2000B -- FOS Server 
Startup. 

Real-Time Server processes are running. 

3. Start the User Station. 

Reference Test Case SYS-2010B -- User Station 
Startup and Authentication. 

Start up eight (8) User Stations and perform steps 4 
- 6 on all eight User Stations. 

The FOT User Station is running and the ‘Control 
Window’ is displayed. 
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4. Bring up the Event Display. 

Note: This section must be performed on all eight 
User Stations 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

5. Select ‘Event_Display_Gobal’ from the control 
window tools menu. 

Click on ‘OK’ button. 

The ‘Event Display’ is up on the User Station. 

6. Click on ‘Filter’ from the pull down menu 

Select ‘Event Type’ 

Click ‘Bold’ button next to ANL and SYS 

Click ‘Apply’ 

Click ‘Close’ 

The Event_Display_Gobal will now display all ANA 
and SYS subsystem activities in bold. 

7. Configure the Request Manager 

On User Station one: 

In the ‘Control Window’ , in the ECL directive box 
type: 

>RM CHANGESTATE NEW = IDLE 
userstationname 

Where userstationname is the name of User 
Station one. 

A message will appear in the events display window 
indicating that the state of the request manager for 
userstationname is idle. 

User Station one will not process any analysis 
requests. 
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8. In the ‘Control Window’ , in the ECL directive box 
type: 

>RM CHANGESTATE NEW = _LOCAL 
userstationname 

Where userstationname is the name of User 
Station two. 

A message will appear in the events display window 
indicating that the state of the request manager for 
userstationname is local. 

User Station two will only process analysis requests 
locally submitted from that User Station. 

9. In the ‘Control Window’ , in the ECL directive box 
type: 

>RM CHANGESTATE NEW = GLOBAL 
userstationname 

Where userstationname is the name of User 
Station three. 

A message will appear in the events display window 
indicating that the state of the request manager for 
userstationname is global. 

User Station three will process any analysis requests. 

10. In the ‘Control Window’ , in the ECL directive box 
type: 

>RM CHANGESTATE NEW = GLOBAL 
userstationname 

Where userstationname is the name of User 
Station four. 

A message will appear in the events display window 
indicating that the state of the request manager for 
userstationname is global. 

User Station four will process any analysis requests. 

11. In the ‘Control Window’ , in the ECL directive box 
type: 

>RM CHANGESTATE NEW = GLOBAL 
userstationname 

Where userstationname is the name of User 
Station five. 

A message will appear in the events display window 
indicating that the state of the request manager for 
userstationname is global. 

User Station five will process any analysis requests. 

4-88
 322-CD-100-001/ 
411-CD-100-001 



12. In the ‘Control Window’ , in the ECL directive box 
type: 

>RM CHANGESTATE NEW = GLOBAL 
userstationname 

Where userstationname is the name of User 
Station six. 

A message will appear in the events display window 
indicating that the state of the request manager for 
userstationname is global. 

User Station six will process any analysis requests. 

13. In the ‘Control Window’ , in the ECL directive box 
type: 

>RM CHANGESTATE NEW = GLOBAL 
userstationname 

Where userstationname is the name of User 
Station seven. 

A message will appear in the events display window 
indicating that the state of the request manager for 
userstationname is global. 

User Station seven will process any analysis 
requests. 

14. In the ‘Control Window’ , in the ECL directive box 
type: 

>RM CHANGESTATE NEW = GLOBAL 
userstationname 

Where userstationname is the name of User 
Station eight. 

A message will appear in the events display window 
indicating that the state of the request manager for 
userstationname is global. 

User Station eight will process any analysis requests. 

15. Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

16. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

17. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 
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18. Select ‘Time_Order_Downlink’. 

Click the ‘OK’ button. 

Analysis Request Time_Order_Downlink is 
displayed 

Note:  No changes will be made to request1. The 
following steps verify filter capabilities. 

19. Select Telemetry Points 

Click on the ‘Select Telemetry …’ button. 

The Telemetry Selector window is displayed. 

20. Click on the ‘Filter…’ button. The Selection Filter Screen is displayed. 

21. Note: Fields are displayed as the user selects a 
filter criteria. 

Select ‘AM1’ in the Spacecraft text area. 

A list of ground systems, spacecraft subsystems, and 
instruments are displayed in the Instrument text. 
field and they include: 

AST EPS SDU 
CEA GCM SMS 
CEF GNC TCS 
CDH MIS SYS 
COM MOD FS1 
EAS MOP FS2 
EDS PMS UPD 

22. Select ‘AST’ in the Instrument/Subsystem text 
area. 

Sample Types associated with AST are displayed in 
the Sample Type text area 

23. Click the ‘Select’ button. The subsystem mnemonic AM1_AST is displayed in 
the Selected text area. 

24. Select ‘CDH’ in the Instrument/Subsystem text 
area. 

Select ‘B’ in the Sample Type text area. 

Click the ‘Select’ button. 

Sample Types associated with AM1_CDH_B are 
displayed in the Selected text area 
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25. Select ‘GNC’ in the Instrument/Subsystem text 
area. 

Sample Types associated with AM1_GNC are 
displayed in the Sample Type text area 

26. Click the ‘Select’ button. The subsystem mnemonic AM1_GNC is displayed 
in the Selected text area. 

27. Click the ‘OK’ button. The selected subsystems are displayed in the 
Subsystems text area. 

28. Click the ‘AM1_AST’ toggle button. Mnemonics are associated with AM1_AST are 
displayed in the Available Parameters text area. 

29. Click the ‘AM1_AST’ toggle button. Mnemonics are associated with AM1_AST are 
removed from the Available Parameters text area. 

30. Click the ‘AM1_CDH_B’ toggle button. Mnemonics are associated with AM1_CDH_B are 
displayed in the Available Parameters text area. 

31. Click the ‘AM1_CDH_B’ toggle button. Mnemonics are associated with AM1_CDH_B are 
removed from the Available Parameters text area. 

32. Click the ‘AM1_GNC’ toggle button. Mnemonics are associated with AM1_GNC are 
displayed in the Available Parameters text area. 

33. Click the ‘AM1_GNC’ toggle button. Mnemonics are associated with AM1_GNC are 
removed from the Available Parameters text area. 

34. Click on the ‘Filter …’ button The Selection Filter Window is displayed 

35. Select ‘AM1’ in the Spacecraft text area. A list of ground systems, spacecraft subsystems and 
instruments is displayed in the Instrument text area. 

36. Select ‘CEA’ in the Instrument/Subsystem text 
area. 

A list of telemetry sample types is displayed in the 
Sample Text area. 

37. Click the ‘Select’ button. The subsystem mnemonic AM1_CEA is displayed in 
the Selected text area. 
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38. Select ‘TCS’ in the Instrument/Subsystem text 
area. 

A list of telemetry sample types is displayed in the 
Sample Text area. 

39. Click the ‘Select’ button. The subsystem mnemonic AM1_TCS is displayed in 
the Selected text area. 

40. Select ‘AM1_AST’ in the Selected text area. 

Click the ‘Remove’ button 

The subsystem AM1_AST is not in the Selected text 
area. 

41. Click the ‘OK’ button. The selected subsystems will be displayed in the 
Subsystems text area. 

42. Click the ‘AM1_TCS’ toggle button. Mnemonics are associated with AM1_TCS are 
displayed in the Available Parameters text area. 

43. Click the ‘CANCEL’ button The Analysis Telemetry Selector window will close. 

44. Click the ‘OK’ button Time_Order_Downlink will be submitted for dataset 
generation. 

45. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

46. Submit previously saved Analysis Request for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

47. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 
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48. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

49. Select ‘Use_As_Input’. 

Click the ‘OK’ button. 

Analysis Request Derived is displayed. 

50. Click the ‘OK’ button Use_As_Input will be submitted for dataset 
generation. 

51. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

52. Submit previously saved Analysis Request for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

53. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

54. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

55. Select ‘Derived’. 

Click the ‘OK’ button. 

Analysis Request Derived is displayed. 

56. Click the ‘OK’ button Use_As_Input will be submitted for dataset 
generation. 
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57. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

58. On User Station two 

Submit previously saved Analysis Request for 
dataset generation. 

Invoke a previously saved Analysis Request, 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

59. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

60. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

61. Select ‘User_Stats’. 

Click the ‘OK’ button. 

Analysis Request User_Stats is displayed. 

62. Click the ‘OK’ button User_Stats will be submitted for dataset generation. 

63. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 
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64. Submit previously saved Analysis Request 5 for 
dataset generation. 

Invoke a previously saved Analysis Request, 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

65. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

66. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

67. Select ‘request5’. 

Click the ‘OK’ button. 

Analysis Request request5 is displayed. 

68. Click the ‘OK’ button request5 will be submitted for dataset generation. 

69. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. (User Station 2) 

70. Submit previously saved Analysis Request 6 for 
dataset generation. 

Invoke a previously saved Analysis Request, 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

71. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 
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72. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

73. Select ‘request6’. 

Click the ‘OK’ button. 

Analysis Request request6 is displayed. 

74. Click the ‘OK’ button request6 will be submitted for dataset generation. 

75. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

76. On User Station three: 

Submit previously saved Analysis Request 7 for 
dataset generation. 

Invoke a previously saved Analysis Request, 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

77. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

78. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

79. Select ‘request7’. 

Click the ‘OK’ button. 

Analysis Request request7 is displayed. 

80. Click the ‘OK’ button request7 will be submitted for dataset generation. 
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81. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

82. Submit previously saved Analysis Request 8 for 
dataset generation. 

Invoke a previously saved Analysis Request, 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

83. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

84. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

85. Select ‘request8’. 

Click the ‘OK’ button. 

Analysis Request request8 is displayed. 

86. Click the ‘OK’ button request8 will be submitted for dataset generation. 

87. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

88. Submit previously saved Analysis Request 9 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 
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89. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

90. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

91. Select ‘request9’. 

Click the ‘OK’ button. 

Analysis Request request9 is displayed. 

92. Click the ‘OK’ button request9 will be submitted for dataset generation. 

93. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

94. On User Station four: 

Submit previously saved Analysis Request 10 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

95. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

96. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 
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97. Select ‘request10’. 

Click the ‘OK’ button. 

Analysis Request request10 is displayed. 

98. Click the ‘OK’ button request10 will be submitted for dataset generation. 

99. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

100. Submit previously saved Analysis Request 11 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

101. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

102. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

103. Select ‘request11’. 

Click the ‘OK’ button. 

Analysis Request request11 is displayed. 

104. Click the ‘OK’ button request11 will be submitted for dataset generation. 

105. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 
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106. Submit previously saved Analysis Request 12 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

107. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

108. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

109. Select ‘request12’. 

Click the ‘OK’ button. 

Analysis Request request12 is displayed. 

110. Click the ‘OK’ button request12 will be submitted for dataset generation. 

111. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

112. On User Station five: 

Submit previously saved Analysis Request 13 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

113. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 
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114. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

115. Select ‘request13’. 

Click the ‘OK’ button. 

Analysis Request request13 is displayed. 

116. Click the ‘OK’ button request13 will be submitted for dataset generation. 

117. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

118. Submit previously saved Analysis Request 14 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

119. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

120. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

121. Select ‘request14’. 

Click the ‘OK’ button. 

Analysis Request request14 is displayed. 

122. Click the ‘OK’ button request14 will be submitted for dataset generation. 
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123. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

124. Submit previously saved Analysis Request 15 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

125. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

126. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

127. Select ‘request15’. 

Click the ‘OK’ button. 

Analysis Request request15 is displayed. 

128. Click the ‘OK’ button request15 will be submitted for dataset generation. 

129. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 
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130. On User Station six: 

Submit previously saved Analysis Request 16 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

131. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

132. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

133. Select ‘request16’. 

Click the ‘OK’ button. 

Analysis Request request16 is displayed. 

134. Click the ‘OK’ button request16 will be submitted for dataset generation. 

135. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

136. Submit previously saved Analysis Request 17 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

137. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 
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138. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

139. Select ‘request17’. 

Click the ‘OK’ button. 

Analysis Request request17 is displayed. 

140. Click the ‘OK’ button request17 will be submitted for dataset generation. 

141. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

142. Submit previously saved Analysis Request 18 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

143. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

144. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

145. Select ‘request18’. 

Click the ‘OK’ button. 

Analysis Request request18 is displayed. 

146. Click the ‘OK’ button request18 will be submitted for dataset generation. 
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147. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

148. On User Station seven: 

Submit previously saved Analysis Request 19 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

149. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

150. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

151. Select ‘request19’. 

Click the ‘OK’ button. 

Analysis Request request19 is displayed. 

152. Click the ‘OK’ button request19 will be submitted for dataset generation. 

153. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 
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154. Submit previously saved Analysis Request 20 for 
dataset generation. 

Invoke a previously saved Analysis Request 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

155. Select ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

156. Click on the File pull down menu. 

Select ‘Open’. 

The File Selection window is displayed. 

157. Select ‘request20’. 

Click the ‘OK’ button. 

Analysis Request request20 is displayed. 

158. Click the ‘OK’ button request20 will be submitted for dataset generation. 

159. Monitor the Event Display for the message 
Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the User Station that started the request. 

The Events Display will indicate that Analysis 
Request X has started on Host N. 

160. On User Station eight: 

Monitor the events display for messages indicating 
that no analysis requests were processed from that 
User Station. 

No analysis requests were processed from User 
Station eight. 
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161. View the Analysis Request Queue 

Select ‘Display Window’ from the control window 
tools menu. 

The Analysis Request Queue will be displayed. 
Verify the following: 

10 requests are in the queue 

The request queue displays an estimated percentage 
complete for each request 

The request queue displays a status for each request 
and the status will be one of the following: 

Request submitted 

Request currently being processed 

Request complete 

162. Delete a request from the queue 

Select ‘TBD’ request from the queue 

Click on ‘Delete’ button 

TBD will be deleted from the queue. 

163. Assign a priority 

Select ‘TBD’ request from the queue 

Click on ‘Priority’ button 

Select a priority 

TBD priority will be changed. 

164. Select ‘TBD’ request from the queue 

Click on ‘Products’ button 

The TBD window will be displayed 

165. Access a Previously Saved Dataset 

Invoke the Analysis Request Builder 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 
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166. Click on ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

167. Create an Analysis Request 

Enter into the request name field: 

Usedasinput 

Usedasinput appears in the Request Name field 

168. Click the ‘Process on This User Station’ button to 
select data to be processed on that workstation. 

‘Process on This User Station’ button should show 
selected 

169. Click the ‘All Data’ button in the Data Quality box. The ‘All Data’ button should show selected 

170. Selecting Telemetry Mnemonics 

Note: The telemetry mnemonics selected are in the 
input dataset 

Click on the ‘Select Telemetry …’ button. 

The Telemetry Selector window is displayed. 

171. Invoke the Selection Filter Screen: 

Click on the ‘Filter…’ button. 

The Selection Filter Screen is displayed. 

172. Note: Fields are displayed as the user selects a 
filter criteria. 

Select ‘AM1’ in the Spacecraft text area. 

Instruments associated with AM1 are displayed in 
the Instrument text area 

173. Select ‘CDH’ in the Instrument text area. Sample Types associated with CDH are displayed in 
the Sample Type text area 

174. Select ‘C’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_CDH_C is 
displayed in the Selected text area. 
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175. Select ‘T’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_CDH_T is 
displayed in the Selected text area. 

176. Select ‘EPS’ in the Instrument text area. Sample Types associated with EPS are displayed in 
the Sample Type text area 

177. Select ‘I’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_EPS_I is displayed 
in the Selected text area. 

178. Click the ‘OK’ button. The filter list is displayed in the Analysis Telemetry 
Selector window in the Subsystems section. 

179. Click the ‘AM1_CDH_C’ toggle button. A list of mnemonics associated AM1_CDH_C with 
are displayed in the Available Parameters text area 
of the Analysis Telemetry Selector window. 

180. Select ‘CDH_CR_SSR1_RECPBBUS’ in the 
available parameters text area. 

Select a sampling rate. 

Click the ‘All Data’ button. 

Click the ‘Select’ button. 

CDH_CR_SSR1_RECPBBUS along with the 
selected sample rate are displayed in the Selected 
Parameters field. 

181. Click on the ‘AM1_CDH_C’ toggle button. The list of mnemonics in the Available Parameters 
text area are removed. 

182. Click on the ‘AM1_CDH_T’ toggle button. A list of mnemonics associated with AM1_CDH_T 
are displayed in the Available Parameters text area 
of the Analysis Telemetry Selector window. 

4-109
 322-CD-100-001/ 
411-CD-100-001 



183. Select ‘CDH_TR_MOD_BDU_EPCB’ in the 
available parameters text area. 

Select a sampling rate. 

Click the ‘All Data’ button. 

Click the ‘Select’ button. 

CDH_TR_MOD_BDU_EPCB along with the 
selected sample rate are displayed in the Selected 
Parameters field. 

184. Click on the ‘AM1_CDH_T’ toggle button. The list of mnemonics in the Available Parameters 
text area are removed. 

185. Select ‘AM1_EPS_I’ toggle button in the 
Subsystem text area. 

A list of mnemonics associated AM1_EPS_I with 
are displayed in the Available Parameters text area 
of the Analysis Telemetry Selector window. 

186. Select ‘EPS_IR_QLTY_1’ in the available 
parameters text area. 

Select a sampling rate. 

Click the ‘All Data’ button. 

Click the ‘Select’ button. 

EPS_IR_QLTY_1 along with the selected sample 
rate are displayed in the Selected Parameters field. 

187. Click on the ‘AM1_EPS_I’ toggle button. The list of mnemonics in the Available Parameters 
text area are removed. 

188. Click the ‘OK’ button. Telemetry points and associated sample rates 
selected match the Selected Telemetry table in the 
Analysis Request window. 

189. Selecting Start and Stop Times 

Note: The times selected must be in the range of the 
input dataset. 

Click on the ‘Select Time’ button. 

The Selected Pair Times window is displayed. 
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190. Click the ‘Select’ button The Pair Time Selector window is displayed. 

191. Click the ‘Absolute’ button. The ‘Absolute’ button is selected 

192. Click the ‘Time’ button. The ‘Time’ button is selected 

193. Click the ‘Specify End Time’ button. The ‘Specify End Time’ button is selected 

194. Enter into the start date field: 

1997/348 

1997/348 is displayed in start date field 

195. Enter into the start time field: 

15:00:00.000 

15:00:00.000 is displayed in start time field 

196. Enter into the stop date field: 

1997/348 

1997/348 is displayed in stop date field 

197. Enter into the stop time field: 

16:00:00.000 

16:00:00.000 is displayed in stop time field 

198. Click the ‘OK’ button. The selected start and stop times match the start and 
stop times in the Selected Pair Times window. 

199. Click the ‘OK’ button. The selected start and stop times match the Selected 
Times table in the Analysis Request window. 

200. Select an output dataset name for the analysis 
request. 

Click the output dataset name toggle button. 

Enter the name of the output dataset (request 
name): 

Datasetasinput 

Datasetasinput will be displayed in the text box. 
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201. Select an input dataset name for the analysis 
request. 

Click the input dataset name toggle button. 

Enter the name of the output dataset (request 
name): 

Use_As_Input 

Use_As_Input will be displayed in the text box. 

202. Save the analysis request 

Save the analysis request. 

Click on the File pull down menu. 

A list of options appears. 

203. Select ‘Save as…’. A File Selection window is displayed with a default 
directory path in the selection field. The default 
directory path will be 
/fosb/test/am1/data/FUI/requests/. 

204. Enter the name of the request: 

Datasetasinput 

Click the ‘OK’ button. 

A dialog box informing the user that the file was 
saved. 

205. Click the ‘Close’ button in the information dialog 
box. 

The dialog box will close. 

206. Click the ‘OK’ button in the Analysis Request 
Builder window. 

The Analysis Request has been resubmitted 

207. Monitor the time the Event Display received the 
message Analysis Request X has started on Host N. 

Where X = the number of the request and N = the 
Name of the Host machine that started the request. 

Wait for an event message indicating that the 
analysis request is complete. In the Events Display 
window, a message will be displayed ‘Analysis 
Request X completed on Host N.’ 
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208. Invoke the Analysis Request Builder 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

209. Click on ‘Analysis_Request_Builder’. 

Click on the ‘OK’ button. 

The Analysis Request Builder window is displayed. 

210. Click the File pull down menu. A list of options appears. 

211. Select ‘Open’. The File Selection window is displayed. 

212. Select ‘ANA2120Template’. 

Click the ‘OK’ button. 

The Analysis Request named ANA2120Template is 
displayed 

213. Check the Request Status text area in the Analysis 
Request Builder window. 

The Request Status will indicate Read/Edit Request. 

214. Create an Analysis Request 

Enter into the request name field: 

Usedasinput1 

Usedasinput1 appears in the Request Name field 

215. Click the ‘Process on This User Station’ button to 
select data to be processed in the EOC. 

‘Process on This User Station’ button should show 
selected 

216. Click the ‘All Data’ button in the Data Quality box. The ‘All Data’ button should show selected 

217. Selecting Start and Stop Times 

Note: The times selected will be out of range of the 
input dataset. 

Click on the ‘Select Time’ button. 

The Pair Time Selector window is displayed. 

218. Click the ‘Select’ button The Pair Time Selector window is displayed. 
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219. Click the ‘Absolute’ button. The ‘Absolute’ button is selected 

220. Click the ‘Time’ button. The ‘Time’ button is selected 

221. Click the ‘Specify End Time’ button. The ‘Specify End Time’ button is selected 

222. Enter into the start date field: 

1997/348 

1997/348 is displayed in start date field 

223. Enter into the start time field: 

13:00:00.000 

13:00:00.000 is displayed in start time field 

224. Enter into the stop date field: 

1997/348 

1997/348 is displayed in stop date field 

225. Enter into the stop time field: 

14:00:00.000 

14:00:00.000 is displayed in stop time field 

226. Click the ‘OK’ button. The Selected Pair Times window is displayed. 

227. Click the ‘OK’ button. The selected start and stop times match the Selected 
Times table in the Analysis Request window. 

228. Select an output dataset name for the analysis 
request. 

Click the output dataset name toggle button. 

Enter the name of the output dataset (request 
name): 

Datasetasinput1 

Datasetasinput1 will be displayed in the text box. 
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229. Select an input dataset name for the analysis 
request. 

Click the input dataset name toggle button. 

Enter the name of the output dataset (request 
name): 

Use_As_Input 

Use_As_Input will be displayed in the text box. 

230. Save the analysis request 

Save the analysis request. 

Click on the File pull down menu. 

A list of options appears. 

231. Select ‘Save as…’. A File Selection window is displayed with a default 
directory path in the selection field. The default 
directory path will be 
/fosb/test/am1/data/FUI/requests/. 

232. Enter the name of the request: 

Usedasinput1 

Click the ‘OK’ button. 

A dialog box informing the user that the file was 
saved. 

233. Click the ‘Close’ button in the information dialog 
box. 

The dialog box will close. 

234. Click the ‘OK’ button. The Analysis Request has been resubmitted 

Wait for an event message indicating that the 
analysis request is unable to process due to database 
unable to locate times for request. 
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235. Place the mouse pointer on the screen and activate 
the pull down menu by pressing the right most 
mouse button. 

Select Programs 

Select X-term 

An X-term window will open. 

236. Go to the datasets directory and do a long listing for 
the Datasetasinput dataset. 

%:cd /fosb/test/am1/datasets 

%:ll -ltr 

The Datasetasinput dataset will appear in the 
datasets directory. Two files will have been created, 
Datasetasinput.data & Datasetasinput.meta and they 
contain data. 

237. Go to the “setup” directory and source FosEnvVars 

%:cd /fosb/test/am1/scripts/setup 

%:setenv SCRIPT UserStation 

%:source FosEnvVars 

The environment is configured to run the 
FaDrReaderDriver. 

238. Execute the FaDrReaderDriver 

$BIN_DIR/FaDrReaderDriver 

The driver is executed. 

239. Follow the menu prompts: 

Enter: 

1 

for Telemetry 

The ReaderDriver will respond with a prompt 

240. Enter the TLM dataset name: 

Datasetasinput_YYYYDOYHHMMSS_NN 

The ReaderDriver will execute and read the TLM 
file. Another menu will appear 
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241. Enter: 

6 

to generate a report. 

The ReaderDriver prompt for a new for the report. 

242. Enter: 

Datasetasinput 

The FaDrReaderDriver will generate the report. 

243. Enter: 

0 

to quit the FaDrReaderDriver 

The FaDrReaderDriver will quit. 

244. Go to the “reports” directory and do a long listing 
for the TimeOrderReport. 

%:cd /fosb/test/am1/reports 

%:ll -ltr 

The Report will be displayed as 

Datasetasinput.report 

245. Print a Time Order Downlink Report 

%:lp Datasetasinput.report 

The report will print. 

246. Print Report 

Select ‘Report Selector’ from the control window 
tools menu. 

The Report Selector window is displayed 
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247. Click the On-Demand toggle button 

Select Spacecraft type ‘AM1’ 

Select Report Category ‘ANA’ 

Select from Available Reports text area ‘Time 
Order Down Link Report’ 

Click ‘OK’ button 

The On-Demand Report Specification window is 
displayed. 

(Dataset as input verification) 

248. Enter Start Time: 

1997/348 15:00:00.000 

Report Start Time is displayed 

249. Enter Stop Time: 

1997/348 16:00:00.000 

Report Stop Time is displayed 

250. Enter Data Set: 

Usedasinput 

The Dataset to be used to crate the report will be 
displayed 

251. Select parameters used in the report: 

Click on ‘Filter’ button 

The Selection Filter Window is displayed. 

252. Select the Spacecraft type 

‘AM1’ 

The instruments associated with AM1 will be 
displayed n the Instrument text area. 

253. Select ‘CDH’ in the Instrument text area. Sample Types associated with CDH are displayed in 
the Sample Type text area 

254. Select ‘C’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_CDH_C is 
displayed in the Selected text area. 
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255. Select ‘T’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_CDH_T is 
displayed in the Selected text area. 

256. Select ‘EPS’ in the Instrument text area. Sample Types associated with EPS are displayed in 
the Sample Type text area 

257. Select ‘I’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_EPS_I is displayed 
in the Selected text area. 

258. Click on the ‘OK’ button The selected parameters will be displayed in the 
Selection Filter Area of the On-Demand Report 
Selector window. 

259. Click the ‘AM1_CDH_C’ toggle button. A list of mnemonics associated AM1_CDH_C with 
are displayed in the Selection Filter Area of the On- 
Demand Report Selector window. 

260. Select ‘CDH_CR_SSR1_RECPBBUS’ from the 
text area. 

Click on the ‚ button 

CDH_CR_SSR1_RECPBBUS is displayed in the 
Selected text area. 

261. Click on the ‘AM1_CDH_C’ toggle button. The list of mnemonics in the Available Parameters 
text area are removed. 

262. Click on the ‘AM1_CDH_T’ toggle button. A list of mnemonics associated with AM1_CDH_T 
are displayed in the Selection Filter Area of the On- 
Demand Report Selector window. 

263. Select ‘CDH_TR_MOD_BDU_EPCB’ from the 
text area. 

Click on the ‚ button 

CDH_TR_MOD_BDU_EPCB is displayed in the 
Selected text area. 
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264. Click on the ‘AM1_CDH_T’ toggle button. The list of mnemonics in the Available Parameters 
text area are removed. 

265. Select ‘AM1_EPS_I’ toggle button in the 
Subsystem text area. 

A list of mnemonics associated AM1_EPS_I with 
are displayed in the Selection Filter Area of the On- 
Demand Report Selector window. 

266. Select ‘EPS_IR_QLTY_1’ from the text area. 

Click on the ‚ button 

EPS_IR_QLTY_1 is displayed in the Selected text 
area. 

267. Click on the ‘AM1_EPS_I’ toggle button. The list of mnemonics in the Available Parameters 
text area are removed. 

268. Click the ‘OK’ button. The report will generate. 

269. Click on ‘Retrieve Report’ A list of available reports will be displayed 

270. Select ‘Time Order Down Link’ 

Click ‘Apply’ button 

The report will print 

271. Retrieve the Time Order Down Link Report ASCII 
printout. Verify via off line analysis ‚ 

The output of this dataset was derived from the input 
dataset. 

272. Place the mouse pointer on the screen and activate 
the pull down menu by pressing the right most 
mouse button. 

Select Programs 

Select X-term 

An X-term window will open. 
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273. Go to the “datasets” directory and do a long listing 
for the User_Stats dataset. 

%:cd /fosb/test/am1/datasets 

%:ll -ltr 

The User_Stats will appear in the datasets directory. 

274. Go to the “setup” directory and source FosEnvVars 

%:cd /fosb/test/am1/scripts/setup 

%:setenv SCRIPT UserStation 

%:source FosEnvVars 

The environment is configured to run the 
FaDrReaderDriver. 

275. Execute the FaDrReaderDriver 

$BIN_DIR/FaDrReaderDriver 

The driver is executed. 

276. Follow the menu prompts: 

Enter: 

2 

for User Stats 

The ReaderDriver will respond with a prompt 

277. Enter the TLM dataset name: 

User_Stats_ YYYYDOYHHMMSS_NN 

The ReaderDriver will execute and read the TLM 
file. Another menu will appear 

278. Enter: 

6 

to generate a report. 

The ReaderDriver prompt for a new for the report. 

279. Enter: 

User_Stats 

The FaDrReaderDriver will generate the report. 

4-121
 322-CD-100-001/ 
411-CD-100-001 



280. Enter: 

0 

to quit the FaDrReaderDriver. 

The FaDrReaderDriver will quit. 

281. Go to the “reports” directory and do a long listing 
for the TimeOrderReport. 

%:cd /fosb/test/am1/reports 

%:ll -ltr 

The Report will be displayed as 

User_Stats.stats 

282. Print a User Stats Report 

%:lp User_Stats.stats 

The report will print. 

283. Print Report 

Select ‘Report Selector’ from the control window 
tools menu. 

The Report Selector window is displayed 

284. Click the On-Demand toggle button 

Select Spacecraft type ‘AM1’ 

Select Report Category ‘ANA’ 

Select from Available Reports text area ‘User 
Specified Statistics’ 

Click ‘OK’ button 

The On-Demand Report Specification window is 
displayed. 

285. Enter Start Time: 

1997/348 15:00:00.000 

Report Start Time is displayed 

286. Enter Stop Time: 

1997/348 16:00:00.000 

Report Stop Time is displayed 
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287. Enter Data Set: 

Usedasinput 

The Dataset to be used to crate the report will be 
displayed 

288. Select parameters used in the report: 

Click on ‘Filter’ button 

The Selection Filter Window is displayed. 

289. Select the Spacecraft type 

‘AM1’ 

The instruments associated with AM1 will be 
displayed n the Instrument text area. 

290. Select ‘CDH’ in the Instrument text area. Sample Types associated with CDH are displayed in 
the Sample Type text area 

291. Select ‘C’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_CDH_C is 
displayed in the Selected text area. 

292. Select ‘T’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_CDH_T is 
displayed in the Selected text area. 

293. Select ‘EPS’ in the Instrument text area. Sample Types associated with EPS are displayed in 
the Sample Type text area 

294. Select ‘I’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_EPS_I is displayed 
in the Selected text area. 

295. Click on the ‘OK’ button The selected parameters will be displayed in the 
Selection Filter Area of the On-Demand Report 
Selector window. 

296. Click the ‘AM1_CDH_C’ toggle button. A list of mnemonics associated AM1_CDH_C with 
are displayed in the Selection Filter Area of the On- 
Demand Report Selector window. 
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297. Select ‘CDH_CR_SSR1_RECPBBUS’ from the 
text area. 

Click on the ‚ button 

CDH_CR_SSR1_RECPBBUS is displayed in the 
Selected text area. 

298. Click on the ‘AM1_CDH_C’ toggle button. The list of mnemonics in the Available Parameters 
text area are removed. 

299. Click on the ‘AM1_CDH_T’ toggle button. A list of mnemonics associated with AM1_CDH_T 
are displayed in the Selection Filter Area of the On- 
Demand Report Selector window. 

300. Select ‘CDH_TR_MOD_BDU_EPCB’ from the 
text area. 

Click on the ‚ button 

CDH_TR_MOD_BDU_EPCB is displayed in the 
Selected text area. 

301. Click on the ‘AM1_CDH_T’ toggle button. The list of mnemonics in the Available Parameters 
text area are removed. 

302. Select ‘AM1_EPS_I’ toggle button in the 
Subsystem text area. 

A list of mnemonics associated AM1_EPS_I with 
are displayed in the Selection Filter Area of the On- 
Demand Report Selector window. 

303. Select ‘EPS_IR_QLTY_1’ from the text area. 

Click on the ‚ button 

EPS_IR_QLTY_1 is displayed in the Selected text 
area. 

304. Click on the ‘AM1_EPS_I’ toggle button. The list of mnemonics in the Available Parameters 
text area are removed. 

305. Click ‘OK’ button The report will generate 

306. Click on ‘Retrieve Report’ A list of available reports will be displayed 

307. Select the ‘User Specified Statistics’ 

Click ‘Apply’ button 

The report will print 
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308. Retrieve the User Specified Statistics ASCII 
printout 

Verify the report header contains the following: 

Date and time of the report 

The starting spacecraft time of the data 

The ending spacecraft time of the data 

The interval type of the statistic 

Verify each telemetry point has an associated 
mnemonic name in the report. 

Verify the report contains the following information: 

Minimum value within each interval time 

Spacecraft time for each minimum value 

Maximum value within each interval time 

Spacecraft time for each maximum value 

Mean value for each interval time 

Standard deviation for each interval time 

Number of samples occurring within each interval 
time. 

309. End of test. 
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Test Command Echo Exchange Test Procedure


Test Case No: EDOS-2002B 

Test Configuration: See Appendix G 

Test Support: Powered-up FOS servers, one EOC user station; FOS Server and EOC user station startup scripts; 
Command Echo Block (CEB) message generator; tcpdump. 

Test Case Description: 

This test is designed to verify that the EOC can transmit Command Test Blocks (CTBs) to EDOS, receive corresponding 
Command Echo Blocks (CEBs) from EDOS, allow the user to specify the timeout value for receipt of CEBs, and generate 
event messages upon occurrence of a timeout and receipt of CEBs. 
station, the user invokes the Event Display and connects to String 100. 
CTBs with invalid timeout values, which result in syntax errors. 
indicating a CEB has not been received within the timeout limit. 
invokes the CEB driver, which emulates EDOS. 
received by the driver. 
timeout limit, and event messages indicate receipt of CEBs. 
values are sent, and an event message indicates a CEB has not been received within the timeout limit. 

Success Criteria: 

This test is successful when the EOC sends CTBs; receives CEBs; allows the user to specify the timeout value for receipt of 
CEBs; and generates appropriate event messages when timeouts occur and when CEBs are received. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log in to an EOC user station, using UNIX login 
procedure, by entering User Name and Password 

Username: <user name> 

Password: ******** 

The login is accepted and several cmdtool windows 
appear 

Following initialization of FOS servers and EOC user 
The user attempts to send, via ECL directive, several 

A valid CTB is sent, which results in an event message 
The user remotely logs in to the Real-Time Server and 

When the CEB driver is running, a CEB is sent to the EOC for each CTB 
CEBs are sent within the The tcpdump tool is utilized to monitor CTB and CEB message traffic. 

Finally the CEB driver is terminated, CTBs with valid timeout 
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2. (This step is necessary only if the Data Server, 
Real-Time Server, and User Station are not up.) 

Execute applicable steps of ‘FOS Server and User 
Station Startup and Shutdown’ test procedure 
(SYS-2000B) procedure to bring up FOS servers 
and EOC user station 

The Data Server, Real-Time Server, and User 
Station are initialized. 

3. Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display-Global’ 

The ‘Tools’ menu comes up, then closes. 

The ‘Event Display’ comes up. 

4. Connect mirrored to string 100. Enter the 
following ECL directive: 

ECL> STRING CONNECT 
STRING=100 CONFIG=MIRROR 

The following event message appears (after several
minutes): 

‘Successfully connected to string 100’. 

5. Initiate the tcpdump tool to capture outgoing CTB
and incoming CEB messages. 

In a new cmdtool window, enter the following: 

%: tcpdump -v port 20x54 

x=0 for Operational LAN 

x=1 for Support LAN 

The following message appears in the cmdtool
window: 

‘listening on le0’ (Operational LAN) or 

‘listening on le1’ (Support LAN) 
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6. Attempt to send a Command Test Block (CTB) and 
set the Command Echo Block (CEB) timeout value 
to a negative number by entering the following in 
the ECL directive line of the Control Window: 

ECL> EDOS COMMTEST TIMEOUT=�
5 

A syntax error on the ECL directive is received 

7. Attempt to send a Command Test Block (CTB) and 
set the Command Echo Block (CEB) timeout to a 
non-numeric character by entering the following in 
the ECL directive line of the Control Window: 

ECL> EDOS COMMTEST 
TIMEOUT=A 

A syntax error on the ECL directive is received 

8. Send a Command Test Block (CTB) and set the 
Command Echo Block (CEB) timeout to the default 
value (5 seconds) by entering the following in the 
ECL directive line of the Control Window: 

ECL> EDOS COMMTEST 

A message in the window where tcpdump is running 
indicates that a CTB has been sent. 

The following event message is displayed after about 
5 seconds: 

‘EDOS has not sent a Command Echo Block within 
the timeout limit’. 

9. Send a CTB and change the CEB timeout value to 
15 seconds by entering the following in the ECL 
directive line of the Control Window: 

ECL> EDOS COMMTEST 
TIMEOUT=15 

A message in the window where tcpdump is running 
indicates that a CTB has been sent. 

The following event message is displayed after about 
15 seconds: 

‘EDOS has not sent a Command Echo Block within 
the timeout limit’. 
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10. Remotely log in to the Real-Time Server by 
entering the following in a new cmdtool window: 

%: rlogin <Real-Time Server> 

A UNIX prompt is received from the Real-Time 
Server. 

11. Invoke the CEB generator for the transmission of a 
CEB to the EOC by entering the following in the 
same cmdtool window: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: setenv SCRIPT RealTimeServer 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/dec_osf_3-2 

%: EdosEchoDriver 

The message ‘Edos connection created’ appears in 
the same window, indicating the ‘EdosEchoDriver’ 
tool is ready to respond to CTBs 

12. Send a CTB and change the CEB timeout value to 
60 seconds by entering the following in the ECL 
directive line of the Control Window: 

ECL> EDOS COMMTEST 
TIMEOUT=60 

Messages in the window where tcpdump is running 
indicate that a CTB has been sent and a CEB 
received. 

Messages in the window where EdosEchoDriver is 
running indicate that a CTB has been received and a 
CEB sent. 

The following event message is displayed: 

‘Command Echo Block received from EDOS’. 
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13. Send a CTB and change the timeout value to the 
default value (5 seconds) by entering the following 
in the ECL directive line of the Control Window: 

ECL> EDOS COMMTEST 

Messages in the window where tcpdump is running 
indicate that a CTB has been sent and a CEB 
received. 

Messages in the window where EdosEchoDriver is 
running indicate that a CTB has been received and a 
CEB sent. 

The following event message is displayed: 

‘Command Echo Block received from EDOS’. 

14. In the window containing the ‘EdosEchoDriver’, 
depress the following two keys simultaneously: 

Ctrl C 

The ‘EdosEchoDriver’ tool quits, and a UNIX 
prompt is received from the Real-Time Server. 

15. Exit from the Real-Time Server by entering the 
following in the same cmdtool window. 

%: exit 

A UNIX prompt is received from the User Station 

16. Send a CTB and change the timeout value to 30 
seconds by entering the following in the ECL 
directive line of the Control Window: 

ECL> EDOS COMMTEST 
TIMEOUT=30 

A message in the window where tcpdump is running 
indicates that a CTB has been sent. 

The following event message is displayed after about 
30 seconds: 

‘EDOS has not sent a Command Echo Block within 
the timeout limit’. 
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17. Send a Command Test Block (CTB) and set the 
Command Echo Block (CEB) timeout to the default 
value (5 seconds) by entering the following in the 
ECL directive line of the Control Window: 

ECL> EDOS COMMTEST 

A message in the window where tcpdump is running 
indicates that a CTB has been sent. 

The following event message is displayed after about 
5 seconds: 

‘EDOS has not sent a Command Echo Block within 
the timeout limit’. 

18. In the window containing tcpdump, depress the
following two keys simultaneously: 

Ctrl C 

The ‘tcpdump’ tool quits, and a UNIX prompt is
received from the user station. 

19. End of test. 

4-131
 322-CD-100-001/ 
411-CD-100-001 



SCS Summary Report Processing Test Procedure


Test Case No: EDOS-2010B 

Test Configuration: See Appendix G 

Test Support: Powered-up FOS servers, one EOC user station; FOS Server and User Station startup scripts; valid and 
invalid Spacecraft Contact Session (SCS) Summary Report binary data and associated signal file in external host. 

Test Case Description: 

This test is designed to verify that the EOC can receive SCS Summary Report binary data, archive these data, convert them 
to ASCII format, and generate a formatted report. the FOS Data Server and EOC user station, the 
user brings up the Event Display. logs in to an emulated EDOS host at the EOC (or telnets to an external host) 
containing valid and invalid SCS Summary Report binary data files.  These files and their associated signal file are sent 
from the external host to the EOC via FTP. s appear on the EOC user station indicating receipt of these data. 
A comparison is made among the SCS Summary Report binary data sent from the external host and archived by the EOC. 
The valid data are converted to ASCII report format. 
resulting ASCII report is stored. 

The user then invokes the Report Generator tool to display the ASCII report. 
binary data to ASCII report format. 

Success Criteria: 

This test is successful when the EOC receives and archives SCS Summary Report binary data from an external host; 
automatically converts these binary data to ASCII report format; and provides the user with the capability to display 
formatted reports from the ASCII and binary data. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Transmit and Process Valid SCS Summary 
Report test follows 

(No expected result/output; information only) 

Following initialization of 
The user 

Event message

Event messages indicating processing status are generated, and the 

This tool is also used to convert archived 
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2. EOC user station: 

Log in to an EOC user station, using UNIX login 
procedure, by entering User Name and Password 

Username: <user name> 

Password: ******** 

The login is accepted and several cmdtool windows 
appear 

3. EOC user station 

Remotely log in to the Data Server, and check the 
current File Watcher cycle time by entering the 
following in a cmdtool window: 

%: rlogin <EOC Data Server> 

Password: ******** 

%: env | grep FDFW 

Note the current File Watcher cycle time so it can 
be reset later 

The remote login is successful. 

The following response appears: 

‘FDFW_TIMEOUT=xxxx’ 

(xxxx = current File Watcher cycle time in seconds) 
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4. EOC user station 

(This step is optional. it to change the File 
Watcher cycle time) 

Reset the time interval for EOC search of SCS 
Summary Report data files to 60 seconds by 
entering the following in the same cmdtool window 
on the Data Server: 

%: ps -ea | grep FdFw 

%: kill <FdFwFileWatcher process id> 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: setenv SCRIPT DataServer 

%: setenv FDFW_TIMEOUT 60 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/dec_osf_3-2 

%: FdFwFileWatcher & 

%: ps -ea | grep FdFw 

%: env | grep FDFW 

The former FdFwFileWatcher process terminates. 

The new FdFwFileWatcher process is shown. 

The following response appears: 

‘FDFW_TIMEOUT=60’ 

Use 
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5. EOC user station: 

(This step is necessary only if the Data Server and 
User Station are not up.) 

Execute applicable steps of ‘FOS Server and User 
Station Startup and Shutdown’ test procedure 
(SYS-2000B) procedure to bring up FOS servers 
and EOC user station 

The Data Server and User Station are initialized. 

6. EOC user station: 

Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display-Global’ 

The ‘Tools’ menu comes up, then closes. 

The ‘Event Display’ comes up. 
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7. EOC user station: 

(Execute this step only if there is no external host at 
the EOC that contains SCS Summary Report test 
data files.) 

Telnet to an EDF host that contains SCS Summary 
Report test data files by entering the following in a 
cmdtool window: 

%: telnet 155.157.100.xxx 

xxx = 100 (beeper), 117 (muttly), or 130 
(traveler) 

login: <user name> 

Password: ******** 

(Note: 
‘External host’ in the following steps) 

(Skip the next step) 

The telnet is accepted 

This cmdtool window is referred to as 
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8. Emulated EDOS host at EOC: 

(Execute this step only if there is an external 
workstation at the EOC that contains SCS 
Summary Report test data files.) 

Log in to the emulated EDOS host, using UNIX 
login procedure, by entering User Name and 
Password 

Username: <user name> 

Password: ******** 

(Note: 
referred to as ‘External host’ in the following steps) 

The login is accepted and several cmdtool windows 
appear 

9. External host: 

From the applicable cmdtool window on the 
external host, access the directory and file 
containing the SCS Summary Report binary data 

%: cd /net/beeper/fosb/int/am1/testdata 
(if telnet) 

%: cd /<applicable directory> (if external 
host at EOC) 

%: ls -lrt 

Note the size of the applicable files to be sent to the 
EOC. 

The directory containing the files to be sent is 
displayed. 

The cmdtool windows that come up are 
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10. External host: 

In the same cmdtool window, establish an FTP 
connection with the EOC server 

%: ftp <EOC Data Server> 

Name: <user name> 

Password: ******** 

An ‘ftp’ prompt appears on the external host 

11. External host: 

Send valid SCS Summary Report binary data file to 
the EOC via FTP. 

In the same cmdtool window, initiate an FTP ‘put’ 
command to send the SCS Summary Report binary 
data file to the EOC: 

ftp> cd 
/fosb/test/am1/external/edos/summary 

ftp> bin 

ftp> put S042WSG97108184438.CSR 

(Wait for completion of file transfer.) 

Message appears on the external host indicating that 
the transfer is complete 
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12. External host: 

Send a ‘signal file’ (indicating completion of SCS 
Summary Report binary data file transfer) to the 
EOC via FTP. 

In the same cmdtool window, initiate a FTP ‘put’ 
command to send the ‘signal file’ to the EOC. 

ftp> put 
S042WSG97108184438.CSR.XFR 

(Wait for completion of file transfer) 

External host: 

Message appears indicating that the transfer is 
complete. 

EOC user station: 

(Note: This takes might take a complete File 
Watcher cycle to occur.) 

The following messages appear on the Event 
Display: 

A message indicating SCS Summary Report data has 
been received; 

‘FaCsReportMonitor processing Spacecraft Contact 
Session report <filename>‘; 

‘FaCsReportMonitor successfully processed 
Spacecraft Contact Session report <filename>‘. 

13. Transmit Invalid SCS Summary Report test 
follows 

(No expected result/output; information only) 

14. External host: 

Send invalid SCS Summary Report binary data file 
with to the EOC via FTP. 

In the same cmdtool window, initiate an FTP ‘put’ 
command to send the SCS Summary Report data 
file to the EOC: 

ftp> put S042WSG97222120000.CSR 

(Wait for completion of file transfer.) 

Message appears on the external host indicating that 
the transfer is complete 
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15. External host: 

Send a ‘signal file’ (indicating completion of SCS 
Summary Report data file transfer) to the EOC 
using FTP. 

In the same cmdtool window, initiate a FTP ‘put’ 
command to send the ‘signal file’ to the EOC. 

ftp> put S042WSG97222120000.CSR.XFR 

(Wait for completion of file transfer) 

External host: 

Message appears indicating that the transfer is 
complete. 

EOC user station: 

(Note: This takes might take a complete File 
Watcher cycle to occur.) 

The following messages appear on the Event 
Display: 

A message indicating SCS Summary Report data has 
been received; 

‘FaCsReportMonitor processing Spacecraft Contact 
Session report S042WSG97222120000.CSR‘ 

‘FaCsReportMonitor failed processing Spacecraft 
Contact Session report 
S042WSG97222120000.CSR: <reason>‘ 

16. External host: 

Terminate the FTP session by entering the 
following in the same cmdtool window:. 

ftp> quit 

A UNIX prompt (%) appears in the cmdtool window 
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17. External host: 

Display the directory containing the SCS Summary 
Report binary data files by entering the following in 
the same cmdtool window: 

%: ls -lrt 

Note the size and time of the applicable file. 

The valid SCS Summary Report binary data files just 
sent is included in the files listing 

18. External host: 

Represent the contents of the valid SCS Summary 
Report binary data file in hexidecimal by entering 
the following in the same cmdtool window: 

%: od -x S042WSG97108184438.CSR 

Valid SCS Summary Report binary data file is 
displayed as a hexidecimal dump 

19. External host: 

Represent the contents of the inval id  SCS 
Summary Report binary data file in hexidecimal by 
entering the following in the same cmdtool 
window: 

%: od -x S042WSG97222120000.CSR 

Invalid SCS Summary Report binary data file is 
displayed as a hexidecimal dump 

20. EOC user station: 

List the SCS Summary Report binary data files 
archived by entering the following in a cmdtool 
window: 

%: cd /fosb/test/am1/reports 

%: ls -lrt 

Note the filename and time of the applicable file. 

The SCS Summary Report binary data files are 
included in the directory listing. 

The size of the applicable files and the date/time are 
consistent with the file transfers. 
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21. EOC user station: 

Represent the contents of the valid EOC SCS 
Summary Report binary data file in hexidecimal by 
entering the following in the same cmdtool 
window: 

%: od -x S042WSG97108184438.CSR 

Valid SCS Summary Report binary data file contents 
are displayed as a hexidecimal dump 

22. EOC user station: 

Print the hexidecimal dump by entering the 
following in a cmdtool window: 

%: snapframe 

Valid SCS Summary Report hexidecimal dump is 
printed 

23. EOC user station: 

Represent the contents of the invalid EOC SCS 
Summary Report binary data file in hexidecimal by 
entering the following in the same cmdtool 
window: 

%: od -x S042WSG97222120000.CSR 

Invalid SCS Summary Report binary data file is 
displayed as a hexidecimal dump 

24. EOC user station: 

Print the hexidecimal dump by entering the 
following in a cmdtool window: 

%: snapframe 

Invalid SCS Summary Report hexidecimal dump is 
printed 

25. Compare the contents of the SCS Summary Report 
data file archive at the EOC with that sent by the 
External Host. 

The SCS Summary Report data file contents at the 
EOC and External Host are identical 
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26. EOC user station 

(This step is optional. to reset the File 
Watcher cycle time) 

Reset the time interval for EOC search of SCS 
Summary Report data files to its former value (in 
seconds) by entering the following in the same 
cmdtool window where File Watcher was 
previously started: 

%: ps -ea | grep FdFw 

%: kill <FdFwFileWatcher process id> 

%: setenv FDFW_TIMEOUT xxxx 

xxxx = former File Watcher cycle time 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/dec_osf_3-2 

%: FdFwFileWatcher & 

%: ps -ea | grep FdFw 

%: env | grep FDFW 

%: exit 

The current FdFwFileWatcher process terminates. 

The new FdFwFileWatcher process is shown. 

The following response appears: 

‘FDFW_TIMEOUT=xxxx’ 

(xxxx = former File Watcher cycle time in seconds) 

A UNIX prompt is received from the EOC User 
Station. 

27. Display SCS Summary Report test follows (No expected result/output; information only) 

Use it 
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28. EOC user station: 

Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Report_Generator’ 

The ‘Tools’ menu comes up, then closes. 

The ‘Report Selector’ window comes up. 

29. EOC user station: 

In the Report Selector window, specify the 
following: 

Report Type: Periodic 

Spacecraft: AM1 

Report Category: ANA 

Available Reports: Spacecraft Contact 
Session Summary (Periodic) 

Click on ‘Apply’ 

The ‘Periodic Report Selector’ window comes up 
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30. EOC user station: 

In the ‘Periodic Report Selector’ window, specify 
the following: 

Start Time: YYYY/DDD 
HH:MM:SS.mmm 

Stop Time: YYYY/DDD 
HH:MM:SS.mmm 

(Note: Specify times that include the SCS 
Summary Report processed earlier as a result of file 
transfer.) 

Report Output Options: Browser 

Click on ‘Retrieve Report’ 

Click on ‘Apply’. 

A list of SCS Summary Report ASCII data files is 
displayed in the large box in the same window 

31. EOC user station: 

In the ‘Periodic Report Selector’ window, select the 
filename with the time corresponding to the SCS 
Summary Report ASCII data file generated 
previously. 

Click on ‘OK’. 

The ‘Periodic Report Selector’ window closes. 

The SCS Summary Report ASCII data file appears 
on the screen. 

32. EOC user station: 

Print the formatted SCS Summary Report just 
displayed by entering the following in a cmdtool 
window: 

%: snapframe 

The formatted SCS Summary Report is printed 
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33. EOC user station: 

In the Report Selector window, specify the 
following: 

Report Type: On Demand 

Spacecraft: AM1 

Report Category: ANA 

Available Reports: Spacecraft Contact 
Session Summary (On Demand) 

Click on ‘OK’. 

The ‘Report Selector’ window closes. 

The ‘On_Demand Report Selector’ window comes 
up. 

34. EOC user station: 

In the ‘On-Demand Report Selector’ window, 
specify the following: 

Click on ‘New Report’ 

The ‘On_Demand Report Specification’ window 
comes up 

35. EOC user station: 

Process valid SCS Summary Report data archived 
earlier. 

In the ‘On-Demand Report Specification’ window, 
specify the following: 

Directory: /fosb/test/am1/reports 

File: S042WSG97108184438.CSR 

Click on ‘OK’. 

The ‘On-Demand Report Specification’ window 
closes. 

A dialog box appears with the message ‘Spacecraft 
Contact Session Report Generating’ 

The following messages appear in the Event 
Display: 

‘FaCsReport Monitor processing Spacecraft Contact 
Session report S042WSG97108184438.CSR‘; 

‘FaCsReport Monitor successfully processed 
Spacecraft Contact Session report 
S042WSG97108184438.CSR’ 

4-146
 322-CD-100-001/ 
411-CD-100-001 



36. EOC user station: 

Process invalid SCS Summary Report data archived 
earlier. 

In the ‘On-Demand Report Specification’ window, 
specify the following: 

Directory: /fosb/test/am1/reports 

File: S042WSG97222120000.CSR 

Click on ‘OK’. 

The ‘On-Demand Report Specification’ window 
closes. 

A dialog box appears with the message ‘Spacecraft 
Contact Session Report Generating’ 

The following messages appear in the Event 
Display: 

‘FaCsReportMonitor processing Spacecraft Contact 
Session report S042WSG97222120000.CSR‘ 

‘FaCsReportMonitor failed processing Spacecraft 
Contact Session report 
S042WSG97222120000.CSR: <reason>‘ 

37. EOC user station: 

List the SCS Summary Report ASCII files by 
entering the following in a cmdtool window: 

%: cd /fosb/test/am1/reports/scs 

%: ls -lrt 

Note the size and time of the applicable file. 

The SCS Summary Report ASCII data file just 
generated from the valid data is included in the 
directory listing. 

The size of this file and the date/time are consistent 
with file generation. 

(No ASCII file is generated from the invalid data.) 
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38. EOC user station: 

In the ‘On-Demand Report Selector’ window, 
specify the following: 

Start Time: YYYY/DDD 
HH:MM:SS.mmm 

Stop Time: YYYY/DDD 
HH:MM:SS.mmm 

(Note: Specify times that include the SCS 
Summary Report just processed as a result of user 
request.) 

Report Output Options: Printer 

Click on ‘Retrieve Report’ 

Click on ‘OK’. 

A list of SCS Summary Report ASCII data files is 
displayed in the large box in the same window. 

39. EOC user station: 

In the ‘On-Demand Report Selector’ window, 
select the file with the time corresponding to the 
SCS Summary Report ASCII data file generated as 
a result of user request. 

Click on ‘OK’. 

The ‘On-Demand Report Selector’ window closes. 

The SCS Summary Report ASCII data file is printed. 

40. EOC user station: 

Compare the two reports generated via the Report 
Generator. 

The information generated via the Report Generator 
are consistent with each other. 

41. End of test. 
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IST Pool Management Test Procedure


Test Case No: IST-2000B 

Test Configuration: See Appendix G 

Test Support: Powered-up FOS Data Server, one EOC user station; three emulated ISTs (two of which should be the same 
type, e.g., CERES); FOS Server, EOC User Station, and IST startup scripts. 

Test Case Description: 

This test is designed to verify that the EOC can administer the allocation of IST connections, including additional IST 
connections; monitor IST startup and shutdown; support dedicated, and a pool of non-dedicated, IST connections based on IST 
type and location; and support simultaneous IST connections. 
management information (‘ist_counter’) to an initial state. Several iterations of logging into/logging out of ISTs and 
reconfiguring the ‘ist_counter’ database table are performed. 
cases, depending on the configuration of the ‘ist_counter’ database table.  to 
overall FOS pool management, is included for completeness. 

Success Criteria: 

This test is successful when the EOC can administer the allocation of IST connections, including additional IST connections; 
monitor IST startup and shutdown; support dedicated, and a pool of non-dedicated, IST connections based on IST type and 
location; and support simultaneous IST connections. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. EOC User Station -- Log in to an EOC user 
station, using UNIX login procedure, by entering 
User Name and Password 

Username: <user name> 

Password: ******** 

The login is accepted and two UNIX cmdtool windows 
appear 

The user configures the database table containing IST pool 

IST logins are allowed in some instances, and denied in other 
EOC User Station login and shutdown, as it pertains
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2. (This step is necessary only if the Data Server is 
not up.) 

Execute applicable steps of ‘FOS Server and User 
Station Startup and Shutdown’ test procedure 
(SYS-2000B) procedure to bring up the Data 
Server. 

The Data Server is initialized. 

3. Display the database table containing IST pool 
management information by entering the 
following in a cmdtool window: 

%: isql -Ufos_dba -Pfos_dba (sql is alias) 

1> use am1_fos_ops 

2> go 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed 

4. Print the database table containing IST pool 
management information by entering the 
following in a cmdtool window: 

%: snapframe 

The ‘ist_counter’ database table is printed so it can be 
reset to current values later in this test procedure 
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5. Edit the ‘ist_counter’ database table and set to 0 
all values, except for UndedTotal, by entering 
these sql commands: 

1> update ist_counter 

2> set XxxYyyyy = 0 

(XxxYyyyy = column name in ist_counter table; 

Xxx = instrument/location; 

Yyyyy = Current, Total, Unded, Flag) 

3> go 

Repeat this sequence for each column name in the 
‘ist_counter’ table, except for ‘UndedTotal’ 

All values in the ‘ist_counter’ database table are set to 
0 (except for UndedTotal) 

6. Edit the ‘ist_counter’ database table and set to 1 
the total number of non-dedicated (‘pool’) 
connections allowed by entering these sql 
commands: 

1> update ist_counter 

2> set UndedTotal = 1 

3> go 

The ‘UndedTotal’ value is set to 1 

7. Display the database table containing IST pool 
management information by entering the sql 
commands below: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0, except for ‘UndedTotal’, which is 1 
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8. IST #1 -- Log in to IST #1 (CERES) using UNIX 
login procedure, by entering User Name and 
Password: 

Username: <user name> 

Password: ******** 

The login is accepted and several UNIX windows 
appear 

9. IST #1 -- Attempt to bring up IST #1 (CERES) by 
entering the following in a cmdtool window: 

%: cd /data/fos/ist/am1/scripts/setup (setup 
is alias) 

%: IST_LOGIN & 

The ‘FOS Login’ screen comes up 

10. IST #1 -- In the ‘FOS Login’ screen, enter name 
and associated password as necessary: 

User: <user name> 

Password: ******** 

Click ‘OK’ button. 

The ‘FOS Login’ screen closes. 

The ‘User Roles’ window comes up. 

11. IST #1 -- In the ‘User Roles’ window, specify the 
following: 

Roles: Select ‘Read Only’; 

Click ‘OK’ button. 

Close the Error Dialog box. 

An Error Dialog box comes up indicating there are no 
available connections. (There are no dedicated 
connections available for this IST, and this IST is not 
allowed to use the available non-dedicated connection 
from the pool.) 

The Error Dialog box closes. 
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12. Edit the ‘ist_counter’ database table and set the 
flag to allow CERES, MISR, and the EOC to use 
non-dedicated connections by entering these sql 
commands: 

1> update ist_counter 

2> set CeresFlag = 1 

3> go 

1> update ist_counter 

2> set MisrFlag = 1 

3> go 

1> update ist_counter 

2> set EocFlag = 1 

3> go 

The applicable values are changed in the ‘ist_counter’ 
table 

13. Display the database table containing IST pool 
management information by entering these sql 
commands: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following, which are 1: 

CeresFlag, Misr Flag, EocFlag, and UndedTotal 

14. IST #1 -- Bring up IST #1 (CERES) by entering 
the following in a cmdtool window: 

%: cd /data/fos/ist/am1/scripts/setup (setup 
is alias) 

%: IST_LOGIN & 

The ‘FOS Login’ screen comes up 
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15. IST #1 -- In the ‘FOS Login’ screen, enter name 
and associated password as necessary: 

User: <user name> 

Password: ******** 

Click ‘OK’ button. 

The ‘FOS Login’ screen closes. 

The ‘User Roles’ window comes up. 

16. IST #1 -- In the User Roles window, specify the 
following: 

Roles: Select ‘Read Only’ 

Click ‘OK’ button 

(Wait for user station startup completion) 

A dialog box appears with the message ‘Starting User 
Station. Please Wait’, indicating that the user station 
startup script has not yet completed. 

User station startup is complete when the Control 
Window comes up. 

17. Display the database table containing IST pool 
management information by entering these sql 
commands: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following, which are 1: 

CeresUnded, CeresFlag, Misr Flag, EocFlag, and 
UndedTotal 

18. IST #2 -- Log in to IST #2 (MISR) using UNIX 
login procedure, by entering User Name and 
Password: 

Username: <user name> 

Password: ******** 

The login is accepted and several UNIX windows 
appear 
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19. IST #2 -- Attempt to bring up IST #2 (MISR) by 
entering the following in a cmdtool window: 

%: cd /data/fos/ist/am1/scripts/setup (setup 
is alias) 

%: IST_LOGIN & 

The ‘FOS Login’ screen comes up 

20. IST #2 -- In the ‘FOS Login’ screen, enter name 
and associated password as necessary: 

User: <user name> 

Password: ******** 

Click ‘OK’ button. 

The ‘FOS Login’ screen closes. 

The ‘User Roles’ window comes up. 

21. IST #2 -- In the ‘User Roles’ window, specify the 
following: 

Roles: Select ‘Read Only’; 

Click ‘OK’ button. 

Close the Error Dialog box. 

An Error Dialog box comes up indicating there are no 
available connections. (There are no dedicated 
connections available for this IST, and there are no 
non-dedicated connections available from the pool.) 

The Error Dialog box closes. 

22. EOC User Station -- Execute applicable portions 
of the ‘FOS Server and User Station Startup and 
Shutdown’ test procedure (SYS-2000B) to attempt 
to bring up an EOC User Station. 

An Error Dialog box comes up indicating there are no 
available connections. (There are no dedicated 
connections available for EOC User Stations, and there 
are no non-dedicated connections available from the 
pool.) 

The Error Dialog box closes. 
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23. Edit the ‘ist_counter’ database table to allow 
dedicated connections for CERES, MISR, and 
EOC User Stations and to increase the size of the 
non-dedicated pool by entering these sql 
commands: 

1> update ist_counter 

2> set CeresTotal = 1 

3> go 

1> update ist_counter 

2> set MisrTotal = 1 

3> go 

1> update ist_counter 

2> set UndedTotal = 2 

3> go 

1> update ist_counter 

2> set EocTotal = 36 

3> go 

The applicable values are changed in the ‘ist_counter’ 
table 

24. Display the database table containing IST pool 
management information by entering the sql 
commands below: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following: 

Value of 1: CeresTotal, CeresUnded, CeresFlag, 
MisrTotal, MisrFlag, and EocFlag; 

Value of 2: Unded Total; 

Value of 36: EocTotal 
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25. EOC User Station -- Execute applicable portions 
of the ‘FOS Server and User Station Startup and 
Shutdown’ test procedure (SYS-2000B) to bring 
up an EOC User Station. 

(Wait for initialization to complete before 
proceeding to the next step) 

The EOC user station is initialized when the Control 
Window appears. 

26. Display the database table containing IST pool 
management information by entering the sql 
commands below: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following: 

Value of 1: CeresTotal, CeresUnded, CeresFlag, 
MisrTotal, MisrFlag, EocCurrent, and EocFlag; 

Value of 2: Unded Total; 

Value of 36: EocTotal 

27. IST #2 -- Bring up IST #2 (MISR) by entering the 
following in a cmdtool window: 

%: cd /data/fosb/ist/am1/scripts/setup (test 
is alias) 

%: IST_LOGIN & 

The ‘FOS Login’ screen comes up 

28. IST #2 -- In the ‘FOS Login’ screen, enter name 
and associated password as necessary: 

User: <user name> 

Password: ******** 

Click ‘OK’ button. 

The ‘FOS Login’ screen closes. 

The ‘User Roles’ window comes up. 
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29. IST #2 -- In the User Roles window, specify the 
following: 

Roles: Select ‘Read Only’ 

Click ‘OK’ button 

(Wait for user station startup completion) 

A dialog box appears with the message ‘Starting User 
Station. Please Wait’, indicating that the user station 
startup script has not yet completed. 

User station startup is complete when the Control 
Window comes up. 

30. EOC User Station -- Display the database table 
containing IST pool management information by 
entering these sql commands: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following: 

Value of 1: CeresTotal, CeresUnded, CeresFlag, 
MisrCurrent, MisrTotal, MisrFlag, EocCurrent, and 
EocFlag; 

Value of 2: Unded Total; 

Value of 36: EocTotal 

31. IST #3 -- Log in to IST #3 (CERES) using UNIX 
login procedure, by entering User Name and 
Password: 

Username: <user name> 

Password: ******** 

The login is accepted and several UNIX windows 
appear 

32. IST #3 -- Bring up IST #3 (CERES) by entering 
the following in a cmdtool window: 

%: cd /data/fos/ist/am1/scripts/setup (setup 
is alias) 

%: IST_LOGIN & 

The ‘FOS Login’ screen comes up 
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33. IST #3 -- In the ‘FOS Login’ screen, enter name 
and associated password as necessary: 

User: <user name> 

Password: ******** 

Click ‘OK’ button. 

The ‘FOS Login’ screen closes. 

The ‘User Roles’ window comes up. 

34. IST #3 -- In the User Roles window, specify the 
following: 

Roles: Select ‘Read Only’ 

Click ‘OK’ button 

(Wait for user station startup completion) 

A dialog box appears with the message ‘Starting User 
Station. Please Wait’, indicating that the user station 
startup script has not yet completed. 

User station startup is complete when the Control 
Window comes up. 

35. Display the database table containing IST pool 
management information by entering these sql 
commands: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following: 

Value of 1: CeresCurrent, CeresTotal, CeresUnded, 
CeresFlag, MisrCurrent, MisrTotal, MisrFlag, 
EocCurrent, and EocFlag; 

Value of 2: Unded Total; 

Value of 36: EocTotal 
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36. IST #1 -- Bring down IST #1 (CERES) by 
entering the following in a cmdtool window: 

%: cd /data/fos/ist/am1/scripts/setup (setup 
is alias) 

%: IstKill 

Note: Ensure the ‘Environment Controller’ 
process is killed before proceeding to the next step 

The CERES IST is brought down 

37. Display the database table containing IST pool 
management information by entering these sql 
commands: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following: 

Value of 1: CeresCurrent, CeresTotal, CeresFlag, 
MisrCurrent, MisrTotal, and MisrFlag; 

Value of 2: Unded Total 

Value of 36: EocTotal 

38. Edit the ‘ist_counter’ database table and set to 0 
the total number of non-dedicated (‘pool’) 
connections allowed by entering the sql 
commands below: 

Max # non-dedicated connection (all sites) 

1> update ist_counter 

2> set UndedTotal = 0 

3> go 

The applicable values are changed in the ‘ist_counter’ 
table 
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39. Display the database table containing IST pool 
management information by entering these sql 
commands: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following: 

Value of 1: CeresCurrent, CeresTotal, CeresFlag, 
MisrCurrent, MisrTotal, MisrFlag, EocCurrent, and 
EocFlag; 

Value of 36: EocTotal 

40. IST #1 -- Attempt to bring up IST #1 (CERES) by 
entering the following in a cmdtool window: 

%: cd /data/fos/ist/am1/scripts/setup (setup 
is alias) 

%: IST_LOGIN & 

The ‘FOS Login’ screen comes up 

41. IST #1 -- In the ‘FOS Login’ screen, enter name 
and associated password as necessary: 

User: <user name> 

Password: ******** 

Click ‘OK’ button. 

The ‘FOS Login’ screen closes. 

The ‘User Roles’ window comes up. 

42. IST #1 -- In the ‘User Roles’ window, specify the 
following: 

Roles: Select ‘Read Only’; 

Click ‘OK’ button. 

Close the Error Dialog box. 

An Error Dialog box comes up indicating there are no 
available connections. (There are no dedicated 
connections available for this IST, and there are no 
non-dedicated connections available from the pool.) 

The Error Dialog box closes. 
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43. Edit the ‘ist_counter’ database table to allow 2 
dedicated CERES connections and set the non- 
dedicated pool size to 1 by entering these sql 
commands below: 

1> update ist_counter 

2> set CeresTotal = 2 

3> go 

1> update ist_counter 

2> set UndedTotal = 1 

3> go 

The applicable values are changed in the ‘ist_counter’ 
table 

44. Display the database table containing IST pool 
management information by entering these sql 
commands: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following: 

Value of 1: CeresCurrent, CeresFlag, MisrCurrent, 
MisrTotal, MisrFlag, EocCurrent, EocFlag, and 
UndedTotal; 

Value of 2: Ceres Total; 

Value of 36: EocTotal 

45. IST #1 -- Bring up IST #1 (CERES) by entering 
the following in a cmdtool window: 

%: cd /data/fos/ist/am1/scripts/setup (setup 
is alias) 

%: IST_LOGIN & 

The ‘FOS Login’ screen comes up 
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46. IST #1 -- In the ‘FOS Login’ screen, enter name 
and associated password as necessary: 

User: <user name> 

Password: ******** 

Click ‘OK’ button. 

The ‘FOS Login’ screen closes. 

The ‘User Roles’ window comes up. 

47. IST #1 -- In the User Roles window, specify the 
following: 

Roles: Select ‘Read Only’ 

Click ‘OK’ button 

(Wait for user station startup completion) 

A dialog box appears with the message ‘Starting User 
Station. Please Wait’, indicating that the user station 
startup script has not yet completed. 

User station startup is complete when the Control 
Window comes up. 

48. Display the database table containing IST pool 
management information by entering these sql 
commands: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following: 

Value of 1: CeresFlag, MisrCurrent, MisrTotal, 
MisrFlag, EocCurrent, EocFlag, and UndedTotal; 

Value of 2: CeresCurrent, and Ceres Total; 

Value of 36: EocTotal 
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49. EOC User Station -- Bring down the EOC User 
Station by entering the following in a cmdtool 
window: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: MyKill 

Note: Ensure the ‘Environment Controller’ proces 
is killed before proceeding to the next step 

The EOC User Station is brought down 

50. IST #1 #2 #3 -- Bring down all ISTs by entering 
the following in a cmdtool window: 

%: cd /data/fos/ist/am1/scripts/setup (setup 
is alias) 

%: IstKill 

Note: Ensure the ‘Environment Controller’ 
process is killed before proceeding to the next step 

All ISTs are brought down 

51. Display the database table containing IST pool 
management information by entering these sql 
commands: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed, and all 
values are 0 except the following: 

Value of 1: CeresFlag, MisrTotal, MisrFlag, EocFlag, 
and UndedTotal; 

Value of 2: Ceres Total; 

Value of 36: EocTotal 
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52. Edit the ‘ist_counter’ database table and reset the 
table name values to their original settings by 
entering these sql commands: 

1> update ist_counter 

2> set XxxYyyyy = <original value> 

(XxxYyyyy = column name in ist_counter table; 

Xxx = instrument/location; 

Yyyyy = Current, Total, Unded, Flag) 

3> go 

Repeat this sequence for each column name in the 
‘ist_counter’ table 

The ‘ist_counter’ database table is reset to its original 
values 

53. Display the database table containing IST pool 
management information by entering these sql 
commands below: 

1> select * from ist_counter 

2> go 

The ‘ist_counter’ database table is displayed and all 
values are reset to their original values 

54. End of test. 
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EOC Regression Test Procedure (FOS Post B)


Test Case No: REG-3000FPB 

Test Configuration: See Appendix G 

Test Support: Powered-up FOS servers; EOC LAN; two EOC user stations (‘User Station 1’ is used for remote access to the 
Data Server and Real-Time Server for server startup, real-time tools execution, and server shutdown); FOS Server and User 
Station startup and shutdown scripts; ‘FtPgPackGen’ telemetry and ‘sc’ CLCW drivers; and pre-built telemetry display pages. 

Test Case Description: 

This test is designed to verify critical FOS functionality after a Post-Release B delivery or patch has been installed at the mini- 
EOC (Releases 2.0.x) or EOC (Releases 2.0.1 and 2.01.00). 
or patch has not adversely impacted FOS functionality. 
analysis capabilities are confirmed prior to executing the FOS test procedures that are specifically affected by the delivery or 
patch. 

Note: 
will have slightly different entry fields for some steps. 

Success Criteria: 

This test is successful when fundamental planning and scheduling, command, telemetry, and analysis capabilities are not 
adversely affected by the newly installed delivery or patch. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. FOS Server and User Station Startup (No expected result/output; information only) 

The test provides a reasonable level of confidence that the delivery 
Fundamental planning and scheduling, command, telemetry, and 

Other configurations This test procedure is tailored to a DEC Data Server and Real-Time Server and SUN User Stations. 
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2. User Station #1 #2 -- Log in to the EOC user 
stations, using UNIX login procedure, by entering 
a valid name and associated password: 

Username: <user name> 

Password: ******** 

User Station #1 #2 -- The login is accepted and several 
cmdtool windows appear 

3. Data Server Startup test follows (No expected result/output; information only) 

4. User Station #1 – Remotely log in to the Data 
Server by entering the following in two cmdtool 
windows (#1 & #2): 

%: rlogin <Data Server> 

User Station #1 -- A UNIX prompt is received from the 
Data Server. 

5. User Station #1 -- Verify that the Sybase Server 
has been initialized on the Data Server by entering 
the following in cmdtool window #1: 

%: isql 

Password:  <Return/Enter key> 

User Station #1 -- After the ‘isql’ command, the user is 
prompted for a password (implying that the Sybase 
Server is up). 

After the Return/Enter key is pressed, a UNIX prompt is 
received from the Data Server. 

6. User Station #1 -- In cmdtool window #1, remove 
all endpoints, on this server and the entire system, 
that might have remained from the previous 
session: 

%: c d /fosb/test/am1/scripts/setup (test is 
alias) 

%: rm_all.sh 

%: rm_all.sh 

User Station #1 -- The message ‘(0 rows affected)’ 
appears, indicating there are no endpoints on the system. 
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7. User Station #1 -- In cmdtool window #1, view 
the processes on this server by entering the 
following: 

%: ps -ea 

Scan the resulting display for any FOS processes 
that might have remained from the previous 
session. If processes remain, terminate them 
unconditionally by entering the following: 

%: kill -9 <processid ... processid> 

(Note: FOS processes begin with ‘FxXx...’, 
‘/fosb/test/AM1 / b i n / s u n _ s p a r c . . . ’ ,  o r  
‘TlmArchiver’.) 

(Note: Execute all ‘kill’ commands on the higher- 
numbered processes first.) 

Double-check the list of processes on this server 
by entering the following once again: 

%: ps -ea 

User Station #1 -- There are no FOS processes on this 
server. 

8. User Station #1 -- Invoke the Data Server startup 
script by entering the following in cmdtool 
window #1: 

%: c d /fosb/test/am1/scripts/setup (test is 
alias) 

%: source DataServerStartup 

Note the time when this ‘source’ command is 
entered. 

User Station #1 -- Data Server startup script messages 
are displayed in cmdtool window #1 
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9. User Station #1 -- (Note: Execute this step several 
times starting no later than 2 minutes after the 
startup script was invoked.) 

Display the number of endpoints and list of 
processes on this server by entering the following 
in cmdtool window #2: 

%: c d /fosb/test/am1/scripts/setup (test is 
alias) 

%: show.sh | grep affected 

%: show_all.sh | grep affected 

%: ps -ea 

(Wait for startup script completion) 

Note the time when the Data Server startup script 
completes. 

User Station #1 -- Data Server startup script is complete 
when the following occur: 

the ‘show.sh’ command indicates there are 80 endpoints 
on the Data Server: ‘(80 rows affected)’ is displayed 
first; 

the ‘show_all.sh’ command indicates there are 128 
endpoints on the system: ‘(128 rows affected) is 
displayed first; 

the ‘ps -ea’ command displays the ‘FuClParserServer’ 
process. 

The Data Server startup script completes within 5 
minutes. 

10. User Station #1 -- With the cursor in cmdtool 
window #1, click on ‘Enter/Return’ button on the 
keyboard 

User Station #1 -- The ‘Enter/Return’ key results in a 
UNIX prompt without any ‘exit’ messages. 

(Note: If no UNIX prompt is received or there is an 
indication that a process has exited, then the server did 
not properly initialize. In this case, execute the 
applicable steps of the ‘Data Server Shutdown’ test, 
below, to bring down the Data Server, and consider 
notifying the Integration Team or System Administrator. 
Then re-run the ‘Data Server Startup’ test above.) 

11. User Station Startup test follows (No expected result/output; information only) 
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12. In a cmdtool window, view the processes on this 
server by entering the following: 

%: ps -ax 

Scan the resulting display for any FOS processes 
that might have remained from the previous 
session. If processes remain, terminate them 
unconditionally by entering the following: 

%: kill -9 <processid ... processid> 

(Note: FOS processes begin with ‘FxXx...’ or 
‘/fosb/test/AM1/bin/sun_sparc...’. 

(Note: Execute all ‘kill’ commands on the higher- 
numbered processes first.) 

Double-check the list of processes on this server 
by entering the following once again: 

%: ps -ax 

There are no FOS applications processes executing on 
this user station. 

13. Invoke the FOS Login screen by entering the 
following in a cmdtool window: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: FOS_LOGIN & 

FOS Login screen appears 
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14. From the FOS Login screen, enter a valid name 
and associated password: 

User: <user name> 

Password: ******** 

Environment: Select ‘Operational’ 

(Note: Do not click on ‘Standalone Mode’ button) 

Click ‘OK’ button. 

FOS Login screen closes. 

The User Roles window comes up. 

15. From the User Roles window, specify the 
following: 

Spacecraft: Select ‘AM1’ 

Site: Select ‘EOC’ 

Roles: Select ‘Command Activity 
Controller’ 

Click ‘OK’ button 

(Wait for user station startup completion) 

A dialog box appears with the message ‘Starting User 
Station. Please Wait’, indicating that the user station 
startup script has not yet completed. 

User station startup is complete when the Control 
Window comes up. 

16. Display the number of endpoints for the EOC user 
station by entering the following in another 
cmdtool window. 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: show.sh | grep affected 

The number of endpoints displayed on the User Station 
is 8: ‘(8 rows affected)’ is displayed. 
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17. Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display- 
Global’ 

The ‘Tools’ menu comes up. 

The ‘Event Display’ comes up. 

18. Real-Time Server Startup test follows (No expected result/output; information only) 

19. User Station #1 -- Remotely log in to the Real- 
Time Server by entering the following in two 
cmdtool windows (#3 & #4): 

%: rlogin <Real-Time Server> 

User Station #1 -- A UNIX prompt is received from the 
Real-Time Server. 
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20. User Station #1 -- In cmdtool window #3, view 
the processes on this server by entering the 
following: 

%: ps -ea 

Scan the resulting display for any FOS processes 
that might have remained from the previous 
session. If processes remain, terminate them 
unconditionally by entering the following: 

%: kill -9 <processid ... processid> 

(Note: FOS processes begin with ‘FxXx...’, 
‘ / f o sb / t e s t /AM1/b in / sun_spa rc . . . ’ ,  o r  
‘TlmArchiver’.) 

(Note: Execute all ‘kill’ commands on the higher- 
numbered processes first.) 

Double-check the list of processes on this server 
by entering the following once again: 

%: ps -ea 

User Station #1 -- There are no FOS processes on this 
server. 

21. User Station #1 -- Invoke the Real-Time Server 
startup script by entering the following in the 
cmdtool window #3: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: source RealTimeServerStartup 

User Station #1 – Real-Time Server startup script 
messages are displayed in cmdtool window #3 
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22. User Station #1 -- (Note: Execute this step several 
times starting no later than 2 minutes after the 
startup script was invoked.) 

Display the number of endpoints and list of 
processes on this server by entering the following 
in cmdtool window #4: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: show.sh | grep affected 

%: ps -ea 

(Wait for startup script completion) 

Real-Time Server Startup script is complete when the 
following occur: 

User Station #1 -- The ‘show.sh’ command indicates 
there are 33 endpoints on the Real-Time Server: ‘(33 
rows affected)’ is displayed first; 

the ‘ps -ea’ command displays the ‘FrRpRepeater’ 
process. 

User Station #2 -- The Event Display contains the 
message ‘Active Processing for string 100 was Created’. 

(Note: If there is an indication that a process has exited, 
then the server did not properly initialize. In this case, 
execute the applicable steps of the ‘Real-Time Server 
Shutdown’ test, below, to bring down the Real-Time 
Server, and consider notifying the Integration Team or 
System Administrator. Then re-run the ‘Real-Time 
Server Startup’ test above.) 
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1. Activity Definition (No expected result/output; information only) 

2. Within the Control window click the ‘Tools’ 
button. 

The Tools dialog box appears. 

3. Select the ‘Activity Definer’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The ‘Activity Definer’ 
window appears. 

4. Select the ‘New’ option under the ‘File’ menu. The New dialog box appears. 

5. Enter the following new activity name: 

Reg_ ATCAct_DDD 

Select the ‘AM1 ASTER’ as the resource name. 

Click the ‘OK’ button. 

The ‘New’ dialog box closes. Within the ‘Activity 
Definer’ window the Activity Name updates with ‘Reg_ 
ATCAct_DDD’. The Resource Name updates with 
‘AM1 ASTER’ 

6. Select the ‘Commands’ option under the ‘Modify’ 
menu. 

The ‘Commands’ dialog box appears. The selected 
resource is AM1 ASTER. ASTER commands are listed 
in the ‘Available Commands’ field. 
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7. Selecting Commands 

Insert ATC commands into the ASTER activity. 

In the ‘Commands’ window, click on ‘ATC 
Command’ button. 

Select the following ATC commands from the 
‘Available Commands’ field and specify an offset 
time: 

AST_TURN_ON_C_TDP 

START + 00:01:00 

Click the ‘Add’ button. 

AST_TURN_OFF_C_TDP 

START + 00:02:00 

Click the ‘Add’ button. 

Click the ‘Apply’ Button 

The command and the offset time appear in the 
‘Selected Commands’ field with any associated 
parameters. 

The ‘Items’ field in the ‘Activity Definer’ window is 
updated with the commands from the ‘Selected 
Commands’ field in chronological order. 
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8. Insert Ground commands into the ASTER 
activity. 

In the ‘Commands’ window, click on ‘Ground 
Command’ button. 

Select the following Ground commands from the 
‘Available Commands’ field and specify an offset 
time: 

Click on ‘Ground’ button. 

AST_TURN_ON_C_TQL 

STOP - 00:04:00 

Click the ‘Add’ button. 

AST_TURN_OFF_C_TQL 

STOP - 00:03:00 

Click the ‘Add’ button. 

Click the ‘Apply’ button. 

The command and the offset time appear in the 
‘Selected Commands’ field with any associated 
parameters. 

The ‘Items’ field in the ‘Activity Definer’ window is 
updated with the commands from the ‘Selected 
Commands’ field in chronological order. 

9. Insert a WAIT directive into the ASTER activity. 

In the ‘Activity Definer’ window, select the ‘ECL 
directives’ option under the ‘Modify’ menu. 

In the ECL Directives window, ECS Command 
Language Editor box, enter ‘WAIT’. 

Enter an offset time of START + 00:01:30 

Click the ‘Add’ button. 

Click the ‘Apply’ Button. 

Click the ‘OK’ Button. 

The ‘ECL Directives’ window comes up. 

The ‘WAIT’ directive is inserted chronologically into 
the ‘Items’ field in the ‘Activity Definer’ window in 
chronological order. 

The ‘ECL Directives’ dialog box closes. 
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10. Insert two more ATC commands into the ASTER 
activity. 

In the ‘Commands’ window, click on ‘ATC 
Command’ button. 

Select the following ATC commands from the 
‘Available Commands’ field and specify an offset 
time: 

AST_ENABLE_SVH 

STOP - 00:02:00 

Click the ‘Add’ button. 

AST_DISABLE_SVH 

STOP - 00:01:00 

Click the ‘Add’ button. 

Click the ‘Apply’ Button. 

Click the OK’ Button. 

The command and the offset time appear in the 
‘Selected Commands’ field with any associated 
parameters. 

The ‘Items’ field in the ‘Activity Definer’ window is 
updated with the commands from the ‘Selected 
Commands’ field in chronological order. 

The ‘Commands’ dialog box closes. 

11. Within the ‘Activity Definer’ window, place the 
cursor in the ‘Activity Description’ field. Enter the 
following description of the activity: 

This activity is defined for the AM1 ASTER 
instrument as part of the FOS Post-Release B 
test effort. 

The text description appears in the ‘Activity 
Description’ box. 

12. Within the ‘Activity Definer’ window, select the 
‘Scheduling Info’ option under the ‘Modify’ 
menu. 

The ‘Activity Default Scheduling Information’ dialog 
box appears. 
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13. Selecting Default Scheduling Information 

Click the Start Time toggle button. 

Click the Duration toggle button. 

Enter a start time. 

20:00:00 

(DDD is the current day of the year) 

Enter a Duration of 60  and select the unit 
‘Minute’. 

Click the ‘OK’ button. 

The ‘Activity Default Scheduling Information’ dialog 
box closes. The information is stored with the activity. 

14. In the ‘Activity Definer’ window, select the 
‘Save’ option under the ‘File’ menu. 

The open activity is saved with the current changes. The 
‘Activity Name’ field is appended with a ‘.1’. (This 
indicates version 1 of this activity.) 

An event message indicates that the Resource Model 
created new activity ‘Reg_ ATCAct_DDD.1’ 

15. Select the ‘Close’ option under the ‘File’ menu. 

Select the ‘Exit’ option under the ‘File’ menu. 

The current activity closes and a blank template appears. 

The ‘Activity Definer’ window closes. 
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1. Activity Scheduling (No expected result/output; information only) 

2. Within the Control window click the ‘Tools’ 
button. 

The Tools dialog box appears. 

3. Select the ‘Timeline’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The ‘Timeline’ window 
appears. 

4. Within the ‘Timeline’ window, select the ‘Open’ 
option under the File menu. 

The Open Plan dialog box appears. 

5. Select the Master Plan. 

Enter a start time. 

YYYY/DDD HH:MM:SS 

(DDD is the current day of the year) 

Enter a stop date and time. 

YYYY/DDD HH:MM:SS 

Click the ‘OK’ button 

The Open Plan dialog box closes. 

The timeline updates with the requested time period and 
plan name as Master Plan:1. 

6. Within the Control window click the ‘Tools’ 
button. 

The Tools dialog box appears. 

7. Select the ‘General_Scheduler’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The ‘General Scheduler’ 
window appears. 

8. From the General Scheduler window, click the 
‘Resource’ button and select ‘AM1 ASTER’. 

AM1 ASTER appears on the ‘Resource’ button. 
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9. Select the ‘Activities’ option from the ‘Filter’ 
menu. 

A list of activities defined under the AM1 ASTER 
resource appears in the Activities field. 

10. Select the ‘Reg_ATCAct_DDD.1’ activity for 
scheduling. 

Select the ‘Master Plan:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 

Default scheduling information specified earlier as part 
of Activity Definition is displayed. 

11. Select the ‘Impact’ option under the Action menu. The Impact button is selected. 

12. Select the ‘Start Time’ and ‘Stop Time’ toggle 
buttons 

Enter a start date and time (in the future). 

YYYY/DDD HH:MM:SS 

(DDD is the current day of the year) 

Enter a stop date and time (in the future). 

YYYY/DDD HH:MM:SS 

Click the ‘Schedule’ icon. 

The activity is scheduled on the EOS Timeline Master 
Plan:1 window in the scheduled location for the ASTER 
resource. 

An event message indicates that the Resource Model 
scheduled activity ‘Reg_ ATCAct_DDD.1’ as an AM1 
ASTER resource on the Master Plan for the time 
scheduled. 

13. In the ‘General Scheduler’ window, click the 
‘Exit’ button under the File menu. 

The ‘General Scheduler’ window closes. 

14. Within the Timeline window, click the ‘Save’ 
button under the File menu. 

An event message indicates that the Master Plan is being 
saved and has been successfully merged. 
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1. DAS/ATC Load Generation/Validation (No expected result/output; information only) 

2. Within the Control window click the ‘Tools’ 
button. 

The Tools dialog box appears. 

3. Select the ‘Load Generator’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The Load Generator 
window appears. 
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4. In the Load Generator window: 

Click the ‘DAS/ATC Load’ toggle button. 

Select the Master Plan. 

Enter the DAS Time: 

Start Date YYYY/DDD Start Time 
HH:MM:00 

Stop Date YYYY/DDD Stop Time 
HH:MM:00 

(‘DDD’ is the current day of the year) 

Enter the Uplink Request: 

Start Date YYYY/DDD Start Time 
HH:MM:00 

Stop Date YYYY/DDD Stop Time 
HH:MM:00 

Click the ‘Submit’ icon. 

A ‘Completed’ message appears in the ‘Completed’ box 
of the Load Generator window. 

The ‘EOS Timeline’ window contains a new ‘DAS’ 
corresponding to the DAS Time entered and the ‘Reg_ 
ATCAct_DDD.1’ activity. 

An event message indicates successful processing and 
completion of the DAS. 

The following files are stored in the directory 
‘fosb/test/am1/loads/atc’: 

AM1_ATC_YYYYDDDxx_x_1.cnt (load contents) 

AM1_ATC_YYYYDDDxx_x_1_01_OF_01.img (load 
image) 

The following file is stored in the directory 
‘fosb/test/am1/loads/uplink’: 

AM1_ATC_YYYYDDDxx_x_1_01_OF_01.upl (load 
uplink). 

The ATC commands are included in the directory 
‘/fosb/test/am1/reports/integrated’: 

Intergrated_Report_YYYYDDDxx_x 

5. List the ATC load file created by entering the 
following in a cmdtool window: 

%: cd /fosb/test/am1/reports 

%: ls -lrt *ATC* 

A report file (.rpt) for the ATC load just generated is
included in the file listing. 
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6. View the ATC load report by entering the 
following in a cmdtool window: 

%: more <ATC load report filename> 

The following items and values, among others, are 
displayed: 

Load name: Consistent with filename 

Valid uplink period: As specified in load generation 

Number of commands: As specified in load definition 

Commands Table: As specified in load definition 

7. In the ‘Load Generator’ window, select the ‘Exit’ 
option under the ‘File’ menu. 

The Load Generator window closes. 

8. Within the Timeline click the ‘Save’ button under 
the File menu. 

An event message indicates that the Master Plan is being 
saved and has been successfully merged. 

9. Within the Timeline window, select the ‘Close’ 
option under the File menu. 

Exit the blank timeline template by selecting the 
‘Exit’ option under the File menu. 

The Master Plan:1 closes. A blank timeline template 
appears, which also closes. 

10. From a cmdtool window: 

%: isql -Ufos_dba -P******* (sql is alias 

1> use am1_fos_ops 

2> go 

1> select * from fos_load_cat 

2> go 

1> quit 

The updated load catalogs within the DMS database 
contain the name ‘AM1_ATC_YYYYDDDxx_0_1’ 
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1. RTS Load Definition, Validation, and 
Generation 

(No expected result/output; information only) 

2. Within the Control window click the ‘Tools’ 
button. 

The Tools dialog box appears. 

3. Select the ‘RTS Load Builder’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The ‘RTS Load Builder’ 
window appears. 

4. Define an RTS load 

In the Selection window: 

Select Spacecraft Id 

Select Subsystem 

RTS #: (1-128) 

Purpose: (Short text field) 

CMD #: (1, 2, ...) 

Time & S/C Time: (2 & 1.024, 3 & 2.048, etc.) 

The Subsystem and Spacecraft selected appear in the 
appropriate text fields. 

The RTSs associated with the Subsystem and 
Spacecraft appear in the Table Template Selection 
window. 

5. Select ‘Directive Builder’ from the Utility pull 
down menu 

The ‘Directive Builder’ appears 
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6. Select commands. Filter on the following: 

‘AM1_XXX’ 

(Note: XXX refers to the subsystem) 

Click Select. 

Click ‘OK’ button 

Click on ‘AM1_XXX’ 

Select a command in the Commands list box. 

Deselect on the selected directive 

Double click on the selected directive 

Double click on one of the parameters (if 
applicable) 

Click ‘OK’, and then ‘Insert’. 

The Filter window closes and the filter selection 
appears in the filter box within the Directive Builder 
window. 

The Commands list box contains command directives. 

Any qualifiers/parameters associated with that 
command are displayed in the ‘Selection Templates’ list 
box. 

The command directive is placed in the ECL text field 
box. 

The command parameter is appended to the command. 
There is no value associated with the parameter. 

The command is inserted in the text area of the RTS 
Builder, and the Filter window closes. 

7. Repeat the ‘Define an RTS load’ subprocedure to 
enter additional commands 

The commands selected appear in the text area of the 
RTS Load Builder 

8. Validate an RTS Load 

From RTS Load Builder window, click on the
‘Validate’ button. 

Message in the status line window indicate that RTS 
load validation was successfully completed. 

The status button displays ‘PASS’ in green. 
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9. Generate an RTS load: 

From RTS Load Builder window, click on
‘Generate’ button. 

Enter an absolute start and stop time for the Valid 
Uplink Period or Click on ‘Select Time’ for 
default values. 

Start> YYYY/DDD HH:MM:SS.mmm 

Stop> YYYY/DDD HH:MM:SS.mmm 

Click on ‘OK’ button. 

The RTS Generator dialog box will be displayed. The 
RTS #, Spacecraft, Sub/Instr, and Purpose Fields will be
filled if those exist in the RTS Load Builder window 

The Start Time and Stop Time fields for Valid Period
will be filled in. 

A command is in the ‘Load Initiate’ text field. 

The RTS Generator dialog box closes. 

A request to generate the RTS load is sent to CMS. 

The returned generation status from CMS will be
displayed in the status line of the RTS Load Builder 
window: 

‘Load Generation complete’ 

The status button displays ‘PASS’ in green. 

Event messages indicate the load generation started and
completed. 

Note: Any error encountered during RTS load 
generation will be displayed in an Error Dialog box. 

10. Verify RTS load files and contents 

List the RTS load image and contents files created 
by entering the following in a cmdtool window: 

%: cd /fosb/test/am1/loads/rts 

%: ls -lrt 

An image file (.img) and a contents file (.cnt) for the 
RTS load just generated are included in the file listing. 

11. List the RTS load uplink file created by entering 
the following in a cmdtool window: 

%: cd /fosb/test/am1/loads/uplink 

%: ls -lrt *RTS* 

An uplink file (.upl) for the RTS load just generated is
included in the file listing. 
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12. List the RTS load files created by entering the 
following in a cmdtool window: 

%: cd /fosb/test/am1/reports 

%: ls -lrt *RTS* 

A report file (.rpt) for the RTS load just generated is
included in the file listing. 

13. View the RTS load report by entering the 
following in a cmdtool window: 

%: more <RTS load report filename> 

The following items and values, among others, are 
displayed: 

Load name: Consistent with filename 

Load type: ‘RTS’ 

Valid uplink period: As specified in load generation 

Number of commands: As specified in load definition 

RTCS Commands Table: As specified in load definition 

14. View the RTS load catalog entry in the load 
catalog table in Sybase. 

In the ‘RTS Load Builder’ window, under the File 
option, select ‘Open’. 

Provide the information requested in the dialog 
box. 

Click on ‘Load Catalog’. 

Iconify the ‘RTS Load Builder’ window. 

The filename for the RTS load just generated will
appear in the Load Catalog list box. 

The ‘RTS Load Builder’ window is iconified. 
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1. Command Preparation (No expected result/output; information only) 

2. Take Ground Control & Command Control 

Connect mirrored to logical String 100. Enter the 
following ECL directive: 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

(Wait for string connection to complete) 

The following event message appears (after several
minutes): 

‘Successfully connected to String 100 as Mirrored’. 

A ‘status’ window containing several SYS parameters
comes up. 

3. Take ground control for String 100. Enter the 
following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

The following event message appears: 

‘Ground Control Authority has changed from <former
user or EcDNull> to <User #1> for string 100‘ 

4. Take command for String 100. Enter the 
following ECL directive: 

ECL> TAKE COMMAND STRING=100 

User Station #1 -- The following event message 
appears: 

‘Command Authority has changed from <former user or
EcDNull> to <User #1> for string 100‘ 

5. Start ‘sc’ driver to emulate CLCWs 

Enter the following in a new cmdtool window. 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: setenv SCRIPT UserStation 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/sun_sparc_5-5 
(bin is alias) 

%: sc AM1 100 Ops 

User Station #1 -- The remote login to the Real-Time
Server is successful. 

The following message appears repeatedly in the Real-
Time Server cmdtool window: 

‘sc Waiting for messages’ 
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6. Initiate the tcpdump tool to capture real-time,
operational commands. 

In a new cmdtool window, enter the following: 

%: tcpdump -v port 20x58 

x=0 for Operational LAN 

x=1 for Support LAN 

The following message appears in the cmdtool window: 

‘listening on le0’ (Applies to Operational LAN) 

‘listening on le1’ (Applies to Support LAN) 

7. View ground script prior to uplink 

Initiate the Ground Script Display Window. 

Click on the Tools button from Control window. 

Select ‘Ground_Script_Display’. 

Click OK. 

The Tools dialog box appears. 

Ground Display Window appears in the selection text 
box. 

The Ground Script Display Window is displayed. 

8. Select a ground script to display. Using the ‘File’ 
pull down menu in ‘Ground Script Display’ 
window select the ‘Open’ option. 

A time selector dialog box appears 
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9. In the ‘Ground Script Display’ dialog: 

Select ‘AM1’ for Spacecraft 

Select ‘Operational’ for Mode 

In the ‘Pair Time Selector’ window: 

Click ‘Select Time’ button 

Use the times corresponding to the DAS generated 
earlier. 

Start Time: YYYY/DDD HH:MM:00.000 

Stop Time: YYYY/DDD HH:MM:00.000 

(‘DDD’ is the current day of the year) 

s/c: Select ‘AM1’ 

Click ‘OK’ 

The ‘Ground Script Display’ dialog closes. 

The ‘Pair Time Selector’ window comes up. 

The times entered will be displayed in the start and stop 
time text fields. 

The times and corresponding directives are displayed in 
the body of the ‘Ground Script Display’ window. 

The ‘Pair Time Selector’ window closes. 

10. Close Ground Script Display Window 

Under the File menu, click on the ‘Quit’ button. 

Click ‘OK’ 

A confirmation dialog box appears, prompting user ‘Do 
you really want to quit?’ 

The Ground Script Display window is no longer in 
view. 
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1. Ground Script & Manual Commanding (No expected result/output; information only) 

2. Perform command initialization 

From the Control window, bring up the
‘Command Control Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Control’ 

In the Command Control dialog box, enter the
following: 

String ID: 100 

Spacecraft ID: AM1 

The ‘Tools’ menu comes up. 

The ‘Command Control Window’ comes up. 

The Command Control dialog box comes up and then 
closes after user input. 

3. In the ‘Config’ pull-down menu of the ‘Command
Control Window’, set the following: 

Cmd Verification (CV): Off 

Tlm Verification (TV): Off 

In the ‘Command Control Window’, enter the
following in the CMD field: 

FOP INIT CHECK 

Hit ‘return/enter’ key on keyboard. 

Click on ‘Resume’ button 

Click on ‘Send’ button 

Click on ‘Suspend’ button 

In the ‘Command Control Window’, the following
occurs: 

The ‘CV’ and ‘TV’ indicators are both ‘Off’. 

The ‘DIRECTIVE’ column contains ‘FOP INIT
CHECK’. 

After the ‘Resume’ button is clicked, the Send/Cancel
options are activated. 

After the ‘Send’ button is clicked, the STATUS column
includes ‘Processed -2 | Sent to subsys’. 

The following event message appears: 

‘Protocol Info: FOP INIT with CLCW check 
successful’. 
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4. Load the DAS commands into the ground 
Script. 

Select a ground script for execution. 

Click on the ‘Load’ button in the Command
Control window. 

A Pair Time Selector window appears. 

5. In the ‘Pair Time Selector’ window: 

Enter the DAS start and stop times of the ground 
script selected for execution. 

Start Time: YYYY/DDD HH:MM:SS.mmm 

(‘DDD’ is the current day of the year) 

press the Enter key 

Stop Time: YYYY/DDD HH:MM:SS.mmm 

press the Enter key 

Click ‘OK’ 

A WARNING dialog box appears with dates and times 
specified, prompting user to load ground script. 

6. In the Warning Dialog box, click ‘OK’ to load the 
ground script. 

The ‘Pair Time Selector’ window closes. 

An Information Dialog appears indicating the Ground 
Script has been saved. 

An event message indicates the Ground Script was 
successfully created. 
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7. In the Information Dialog, click ‘Close’ The following items are properly displayed in the 
Command Control window. 

ground script start time 

ground script stop time 

spacecraft id associated with ground script 

ground script status - Suspend (default) 

ground script processing mode - Auto (default) 

current bias time 

Applicable commands/directives 

8. In the ‘Config’ menu of the ‘Command Control 
Window’: 

Turn Telemetry Verification (TV): ‘Off’. 

Turn Command Verification (CV): ‘Off’ 

The ‘CV’ and ‘TV’ indicators are both ‘OFF’ 

9. (This step is optional.) 

Put ground script in confirmation mode 

enter MODE STEP. 

Note: This makes for easier manipulation. 

The Mode displayed is changed from ‘Auto’ to ‘Step’. 
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10. Insert a real-time command into the ground 
script. 

Click on ‘%AST_TURN_OFF_C_TDP’ 

In the ‘Command Control Window’, enter the
following real-time command in the CMD field: 

/AST_TURN_OFF_C_SDP 

Hit ‘return/enter’ key on keyboard. 

The ‘%AST_TURN_OFF_C_TDP’ command is
highlighted in the ground script. 

The /AST_TURN_OFF_C_SDP’ command is inserted
just above the ‘%AST_TURN_OFF_C_TDP’ command
in the ‘Directive’ column.. 

11. Execute the ground script. 

Click on ‘Resume’ button 

Click on ‘Send’ button 

Click on ‘Override’ button if necessary 

In the ‘Command Control Window’, the following
occurs: 

After the ‘Resume’ button is clicked, the Send/Cancel
options are activated. 

The following event messages appear: 

‘Command XXXXXXXXXX was successfully build
with binary = ...’; 

‘CLTU id XXXXXXXXXX placed in command data
block number x’; 

‘Command Data Block number x sent to EDOS’; 

For each command prior to the WAIT directive in the
Command Control Window, the STATUS column
includes something like ‘CV Pass -2 | Processed -2 |
Sent to FOP | Sent to subsys’. 

A message in the window where tcpdump is running
indicates that a command has been sent. 

The ground script stops at the WAIT directive 
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12. Bypass the WAIT command by clicking on the 
‘Continue’ button. 

Click on ‘Send’ button. 

Click on ‘Suspend’ button. 

The non-ATC commands following the ‘WAIT’ 
directive in the Ground Script are transmitted. 

The following event messages appear: 

‘Command XXXXXXXXXX was successfully build
with binary = ...’; 

‘CLTU id XXXXXXXXXX placed in command data
block number x’; 

‘Command Data Block number x sent to EDOS’; 

For each command prior to the WAIT directive in the
Command Control Window, the STATUS column
includes something like ‘CV Pass -2 | Processed -2 |
Sent to FOP | Sent to subsys’. 

A message in the window where tcpdump is running 
indicates that a command has been sent. 
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13. Critical command execution 

In the ‘Command Control Window’, enter two
critical commands in the CMD field: 

/COM_ENABLE_SBT1_AON 

Hit ‘return/enter’ key on keyboard. 

/COM_ENABLE_SBT2_AON 

Hit ‘return/enter’ key on keyboard. 

Click the ‘Resume’ button. 

Click the ‘Send’ button. 

Click the ‘Continue’ button. 

Click ‘allow’ button for each command. 

Click on ‘Suspend’ button. 

Repeat above button clicks, as necessary, to 
execute the second critical command 

A send/cancel and an allow/cancel message will flash in 
the status column of the Command Control window. 

The following event messages appear: 

‘Command XXXXXXXXXX is CRITICAL’; 

‘Critical command XXXXXXXXX was ALLOWED’; 

‘Command XXXXXXXXXX was successfully build
with binary = ...’; 

‘CLTU id XXXXXXXXXX placed in command data
block number x’; 

‘Command Data Block number x sent to EDOS’; 

For each critical command: 

The STATUS column includes something like ‘CV Pass
-2 | Processed -2 | Sent to FOP | Sent to subsys’. 

A message in the window where tcpdump is running 
indicates that a command has been sent. 
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1. PROC Execution, Load Uplinking, 
Dumps, and Image Compare 

(No expected result/output; information only) 

2. Execute a Command Procedure 

Enter the following in a cmdtool window to 
change to the PROC directory: 

%: cd /fosb/test/am1/procs 

%: ls -lrt 

Search the directory for a recent PROC, i.e., a 
filename that has the same filename with a ‘.xdr’ 
extension. 

In the ‘Command Control Window’, enter the
following in the CMD field: 

CMD: START <PROC filename> 

Hit ‘return/enter’ key on keyboard. 

Click the ‘Resume’ button. 

Click the ‘Send’ button. 

Click the ‘Suspend’ button. 

Click the ‘Resume’ button. 

A list of PROC filenames appears. 

The PROC entered is appended to the directives column 
in the Command Control Window. 

When the ‘Send’ button is clicked, the PROC contents 
are displayed in the Command Control Window. 

When the second ‘Resume’ button is clicked, the PROC
contents are executed. 

The following event message appears for each
command in the PROC: 

‘Command Data Block number x sent to EDOS’. 

The STATUS column in the Command Control
Window includes something like ‘CV Pass -2 |
Processed -2 | Sent to FOP | Sent to subsys’. 

A message in the window where tcpdump is running 
indicates that a command has been sent. 
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3. Uplink an RTS Load 

Enter the following in a cmdtool window to 
change to list RTS load uplink files: 

%: cd /fosb/test/am1/loads/uplink 

%: ls -lrt *RTS* 

Select an RTS load uplink file 

A list of RTS load uplink filenames appears 

4. Ensure the RTS load has an entry in the load 
catalog table in Sybase. 

In the ‘RTS Load Builder’ window, under the File 
option, select ‘Open’. 

Provide the information requested in the dialog 
box. 

Click on ‘Load Catalog’. 

The filename for the applicable RTS load will appear in
the Load Catalog list box 

5. In the ‘Command Control Window’, enter the
following in the CMD field: 

CMD: LOAD <RTS filename> 1 1 

Hit ‘return/enter’ key on keyboard. 

Click the ‘Resume’ button. 

Click the ‘Send’ button. 

Click the ‘Suspend’ button. 

The RTS load entered is appended to the directives 
column in the Command Control Window. 

The following event message appears for each
command in the load: 

‘Command Data Block number x sent to EDOS’. 

The STATUS column in the Command Control
Window includes something like ‘CV Pass -2 |
Processed -2 | Sent to FOP | Sent to subsys’. 

A message in the window where tcpdump is running 
indicates that the RTS commands have been sent. 
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6. Update the ground reference Table image 

Enter the following directive from the Control 
window 

ECL> MUN <loadname-including 
partitions> 
YYYY:DDD:HH:MM:SS.mmm 

A event message is generated indicating the Table 
Memory model has been updated. 

7. View ground reference image 

Click on ‘TOOLS’ button on Control window. 

Select ‘Report Generator’. 

Click ‘OK’. 

Select ‘Ground Reference Image Reports (On 
Demand)’. 

Select ‘Table’. 

Enter Table Name, Start and End locations in the 
text boxes provided. 

Click ‘Ok’. 

The Report Generator tool is displayed 

Ground Reference Image Reports (On Demand) 
window is displayed. 

FUI will submit the request to the CMS memory model 
and a ground image report will be generated in the 
reports/image directory. 

8. From the CMD input line in the Command 
Control window enter the following commands to 
uplink the load, initiate the dump for 16K 
diagnostic rate 

ECL> /FS1_DUMP_TBLINIT1 
TABLE_ID=<tableid> 
WORD_OFFSET=<wordoffset> 
WORD_COUNT<wordcount> 

Once the telemetry receives the dump message, a file is 
opened, the file is closed when the number of words for 
the particular RT addressed is received. 

CMS processes dump. An event message indicates that 
the dump is finished 

The ground reference image has been updated 
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9. Verification of formatted dump file 

The dump input file is formatted and a formatted 
dump image file is generated. Go to the proper 
CMS directory 

% cd /fosb/test/am1/reports/table 

% ls -ltr 

The CMS memory image receives the message, reads 
the input dump file, formats the data from the input file, 
and generates a formatted dump image file. This file 
will be used for dump compares and dump conversions. 

Verify there is a <filename>.fdmp associated the 
Telemetry <filename>.dmp 

10. Verify the ground reference image was updated. 

Repeat Ground Reference Image steps. 

11. Generate a RTS Dump Compare 

From the Command Control window, enter the 
RTS image compare directive 

ECL> IMGCMP RTS 
DUMP=<.dmpFilename> LOAD= <.img 
Filename> 

Note: File Extensions are not needed. 

The command will be inserted into the text area of the 
CCW. A send/cancel message will flash in the status 
column of the Command Control window. 

The command will be executed. 

The request is automatically sent to CMS for 
processing. CMS will generate a list of table values 
from the binary in the dump file. The computed value 
from the dump file is compared to the value for the field 
in the table definition. 

A report is generated for any miscompares. 

12. View Comparison Report 

% cd /fosb/test/am1/reports/compare 

% ls -ltr 

% more <filename> 

The files in the directory will be displayed in reverse 
time order. 
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13. From the Control window, enter the image report 
directive and the dump file name that is to be 
reported. 

ECL> IMGRPT TABLE = <filename> 

A dump report request is sent to the CMS memory 
image subsystem. A report is generated by CMS. 

An event message is generated when the report is 
finished. 

14. Repeat View Ground Reference Image. 

15. Uplink a Table Load 

Enter the following in a cmdtool window to 
change to list Table load uplink files: 

%: cd /fosb/test/am1/loads/uplink 

%: ls -lrt *TBL* 

Select a Table load uplink file 

A list of Table load uplink filenames appears 

16. In the ‘Command Control Window’, enter the
following in the CMD field: 

CMD: LOAD <TBL filename> 1 1 

Hit ‘return/enter’ key on keyboard. 

Click the ‘Resume’ button. 

Click the ‘Send’ button. 

Click the ‘Suspend’ button. 

The Table load entered is appended to the directives 
column in the Command Control Window. 

The following event message appears for each
command in the load: 

‘Command Data Block number x sent to EDOS’. 

The STATUS column in the Command Control
Window includes something like ‘CV Pass -2 |
Processed -2 | Sent to FOP | Sent to subsys’. 

A message in the window where tcpdump is running 
indicates that a command has been sent. 
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17. Uplink a Microprocessor (Binary) Load 

Enter the following in a cmdtool window to 
change to list Microprocessor load uplink files: 

%: cd /fosb/test/am1/loads/uplink 

%: ls -lrt *MPR* 

Select a Microprocessor load uplink file 

A list of Microprocessor load uplink filenames appears. 

18. In the ‘Command Control Window’, enter the
following in the CMD field: 

CMD: LOAD <MPR filename> 1 1 

Hit ‘return/enter’ key on keyboard. 

Click the ‘Resume’ button. 

Click the ‘Send’ button. 

Click the ‘Suspend’ button. 

The Microprocessor load entered is appended to the 
directives column in the Command Control Window. 

The following event message appears for each
command in the load: 

‘Command Data Block number x sent to EDOS’. 

The STATUS column in the Command Control
Window includes something like ‘CV Pass -2 |
Processed -2 | Sent to FOP | Sent to subsys’. 

A message in the window where tcpdump is running 
indicates that a command has been sent. 

19. Uplink a Flight Software (Binary) Load 

Enter the following in a cmdtool window to 
change to list Flight Software load uplink files: 

%: cd /fosb/test/am1/loads/uplink 

%: ls -lrt *FSW* 

Select a Flight Software load uplink file 

A list of Flight Software load uplink filenames appears. 
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20. In the ‘Command Control Window’, enter the
following in the CMD field: 

CMD: LOAD <FSW filename> 1 1 

Hit ‘return/enter’ key on keyboard. 

Click the ‘Resume’ button. 

Click the ‘Send’ button. 

Click the ‘Suspend’ button. 

The Flight Software load entered is appended to the 
directives column in the Command Control Window. 

The following event message appears for each
command in the load: 

‘Command Data Block number x sent to EDOS’. 

The STATUS column in the Command Control
Window includes something like ‘CV Pass -2 |
Processed -2 | Sent to FOP | Sent to subsys’. 

A message in the window where tcpdump is running 
indicates that a command has been sent. 

21. Enter the following to change directory to 
tlmarchive: 

%: cd /fosb/test/am1/tlmarchive 

% ls -lrt 

A logging file for the command link control word 
(CLCW.log) is generated with current date and time 
stamp in directory /fosb/test/am1/tlmarchive. 

22. Check for command data block log file: 

%: cd /fosb/test/am1/reports 

%: ls -ltr 

A log file for the command data block (CDB.log) is 
generated with current date and timestamp in directory 
/fosb/test/am1/reports. 

CDB.log is generated. 

23. Terminate the current ground script by clicking on 
‘Quit’ from the File pull-down menu. 

A dialog box appears prompting user for certainty. 

The Command Control window closes. 

24. In the window containing tcpdump, depress the
following two keys simultaneously: 

Ctrl C 

The ‘tcpdump’ tool quits, and a UNIX prompt is
received from the user station. 
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1. Logical String Manipulation (No expected result/output; information only) 

2. Create a Simulation/Training String (101) 

Enter the following ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 
MODE=TRAINING SERVER=1 

The following event message appears: 

‘Active Processing for string 101 was Created.’ 

3. Command Preparation for String 101 

Connect mirrored to logical String 101. Enter the 
following ECL directive: 

ECL> STRING CONNECT STRING=101 
CONFIG=MIRROR 

(Wait for string connection to complete) 

The following event message appears (after several
minutes): 

‘Successfully connected to String 101 as Mirrored’. 

A ‘status’ window containing several SYS parameters
comes up. 

4. Take ground control for String 101. Enter the 
following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=101 

The following event message appears: 

‘Ground Control Authority has changed from <former
user or EcDNull> to <User #1> for string 101‘ 

5. Take command for String 101. Enter the 
following ECL directive: 

ECL> TAKE COMMAND STRING=101 

User Station #1 -- The following event message 
appears: 

‘Command Authority has changed from <former user or
EcDNull> to <User #1> for string 101‘ 
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6. Remotely log in to the Real-Time Server by
entering the following in a new cmdtool window. 

%: rlogin <RealTimeServer> 

At the Real-Time Server prompt, enter the
following: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: setenv SCRIPT RealTimeServer 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/sun_sparc_5-5 
(bin is alias) 

%: sc AM1 101 Training 

The remote login to the Real-Time Server is successful. 

The following message appears repeatedly in the Real-
Time Server cmdtool window: 

‘sc Waiting for messages’ 

7. Initiate the tcpdump tool to capture real-time,
operational commands. 

In a new cmdtool window, enter the following: 

%: tcpdump -v port 20x98 

x=0 for Operational LAN 

x=1 for Support LAN 

The following message appears in the cmdtool window: 

‘listening on le0’ (Applies to Operational LAN) 

‘listening on le1’ (Applies to Support LAN) 
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8. From the Control window, bring up the
‘Command Control Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Control’ 

In the Command Control dialog box, enter the
following: 

String ID: 101 

Spacecraft ID: AM1 

The ‘Tools’ menu comes up. 

The ‘Command Control Window’ comes up. 

The Command Control dialog box comes up and then 
closes after user input. 

9. In the ‘Config’ pull-down menu of the ‘Command
Control Window’, set the following: 

Cmd Verification (CV): Off 

Tlm Verification (TV): Off 

In the ‘Command Control Window’, enter the
following in the CMD field: 

FOP INIT NOCHECK 

Hit ‘return/enter’ key on keyboard. 

Click on ‘Resume’ button 

Click on ‘Send’ button 

Click on ‘Suspend’ button 

In the ‘Command Control Window’, the following
occurs: 

The ‘CV’ and ‘TV’ indicators are both ‘Off’. 

The ‘DIRECTIVE’ column contains ‘FOP INIT
NOCHECK’. 

After the ‘Resume’ button is clicked, the Send/Cancel
options are activated. 

After the ‘Send’ button is clicked, the STATUS column
includes ‘Processed -2 | Sent to subsys’. 
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10. Execute a real-time command for String 101. 

Click on ‘%AST_TURN_OFF_C_TDP’ 

In the ‘Command Control Window’, enter the
following real-time command in the CMD field: 

/AST_TURN_OFF_C_SDP 

Hit ‘return/enter’ key on keyboard. 

The ‘/AST_TURN_OFF_C_SDP’ command is inserted
in the ‘Directive’ column.. 

11. Click on ‘Resume’ button 

Click on ‘Send’ button 

In the ‘Command Control Window’, the following
occurs: 

After the ‘Resume’ button is clicked, the Send/Cancel
options are activated. 

For each command prior to the WAIT directive in the
ground script: 

After the ‘Send’ button is clicked, the STATUS column
includes something like ‘CV Pass -2 | Processed -2 |
Sent to FOP | Sent to subsys’. 

The following event messages appear: 

‘Command XXXXXXXXXX was successfully build
with binary = ...’; 

‘CLTU id XXXXXXXXXX placed in command data
block number x’; 

‘Command Data Block number x sent to EDOS’. 

A message in the window where tcpdump is running
indicates that a command has been sent. 

12. Terminate the current ground script by clicking on 
‘Exit’ from the File pull-down menu. 

A dialog box appears prompting user for certainty. 

The Command Control window closes. 

4-208
 322-CD-100-001/ 
411-CD-100-001 



13. User Station #1 -- In the window containing 
tcpdump, depress the following two keys
simultaneously: 

Ctrl C 

User Station #1 -- The ‘tcpdump’ tool quits, and a UNIX
prompt is received from the user station. 

14. Delete String 101 

Attempt to delete String 101. Enter the following 
ECL directive: 

ECL> STRING DELETE STRING=101 

The following event message appears: 

‘Unable to delete String 101 when users are connected. 
Suggest notifying users to disconnect from String.’ 

15. Disconnect from String 101. Enter the following 
ECL directive: 

ECL> S T R I N G  D I S C O N N E C T  
STRING=101 

The following event messages appear: 

‘User successfully disconnected from String 101’ 

16. Delete String 101. Enter the following ECL 
directive: 

ECL> STRING DELETE STRING=101 

The following event message appears: 

‘Active processing for String 101 was deleted.’ 

17. Attempt to connect mirrored to String 101. Enter 
the following ECL directive: 

ECL> STRING CONNECT STRING=101 
CONFIG=MIRROR 

The following event message appears: 

‘Unable to locate string 101. User should make sure
directive contains correct string ID.’ 

18. Create a Simulation/Test String (101) 

Enter the following ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 MODE=TEST 
SERVER=1 

The following event message appears: 

‘Active Processing for string 101 was Created.’ 
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19. Execute the ‘Command Preparation for String 
101’ subprocedure with the following exceptions: 

At the Real-Time Server prompt, enter the
following: 

%: sc AM1 101 Test 

In the window where tcpdump was running, enter 
the following: 

%: tcpdump -v port 20x59 

x=0 for Operational LAN 

x=1 for Support LAN 

Ground control and command authority are authorized. 

The sc and tcpdump tools come up. 

The Command Control Window appears. 

20. Execute the ‘Execute a real-time command for 
String 101’ subprocedure 

The following event messages appear: 

FOP-related and AST_TURN_OFF_C_SDP-related 
messages as indicated in the ‘Logical String Command
Subprocedure.’ 

A message in the window where tcpdump is running
indicates that a command has been sent. 

21. Execute the ‘Delete String 101’ subprocedure The following event messages appear: 

‘Active processing for String 101 was deleted.’ 

22. Create a Real-Time/Test String (101) 

Enter the following ECL directive: 

ECL> STRING CREATE REALTIME 
SPACECRAFTID=AM1 MODE=TEST 
SERVER=1 

The following event message appears: 

‘Active Processing for string 101 was Created.’ 
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23. Execute the ‘Command Preparation for String 
101’ subprocedure with the following exceptions: 

At the Real-Time Server prompt, enter the
following: 

%: sc AM1 101 Test 

In the window where tcpdump was running, enter 
the following: 

%: tcpdump -v port 20x59 

x=0 for Operational LAN 

x=1 for Support LAN 

Ground control and command authority are authorized. 

The sc and tcpdump tools come up. 

The Command Control Window appears. 

24. Execute the ‘Execute a real-time command for 
String 101’ subprocedure 

The following event messages appear: 

FOP-related and AST_TURN_OFF_C_SDP-related 
messages as indicated in the ‘Logical String Command
Subprocedure.’ 

A message in the window where tcpdump is running
indicates that a command has been sent. 

25. Terminate the current ground script by clicking on 
‘Exit’ from the File pull-down menu. 

A dialog box appears prompting user for certainty. 

The Command Control window closes. 

26. User Station #1 -- In the window containing 
tcpdump, depress the following two keys
simultaneously: 

Ctrl C 

User Station #1 -- The ‘tcpdump’ tool quits, and a UNIX
prompt is received from the user station. 
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27. User Station #1 -- In the window containing the 
remote login to the Real-Time Server for the ‘sc’
tool, depress the following two keys 
simultaneously: 

Ctrl C 

User Station #1 -- The ‘sc’ tool quits, and a UNIX 
prompt is received from the Real-Time Server. 
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1. Housekeeping Telemetry Processing (No expected result/output; information only) 

2. At the user station, display the EDU ‘Header’ 
alphanumeric page which displays telemetry 
header field values by entering the following in 
the ECL directive line of the Control window: 

ECL> PAGE Header 

Verify the Header window appears at the user station 
and contains the following fields: 

-Static flags for all descriptors 

-Spacecraft time (SDU_SCTIME) 

-Data source (spacecraft ID) (EDS_SCID) 

-Quality indicator (EDS_QUALITY) 

-APID number (SDU_PCKT_APID) 

-Packet sequence count SDU_PACKET_SEQ) 

-Header ID (SDU_SEC_HEADER) 

-Packet length count (SDU_PCKT_LENGTH) 

-Mstr. Cycle Count (EDS_CYCLE_COUNT) 

-Header Length (EDS_CCSDS_HDR_LENGTH) 

-CCSDC Version (SDU_CCSDS_VER) 

‘STATIC’ flags should be present for all descriptors. 

3. At the user station, display the ‘Regression 
alphanumeric page, which displays Housekeeping 
mnemonic values, by entering the following in the 
ECL directive line of the Control window: 

ECL> PAGE Regression 

The ‘Regression’ display appears at the user station and 
contains many telemetry parameters: 

‘STATIC’ flags should be present for all descriptors. 

4. Move the cursor over the ‘Header’ alphanumeric 
page. 
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5. Click the mouse on the right button. 

6. Choose Data Source Selector from the menu. The Data Source Selector window will appear. 

7. Highlight the ‘Assigned Connection’ windows on 
the left and then highlight the ‘Established 
Connection’ for the I channel on the right. 

Both rows will become highlighted. 

8. Click the mouse on the ‘Switch Connection’ 
button. 

The message ‘Data Sources Switched Successfully’ will 
appear in the status box. 

9. Click the mouse on the ‘Close’ button. The ‘Data Source Selector’ window will disappear. 

10. Move the cursor over the ‘Regression’ 
alphanumeric page and repeat steps 5-10. 

The ‘Data Source Selector’ window will disappear. 

11. Invoke the telemetry driver for the multicast of 
telemetry packets. 

In a new cmdtool window, enter the following: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: setenv SCRIPT UserStation 

%: source FosEnvVars 

%:cd/fosb/test/am1/bin/sun_sparc_5-5 
(bin is alias) 

%: FtPgPackGen 

The following message appears in the window where 
the FtPgPackGen tool is running: 

‘Packet Generator is ready to receive directives.’ 
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12. Start the multicast of real-time/operational/I- 
channel housekeeping telemetry packets for 
processing. Enter the following ECL directives: 

ECL> PG CONFIG HOST=225.2.7.00 
PORT=20001 APID=1 

ECL> PG STARTDATA APID=1 
COUNT=64 

(Note: The IP address and port number is in the 
file 
‘/fosb/test/am1/config/FoSwConfigData.cnfg’.) 

Note the telemetry start time for the Analysis 
Request portion of this test procedure. 

Telemetry values are updated on the ‘Header’ and 
‘Regression’ Housekeeping Telemetry display pages, 
and the STATIC flag indicators (‘S’) no longer appear 
as parameters are updated. 

The STATIC flag indicators (‘S’) reappear shortly after 
the telemetry stops flowing. 

13. List the telemetry files archived by entering the 
following in a cmdtool window: 

%: cd /fosb/test/am1/tlmarchive 

%: ls -lrt 

A filename corresponding to the date/hour of the 
Housekeeping telemetry data received is included 
among the list of archived filenames. 

The size of the applicable file is non-zero and the time 
is consistent with the recent Housekeeping telemetry 
data. 
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1. Analysis Dataset Generation (No expected result/output; information only) 

2. In the Event Display, click on ‘Filter’ from the 
pull down menu 

Select ‘Event Type’ 

Click ‘Bold’ button next to ANL & SYS 

Click ‘Apply’ 

Click ‘Close’ 

The Event_Display_Gobal will now display all ANA 
subsystem activities in bold. 

3. Invoke the Analysis Request Builder 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

4. Select ‘Analysis_Request_Builder’. 

Click on ‘OK’ button. 

The Analysis Request Builder window is displayed and 
it contains the following fields and user interface 
menus: 

Request Name 

Processing site of data (local or EOC) 

Data quality 

Select Telemetry 

Select Time 

Product Options 

Product Formats 

Algorithms 
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5. Create an Analysis Request 

Enter into the request name field: 

Reg_AnlReq_DDD 

Reg_AnlReq_DDD appears in the Request Name field. 

6. Click the mouse on the ‘EOC Only’ icon to select 
data to be processed in the EOC. 

‘EOC Only’ icon should show selected. 

7. Click the mouse on the ‘All Data’ button in the 
Data Quality box. 

The ‘All Data’ button should show selected. 

8. Selecting Telemetry Mnemonics 

Click on the ‘Select Telemetry …’ button. 

The Telemetry Selector window is displayed and it 
contains the following fields and user interface menus: 

Subsystems 

Available Parameters 

Sampling rates 

Statistics interval time 

Selected Parameters 

Data Filters 

The possible choices in the sampling rate field include: 

All data 

Changes only 

Every Nth sample where N equals a user specified 
number. 
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9. Note: Fields are displayed as the user selects a 
filter criteria. 

Invoke the Selection Filter Screen: 

Click on the ‘Filter…’ button. 

The Selection Filter Screen is displayed and it contains 
the following fields and user interface menus: 

Spacecraft text area 

Instrument text area 

Sample Type text area 

Selected subsystem text area 

10. Select ‘AM1’ in the Spacecraft text area. Instruments associated with AM1 are displayed in the 
Instrument text area. 

11. Select ‘CDH’ in the Instrument text area. Sample Types associated with CDH are displayed in the 
Sample Type text area. 

12. Select ‘B’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_CDH_B is displayed 
in the Selected text area. 

13. Select ‘CEA’ in the Instrument text area. Sample Types associated with CEA are displayed in the 
Sample Type text area. 

14. Select ‘C’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_CEA_C is displayed in 
the Selected text area. 

15. Select ‘V’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_CEA_V is displayed in 
the Selected text area. 

16. Select ‘EAS’ in the Instrument text area. Sample Types associated with EAS are displayed in the 
Sample Type text area. 
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17. Select ‘B’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_EAS_B is displayed in 
the Selected text area. 

18. Select ‘FS1’ in the Instrument text area. Sample Types associated with FS1 are displayed in the 
Sample Type text area. 

19. Select ‘N’ in the sample type text area. 

Click on the ‘Select’ button. 

The subsystem mnemonic AM1_FS1_N is displayed in 
the Selected text area. 

20. Select ‘SDU’ in the Instrument text area. Sample Types associated with SDU are displayed in the 
Sample Type text area. 

21. Click on the ‘Select’ button. The subsystem mnemonic AM1_SDU is displayed in 
the Selected text area. 

22. Click the ‘OK’ button. The filter list is displayed in the Analysis Telemetry 
Selector window in the Subsystems section. 

23. Health & Safety telemetry points and sampling 
rate 

Click on the ‘AM1_EAS_B’ toggle button in the 
subsystems text area. 

A list of mnemonics associated with AM1_EAS_B are 
displayed in the Available Parameters text area of the 
Analysis Telemetry Selector window. 
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24. Select: 

‘EAS_BR_HGA_BOX1A_ARM’ 

‘EAS_BR_NEA_BUSA’ 

‘EAS_BR_SA_BOXE1A_ARM’ 

‘EAS_BR_SA_BOXI2A_ARM’ 

‘EAS_BR_SA_CAN2A_ARM’ 

in the available parameters text area. 

Select a sampling rate. 

Click the ‘All Data’ button. 

Click the ‘Select’ button. 

Mnemonics: 

EAS_BR_HGA_BOX1A_ARM 

EAS_BR_NEA_BUSA 

EAS_BR_SA_BOXE1A_ARM 

EAS_BR_SA_BOXI2A_ARM 

EAS_BR_SA_CAN2A_ARM 

along with the selected sample rate are displayed in the 
Selected Parameters field. 

25. Click on the ‘AM1_EAS_B’ toggle button. The list of mnemonics in the Available Parameters text 
area are removed. 

26. Standby telemetry points with a statistics 
interval. 

Select ‘AM1_CDH_B’ toggle button in the 
Subsystem text area. 

A list of mnemonics associated AM1_CDH_B with are 
displayed in the Available Parameters text area of the 
Analysis Telemetry Selector window. 
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27. Select: 

‘CDH_BR_ACT_DPPLRRCVD’ 

‘CDH_BR_ACT_LV_UMB_IF’ 

‘CDH_BR_CDHBU_VALDAT’ 

‘CDH_BR_SCT_MSGFULL’ 

in the available parameters text area. 

Select a sampling rate. 

Click the ‘Changes Only’ button. 

Click the ‘Select’ button. 

Mnemonics: 

CDH_BR_ACT_DPPLRRCVD 

CDH_BR_ACT_LV_UMB_IF 

CDH_BR_CDHBU_VALDAT 

CDH_BR_SCT_MSGFULL 

along with the selected sample rate are displayed in the 
Selected Parameters field. 

28. Click on the ‘AM1_CDH_B’ toggle button. The list of mnemonics in the Available Parameters text 
area are removed. 

29. Housekeeping telemetry points with a statistics 
interval. 

Select ‘AM1_CEA_C’ toggle button in the 
Subsystem text area. 

A list of mnemonics associated with AM1_CEA_C are 
displayed in the Available Parameters text area of the 
Analysis Telemetry Selector window. 
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30. Select: 

‘CEA_CS_INSTR_ID’ 

‘CEA_CS_LWSTPTT’ 

‘CEA_CS_SWSTPTT’ 

‘CEA_CS_TSTPTT’ 

in the available parameters text area. 

Select a sample rate. 

Enter into the ‘Nth sample’ field: 

1 

Click the ‘Select’ button. 

Mnemonics: 

CEA_CS_INSTR_ID 

CEA_CS_LWSTPTT 

CEA_CS_SWSTPTT 

CEA_CS_TSTPTT 

along with the selected sample rate are displayed in the 
Selected Parameters field. 

31. Click on the ‘AM1_CEA_C’ toggle button. The list of mnemonics in the Available Parameters text 
area are removed. 

32. Select ‘AM1_CEA_V’ toggle button in the 
Subsystem text area. 

A list of mnemonics associated with AM1_CEA_V are 
displayed in the Available Parameters text area of the 
Analysis Telemetry Selector window. 
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33. Select: 

‘CEA_VR_NVBMON’ 

‘CEA_VR_P15VMON’ 

‘CEA_VR_P5MON’ 

‘CEA_VR_SPSS2’ 

‘CEA_VR_SPST1’ 

in the available parameters text area. 

Select a sample rate. 

Enter into the ‘Nth sample’ field: 

5 

Click the ‘Select’ button. 

Mnemonics: 

CEA_VR_NVBMON 

CEA_VR_P15VMON 

CEA_VR_P5MON 

CEA_VR_SPSS2 

CEA_VR_SPST1 

along with the selected sample rate are displayed in the 
Selected Parameters field. 

34. Click on the ‘AM1_CEA_V’ toggle button. The list of mnemonics in the Available Parameters text 
area are removed. 

35. Select ‘AM1_FS1_N’ toggle button in the 
Subsystem text area. 

A list of mnemonics associated with AM1_FS1_N are 
displayed in the Available Parameters text area of the 
Analysis Telemetry Selector window. 
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36. Select: 

‘FS1_NR_ACQ_MODE11’ 

‘FS1_NR_ACQ_MODE23’ 

‘FS1_NR_ESAOUT_H2F’ 

‘FS1_NR_IRU_CNG1_R2’ 

‘FS1_NR_IRU_CNG2_Y2’ 

in the available parameters text area. 

Select a sample rate. 

Enter into the ‘Nth sample’ field: 

10 

Click the ‘Select’ button. 

Mnemonics: 

FS1_NR_ACQ_MODE11 

FS1_NR_ACQ_MODE23 

FS1_NR_ESAOUT_H2F 

FS1_NR_IRU_CNG1_R2 

FS1_NR_IRU_CNG2_Y2 

along with the selected sample rate are displayed in the 
Selected Parameters field. 

37. Click on the ‘AM1_FS1_N’ toggle button. The list of mnemonics in the Available Parameters text 
area are removed. 

38. Click on the ‘AM1_SDU’ toggle button. A list of mnemonics associated with AM1_SDU are 
displayed in the Available Parameters text area of the 
Analysis Telemetry Selector window. 

39. Selec t  ‘SDU_SCTIME’ in the available 
parameters text area. 

Select a sample rate. 

Enter into the ‘Nth sample’ field: 

1 

Click the ‘Select’ button. 

SDU_SCTIME along with the selected sample rate are 
displayed in the Selected Parameters field. 
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40. Click the ‘OK’ button. Telemetry points and associated sample rates selected 
match the Selected Telemetry table in the Analysis 
Request window. 

41. Save the analysis request. 

Click on the File pull down menu. 

A list of options appears. These options include new, 
open, save, save as, delete, and quit. 

42. Select ‘Save as…’. A File Selection window is displayed with a default 
directory path in the selection field. The default 
directory path will be /fosb/test/am1/data/FUI/requests/. 

43. Enter the name of the request: 

Reg_FPB_Anl_DDD 

Click the ‘OK’ button. 

An error message is displayed indicating that the time 
selection is missing from the request. 

44. Click the ‘Close’ button in the error dialog box. The error dialog box will close. 

45. Selecting Start and Stop Times 

Click on the ‘Select Time’ button. 

The Selected Pair Times window is displayed and it 
contains the following fields and user interfaces: 

Start and Stop Times 

Select 

Remove 

46. Click the ‘Select’ button The Pair Time Selector window is displayed and 
includes the following fields and user interface menus: 

Type of pair time (Absolute or Relative) 

Start/stop key (Time or Event) 

Specify selection (End Time, End Event, or Duration) 

47. Click the ‘Absolute’ button. The ‘Absolute’ button is selected. 
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48. Click the ‘Time’ button. The ‘Time’ button is selected. 

49. Click the ‘Specify End Time’ button. The ‘Specify End Time’ button is selected. 

50. Enter into the stop time field: 

HH:MM:SS.mmm 

Use the time from the telemetry data processed 
earlier in this test procedure 

The time entered is displayed in stop time field. 

51. Enter into the start time field: 

HH:MM:SS.mmm 

Use the time from the telemetry data processed 
earlier in this test procedure 

The time entered is displayed in start time field. 

52. Enter into the start date field: 

YYYY/DDD 

(DDD is the current day of the year) 

YYYY/DDD is displayed in start date field. 

53. Enter into the stop date field: 

YYYY/DDD 

(DDD is the current day of the year) 

YYYY/DDD is displayed in stop date field. 

54. Click the ‘OK’ button. The selected start and stop times match the start and 
stop times in the Selected Pair Times window. 
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55. Select an output dataset name for the analysis 
request. 

Click the output dataset name toggle button. 

Enter the name of the output dataset (request 
name): 

Reg_AnlReq_DDD 

Reg_AnlReq_DDD will be displayed in the Output 
Dataset Name box. 

56. Click the CarryOut File Name toggle button. This will generate a carry out file with the same names 
as the Analysis Request. 

57. Save the analysis request 

Click on the File pull down menu. 

A list of options appears. 

58. Select ‘Save as…’. A File Selection window is displayed with a default 
directory path in the selection field. The default 
directory path will be /fosb/test/am1/data/FUI/requests/. 

59. Enter the name of the request: 

Reg_AnlReq_DDD 

Click the ‘OK’ button. 

A dialog box informing the user that the file was saved. 

60. Click the ‘Close’ button in the information dialog 
box. 

The dialog box will close. 

61. Click the ‘OK’ button in the Analysis Request 
Builder window. 

A dataset for the given options selected has been 
submitted for generated. 
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62. Monitor the time the Event Display received the 
message ‘Analysis Request X has started on Host 
N’. 

Monitor the time the Event Display received the 
message ‘Analysis Request X is completed on 
Host N’. 

Where X = the number of the request and N = the 
Name of the Host machine that started the request. 

Wait for an event message indicating that the analysis 
request is complete. The following event message is 
displayed: 

‘Analysis Request X completed on Host N.’ 

63. Verify the analysis request was saved. 

Invoke the Analysis Request Builder 

Click on the ‘Tools’ button. 

The Tools Dialog window and a list of tools is 
displayed to the user. 

64. Select ‘Analysis_Request_Builder’. 

Click on ‘OK’ button. 

The Analysis Request Builder window is displayed. 

65. Click the File pull down menu. A list of options appears. 

66. Select ‘Open’. The File Selection window is displayed. 

67. Select ‘Reg_AnlReq_DDD’ 

Click the ‘OK’ button. 

An Analysis Request Information dialog box will 
appear stating: 

This request was already sent. 

Modifying or resending this request will not be 
permitted. 

68. Click the ‘Close’ button in the dialog box. A request is displayed and that it matches the previously 
saved request. 

69. Check the Request Status text area in the Analysis 
Request Builder window. 

The Request Status will indicate Submitted. 
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70. Click the ‘Cancel’ button. The Analysis Request Builder window will close. 

71. Verify that a dataset was created 

Enter the following in a terminal window: 

%:cd /fosb/test/am1/datasets 

%:ls -lrt 

A listing of the contents of the directory datasets is 
d i s p l a y e d  co n t a i n i n g  f i l e s  n a m e d  
Reg_AnlReq_DDD.meta, Reg_AnlReq_DDD.data 

72. Enter the following in a terminal window: 

%:cd /fosb/test/am1/data 

%:ls -la 

A long listing of the contents of the directory data is 
d i s p l a y e d  co n t a i n i n g  f i l e s  n a m e d  
Reg_AnlReq_DDD.out. 
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1. Real time Tables and Graphs (No expected result/output; information only) 

2. Log onto 1 FOT User Station. 

Start the User Station. Reference Test Case 
SYS2010B -- User Station Startup and 
Authentication. 

The FOT User Station is running and the ‘Control 
Window’ is displayed. 

3. Connect to Operational String. 

From the directive dialog box inside of the Control 
window on the UserStation, issue the following 
directive: 

STRING CONNECT STRING=100 CONFIG=MIRROR 

Look for below message inside of event display area: 

‘Successfully connected to String 100’ 

4. Select ‘Display Builder’ from the Tools dialog box. 

1. Click on ‘Tools’ from the Environment Control 
Window. 

2. Click on ‘Display Builder’. 

3. Click on ‘OK’. 

A suite of Display Builder windows will appear on the 
screen. 

1. Display Builder Palette 

2. Display Builder (Blank) 

3. Display Item Data Sources 

4. Display Item Format 

5. Display Builder Console 

5. From the ‘Display Builder Palette’; 

1. Click on ‘2D Graph’. 

2. Drag mouse to the blank ‘Display Builder’
window and drop in desired location. 

The boundaries for the 2D Graph will appear in the 
blank ‘Display Builder’ window. 
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6. Enlarge the ‘Display Builder’ window so the 
boundaries of the ‘2D Graph’ are visible. 

1. Click on the right side of the ‘Display Builder’ 
window and drag to the right until 
sides of the ‘2D Graph’ are totally visible. 

All four sides of the ‘2D Graph’ will be visible inside 
the ‘Display Builder’ window. 

7. Select Graph data sources Information only. 

8. Select the Data Source from the ‘Display Builder 
Palette’; 

1. Click on ‘Page’. 

2. Click on 

3. Click on the ‘Spacecraft’ button and select 
‘AM1’. 

4. Click on the ‘Source’ button and select ‘Real 
Time’. 

5. Click on 
‘Operational’. 

6. Click on ‘Add’. 

7. Click ‘OK’ 

‘AM1 RealTime Operational Default’ will be displayed 
in the ‘Logical String Management’ box. 

all four 

‘Logical String Management’. 

the ‘Mode’ button and select 
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9. Select the mnemonic/parameter ‘Filters’ from the 
‘Display Items Data Sources’ window. 

1. Click on the ‘Add’ button. 

2. Click on the ‘Filter’ button. 

3. Click on ‘AM1’ for ‘Spacecraft’. 

4. Click on ‘CDH’ for ‘Instrument’. 

5. Click on the ‘Select’ button. 

6. Click on ‘EPS’ for ‘Instrument’. 

7. Click on the ‘Select’ button. 

8. Click on ‘SDU’ for ‘Instrument’. 

9. Click on the ‘Select’ button. 

10. Click on the ‘OK’ button. 

The desired subsystem or instrument will appear in the 
‘Selection Filter’ window, 

AM1_CDH 

AM1_EPS 

AM1_SDU 
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10. Select the desired mnemonics. 

1. Click on ‘AM1_CDH’ from the ‘Selection 
Filter’ list. Wait for the mnemonics to show in 
the box under ‘Available Parameters’. 

2. Click on ‘CDH_BR_SFEALPCMDREJ’ from 
the ‘Available Parameters’ list. 

3. Click on the arrow button ‘‚’. 

4. Repeat items 1 and 2 of this procedure for the 
following: 

CDH_BR_ SFEABLPCMDREJ 

CDH_BR_SSR1_HKDIS 

1. Click on the ‘OK’. 

The mnemonics are selected for the graph. 

11. Deselect the mnemonics. 

2. Click on the ‘Add’ button from the ‘Display 
Item Data Sources’ window. 

3. Click on the ‘·All’ button. 

4. Click on ‘AM1_CDH’. 

5. Wait for the ‘Available Parameters’ box to 
return. 

1. The ‘·All’ button will move the selected
mnemonics back to the ‘Available Parameters’ list. 

2. The mnemonics will disappear from the ‘Available 
Parameters’ box. The ‘Available Parameters’ box 
will be empty 
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12. Select the desired mnemonics. 

1. Click on ‘AM1_EPS’ from the ‘Selection 
Filter’ list. Wait for the mnemonics to show in 
the box under ‘Available Parameters’. 

2. Click on ‘EPS_IR_PDU_EPC_INPA’ from the 
‘Available Parameters’ box. 

3. Click on the arrow button ‘‚’. 

4. Repeat items 1 and 2 of this step for the 
following: 

EPS_IR_PDU_EPC_INPB 

EPS_VR_ADE_EPCA 

1. Click on the ‘OK’. 

The mnemonics are selected for the graph. 

13. Deselect the mnemonics. 

2. Click on the ‘Add’ button from the ‘Display 
Item Data Sources’ window. 

3. Click on the ‘·All’ button. 

4. Click on ‘AM1_CDH’. 

5. Wait for the ‘Available Parameters’ box to 
return. 

1. The ‘·All’ button will move the selected
mnemonics back to the ‘Available Parameters’ list. 

1. The mnemonics will disappear from the ‘Available
Parameters’ box. The ‘Available Parameters’ box
will be empty. 
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14. Select the desired mnemonics. 

1. Click on ‘AM1_SDU’ from the ‘Selection 
Filter’ list. Wait for the mnemonics to show in 
the box under ‘Available Parameters’. 

2. Click on ‘SDU_SCTIME’ from the ‘Available 
Parameters’ box. 

3. Click on the arrow button ‘‚’. 

4. Click on the ‘OK’. 

2. The mnemonic is selected for the graph. 

15. Customize mnemonics/parameters Information only 
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16. From the ‘Display Item Format’ window select
the ‘Legend’ and ‘Title’. 

1. Click on the ‘Edit’ button. 

2. Click on ‘Legend’. 

Next to the ‘Title’ heading; 

3. Click inside the ‘Title’ box and enter: ‘FUI�
2110B’ 

Next to the ‘Show’ heading; 

1. Ensure the ‘Legend’ box is depressed. 

Next to the ‘Position’ heading; 

1. Click on ‘Northeast’.. 

Next to the ‘Border Type’ heading; 

1. Click on ‘Etched In’. 

2. Click on ‘Apply’. 

The mnemonics will be positioned in the upper right
hand corner of the graph inside a box. 
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17. From the ‘Display Item Format Window’ select the
‘Axes’. 

1. Click on the ‘Edit’ button. 

2. Click on ‘Axes’. 

3. Next to the ‘X Axis Label’ heading; 

Enter ‘SDU_SCTIME’. 

4. Next to ‘X Axis Parameter’; 

Click on ‘SDU_SCTIIME’. 

5. Next to the ‘X Axis Display Interval’ heading; 

Leave the default value of 0.00347 

6. Next to the ‘Y Axis Label’ heading; 

Enter ‘Mnemonics’ 

Leave the default values of ‘0.00000’ for the 
other fields. 

7. Click on ‘Apply’. 

The Axis will be selected for the graph. 
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18. From the ‘Display Item Format Window’ select 
the ‘Color & Line Style’ 

1. Click on the ‘Edit’ button select ‘Color & Line 
Style’. 

2. Click on the first parameter from the 
‘Parameter’ list. Ensure it is highlighted. 

3. Click on the ‘Line’ button and click on ‘None’ 

4. Click on the ‘Point’ button and click on ‘Dot’. 

5. Click on the ‘Color’ button and click on ‘Red’ 

6. Click on the ‘Limit Line’ button and click on 
‘Solid’. 

7. Click on ‘Apply’. 

8. Click on the second parameter from the 
‘Parameter’ list. Ensure it is highlighted. 

9. Click on the ‘Line’ button and click on ‘Long 
Dash’ 

10. Click on the ‘Point’ button and click on ‘Box’. 

11. Click on the ‘Color’ button and click on 
‘Green’ 

12. Click on the ‘Limit Line’ button and click on 
‘Solid’. 

13. Click on ‘Apply’. 

14. Click on the third parameter from the 
‘Parameter’ list. Ensure it is highlighted. 

15. Click on the ‘Line’ button and click on 
‘Dotted’ 

16. Click on the ‘Point’ button and click on 
‘Triangle’. 

The ‘Legend’ will change to reflect the attributes 
selected for the mnemonics. 
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19. 1. Click on the ‘Color’ button and click on 
‘Yellow’ 

2. Click on the ‘Limit Line’ button and click on 
‘Long Dash’ 

3. Click on ‘Apply’. 

4. Click on the fourth parameter from the 
‘Parameter’ list. Ensure it is highlighted. 

5. Click on the ‘Line’ button and click on ‘Short 
Dash’ 

6. Click on the ‘Point’ button and click on 
‘Diamond’. 

7. Click on the ‘Color’ button and click on ‘Cyan’ 

8. Click on the ‘Limit Line’ button and click on 
‘Dotted’. 

9. Click on ‘Apply’. 

10. Click on the fifth parameter from the 
‘Parameter’ list. Ensure it is highlighted. 

11. Click on the ‘Line’ button and click on ‘Long 
Short Dash’ 

12. Click on the ‘Point’ button and click on ‘Star’. 

13. Click on the ‘Color’ button and click on 
‘Magenta’ 

14. Click on the ‘Limit Line’ button and click on 
‘Solid’. 
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20. 1. Click on ‘Apply’. 

2. Click on the sixth parameter from the 
‘Parameter’ list. Ensure it is highlighted. 

3. Click on the ‘Line’ button and click on ‘Dash 
Dot’ 

4. Click on the ‘Point’ button and click on 
‘Circle’. 

5. Click on the ‘Color’ button and click on ‘Blue’ 

6. Click on the ‘Limit Line’ button and click on 
‘Long Dash’. 

7. Click on ‘Apply’. 

21. From the ‘Display Item Format’ window select the 

‘Footer’ 

1. Click on the ‘Edit’ button and select ‘Footer’ 

2. Next to the ‘Show’ heading depress the 
‘Footer’ box. 

3. Next to the ‘Text’ heading enter ‘080797’. 

4. Next to the ‘Border Type’ click on ‘Etched in’. 

5. Click on ‘Apply’ 

22. Save Graph as ‘file’ and Build Graph to System Information only 
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23. From the ‘Display Builder Palette’ window; 

1. Click on ‘File’. 

2. Click on ‘Save As’. 

3. Click on ‘System’. 

4. Click inside the ‘Selection’ box and type; 
‘/fosb/test/AM1/displaydefs/FUI_2110B_GRA
PH’ 

5. Click on ‘OK’. 

6. Click on ‘File’. 

7. Click on ‘Build to CM’. 

Graph will be saved to targeted directory. 

Graph will be built to the System. 

Console Window message: 

Saving /fosb/test/AM1/displaydefs/FUI_2110B_GRAPH 

Done. 

Invoked Build to CM executable 

Build to CM complete. 

24. Save Graph as ‘file’ and Build Graph to Local Information only 
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25. From the ‘Display Builder Palette’ window; 

1. Click on ‘File’. 

2. Click on ‘Save As’. 

3. Click on ‘Local’. 

4. Click inside the ‘Selection’ box and type; 
‘/home/fostest1/pages/FUI_2110B_GRAPH’ 

5. Click on ‘OK’. 

6. Click on ‘File’. 

7. Click on ‘Build to Local’. 

8. Click on ‘File’. 

9. Click on ‘Quit’. 

Graph will be saved to targeted directory. 

Graph will be built to Local machine 

Console Window message: 

Saving /home/fostest1/pages/FUI_2110B_GRAPH 

Done. 

Invoked Build to Local executable 

Build to Local complete. 

Display Builder windows will disappear. 

26. Recall graph to plot. 

1. From the ‘Control Window’ click on ‘Tlm 
Wins’. 

2. Click on the file name ‘FUI_2110B_GRAPH’ 

3. Click on ‘OK’. 

The graph will appear. 

27. Initiate the Packet Generator (packGen) Information only 
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28. Open a X-Term window, at the UNIX prompt type; 

1. % cd /fosb/test/AM1/scripts/setup 

2. or use alias test 

3. % setenv SCRIPT UserStation 

4. % source PackGenEnvVars 

5. % cd /fosb/test/AM1/bin/sun_sparc_5-5 

6. or use alias bin 

7. % packGen 

Valid data type = am1-hk 

IP address = 225.2.7.00 

Port number = 20001 

Number of packets = -1 (infinite) 

packet delay = 3000 

Return 

Packet Generator is running and the Graph is updating. 

29. Demonstrate Min, Max, and Current values of a
current mnemonic. 

1. Click on Mnemonic inside of graph display
with left mouse button. 

2. Min, Max, and Current values should appear at 
the bottom of the graph display with the
associated mnemonic displayed in the
Parameter box. 
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30. Display ‘Limit Lines’ 

From the graph click on the ‘Limits: ON/OFF’ 
box. 

The Limit Lines will be displayed. 

31. From a UNIX prompt, stop ‘packGen’ by
executing 

‘cntl C’. 

32. Edit Graph Information only 

33. From the ‘Display Builder Palette’ window; 

1. Click on ‘File’ 

2. Click on ‘Open’ 

3. Click on ‘Local’. 

4. Click inside the ‘Selection’ box and type; 
‘/home/fostest1/pages/FUI_2110B_GRAPH’ 

5. Click on ‘OK’. 

6. Click inside the graph boundaries to see the 
legend and access the windows. 

The graph and the Display Builder windows will appear. 
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34. Edit graph ‘ X Axis’ from the ‘Display Item Data 
Sources’ Window; 

1. Click on the ‘SDU_SCTIME’ and highlight. 

2. Click on ‘Remove’. 

3. Click on ‘Add’ 

4. Click on the all button ‘È All’ if there are 
parameters listed under ‘Selected Parameters’ 

5. Deselect whatever mnemonics are displayed 
under ‘Available Parameters’ by clicking on its 
associated ‘Selection Filter’. 

6. Wait for the ‘Available Parameters’ box to 
return. 

7. Click on ‘AM1_CDH’ from the ‘Selection 
Filter’ list. Wait for the mnemonics to show in 
the box under ‘Available Parameters’. 

8. Click on ‘CDH_BR_SSR1_HKRATE from the 
‘Available Parameters’ box. 

9. Click on the arrow button ‘‚’. 

10. Click on ‘OK’ 

SDU_SCTIME will be removed. 
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35. From the ‘Display Item Format Window’ select the 
‘Axes’. 

1. Click on the ‘Edit’ button. 

2. Click on ‘Axes’ 

Next to the ‘X Axis Label’ heading; 

3. Enter ‘CDH_BR_SSR1_HKBRATE’ 

Next to ‘X Axis Parameter’; 

4. Click on ‘X Axis Parameter’ box and click on 

5. ‘CDH_BR_SSR1_HKBRATE 

Next to the ‘X Axis Display Interval’ 
heading; 

6. Leave the default value of 0.00347 

Next to the ‘Y Axis Label’ heading; 

7. Enter ‘Mnemonics’ 

8. Leave the default values of ‘0.00000’ for the 
other fields. 

9. Click on ‘Apply’. 

Replace the X Axis with 
‘CDH_BR_SSR1_HKBRATE’. 

36. Save Graph as ‘file’ and Build Graph to Local Information only 
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37. From the ‘Display Builder Palette’ window; 

1. Click on ‘File’. 

2. Click on ‘Save As’. 

3. Click on ‘Local’. 

4. Click inside the ‘Selection’ box and type; 
‘/home/fostest1/pages/FUI_2110B_Graph2’. 

5. Click on ‘OK’. 

6. Click on ‘File’. 

7. Click on ‘Build to Local’. 

8. Click on ‘File’. 

9. Click on ‘Quit’. 

Graph will be saved to targeted directory. 

Graph will be built to Local machine 

Console Window message: 

Saving /home/fostest1/pages/FUI_2110B_Graph2 

Done. 

Invoked Build to Local executable 

Build to Local complete. 

Display Builder windows will disappear. 

38. Recall graph to plot. 

1. From the ‘Control Window’ click on ‘Tlm 
Wins’. 

2. Click on the file name ‘FUI_2110B_GRAPH2’ 

3. Click on ‘OK’. 

The graph will appear. 

39. Initiate the Packet Generator (packGen) Information only 
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40. Open a X-Term window, at the UNIX prompt type; 

1. % cd /fosb/test/AM1/scripts/setup 

or use alias test 

2. % source PackGenEnvVars 

3. % cd /fosb/test/AM1/bin/sun_sparc_5-5 

or use alias bin 

4. % packGen 

Valid data type = am1-hk 

IP address = 225.2.7.00 

Port number = 20001 

Number of packets = -1 (infinite) 

packet delay = 3000 

5. Return 

Packet Generator is running and the Graph is updating. 

41. Demonstrate Min, Max, and Current values of a
current mnemonic. 

1. Click on Mnemonic inside of graph display 
with left mouse button. 

2. Min, Max, and Current values should appear at 
the bottom of the graph display with the 
associated mnemonic displayed in the 
Parameter box. 

Mnemonic against a mnemonic graph is displayed. 
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42. Display ‘Limit Lines’ 

From the graph click on the ‘Limits: ON/OFF’ 
box. 

The Limit Lines will be displayed. 

43. From a UNIX prompt, stop ‘PackGen’ by
executing 

‘cntl C’. 

PackGen has terminated. 

44. Edit Graph Information only 

45. 1. Click on the ‘Tools’ button from the
environment control window. 

2. Click on ‘Display Builder’. 

3. From the ‘Display Builder Palette’ window; 

Click on ‘File’ 

Click on ‘Open’ 

Click on ‘Local’. 

Click inside the ‘Selection’ box and type; 
‘/home/fostest1/pages/FUI_2110B_GRAPH’ 

Click on ‘OK’. 

Click inside the graph boundaries to see the 
legend and access the windows. 

The graph and Display Builder windows will appear. 
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46. Edit graph ‘Grid’ and ‘Granularity’ from the 
‘Display Item Format’ window; 

1. Click on the ‘Edit’ button and select ‘Axes’ 

2. Depress the ‘Grid’ box if not already 
depressed. 

3. Change the ‘X Axis Grid Granularity’ to a 
‘3.00000’ 

4. Change the Y Axis Grid Granularity’ to a 
‘4.00000’. 

5. Next to the ‘X Axis Label’ heading; 

Enter ‘SDU_SCTIME’. 

Next to ‘X Axis Parameter’; 

Click on ‘SDU_SCTIIME’. 

Next to the ‘X Axis Display Interval’ heading; 

Leave the default value of 0.00347 

Next to the ‘Y Axis Label’ heading; 

Enter ‘Mnemonics’ 

Leave the default values of ‘0.00000’ for the 
other fields. 

Click on ‘Apply’. 

The graph will change to reflect the new options 
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47. 1. Click on the ‘Edit’ button and select ‘Color & 
Line Style’. 

2. Click on the ‘Grid Line Style’ button and select 
‘Solid’ 

Click on ‘Apply’. 

The graph will reflect the options chosen. 

48. Save Graph as ‘file’ and Build Graph to Local Information only 

49. From the ‘Display Builder Palette’ window; 

1. Click on ‘File’ 

2. Click on ‘Save As’ 

3. Click on ‘Local’. 

4. Click inside the ‘Selection’ box and type; 
‘/home/fostest1/pages/FUI_2110B_GRAPH3’ 

5. Click on ‘OK’. 

6. Click on ‘File’ 

7. Click on ‘Build to Local’. 

8. Click on ‘File’. 

Click on ‘Quit’. 

Graph will be saved to targeted directory. 

Graph will be built to Local machine 

Console Window message: 

Saving /home/fostest1/pages/FUI_2110B_GRAPH3 

Done. 

Invoked Build to Local executable 

Build to Local complete. 

Display Builder windows will disappear. 

50. Recall graph to plot. 

1. From the ‘Control Window’ click on ‘Tlm 
Wins’. 

2. Click on the file name ‘FUI_2110B_GRAPH3’ 

3. Click on ‘OK’. 

The graph will appear. 
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51. Initiate the Packet Generator (packGen) Information only 

52. Open a X-Term window, at the UNIX prompt type; 

1. % setenv SCRIPT UserStation 

2. % cd /fosb/test/AM1/scripts/setup 

or use alias test 

3. % source PackGenEnvVars 

4. % cd /fosb/test/AM1/bin/sun_sparc_5-5 

or use alias bin 

5. % packGen 

Valid data type = am1-hk 

IP address = 225.2.7.00 

Port number = 20001 

Number of packets = -1 (infinite) 

packet delay = 3000 

6. Return 

Packet Generator is running and the Graph is updating. 
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53. Demonstrate Min, Max, and Current values of a
current mnemonic. 

1. Click on Mnemonic inside of graph display 
with left mouse button. 

2. Min, Max, and Current values should appear at 
the bottom of the graph display with the 
associated mnemonic displayed in the 
Parameter box. 

Min and Max values are displayed in the display 
window. 

54. From a UNIX prompt, stop ‘PackGen’ by
executing 

‘cntl C’. 

PackGen is terminated. 

55. Position 4 graphs on UserStation screen 

1. Click on ‘Tlm Wins’. 

2. Click on 
‘FUI_2110B_GRAPH’,’FUI_2110B_GRAPH2 
’ and ,’FUI_2110B_GRAPH3’. 

3. Click on ’FUI_2110B_GRAPH3’ again. 

4. Position all 4 graphs on the screen and use the 
‘Snapshot’ tool to print to a local printer as 
landscape and portrait. 

The four graphs appear. 
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56. Delete a Graph from the ‘Display Builder Palette’; 

1. Click on ‘Display Builder’ from the ‘Tools’
menu. 

2. Click on ‘Delete File’ 

3. Click on ‘Local or System’ filter bar 

4. Select ‘Graph’ from the Files box by scrolling
to the filename, and then highlighting filename 
FUI_2110B_GRAPH 

5. Click on the ’OK’ button. 

6. Repeat this step for 2’nd file 
FUI_2110B_GRAPH.pmss’ 

extension and delete from ‘both’ Local and 

System. 

Graph will be deleted. 

57. Create a Table, Quit and restart Display Builder. Information only 

58. Select ‘Display Builder’ from the Tools dialog box. 

1. Click on ‘Tools’ from the Environment Control 
Window. 

2. Click on ‘Display Builder’. 

3. Click on ‘OK’. 

A suite of Display Builder windows will appear on the 
screen. 

1. Display Builder Palette 

2. Display Builder (Blank) 

3. Display Item Data Sources 

4. Display Item Format 

5. Display Builder Console 
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59. From the ‘Display Builder Palette’; 

1. Click on ‘Table’. 

2. Drag mouse to the blank ‘Display Builder’
window and drop in desired location. 

The boundaries for the Table will appear in the blank 
‘Display Builder’ window. 

60. Select Table data sources Information only. 

61. Select the Data Source from the ‘Display Builder 
Palette’; 

1. Click on ‘Page’. 

2. Click on ‘Logical String Management’. 

3. Click on the ‘Spacecraft’ button and select 
‘AM1’. 

4. Click on the ‘Source’ button and select ‘Real 
Time’. 

5. Click on the ‘Mode’ button and select 
‘Operational’. 

6. Click on ‘Add’. 

7. Click ‘OK’ 

‘AM1 RealTime Operational Default’ will be displayed 
in the ‘Logical String Management’ box. 
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62. Select the mnemonic/parameter ‘Filters’ from the 
‘Display Items Data Sources’ window. 

1. Click on the ‘Add’ button. 

2. Click on the ‘Filter’ button. 

3. Click on ‘AM1’ for ‘Spacecraft’. 

4. Click on ‘CDH’ for ‘Instrument’. 

5. Click on the ‘Select’ button. 

6. Click on ‘EPS’ for ‘Instrument’. 

7. Click on the ‘Select’ button. 

Click on the ‘OK’ button. 

The desired subsystem or instrument will appear in the 
‘Selection Filter’ window, 

AM1_CDH 

AM1_EPS 
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63. Select the desired mnemonics. 

1. Click on ‘AM1_CDH’ from the ‘Selection 
Filter’ list. Wait for the mnemonics to show in 
the box under ‘Available Parameters’. 

2. Click on ‘CDH_BR_SFEALPCMDREJ’ from 
the ‘Available Parameters’ list. 

3. Click on the arrow button ‘‚’. 

4. Repeat items 1 and 2 of this procedure for the 
following: 

CDH_BR_ SFEBLPCMDREJ 

CDH_BR_SSR1_HKDIS 

and 22 more mnemonics of your choice. 

Click on the ‘OK’. 

The mnemonics are selected for the table. 

64. Deselect the mnemonics. 

1. Click on the ‘Add’ button from the ‘Display 
Item Data Sources’ window. 

2. Click on the ‘·All’ button. 

3. Click on ‘AM1_CDH’. 

4. Wait for the ‘Available Parameters’ box to 
return. 

1. The ‘·All’ button will move the selected 
mnemonics back to the ‘Available Parameters’ list. 

2. The mnemonics will disappear from the ‘Available 
Parameters’ box. The ‘Available Parameters’ box 
will be empty 
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65. Select the desired mnemonics. 

1. Click on ‘AM1_EPS’ from the ‘Selection 
Filter’ list. Wait for the mnemonics to show in 
the box under ‘Available Parameters’. 

2. Click on ‘EPS_IR_PDU_EPC_INPA’ from the 
‘Available Parameters’ box. 

3. Click on the arrow button ‘‚’. 

4. Repeat items 1 and 2 of this step for the 
following: 

EPS_IR_PDU_EPC_INPB 

EPS_VR_ADE_EPCA 

and 22 more mnemonics of your choice. 

Click on the ‘OK’. 

The mnemonics are selected for the table. 

There will be 50 mnemonic parameters in the table. 

66. From the ‘Display Item Format’ window select the 

table ‘Title and Mnemonic/Descriptor’ 

1. Click inside the ‘Title’ box and enter; 
‘FUI_2110B’. 

2. Ensure the ‘Mnemonic’ box is depressed. 

3. Click on ‘Apply’. 

The mnemonic will be displayed. 

67. Save Table as ‘file’ and Build Table to System Information only 
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68. From the ‘Display Builder Palette’ window; 

1. Click on ‘File’. 

2. Click on ‘Save As’. 

3. Click on ‘System’. 

Click inside the ‘Selection’ box and type; 
/fosb/test/AM1/displaydefs/FUI_2110B_Tabl 
e 

4. Click on ‘OK’. 

5. Click on ‘File’. 

6. Click on ‘Build to CM’. 

The table will be saved to targeted directory. 

The table will be built to the System. 

Console Window message: 

Saving /fosb/test/AM1/displaydefs/FUI_2110B_Table 

Done. 

Invoked Build to CM executable 

Build to CM complete. 

69. Save Table as ‘file’ and Build Table to Local Information only 

4-259
 322-CD-100-001/ 
411-CD-100-001 



70. From the ‘Display Builder Palette’ window; 

1. Click on ‘File’. 

2. Click on ‘Save As’. 

3. Click on ‘Local’. 

4. Click inside the ‘Selection’ box and type; 
‘/home/fostest1/pages/FUI_2110B_Table’ 

5. Click on ‘OK’. 

6. Click on ‘File’. 

7. Click on ‘Build to Local’. 

8. Click on ‘File’. 

9. Click on ‘Quit’. 

The table will be saved to targeted directory. 

The table will be built to Local machine 

Console Window message: 

Saving /home/fostest1/pages/FUI_2110B_Table 

Done. 

Invoked Build to Local executable 

Build to Local complete. 

Display Builder windows will disappear. 

71. Recall table. 

1. From the ‘Control Window’ click on ‘Tlm 
Wins’. 

2. Click on the file name ‘FUI_2110B_Table’ 

3. Click on ‘OK’. 

The table will appear. 

72. Initiate the Packet Generator (packGen) Information only 
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73. Open a X-Term window, at the UNIX prompt type; 

1. % cd /fosb/test/AM1/scripts/setup 

or use alias test 

2. % setenv SCRIPT UserStation 

3. % source PackGenEnvVars 

4. % cd /fosb/test/AM1/bin/sun_sparc_5-5 

or use alias bin 

5. % packGen 

a. Valid data type = am1-hk 

b. IP address = 225.2.7.00 

c. Port number = 20001 

d. Number of packets = -1 (infinite) 

e. packet delay = 3000 

f. Return 

Packet Generator is running and the Table is updating. 

The table should have 50 mnemonic parameters
updating with values. 

74. From a UNIX prompt, stop ‘PackGen’ by
executing 

‘cntl C’. 

PackGen has terminated. 

75. Edit Table Information Only 
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76. From the ‘Display Builder Palette’ window; 

1. Click on ‘File’ 

2. Click on ‘Open’ 

3. Click on ‘Local’. 

4. Click inside the ‘Selection’ box and type; 
‘/home/fostest1/pages/FUI_2110B_Table’ 

5. Click on ‘OK’. 

6. Click inside the graph boundaries to see the 
legend and access the windows. 

The table and the Display Builder windows will appear. 

77. From the ‘Display Item Format’ window select the 

table ‘Title and Mnemonic/Descriptor’ 

1. Depress the ‘Descriptor’ box. 

2. Click on ‘OK’. 

The descriptor will be displayed. 

78. Save Table as ‘file’ and Build Table to Local Information only 
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79. From the ‘Display Builder Palette’ window; 

1. Click on ‘File’. 

2. Click on ‘Save As’. 

3. Click on ‘Local’. 

4. Click inside the ‘Selection’ box and type; 
‘/home/fostest1/pages/FUI_2110B_Table2’ 

5. Click on ‘OK’. 

6. Click on ‘File’. 

7. Click on ‘Build to Local’. 

8. Click on ‘File’. 

9. Click on ‘Quit’. 

Table will be saved to targeted directory. 

Table will be built to Local machine 

Console Window message: 

Saving /home/fostest1/pages/FUI_2110B_Table2 

Done. 

Invoked Build to Local executable 

Build to Local complete. 

Display Builder windows will disappear. 

80. Recall table. 

1. From the ‘Control Window’ click on ‘Tlm 
Wins’. 

2. Click on the file name ‘FUI_2110B_Table2’ 

3. Click on ‘Apply’. 

The table will appear. 

81. Initiate the Packet Generator (packGen) Information only 
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82. 1. Open a X-Term window, at the UNIX prompt 
type; 

2. % cd /fosb/test/AM1/scripts/setup 

or use alias test 

3. % setenv SCRIPT UserStation 

4. % source PackGenEnvVars 

5. % cd /fosb/test/AM1/bin/sun_sparc_5-5 

or use alias bin 

6. % packGen 

Valid data type = am1-hk 

IP address = 225.2.7.00 

Port number = 20001 

Number of packets = -1 (infinite) 

packet delay = 3000 

Return 

Packet Generator is running and the Table is updating. 

The table will update with 50 descriptor parameters. 

83. From a UNIX prompt, stop ‘PackGen’ by
executing 

‘cntl C’. 

PackGen is terminated. 

4-264
 322-CD-100-001/ 
411-CD-100-001 



1. FOS Server and User Station Shutdown (No expected result/output; information only) 

2. Delete String 101 

Disconnect from String 101. Enter the following 
ECL directive: 

ECL> S T R I N G  D I S C O N N E C T  
STRING=101 

The following event messages appear: 

‘User successfully disconnected from String 101’ 

3. Delete String 101. Enter the following ECL 
directive: 

ECL> STRING DELETE STRING=101 

The following event message appears: 

‘Active processing for String 101 was deleted.’ 

4. Real-Time Server Shutdown test follows (No expected result/output; information only) 

5. User Station #1 -- Terminate the processes on the 
Real-Time Server by entering the following in 
cmdtool window #4: 

%: MyKill 

(Wait for MyKill completion) 

User Station #1 -- MyKill is complete when a UNIX 
prompt is received from the Real-Time Server 
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6. User Station #1 -- In cmdtool window #4, view 
the processes on this server by entering the 
following: 

%: ps -ea 

Scan the resulting display for any FOS processes 
that might remain from the current session. If 
processes remain, terminate them unconditionally 
by entering the following: 

%: kill -9 <processid ... processid> 

(Note: FOS processes begin with ‘FxXx...’, 
‘ / f o sb / t e s t /AM1/b in / sun_spa rc . . . ’ ,  o r  
‘TlmArchiver’.) 

(Note: Execute all ‘kill’ commands on the higher- 
numbered processes first.) 

Double-check the list of processes on this server 
by entering the following once again: 

%: ps -ea 

User Station #1 -- There are no FOS processes on this 
server. 

7. User Station #1 -- Remove all endpoints on this 
server that still remain from the current session by 
entering the following in cmdtool window #4: 

%: c d /fosb/test/am1/scripts/setup (test is 
alias) 

%: rm.sh 

User Station #1 -- The message ‘(0 rows affected)’ 
appears, indicating there are no endpoints on this server. 
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8. User Station #1 -- Exit from the Real-Time Server 
by entering the following in cmdtool windows #3 
& #4. 

%: exit 

User Station #1 -- A UNIX prompt is received from the 
User Station 

9. User Station #1 -- Close cmdtool windows #3 & 
#4 by entering the following in these cmdtool 
windows. 

%: exit 

User Station #1 -- The cmdtool windows close 

10. User Station Shutdown test follows (No expected result/output; information only) 

11. Terminate the processes on the User Station by 
entering the following in a cmdtool window: 

%: MyKill 

(Wait for MyKill completion) 

MyKill is complete when a UNIX prompt is received 
from the User Station 
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12. In a cmdtool window, view the processes on this 
user station by entering the following: 

%: ps -ax 

Scan the resulting display for any FOS processes 
that might have remained from the previous 
session. If processes remain, terminate them 
unconditionally by entering the following: 

%: kill -9 <processid ... processid> 

(Note: FOS processes begin with ‘FxXx...’ or 
‘/fosb/test/AM1/bin/sun_sparc...’.) 

(Note: Execute all ‘kill’ commands on the higher- 
numbered processes first.) 

Double-check the list of processes on this User 
Station by entering the following once again: 

%: ps -ax 

There are no FOS processes on this User Station. 

13. Remove all endpoints on this User Station that 
still remain from the current session by entering 
the following in a cmdtool window: 

%: c d /fosb/test/am1/scripts/setup (test is 
alias) 

%: rm.sh 

The message ‘(0 rows affected)’ appears, indicating 
there are no endpoints on this User Station. 

14. Close all cmdtool windows by entering the 
following in these cmdtool windows. 

%: exit 

The cmdtool windows close. 
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15. Terminate this session by using the right mouse 
button to click on ‘Exit’ 

The user session terminates and a ‘login’ prompt 
appears. 

16. Data Server Shutdown test follows (No expected result/output; information only) 

17. User Station #1 -- Terminate all processes on the 
Data Server by entering the following in cmdtool 
window #2: 

%: MyKill 

(Wait for MyKill completion) 

User Station #1 -- MyKill is complete when a UNIX 
prompt is received from the Data Server 

18. User Station #1 -- In cmdtool window #2, view 
the processes on this server by entering the 
following: 

%: ps -ea 

Scan the resulting display for any FOS processes 
that might remain from the current session. If 
processes remain, terminate them unconditionally 
by entering the following: 

%: kill -9 <processid ... processid> 

(Note: 
‘ / f o sb / t e s t /AM1/b in / sun_spa rc . . . ’ ,  
‘TlmArchiver’.) 

(Note: Execute all ‘kill’ commands on the higher- 
numbered processes first.) 

Double-check the list of processes on this server 
by entering the following once again: 

%: ps -ea 

User Station #1 -- There are no FOS processes on this 
server 

FOS processes begin with ‘FxXx...’, 
o r  
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19. User Station #1 -- Remove all endpoints, on this 
server and the entire system, that still remain from 
the current session by entering the following in 
cmdtool window #2: 

%: c d /fosb/test/am1/scripts/setup (test is 
alias) 

%: rm_all.sh 

%: rm_all.sh 

User Station #1 -- The message ‘(0 rows affected)’ 
appears, indicating there are no endpoints on the system. 

20. User Station #1 -- Exit from the Data Server by 
entering the following in cmdtool windows #1 & 
#2: 

%: exit 

User Station #1 -- A UNIX prompt is received from the 
User Station 

21. User Station #1 -- Close all cmdtool windows by 
entering the following in these cmdtool windows. 

%: exit 

User Station #1 -- The cmdtool windows close 

22. User Station #1 -- Terminate this session by using 
the right mouse button to click on ‘Exit’ 

User Station #1 -- The user session terminates and a 
‘login’ prompt appears. 

23. End of test. 
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TLM-2020B Decom - Context Dependent Telemetry


Test Case No.: TLM 2020B 

Test Configuration: See Appendix G 

Test Support: Telemetry packet driver “packGen” supporting multiple APIDs, valid sequence counts, packet length, time 
stamp and telemetry data values. Previously defined alphanumeric display page “Context”, which includes all test and 
context key mnemonics. Housekeeping telemetry mnemonics defined in the I&T database with offsets matching those 
output by the telemetry data driver; test mnemonic TBS(1) contains 16 pre-defined switch ranges based on its key 
mnemonic TBS(2). Test mnemonic TBS(3) contains switch ranges based on a derived mnemonic (TBS(4)) value. A 
predefined value file that is used by the Telemetry packet generator to input raw values for each test mnemonic and its 
representative key/derived parameter calculation. 

Test Case Description: 

This test is designed to verify the ability of the FOS to automatically compute values of specified mnemonics based on 
context key mnemonics, whether the key be a discrete mnemonic key or derived parameter mnemonic. 

Following sign-on, an alphanumeric telemetry page which includes EU conversion values for mnemonics and their context 
keys (both discrete and derived parameter keys) is invoked at the user station. The telemetry data driver is initiated, 
broadcasting housekeeping telemetry onto the FOS LAN in the form of EDUs. As telemetry packets are received and the 
telemetry information decommutated, telemetry displays are viewed and snapped at specified times. These specified times 
coincide with EU changes initiated by the telemetry packet generator for specified mnemonic keys. Steps are then provided 
to ensure that when context keys are static or marked with bad quality, the output value of associated mnemonics are also 
marked as static. 

Success Criteria: 

This test is considered successful when all EU converted values as shown on the display page match EU values from 
specified EU algorithm information when the context key value is applied, for both discrete parameters and derived 
parameter input. All context-associated mnemonics providing input to EU specifications, when marked as bad quality or 
static, result in static condition for the output mnemonics. 

Step Id Action Expected Result/Output Pass/ 
Fail 
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1. Log onto an EOC workstation. 

Start the Data Server. Reference Test Case 
SYS2000B -- FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. Reference Test Case 
SYS2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

3. Log onto an FOT User Station. 

Start the User Station. Reference Test Case 
SYS2010B -- User Station Startup and 
Authentication. 

The FOT User Station is running and the ‘Control 
Window’ is displayed. 

4. Bring up the Event Display. Select 
‘Event_Display’ from the control window tools 
menu. 

The ‘Event Display’ is up on the FOT User Station. 

5. At user station fose8oe, connect to a real-time 
operational string, take ground control and display 
the “Context” display page: 

ECL> STRING CONNECT 
STRING=100 
CONFIG=MIRROR 

ECL> TAKE GROUNDCONTROL 
STRING=100 

ECL> P Context 

Verify the following messages appear in the Event 
Display window: 

“Successfully connected to string 100”. 

“Workstation fose8oe Given Ground control 
Authority” 

Verify the Context alphanumeric display appears at 
the user station and the following are displayed: 
Mnemonic TBS(1) and its context key TBS(2).
Mnemonic TBS(3) and its context derived
parameter key TBS(4) and SDU_PACKET_SEQ. 
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6. EU based on Context Key: 

At the real-time server, invoke the EDOS telemetry 
driver for the multicast of Housekeeping telemetry 
packets for processing. 

a. In a new terminal window, enter the following: 

%: cd /fos/test/am1/scripts/setup 

%: source packGenEnvVars 

%:cd/fos/test/am1/bin/sun_sparc_5-5 

%: packGen 

Enter tlm type: am1-hk 

At the packGen prompt enter the following: 

IP address = 225.2.7.00 

Port number = 20000 

Number of packets to send: -1 

Packet delay in milliseconds: 8000 

Note: 

The file used by the packet generator will change 
the value of mnemonic TBS(1)’s context key 
(mnemonic TBS(2)), every major cycle, beginning 
with packet number TBS. 

Verify (after one master cycle) that each 
mnemonic’s “NODATA” and “STATIC” flag 
indicators no longer appear on any of the display 
pages and that the mnemonics are marked as active. 
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7. View the “Context” page and when packet TBS is 
received, snap the telemetry page by entering the 
following inside a terminal window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis to ensure the proper 
calculation of the EU value based on its context key. 
See table TLM2020B-1. 

8. Repeat step 9 for fifteen more iterations (i.e. every 
major cycle following the receipt of packet TBS). 

Note: the context key TBS(2) changes value each 
major cycle, causing TBS(1)’s equation value to 
change. 

The snaps are printed at the system printer. Collect 
the printouts for off-line analysis to ensure the 
proper calculations of the EU value of mnemonic
TBS(1) based on context key TBS(2). See Table 
TLM2020B-1. 

9. EU based on Context Key of Derived 
Parameter: 

The selected packet generator file will change the 
value of mnemonic TBS(3)’s EU context keyed 
derived parameter (TBS(4)) every master cycle 
starting at packet number TBS, but will keep 
mnemonic TBS(3) at a constant raw value setting. 

View the “Context” page and when packet TBS is 
received, snap the telemetry page by entering the 
following inside a terminal window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis to ensure the proper 
calculation of mnemonic TBS(3) based on its
context key TBS(4). See table TLM2020B-2. 

10. Repeat step 11 two more iterations (i.e. every major 
cycle following the receipt of packet TBS). 

Note: the derived parameter key result change 
should result in an EU value change for mnemonic 
TBS(3) each major cycle, beginning with packet 
number TBS. 

The snaps are printed at the system printer. Collect 
the printouts for off-line analysis to ensure the 
proper calculations of the EU value of mnemonic
TBS(3) based on its derived input of TBS(4). See 
Table TLM2020B-2. 
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11. Context Dependency for Bad Quality Key: 

Note: The packGenHKValues file will cause bad 
quality conditions for all mnemonics TBS(1)- 
TBS(4). 

Note: The selected packet generator file will 
change the value of mnemonic TBS(1)’s EU 
context key TBS(2) every master cycle starting at 
packet number TBS. 

12. View the Event Display page Verify that event message TBD is displayed stating
sequence error detection. 

13. View the “Context” page and when packet TBS is 
received, snap the telemetry page by entering the 
following inside a terminal window: 

%: snap 

The snap is printed at the system printer. Verify that 
all mnemonics are flagged with the Static and
Questionable Quality indicators. 

14. Repeat step 18 two more iterations (i.e. every major 
cycle following the receipt of packet TBS). 

Note: the derived parameter key result change 
should result in an EU value change for mnemonic 
TBS(3) each major cycle, beginning with packet 
number TBS. 

The snaps are printed at the system printer. Verify 
that mnemonics TBS(1) and TBS(3) are constant for
each snap iteration (i.e. calculation is not performed
due to questionable quality data). 
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15. Context Dependency - Static Key: 

Note: FREQ file set to skip packet TBS, which 
causes a STATIC condition for mnemonic 
TBS(1)’s context key (TBS(2)). 

Note: The selected packet generator file will 
change the value of mnemonic TBS(1)’s EU 
context key TBS(2) every master cycle starting at 
packet number TBS. 

View the Event Display page 

Verify that event message TBS event message is
displayed stating missing packet. 

16. View the “Context” page and when packet TBS is 
received, snap the telemetry page by entering the 
following inside a terminal window: 

%: snap 

The snap is printed at the system printer. Verify that 
mnemonics TBS(1) and TBS(2) are flagged with the
Static indicators. 

17. Repeat step 23 two more iterations (i.e. every major 
cycle following the receipt of packet TBS). 

The snaps are printed at the system printer. Verify 
that mnemonics TBS(1) and TBS(3) remain flagged
as STATIC and values on the display for these 
mnemonics do not change. 

18. Stop the telemetry driver by entering CTRL-C in 
the telemetry driver windows. 

19. Log off User Station. 

20. End of test. 
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TABLE TLM2020B-1

TBS(2) Key 

Value 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

TBS(1)EU 
Value TBS TBS TBS TBS TBS TBS TBS TBS TBS TBS TBS TBS TBS TBS TBS TBS 

TABLE TLM2020B-2

TBS(4) Key 

Value TBS TBS TBS 

TBS(3) 

EU Value TBS TBS TBS 
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TLM 2060B - Derived Parameter Processing


Test Case No.: TLM-2060B 

Test Configuration: See Appendix G 

Test Support: Telemetry packet driver “packGen” supporting multiple APIDs, valid sequence counts, packet length, time 
stamp and telemetry data values. Previously defined alphanumeric display pages “Header” and “DRParm”. Housekeeping 
telemetry mnemonics defined in the I&T database with offsets matching those output by the telemetry data driver. Fifty- 
five (55) derived parameters (TBS(1)…..TBS(55) and TBS(A)….TBS(G) which are defined using arithmetic operators 
(addition, subtraction, negation, multiplication, division, sine, arcsine, cosine, arccosine, tangent, and arctangent). 

Test Description: 

This test is designed to verify the FOS’s capability of processing spacecraft/instrument Housekeeping data via special 
computations using predefined algorithms. These simple calculations will be done via derived parameters. Derived 
parameters are built by combining existing parameters via arithmetic or logical functions. It will be possible to use 
predefined analog, discrete, constant, or other derived values as a source to build a new derived parameter. 

Following sign-on, alphanumeric telemetry pages which include parameter and associated parameter Decom value displays 
are invoked at the user station. The telemetry data driver is initiated, broadcasting Housekeeping telemetry onto the FOS 
LAN in the form of EDU’s. As telemetry packets are received and the telemetry information decommutated, telemetry 
displays are viewed and snapped at specified times. Parameter values residing on alphanumeric displays are analyzed post- 
test to ensure derived parameter values match scripted values for specific mnemonics. 

Success Criteria: 

The test is considered successful when all Housekeeping mnemonics are decommutated and calculated as specified and 
match data driven values; values as seen on multiple user stations match data driven values; and static and NODATA flags 
are disabled from alphanumeric telemetry displays upon active data periods. 

Step Id Action Expected Result/Output Pass/ 
Fail 
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1. Log onto an EOC workstation. 

Start the Data Server. Reference Test Case 
SYS2000B -- FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. Reference Test Case 
SYS2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

3. Log onto an FOT User Station. 

Start the User Station. Reference Test Case 
SYS2010B -- User Station Startup and 
Authentication. 

The FOT User Station is running and the ‘Control 
Window’ is displayed. 

4. Bring up the Event Display. Select 
‘Event_Display’ from the control window tools 
menu. 

The ‘Event Display’ is up on the FOT User Station. 

5. Connect to a real-time operational string, to accept 
Health & Safety data, by entering the following in 
the ECL directive line of the Control window: 

ECL>STRING CONNECT STRING=100 
CONFIG= MIRROR 

ECL>TAKE GROUNDCONTROL 
STRING=100 

The following message will appear in the Event
Display window: 

“Successfully connected to string 100”. 
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6. At the user station, display the EDU Header and 
“DRParm” alphanumeric pages which displays 
telemetry header field values by entering the 
following: 

ECL>P Header 

ECL>P DRParm 

Verify the Header window appears at the user station 
and contains the following fields: 

Mnemonic descriptors
Static flags for all descriptors 
NODATA flags for all descriptors 
Spacecraft time (SDU_SCTIME)
Data source (spacecraft ID) (EDS_SCID)
Quality indicator (EDS_QUALITY)
APID number (SDU_PCKT_APID)
Packet sequence count 

SDU_PACKET_SEQ)
Packet length count 

(SDU_PCKT_LENGTH)
CCSDC Version (SDU_CCSDS_VER) 

Verify the “DRParm” display appears at the user 
station and contains the following: 

Mnemonics TBS(1)…..TBS(7)
Mnemonics TBS(A)….TBS(G) 

7. Disable the limit notification messages for all 
parameters by entering the following in the ECL 
directive line of the Control window: 

ECL> LIMITS ALL MESSAGE=OFF 

A message TBS will appear in the Event Display 
window stating that all limit messages have been 
turned off. 
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8. Invoke the EDOS telemetry driver for the multicast 
of Housekeeping telemetry packets for processing. 

In a new terminal window, enter the following: 

%: cd /fos/test/am1/scripts/setup 

%: source A2tlmEnvVars 

%: cd /fos/test/am1/bin/sun_sparc_5-5 

%: A2tlm 

Enter tlm type: am1-hk 

At the A2tlm prompt enter the following: 

IP address = 224.2.7.20 

Port number = 20000 

Number of packets to send: -1 

Packet delay in milliseconds: 8000 

Verify that the following message appears on the 
screen: 

“%s Decom: Ready to receive telemetry packets.” 

Verify that telemetry begins to flow. 

9. View the real-time server and when packet V is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

All mnemonics will be marked “NODATA” and 
“STATIC” flag indicators will appear the display 
page. 
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10. View the real-time server and when packet W is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. 
printout for off-line analysis. 

Mnemonics TBS(1), TBS(3), TBS(4) and 
“NODATA” and “STATIC” flag indicators no 
longer appear on the “DRParm” display page and the
mnemonics are marked as active. 

All other 
TBS(7), TBS(A), TBS(B), TBS( C), TBS (D), 
be marked 
indicators will 

11. View the real-time server and when packet X is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. 
printout for off-line analysis. 

The Housekeeping mnemonics TBS(5), TBS(6),
TBS(7), TBS(B), and TBS( C)‘s “NODATA” or
“STATIC” flag indicators no longer appear on the 
display page and the mnemonics are marked as
active. 

The Housekeeping mnemonics TBS(2), TBS(A),
TBS(D), TBS(E) and TBS(G)’s “NODATA” and
“STATIC” flag indicators will 
display page. 

12. View the real-time server and when packet Y is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. 
printout for off-line analysis. 

All Housekeeping mnemonics “NODATA” or
“STATIC” flag indicators no longer appear on the 
display page and all mnemonics are marked as
active. 

Collect the 

TBS(F)’s

TBS(2), TBS(5), TBS(6),mnemonics 
will 

“NODATA” and “STATIC” flag 
appear the display page. 

Collect the 

still appear on the 

Collect the 
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13. View the real-time server and when packet Z is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis. 

14. Via offline analysis, verify that mnemonics
SDU_SCTIME, EDS_SCID, EDS_QUALITY, 
SDU_PCKT_APID, SDU_PCKT_LENGTH, 
SDU_CCSDS_VER, and SDU_PACKET_SEQ as 
shown on screen snaps of the user station match
values specified in Table TLM2060B-1. 

The mnemonics, as shown on the screen snaps of the
user station, will match the values specified in Table
TLM2060B-1. 

15. Via offline analysis, verify that the Housekeeping 
telemetry mnemonics, as shown on screen snaps of 
the user station, match values specified in Table
TLM2060B-1. 

The Health & Safety telemetry mnemonic TBS(2),
as shown on screen snaps of the user station, will 
match values specified in Table TLM2060B-1. 

16. Disabling of Derived Processing 

Disable the derived parameter processing by 
entering the following in the ECL directive line of 
the Control window: 

ECL> DERIVED TBS(F)=0 

A message TBS will appear in the Event Display 
window stating that derived parameter processing for 
mnemonic TBS(F) has been disabled. 

17. View the real-time server and when packet V is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect 
the printout for off-line analysis. 
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18. View the real-time server and when packet W is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis. 

19. View the real-time server and when packet X is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis. 

20. View the real-time server and when packet Y is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis. 

21. View the real-time server and when packet Z is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis. 

22. Via offline analysis, verify that mnemonics
SDU_SCTIME, EDS_SCID, EDS_QUALITY, 
SDU_PCKT_APID, SDU_PCKT_LENGTH, 
SDU_CCSDS_VER, and SDU_PACKET_SEQ as 
shown on screen snaps of the user station match
values specified in Table TLM2060B-2. 

The mnemonics, as shown on the screen snaps of the
user station, will match the values specified in Table
TLM2060B-2. 
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23. Via offline analysis, verify that the Housekeeping 
telemetry mnemonics, as shown on screen snaps of 
the user station, match values specified in Table
TLM2060B-2. 

The Health & Safety telemetry mnemonic TBS(2),
as shown on screen snaps of the user station, will 
match values specified in Table TLM2060B-2. 

24. Derived Processing Interval Adjustment 

Adjust the evaluation/update rate of mnemonic 
TBS(F) by entering the following in the ECL 
directive line of the Control window: 

ECL> DERIVED TBS(F)=30 

A message TBS will appear in the Event Display
window stating that interval for derived parameter
re-evaluation for mnemonic TBS(F) has been set to
30 seconds. 

25. View the real-time server and when packet W is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis. 

26. View the real-time server and when packet X is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis. 

27. View the real-time server and when packet Y is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis. 
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28. View the real-time server and when packet Z is 
sent, snap the telemetry page DRParm at the user 
station by entering the following inside the console 
window: 

%: snap 

The snap is printed at the system printer. Collect the 
printout for off-line analysis. 

29. Via offline analysis, verify that mnemonics
SDU_SCTIME, EDS_SCID, EDS_QUALITY, 
SDU_PCKT_APID, SDU_PCKT_LENGTH, 
SDU_CCSDS_VER, and SDU_PACKET_SEQ as 
shown on screen snaps of the user station match
values specified in Table TLM2060B-3. 

The mnemonics, as shown on the screen snaps of the
user station, will match the values specified in Table
TLM2060B-3. 

30. Via offline analysis, verify that the Housekeeping 
telemetry mnemonics TBS(1), TBS(4), and
TBS(F), as shown on screen snaps of the user 
station, match values specified in Table
TLM2060B-3. 

The Health & Safety telemetry mnemonic TBS(2),
as shown on screen snaps of the user station, will 
match values specified in Table TLM2060B-3. 

31. Attempt to adjust the evaluation/update rate of
mnemonic TBS(F) to less than (1) spacecraft clock
second by entering the following in the ECL 
directive line of the Control window: 

ECL> DERIVED TBS(F)=.5 

An event message TBS appears on the Event display
window stating that (.5) is not a valid interval value. 

32. Exit the telemetry driver by entering CTRL-C in
the console window where the Telemetry driver
was running. 

33. Log off the user station(s). 
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CONT-2030B-SSR Monitoring


Test Case No.: CONT- 2030B 

Test Configuration: See Appendix G 

Test Support: Telemetry Simulator, FtPgPackGen, for generating AM-1 Housekeeping telemetry packets, UPD simulator, 
upd and RcmClient, for simulating messages from the NCC. RT Works to display SSR Buffer Management. Resource 
Model, SSR Updater, Communication Contact Scheduler, Timeline, and General Scheduler for test preparation. 

Test Case Description: This test is designed to show that the AM-1 Solid State Recorder (SSR) buffers can be monitored in 
real-time by the SSR Manager. The SSR Manager will detect and handle RF failures, via UPD messages that report the 
status of the buffers at the end of each contact. That notification will be provided when a user attempts to schedule science 
data collection activities that cause an overflow of any of the SSR buffers. In addition, S/C data volume will be monitored 
by the planning and scheduling software along with predictions of the SSR buffer status based on science collection 
activities. It is designed to show that the capability exists to change the SSR buffer playback order of the science data 
instruments. SSR Manager shall provide an analysis window that contains buffer pointers, buffer status, playback state and 
RF failures. 

Following sign-on, The system will be brought up. The AM-1 Telemetry, the UPD data will be started to run on the system. 
As the different segments of the data pass through the system, requirements will be verified by the displays and expected 
behavior of the system. The system will then be brought down. 
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Success Criteria: This test is considered successful when the SSR Manager has the capability to: 

• monitor the SSR buffer status in real-time, detect RF failures, and report the state for such failures 

• report and verify the status of the SSR buffer at the end of each contact 

• accept NCC User Performance Data (UPD) and 

• recommend recovery procedures to correct for and RF link faults 

• display updated SSR buffer status 

• change the SSR buffer playback order of the science data instruments 

• display a window that contains buffer pointers, buffer status, playback state, and RF failures 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log in to an EOC user station, using the UNIX 
login procedure, by entering a valid User Name and 
Password: 

Username: fostest2 

Password: XXXXXX 

The login is accepted and a blank desktop area 
appears. 

2. Start the Data Server. 
SYS2000B—FOS Server Startup 

Data Server Processes are running. 

3. Start the Real-Time Server. 
SYS2000B—FOS Server Startup 

Real-Time Server Processes are running. 

Reference Test Case 

Reference Test Case 
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4. Start the User Station. Reference Test Case 
SYS2010B—User Station Startup and 
Authentication. 

The FOT User Station is running and the ‘Control 
Window’ is displayed. 

5. Invoke the Event Display by selecting Event 
Display Global from the tools menu. 

(Wait for completion of Real-Time Server startup 
script before going to the next step.) 

The Event Display window appears on the EOC user 
station 

Real-Time Server startup script is complete when the
following message appears on the Event Display: 

‘String 100 was created’ 

6. Connect to the default real-time operational string
by entering the following in the ECL directive line 
of the Control Window: 

ECL>STRING CONNECT STRING=100 

CONFIG=MIRROR 

(Wait for string connection to complete before 
going to the next step) 

The following event message appears within several
minutes of entering the ‘CONNECT’ directive: 

‘Successfully connected to String 100’ 

7. Take groundcontrol and command control by
entering the ECL directives: 

ECL>TAKE COMMAND STRING=100 

ECL>TAKE GROUNDCONTROL 
STRING=100 

8. Request NCC UPD messages from the upd
simulator by entering the following directive: 

ECL>NCC UPD ENABLE 

The UPD driver does not send UPDs until both the 
Enable directive and UPD driver configuration is 
performed. UPD driver configuration will 
performed in step 23. 

9. Open the Master Plan using FPTlTimeline. Open the Master Plan for a whole day. 
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10. Arrange the resources displayed on the timeline in 
order to aid test execution. Specifically, display 
TDRS In-View periods, AM1 Communications 
resource, K-Band Downlink resource, AM1 SSR 
resource along with SSR buffers. 

11. Define activity for K-band down-link. From the 
Activity Definer tool select <file>, <new>, enter an 
activity name, select appropriate resource <AM1 
K-Band SA Downlink>, select <OK>, select 
<Modify> and enter ‘S00’ for the NCC CODE. 
Save the activity. 

An event message will be displayed stating the new 
activity was successfully created. 

12. Define an activity for AM1 Communications. From 
the Activity Definer tool select <file>, <new>, 
enter an activity name, select appropriate resource 
<AM1 Communications>, select <OK>, select 
<Modify - Complex Activity>, choose <Resource 
Selection> and select activity defined in step 11. 
Set Start and Stop Times to +15 and -15 seconds, 
respectively. Click <Add> and <Ok>. Select 
<Modify> and enter ‘S01’ for the NCC CODE. 
Save the activity. 

An event message will be displayed stating the new 
activity was successfully created. 

13. Define activities to place Science Instruments in 
Data Collection Mode. From the Activity Definer 
tool select <file>, <new>, enter an activity name, 
select appropriate resource (e.g. AM1 MODIS 
Formatter), 

An event message will be displayed stating the new 
activity was successfully created. 
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14. Using the FpGsGeneralScheduler, schedule the 
activities from step 13, which will cause a buffer 
overflow. Save the Master Plan. 

Make sure the activity schedules will make the SSR
Buffer overflow. 

15. Verify that the resource model recalculates the 
predicted buffer volumes and displays the changes 
on the timeline. Verify that the timeline turns color 
to indicate the buffer overflow condition. Use 
FpRmResourceModel and FpTlTimeline. 

This demonstrates the ability of the software to
notify the user when he attempts to schedule science
data collection activities that cause overflow of any 
of the buffers. 

16. Using the Communications Contact Scheduler, 
schedule 7 contact sessions. Save the Master Plan. 

17. Verify that the resource model recalculates the 
predicted buffer volumes and displays the changes 
reflecting SSR Buffer Playback activities on the 
timeline. 

18. Start RTworks dataserver using the ECL directive: 

ECL>EA ENABLE STRING=100 

This steps starts a dataserver which provides the 
link for passing data between the FOS Applications 
and the RTworks Application. 

19. From the FUI Environment Control window.
Select Tools, select SSR Display and then select 
ssr_top Verify that the SSR monitor pages are
displayed. 

20. From an Xterm window run the SSRStartUp script
out of scripts directory. 

This starts the SSR Manager. 

21. Verify receipt of buffer predicts from PAS, SSR
Updater. 

This can be verified through SSR Manager’s display 
window. 

22. Verify the SSR Dump Command request is created
and sent to the FUI command request window. 

This will occur before AOS is scheduled. Currently 
this time is set to 30 seconds. 
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23. Look at thecommand requests. 

24. At AOS start the UPD simulator. See RcmClient 
usage instructions. 

Use nominal data in TABLE CONT-2030B-2
column 1. 

25. At AOS start sending simulated AM1 HK data 
using FtPgPackGen. See FtPgPackGen usage 
instructions. 

Use mnemonics in TABLE CONT-2030B-1
column1. This nominal data with no errors. 

26. Send the first SSR Buffer Dump Command request 
be clicking the ‘SEND’ button on the FUI 
Command Request Window. 

27. Using FtPgPackGen, adjust telemetry mnemonic 
values to simulate the dumping of this SSR Buffer. 

See FtPgPackGen usage instructions for details on 
how to perform this step. The mnemonic to be
adjusted is TBD and should take values in the range 
of nn to mm. This will be determined at run-time, by
examining the buffer dump requests. 

28. View the RTworks display page. All readings should be nominal for this case. Verify
that the SSR Manager has a display that contains 
buffer pointers, buffer status, playback state, 
information about RF failures and information about
recovery from data dropout. 

29. Upon completion of the first Buffer Dump 
Command request, send the second request. 

30. Using FtPgPackGen, adjust telemetry mnemonic 
values to simulate the dumping of this SSR Buffer. 

See FtPgPackGen usage instructions for details on 
how to perform this step. The mnemonic to be
adjusted is TBD and should take values in the range 
of nn to mm. This will be determined at run-time, by
examining the buffer dump requests. 
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31. View the RT Works display page. All readings should be nominal for this buffer
playback. Verify that the SSR Manager has a display 
that contains buffer pointers, buffer status, playback 
state, information about RF failures and information
about recovery from data dropout. 

32. Upon completion of the second Buffer Dump 
Command request, send the third request. 

33. Using FtPgPackGen, adjust telemetry mnemonic 
values to simulate the dumping of this SSR Buffer. 

See FtPgPackGen usage instructions for details on 
how to perform this step. The mnemonic to be
adjusted is TBD and should take values in the range 
of nn to mm. This will be determined at run-time, by
examining the buffer dump requests. 

34. View the RT Works display page. All readings should be nominal for this buffer
playback. 

35. Upon completion of the third Buffer Dump 
Command request, send the fourth request. 

36. Using FtPgPackGen, adjust telemetry mnemonic 
values to simulate the dumping of this SSR Buffer. 

See FtPgPackGen usage instructions for details on 
how to perform this step. The mnemonic to be
adjusted is TBD and should take values in the range 
of nn to mm. This will be determined at run-time, by
examining the buffer dump requests. 

37. View the RT Works display page. All readings should be nominal for this buffer
playback. 

38. Allow to continue till LOS. 

39. Verify upon completion of the S/C contact SSR 
buffer actuals are sent to PAS. 

SSR Updater will compare actuals to predicts. 
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40. Verify that SSR Updater makes a correction to the 
SSR Buffer graphs on Timelines. 

This correction will be for the amount that the
predicts differed from the actuals. 

41. Leave the system up and verify that the SSR 
Management tool requests the buffer predicts for 
the next contact session and creates the SSR Dump 
Command Request. 

This will occur prior to the AOS of the next AOS. 
Currently this time is set to 5 minutes. 

42. Bring down the FtPgPackGen 

43. Stop the flow of the NCC UPD messages by 
entering the following directive: 

ECL>NCC UPD DISABLE 

44. Repeat steps 19 - 42 except use UPD data that 
indicates the RF link was broke. Use the UPD data 
in Table CONT-2030B-2 column 2. 

The SSR monitor should indicate that there was an
RF link failure and should provide a recovery 
procedure. The appropriate recovery procedure 
should be a message indicating that NCC UPD data
detects a data dropout, the recommended recovery
procedure is to contact the NCC to determine the
cause of the problem.. 

45. Change the order of SSR Buffer playbacks by 
editing the following file: 
/net/data/giraffes/RTWORKS_SSR/bufferOrder.cfg 

46. Repeat steps 19 - 42. Look at the command requests they should be 
changed from the first test. Take a snap to verify this. 
Snap is printed at system printer. Collect for off-line 
analysis. 
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TABLE CONT-2030B-1

Telemetry Mnemonics Starting Value Low Value High Value Status 

CDH_NR_SSR1_LRSSSCN 
T 

1 - - Static 

CDH_NR_SSR1_MISSSCN 
T 

16 - - Static 

CDH_NR_SSR1_MODSSCN 
T 

27 - - Static 

CDH_NR_SSR1_ASTSSCN 
T 

49 - - Static 

CDH_NR_SSR1_TSHSSCN 
T 

1 - - Static 

CDH_NR_SSR1_SC0RECT 
R 

0 0 516 Increasing 

CDH_NR_SSR1_SC1RECT 
R 

0 0 516 Increasing 

CDH_NR_SSR1_SC2RECT 
R 

0 0 8256 Increasing 

CDH_NR_SSR1_SC3RECT 
R 

0 0 13932 Increasing 

CDH_NR_SSR1_SC4RECT 
R 

0 0 25284 Increasing 

CDH_NR_SSR1_SC0PBCT 
R 

CDH_NR_SSR1_SC0RECT 
R 

0 516 Decreasing 

CDH_NR_SSR1_SC1PBCT 
R 

CDH_NR_SSR1_SC1RECT 
R 

0 516 Decreasing 

CDH_NR_SSR1_SC2PBCT 
R 

CDH_NR_SSR1_SC2RECT 
R 

0 8256 Decreasing 

CDH_NR_SSR1_SC3PBCT 
R 

CDH_NR_SSR1_SC3RECT 
R 

0 13932 Decreasing 
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Telemetry Mnemonics Starting Value Low Value High Value Status 

CDH_NR_SSR1_SC4PBCT 
R 

CDH_NR_SSR1_SC4RECT 
R 

0 25284 Decreasing 

CDH_BR_SSR1_SCPB 0 0 1 Toggled 

Notes: The RECTR mnemonics are the recording buffers, they will increase at a slow rate throughout the SCS, but they will be 
reset to 0 at the beginning of the specific buffer playback. The PBCTR mnemonics are the playback buffer counters, they will be 
stable at 0 until the specific buffer is dumped, at which point it will take on the value of the RECTR mnemonic and begin 
decreasing at a moderate rate. The SCPB mnemonic is to indicate playback, 0 = off 1=ongoing, this will change values 
appropriately during test execution 

TABLE CONT- 2030B-3 
UPD Mnemonics Initial Value AOS Value LOS Value Error Value 

UPD_K2_STATUS 2 0 2 

UPD_K2_DATA_VALIDITY 0 0 0 

UPD_K2_I_LOCK 0 1 0 

UPD_K2_I_SIG 12345 12345 12345 

UPD_K2_Q_LOCK 0 1 0 

UPD_K2_Q_SIG 23456 23456 23456 

UPD_K2_I_SYN_LOCK 0 1 0 

UPD_K2_Q_SYN_LOCK 0 1 0 

UPD_K2_I_BER 0 1 0 
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UPD Mnemonics Initial Value AOS Value LOS Value Error Value 

UPD_K2_Q_BER 0 1 0 

UPD_S1_STATUS 2 0 2 

UPD_S1_DATA_VALIDITY 0 0 0 

UPD_S1_1_RCVR 0 1 0 

UPD_S1_1_SIG 12345 12345 12345 

UPD_S1_ILOCK 0 1 0 

UPD_S1_QLOCK 0 1 0 

UPD_S1_IBER 1 1 1 

UPD_S1_QBER 1 1 1 
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Database Management via Web Pages Test Procedure


Test Case No: DBS-3100FPB 

Test Configuration:  See Appendix G 

Test Support:  A web browser (Netscape) 

Test Description: 

This test is designed to verify DMS provides the user with the 
event Project Database (PDB) definitions that reside in the FOS database. 

Success Criteria: 

The success of this test is based on the user’s capability to edit FOS PDB definition files. b 
pages the user should be able to modify, add, or delete a command, telemetry, or event definition. 

Step 
Id 

Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Enter a user name and password. 

username: 

password: 

A desktop appears with a xterm window 

2. Initiate FOS Database Utilities (JAVA) through a 
web browser (Netscape). From the Unix prompt 
enter 

%netscape 

The Netscape home is displayed. 

and JAVA executables. 

capability to modify, add, or delete a command, telemetry, or 

Using the FOS Database Utility We
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3. Enter the following http address in the location 
text box: 

http://elmyra.hitc.com/db_util/db_util_dba.ht 
ml 

and press “Enter”. 

The FOS Database Utilities home page appears. 

4. Select the “Database Access” option to modify, 
delete or add a Telemetry definition. 

The FOS Database Edits web page appears. 

5. Click the mouse on “PDB Telemetry 
Definitions” 

The FOS Telemetry Parameters window appears. 

6. Type “MOP_WEB_TST” in the Telemetry 
Mnemonic field. 

Click on the “Find” button. 

Click on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in no match(es). 

7. Close the Parameter Search Results window. The window is closed. 
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8. Insertion of Parameters - Name/ID 

Enter the following data in the chosen fields in 
the FOS Telemetry Parameters window: 

Telemetry Mnemonic: 
MOP_WEB_TST1 

Parameter Type: A 

Parameter ID: 30001 

Description: Web Page Test1 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

Note:  Mnemonic MOP_WEB_TST1 is HK/EU 
Converted. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

9. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameters window. 

All fields in the FOS Telemetry Parameters window will 
become blank. 
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10. Enter the following data in the chosen fields in 
the FOS Telemetry Parameters window: 

Telemetry Mnemonic: 
MOP_WEB_TST2 

Parameter Type: A 

Parameter ID: 30002 

Description: Web Page Test2 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

Note:  Mnemonic MOP_WEB_TST2 is H&S with 
Red/Yellow Limits. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

11. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameters window. 

All fields in the FOS Telemetry Parameters window will 
become blank. 
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12. Enter the following data in the chosen fields in 
the FOS Telemetry Parameters window: 

Telemetry Mnemonic: 
MOP_WEB_TST3 

Parameter Type: A 

Parameter ID: 30003 

Description: Web Page Test3 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

Note:  Mnemonic MOP_WEB_TST3 is 
Standby/EU Converted with Red/Yellow Limits. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

13. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameters window. 

All fields in the FOS Telemetry Parameters window are 
empty. 
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14. Enter the following data in the chosen fields in 
the FOS Telemetry Parameters window: 

Telemetry Mnemonic: 
MOP_WEB_TST4 

Parameter Type: D 

Parameter ID: 30004 

Description: Web Page Test4 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

Note:  Mnemonic MOP_WEB_TST4 is a is a 
Discrete mnemonic with 5 states. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

15. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameters window. 

All fields in the FOS Telemetry Parameters window will 
become blank. 
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16. Enter the following data in the chosen fields in 
the FOS Telemetry Parameters window: 

Telemetry Mnemonic: 
MOP_WEB_TST5 

Parameter Type: A 

Parameter ID: 30005 

Description: Web Page Test4A 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

Note:  Mnemonic MOP_WEB_TST5 is a 
Mnemonic Used for Context Dependent 
mnemonics. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

17. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameters window. 

All fields in the FOS Telemetry Parameters window will 
become blank. 
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18. Enter the following data in the chosen fields in 
the FOS Telemetry Parameters window: 

Telemetry Mnemonic: 
MOP_WEB_TST5A 

Parameter Type: A 

Parameter ID: 30006 

Description: Web Page Test4B 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

Note:  Mnemonic MOP_WEB_TST5A is a 
Context Dependent mnemonic. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

19. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameters window. 

All fields in the FOS Telemetry Parameters window will 
become blank. 

4-305
 322-CD-100-001/ 
411-CD-100-001 



20. Enter the following data in the chosen fields in 
the FOS Telemetry Parameters window: 

Telemetry Mnemonic: 
MOP_WEB_TST5B 

Parameter Type: A 

Parameter ID: 30007 

Description: Web Page Test4C 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

Note:  Mnemonic MOP_WEB_TST5B is a 
Context Dependent mnemonic. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

21. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameters window. 

All fields in the FOS Telemetry Parameters window will 
become blank. 

4-306
 322-CD-100-001/ 
411-CD-100-001 



22. Enter the following data in the chosen fields in 
the FOS Telemetry Parameters window: 

Telemetry Mnemonic: 
MOP_WEB_TST5C 

Parameter Type: A 

Parameter ID: 30008 

Description: Web Page Test4D 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

Note:  Mnemonic MOP_WEB_TST5C is a 
Context Dependent mnemonic. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

23. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameters window. 

All fields in the FOS Telemetry Parameters window will 
become blank. 
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24. Enter the following data in the chosen fields in 
the FOS Telemetry Parameters window: 

Telemetry Mnemonic: 
MOP_WEB_TST5D 

Parameter Type: A 

Parameter ID: 30009 

Description: Web Page Test5 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

Note:  Mnemonic MOP_WEB_TST5D is a context 
Dependent Mnemonic. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

25. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameters window. 

All fields in the FOS Telemetry Parameters window will 
become blank. 

26. In the FOS Telemetry Parameters window: 

Enter “MOP_WEB” in the Telemetry 
Mnemonic field 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 9 match(es). 

Verify the results for the mnemonic MOP_WEB_TST1, 
MOP_WEB_TST2, and MOP_WEB_TST3 match those in 
Table DBS2030-1. 

27. In the Parameter Search Results window: 

Click the mouse on the Parameter 
“MOP_WEB_TST1”. 

The Mnemonic, and it’s associated fields become 
highlighted. 
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28. Click the mouse on the “Parameter Location” in 
the Parameter Search Results window. 

The FOS Telemetry Parameter Location window appears 
with the Telemetry Mnemonic and Parameter ID fields 
already completed. 

29. Insertion of Parameters - Location 

In the FOS Telemetry Parameter Location 
window, enter the following: 

Application Process Identifier: 1 
Cycle ID: 10 
Comp Size: 1 
Parameter ID: 30001 
Telemetry Instance: 1 
Comp Number: 1 
Packet Offset: 100 
Delta Time: 2 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 
Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 
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30. Repeat the prior step with the following 
information: 

Application Process Identifier: 1 
Cycle ID: 30 
Comp Size: 1 
Parameter ID: 30001 
Telemetry Instance: 1 
Comp Number: 1 
Packet Offset: 200 
Delta Time: 2 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

31. Repeat the prior step with the following 
information: 

Application Process Identifier: 1 
Cycle ID: 40 
Comp Size: 1 
Parameter ID: 30001 
Telemetry Instance: 1 
Comp Number: 1 
Packet Offset: 300 
Delta Time: 2 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 
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32. Repeat the prior step with the following 
information: 

Application Process Identifier: 1 
Cycle ID: 50 
Comp Size: 1 
Parameter ID: 30001 
Telemetry Instance: 1 
Comp Number: 1 
Packet Offset: 400 
Delta Time: 2 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 

Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

33. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameter Location 
Information window. 

Close the Parameter Search Results window. 

All fields in the FOS Telemetry Parameter Location 
Information window will become blank and the Parameter 
Search Results window is closed. 

34. FOS Telemetry Parameter Location Information 
window: 

Enter “MOP_WEB_TST1” in the Telemetry 
Mnemonic field. 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 4 match(es). 

Verify the results for the mnemonic MOP_WEB_TST1, 
match those in Table DBS2030-2. 
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35. Close the Parameter Search Results window. 

Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameter Location 
Information window: 

To Update the mnemonic MOP_WEB_TST1, 
Enter the following information in the FOS 
Telemetry Parameter Location Information 
window: 

Application Process Identifier: 1 
Cycle ID: 40 
Comp Size: 1 
Parameter ID: 30001 
Telemetry Instance: 1 
Comp Number: 1 
Packet Offset: 800 
Delta Time: 2 

Enter the specific password. (fosops) 

Click the mouse on the “Update” button. 

Click the mouse on the “Submit” button. 

The Parameter Search Results window will close. 

The event message “Update Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 
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36. Remove the mnemonic MOP_WEB_TST1 from 
telemetry packet 40 by entering the following in 
the FOS Telemetry Parameter Location 
Information window: 

Application Process Identifier: 1 
Cycle ID: 10 
Comp Size: 1 
Parameter ID: 30001 
Telemetry Instance: 1 
Comp Number: 1 
Packet Offset: 100 
Delta Time: 2 

Enter the specific password. (fosops) 

Click the mouse on the “Remove” button. 

Click the mouse on the “Submit” button. 

The event message “Removal Complete” will appear on 
the Info: line in the FOS Telemetry Parameters window. 

37. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameter Location 
Information window. 

Close the Parameter Search Results window. 

All fields in the FOS Telemetry Parameter Location 
Information window will become blank and the Parameter 
Search Results window is closed. 
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38. Enter the following information in the FOS 
Telemetry Parameter Location Information 
window: 

Telemetry Mnemonic: 
MOP_WEB_TST1 

Parameter ID: 30001 

Cycle ID: 10 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 0 match(es). 

39. Click the mouse on the “Cancel” button in the 
FOS Telemetry Parameter Location Information 
window. 

Close the Parameter Search Results window. 

The FOS Telemetry Parameter Location Information and 
the Parameter Search Results windows are closed. 

40. Limit Set Development 

FOS Telemetry Parameter Location Information 
window: 

Enter “MOP_WEB_TST2” in the 
Telemetry Mnemonic field. 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 0 match(es). 

41. Close the Parameter Search Results window. The Parameter Search Results window is closed. 
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42. In the Original Parameter Search Results window: 

Click the mouse on the Parameter 
“MOP_WEB_TST2”. 

The Mnemonic, and it’s associated fields become 
highlighted. 

43. Click the mouse on the “Red/Yellow Limits” 
button in the Parameter Search Results window. 

The FOS Telemetry Parameter Red/Yellow Limits 
Information window appears with the Telemetry Parameter 
ID and Telemetry Mnemonic fields filled in with the 
information corresponding to MOP_WEB_TST2. 

44. Click the mouse on the “Find” button in the Fos 
Telemetry Parameter Red/Yellow Limits 
Information window. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in no match(es). 

45. Create a Red/Yellow Limit set for the mnemonic 
MOP_WEB_TST2 by entering the following in 
the FOS Telemetry Parameter Red/Yellow Limits 
information: 

Limit Set: 1 
Dneu indicator: UI 
Red Low: 5 
Yellow Low: 10 
Yellow High: 15 
Red High: 20 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 
Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

46. Click the mouse on the “Clear Form” button. All fields in the FOS Telemetry Parameter Location 
Information window will become blank. 
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47. In the FOS Telemetry Parameter Red/Yellow 
Limits Information window, enter the following: 

Telemetry Parameter ID: 30002 

Telemetry Mnemonic: 
MOP_WEB_TST2 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 1 match(es). 

Verify the search results for the mnemonic 
MOP_WEB_TST2 Red/Yellow Limits Table DBS2030-4. 

48. Close the Parameter Search Results window that 
contains the Red/Yellow Limit set for 
MOP_WEB_TST2. 

The Parameter Search Results window is closed. 

49. Create a second Red/Yellow Limit set for the 
mnemonic MOP_WEB_TST2 by entering the 
following in the FOS Telemetry Parameter 
Red/Yellow Limits information: 

Limit Set: 2 
Dneu indicator: UI 
Red Low: 25 
Yellow Low: 50 
Yellow High: 75 
Red High: 100 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 
Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 
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50. Create a Third Red/Yellow Limit set for the 
mnemonic MOP_WEB_TST2 by entering the 
following in the FOS Telemetry Parameter 
Red/Yellow Limits information: 

Limit Set: 2 
Dneu indicator: UI 
Red Low: 25 
Yellow Low: 50 
Yellow High: 75 
Red High: 100 

Enter the specific password. (fosops) 

Click the mouse on the “Update” button. 
Click the mouse on the “Submit” button. 

The event message “Update Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

51. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameter Red/Yellow Limits 
Information window. 

All fields in the FOS Telemetry Parameter Location 
Information window will become blank. 

52. In the FOS Telemetry Parameter Red/Yellow 
Limits Information window, enter the following: 

Telemetry Parameter ID: 30002 

Telemetry Mnemonic: 
MOP_WEB_TST2 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 1 match(es). 
Verify the search results for the mnemonic
MOP_WEB_TST2 Red/Yellow Limits Table
DBS2030-4A. 

53. Click the mouse on the “Cancel” button in the 
Parameter Search Results window that contains 
the Red/Yellow Limit set for MOP_WEB_TST2. 

The Parameter Search Results window is closed. 
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54. Delete the third Red/Yellow Limit set by entering 
the following in the FOS Telemetry Parameter 
Red/Yellow Limits Information: 

Telemetry Parameter ID: 30002 
Telemetry Mnemonic: 
MOP_WEB_TST2 
Limit Set: 3 

Enter the specific password. (fosops) 

Click the mouse on the “Remove” button. 

Click the mouse on the “Submit” button. 

The event message “Removal Complete” will appear on 
the Info: line in the FOS Telemetry Parameters window. 

55. Click the mouse on the “Clear form” button in the 
FOS Telemetry Parameter Red/Yellow Limits 
Information window. 

All fields in the FOS Telemetry Parameter Location 
Information window will become blank. 

56. In the FOS Telemetry Parameter Red/Yellow 
Limits Information window, enter the following: 

Telemetry Parameter ID: 30002 
Telemetry Mnemonic: 
MOP_WEB_TST2 
Limit Set: 3 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 0 match(es). 

57. Click the mouse on the “Cancel” button in the 
FOS Telemetry Parameter Location Information 
window. 

Close the Parameter Search Results window. 

The FOS Telemetry Parameter Location Information and 
the Parameter Search Results windows are closed. 
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58. EU Conversion Insertion 

In the Original Parameter Search Results window: 

Click the mouse on the Parameter 
“MOP_WEB_TST3”. 

The Mnemonic, and it’s associated fields become 
highlighted. 

59. Click the mouse on the “Polynomial Coefficients” 
button in the Parameter Search Results window. 

The FOS Telemetry Parameter Polynomial Coefficients 
Information window appears. 

60. Click the mouse on the “Find” button in the FOS 
Telemetry Parameter Polynomial Coefficients 
Information window. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in no match(es). 

61. Create a Polynomial Conversion Equation for the 
mnemonic MOP_WEB_TST3 by entering the 
following in the FOS Telemetry Parameter 
Polynomial Coefficients Information window: 

Polynomial Number: 10 
Polynomial Name: Voltage 
Coefficient 0: 5.0 
Coefficient 1: - 2.11 
Coefficient 2: 3.67 
Coefficient 3: 2.4 
Coefficient 4: - 0.99 
Coefficient 5: - 0.01 
Coefficient 6: 4.1 
Coefficient 7: 6.9 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 
Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 
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62. In the Original Parameter Search Results window: 

Click the mouse on the Parameter 
“MOP_WEB_TST4. 

The Mnemonic, and it’s associated fields become 
highlighted. 

63. Create a Polynomial Conversion Equation for the 
mnemonic MOP_WEB_TST4 by entering the 
following in the FOS Telemetry Parameter 
Polynomial Coefficients Information window: 

Polynomial Number: 20 
Polynomial Name: Amperage 
Coefficient 0: 0.01 
Coefficient 1: 2.11 
Coefficient 2: - 3.1 
Coefficient 3: - 2.4 
Coefficient 4: 3.99 
Coefficient 5:  4.01 
Coefficient 6: - 2.1 
Coefficient 7: 0.11 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 
Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

64. In the FOS Telemetry Parameter Red/Yellow 
Limits Information window, enter the following: 

Telemetry Mnemonic: MOP_WEB 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 2 match(es). 
Verify the search results for the mnemonic
MOP_WEB_TST3 and MOP_WEB_TST4 match the
Table DBS2030-5. 
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65. Click the mouse on the “Cancel” button in the 
Parameter Search Results window that contains 
the Polynomial Coefficients for each mnemonic. 

The Parameter Search Results window is closed. 

66. Change the 3rd Coefficient in the polynomial 
conversion equation for MOP_WEB_TST3 by 
entering the following in the FOS Telemetry 
Parameter Polynomial Coefficients Information 
window: 

Polynomial Number: 10 
Polynomial Name: Voltage 
Coefficient 0: 5.0 
Coefficient 1: - 2.11 
Coefficient 2: 3.67 
Coefficient 3: 8.9 
Coefficient 4: - 0.99 
Coefficient 5: - 0.01 
Coefficient 6: 4.1 
Coefficient 7: 6.9 

Enter the specific password. (fosops) 

Click the mouse on the “Update” button. 

Click the mouse on the “Submit” button. 

The event message “Update Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

67. In the FOS Telemetry Parameter Red/Yellow 
Limits Information window, enter the following: 

Polynomial Number: 10 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 1 match(es). 
Verify the search results for the mnemonic match Table
DBS2030-5A. 
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68. Click the mouse on the “Cancel” button in the 
Parameter Search Results window that contains 
the Polynomial Coefficients for each mnemonic. 

The Parameter Search Results window is closed. 

69. Delete the Polynomial Conversion Equation by 
entering the following in the FOS Telemetry 
Parameter Polynomial Coefficients Information 
window: 

Polynomial Number: 20 

Enter the specific password. (fosops) 

Click the mouse on the “Remove” button. 

Click the mouse on the “Submit” button. 

The event message “Removal Complete” will appear on 
the Info: line in the FOS Telemetry Parameters window. 

70. Click the mouse on the “Clear form” button in the 
FOS Telemetry Parameter Red/Yellow Limits 
Information window. 

All fields in the FOS Telemetry Parameter Location 
Information window will become blank. 

71. In the FOS Telemetry Parameter Red/Yellow 
Limits Information window, enter the following: 

Polynomial Number: 20 
Polynomial Name:  Amperage 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 0 match(es). 

72. Click the mouse on the “Cancel” button in the 
FOS Telemetry Parameter Location Information 
window. 

Close the Parameter Search Results window. 

The FOS Telemetry Parameter Location Information and 
the Parameter Search Results windows are closed. 
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73. Insertion of Discrete Mnemonics 

In the Original Parameter Search Results window: 

Click the mouse on the Parameter 
“MOP_WEB_TST4”. 

The Mnemonic, and it’s associated fields become 
highlighted. 

74. Click the mouse on the “Discrete States” button in 
the Parameter Search Results window. 

The FOS Telemetry Parameter Discrete States Information 
window appears. 

75. Enter the following in the Telemetry Parameter 
ID field of the Telemetry Parameter Discrete 
States Information window: 

Telemetry Parameter ID: 30004 

Click the mouse on the “Find” button in the FOS 
Telemetry Parameter Polynomial Coefficients 
Information window. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in no match(es). 

76. Click the mouse on the “Cancel” button in the 
Parameter Search Results window that contains 
the Polynomial Coefficients for each mnemonic. 

The Parameter Search Results window is closed. 
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77. Create a Discrete State for the mnemonic 
MOP_WEB_TST4 by entering the following in 
the FOS Telemetry Parameter Discrete States 
Information window: 

Telemetry Parameter ID: 30004 
Telemetry Mnemonic: 
MOP_WEB_TST4 
Minimum Value: 0 
Maximum Value: 5 
State Text: ENABLED 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 
Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

78. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameter Discrete States 
Information window. 

All fields in the FOS Telemetry Parameter Discrete States 
Information window will become blank. 
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79. Create a 2nd Discrete State for the mnemonic 
MOP_WEB_TST4 by entering the following in 
the FOS Telemetry Parameter Discrete States 
Information window: 

Telemetry Parameter ID: 30004 
Telemetry Mnemonic: 
MOP_WEB_TST4 
Minimum Value: 6 
Maximum Value: 14 
State Text: OFF 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 
Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

80. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameter Discrete States 
Information window. 

All fields in the FOS Telemetry Parameter Discrete States 
Information window will become blank. 
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81. Create a 3rd Discrete State for the mnemonic 
MOP_WEB_TST4 by entering the following in 
the FOS Telemetry Parameter Discrete States 
Information window: 

Telemetry Parameter ID: 30004 
Telemetry Mnemonic: 
MOP_WEB_TST4 
Minimum Value: 15 
Maximum Value: 21 
State Text: DISABLED 

Enter the specific password. (fosops) 

Click the mouse on the “Add” button. 
Click the mouse on the “Submit” button. 

The event message “Insert Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

82. In the FOS Telemetry Parameter Discrete States 
Information window, enter the following: 

Telemetry Parameter ID: 30004 
Telemetry Mnemonic: 
MOP_WEB_TST4 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 3 match(es). 
Verify the search results for the mnemonic match Table
DBS2030-6. 

4-326
 322-CD-100-001/ 
411-CD-100-001 



83. Modify the Maximum Value and the State Text 
of the “DISABLED” state by entering the 
following in the Discrete States Information 
window: 

Telemetry Parameter ID: 30004 
Telemetry Mnemonic: 
MOP_WEB_TST4 
Minimum Value: 15 
Maximum Value: 30 

State Text: ALL_DISABLED 

Enter the specific password. (fosops) 

Click the mouse on the “Update” button. 

Click the mouse on the “Submit” button. 

The event message “Update Complete” will appear on the 
Info: line in the FOS Telemetry Parameters window. 

84. Click the mouse on the “Clear Form” button in 
the FOS Telemetry Parameter Discrete States 
Information window. 

All fields in the FOS Telemetry Parameter Discrete States 
Information window will become blank. 

85. In the FOS Telemetry Parameter Discrete States 
Information window, enter the following: 

Telemetry Parameter ID: 30004 
Telemetry Mnemonic: 
MOP_WEB_TST4 

Click the mouse on the “Find” button. 

Click the mouse on the “Submit” button. 

Results of Find criteria will be displayed on the screen in 
the Parameter Search Results window. 

The search will result in 1 match(es). 
Verify the search results for the mnemonic match Table
DBS2030-6A. 

4-327
 322-CD-100-001/ 
411-CD-100-001 



86. Click the mouse on the “Cancel” button in the 
FOS Telemetry Parameter Discrete States 
Information window. 

Click the mouse on the “Cancel” in the Parameter 
Search Results window. 

The FOS Telemetry Parameter Location Information and 
the Parameter Search Results windows are closed. 

87. Insertion of Context Dependent Mnemonics 

In the Original Parameter Search Results window: 

Click the mouse on the Parameter 
“MOP_WEB_TST5”. 

The Mnemonic, and it’s associated fields become 
highlighted. 

88. Click the mouse on the “Context” button in the 
Parameter Search Results window. 

The FOS Telemetry Parameter Context Information 
window appears. 

89. End of test. End of test. 
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FDF3100FPB - Disk Cleaner


Test No.: FDF-3100FPB 

Test Title: Disk Cleaner 

Test Support:  A test script containing data files (which are older than 30 minutes) in directories such as tlmarchive, 
in database tables (file_meta, fos_Event_Archive) which are older than 30 minutes. 

Test Description: This test is designed to verify the ability delete files and/or change their status in the database tables which have 
been moved to long-term storage. 

Following sign-on, files are entered into the directories and tables to be cleaned. n verified 
that all directories have been cleaned out and database tables have been updated to reflect the status of the files in the script. 

Success Criteria: This test is considered successful when all files have been cleaned from the directories and all database tables 
have been updated. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. 
SYS2000B -- FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. 
SYS2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

3. Enter the following in an X-term window: 

% setenv TEST_DISK to 900 

% setenv FDDC_TIMEOUT to 1800 

and entries 

It is theDisk cleaner is then initiated. 

Reference Test Case 

Reference Test Case 
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4. Enter the following in an X-term window: 

%FdDbDiskCleaner 

Disk Cleaner will begin to clean directories and tables. 

5. Verify through sybase that file_meta and 
fos_Event_Archive have been updated and/or 
cleaned out. 

Files older than 15 minutes will be deleted and/or updated 
in file_meta. 

6. Verify in each directory listed in table FDF- 
3100FPB(1) that all files older than 15 minutes 
have been cleaned out. 

All files older than 15 minutes will no longer be in the
directory. 

7. Log off the user station(s). 

8. End of Test 
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Roles Usability Test Procedure


Test Case No:  FUI-3000FPB 

Test Configuration:  See Appendix G 

Test Support: Powered-up FOS servers; EOC LAN; EOC user station; emulated IST; and FOS Server and User Station startup 
scripts. 

Test Case Description: 

This test is designed to verify that user roles are enforced for five FOS tools, i.e., Command Control Window, Command 
Request, RTS Load Builder, Binary Load Builder, and Room Builder. The ‘user_roles’ database table is edited, as necessary, to 
restrict an IST user to ‘Read-Only’ privileges and to provide an EOC user the privileges associated with various user roles. The 
user specifies the ‘Read-Only’ role as part of the FOS login process, brings up the IST and EOC user station, and then attempts 
to use 12 FOS (including 7 Planning & Scheduling) tools for which user roles enforcement is intended. The privileges for each 
user role are pre-defined in the ‘/fosb/test/am1/config/RoleTask’ file, which is the basis for determining the ability/inability to 
create, generate, save, or schedule using these tools. The user selects the ‘Roles’ button from the Control Window and selects a 
different role, then attempts to use the FOS tools as before. This process is repeated for each user role. 

Note: Since Planning & Scheduling tool privileges are limited to PAS Scheduler and PAS Definer roles, these tools are 
exercised for the Read-Only, PAS Scheduler, and PAS Definer roles. Also, since the Read-Only role has the most limited 
privileges, it is selected prior to most other user roles to ensure that privileges are correctly enforced upon each role change (and 
not carried over from the previous role selection). 

Success Criteria: 

This test is successful when an IST site can be restricted to ‘Read-Only’ privileges; and user roles are correctly enforced for 12 
FOS tools (Command Control Window, Command Request, RTS Load Builder, Binary Load Builder, Room Builder, Activity 
Definer, BAP Definer, Activity Recycler, Constraint Definer, General Scheduler, Contact Scheduler, and Load Generator) as 
they apply to eight user roles (Command Activity Controller, Data Base Administrator, Generic User, Instrument Controller, 
Operations Controller, Read-Only, PAS Scheduler, and PAS Definer). 
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Step Id Action Expected Result/Output Pass/ 
Fail 

1. EOC -- Log in to an EOC user station, using 
UNIX login procedure, by entering User Name 
and Password 

Username: <EOC user name> 

Password: ******** 

The login is accepted and two UNIX cmdtool windows 
appear 

2. IST -- Log in to an emulated IST, using UNIX 
login procedure, by entering User Name and 
Password 

Username: <IST user name> 

Password: ******** 

The login is accepted and two UNIX cmdtool windows 
appear 

3. User Roles Setup (IST & EOC) (No expected result/output; information only) 
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4. EOC -- Display the database table containing user 
roles information by entering the following in a 
cmdtool window: 

%: isql -Ufos_dba -Pfos_dba (sql is alias) 

1> use am1_fos_ops 

2> go 

1> select * from user_roles where 
user_name=‘<IST user name>‘ 

2> select * from user_roles where 
user_name=‘<EOC user name>‘ 

3> go 

Note carefully the current contents of the 
user_roles table prior to making deletions in the 
next step, since the user-roles table will be reset to 
its former contents at the end of this test. 

The rows that apply to these IST and EOC user names in 
the ‘user_roles’ database table are displayed 
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5. Note carefully the current contents of the 
user_roles table prior to making deletions in this 
step, since the user-roles table will be reset to its 
former contents at the end of this test. 

EOC -- Search the user_roles table to see if the 
logged on IST and EOC user names have any 
privileges. 

Enter the following sql commands, as necessary: 

1> delete from user_roles where 
user_name=’<IST user name>‘ 

2> delete from user_roles where 
user_name=’<EOC user name>‘ 

3> go 

1> select * from user_roles where 
user_name=’<IST user name>‘ 

2> select * from user_roles where 
user_name=’<EOC user name>‘ 

3> go 

The ‘user_roles’ database table is updated and 
displayed. 
are included. 

Delete these rows. 

No rows for these IST and EOC user names 
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6. EOC -- Update database table for this user name 
for the Read-Only role at the IST. 
following sql commands: 

1> insert into user_roles values (‘<IST 
user name>‘, 1, 0, 0, 1, ‘<IST host>‘) 

2> go 

1> select * from user_roles where 
user_name=’<IST user name>‘ 

2> go 

The ‘user_roles’ database table is updated and 
displayed. 
name at the IST. 

7. EOC -- Update database table for this user name 
for 6 roles (user_type) at the EOC (Command 
Activity Controller and Operations Controller 
excluded). 

1> insert into user_roles values (‘<EOC 
user name>‘, 1, 2, x, 1, ‘<EOC user 
station>‘) 

Note: 

Repeat this insert command for all 6 user roles. 

7> go 

1> select * from user_roles where 
user_name=’<EOC user name>‘ 

2> go 

The ‘user_roles’ database table is updated and 
displayed. 
name at the EOC (Command Activity Controller and 
Operations Controller excluded). 

8. FOS Server, EOC User Station, and IST 
Startup 

(No expected result/output; information only) 

Enter the It includes Read-Only privileges for this user 

Enter the following sql commands: 

x is 0, 1, 3, 4, 6, 7. 

It includes 6 roles (user_type) for this user 

4-335
 322-CD-100-001/ 
411-CD-100-001 



9. Note: 
Server is not up. 

EOC -- Execute applicable portions of the ‘FOS 
Server and User Station Startup and Shutdown’ 
test procedure (SYS-2000B) to bring up FOS Data 
Server. 

(Wait for initialization of the Data Server to 
complete before going to the next step) 

The FOS Data Server is properly initialized 

10. EOC -- Execute applicable steps of the ‘FOS 
Server and User Station Startup and Shutdown’ 
(SYS-2000B) test procedure to bring up an EOC 
user station. 

In the User Roles window, select ‘Read-Only’. 

(Wait for completion of user station startup) 

User station startup is complete when the Control 
Window comes up 

11. IST -- Bring up an emulated IST by entering the 
following in a cmdtool window: 

%: cd /data/fos/ist/am1/scripts/setup (setup 
is alias) 

%: IST_LOGIN & 

In the User Roles window, select ‘Read-Only’. 

(Wait for initialization to complete before 
proceeding to the next step) 

The IST is initialized when the Control Window 
appears. 

This step is necessary only if the Data 
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12. EOC & IST -- Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display- 
Global’ 

The ‘Tools’ menu comes up, then closes. 

The ‘Event Display’ comes up. 

13. Note: 
Server is not up. 

EOC -- Execute applicable steps of the ‘FOS 
Server and User Station Startup and Shutdown’ 
(SYS-2000B) procedure to bring up the Real- 
Time Server 

(Wait for completion of Real-Time Server startup 
before going to the next step.) 

Real-Time Server Startup is complete when the 
following message appears in the Event Display: 

‘Active processing for String 100 was created.’ 

14. Read-Only Privileges (EOC) (No expected result/output; information only) 

15. Connect mirrored to logical String 100. 
following ECL directive: 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

(Wait for string connection to complete) 

The following event message appears (after several
minutes): 

‘Successfully connected to String 100 as Mirrored’. 

16. Attempt to take ground control for String 100. 
Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

The following event message appears: 

‘<IST user name> is not authorized for Ground Control
privilege.’ 

This step is necessary only if the Real Time 

Enter the 
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17. Attempt to take command for String 100. Enter 
the following ECL directive: 

ECL> TAKE COMMAND STRING=100 

The following event message appears: 

‘<IST user name> is not authorized for Command
privilege.’ 

18. From the Control window, bring up the
‘Command Control Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Control’ 

In the Command Control dialog box, enter the
following: 

String ID: 100 

Spacecraft ID: AM1 

Close Command Monitor Window 

The ‘Tools’ window comes up, then closes. 

The Command Monitor Window comes up, then closes. 

19. From the Control window, bring up the
‘Command Request Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Request’. 

Click on ‘Create’ button. 

Close dialog box and Command Request window. 

The ‘Tools’ window comes up, then closes. 

The Command Request window comes up. 

A dialog box indicates that the user is not authorized to 
create a Command Request. 

The dialog box and Command Request windows close. 
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20. From the Control window, bring up the ‘Binary
Load Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

I n  t h e  ‘ T o o l s ’  m e n u ,  s e l e c t  
‘Binary_Load_Builder’ 

In the Binary Load Builder window, select a Load 
Contents file. 

Click on ‘Generate’. 

Close dialog box and Binary Load Builder 
window. 

The ‘Tools’ window comes up, then closes. 

The Binary Load Builder window comes up. 

A dialog box indicates that the user does not have 
authorization to generate a binary load. 

The dialog box and Binary Load Builder windows 
close. 

21. From the Control window, bring up the ‘RTS
Load Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘RTS_Load_Builder’. 

In the RTS Load Builder window, under File pull- 
down menu, select ‘Open’. 

Select an RTS load contents file from the ‘Open’
dialog box. 

In the ‘Open’ dialog box, click on ‘OK’. 

in the RTS Load Builder window, click on 
‘Generate’. 

Close dialog box and RTS Load Builder window. 

The ‘Tools’ window comes up, then closes. 

The RTS Load Builder window comes up. 

An ‘Open’ dialog box comes up, then closes after user 
selection. 

Command information is displayed in the large area in 
the RTS Load Builder window. 

A dialog box indicates that the user does not have 
authorization to generate an RTS load. 

The dialog box and RTS Load Builder windows close. 
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22. Planning & Scheduling Tools (Start) 

From the Control window, bring up the Timeline
window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Timeline’. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the Master Plan. 

Enter start/stop times as necessary. 

Click on ‘OK’ button. 

The ‘Tools’ window comes up, then closes. 

The Timeline and Open Plan windows comes up. 

The Open Plan window closes. 

The timeline updates with the requested time period and 
plan name as Master Plan:1. 

23. From the Control window, bring up the Activity
Definer window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Activity_Definer’. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

Select an activity. 

Click on ‘Save As’ under the ‘File’ pull-down 
menu, and enter another name for saving the
activity. 

Close dialog box and Activity Definer windows. 

The ‘Tools’ window comes up, then closes. 

The Activity Definer and activity selection windows 
comes up. 

A dialog box indicates that the user is not authorized to 
save an activity. 

The dialog box and Activity Definer windows close. 
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24. From the Control window, bring up the BAP
Definer window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘BAP_Definer’. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1’ resource, or another resource 
that contains existing BAPs. 

Select a BAP. 

Click on ‘Save As’ under the ‘File’ pull-down 
menu, and enter another name for saving the BAP. 

Close dialog box and BAP Definer windows. 

The ‘Tools’ window comes up, then closes. 

The BAP Definer and BAP selection windows comes 
up. 

A dialog box indicates that the user is not authorized to 
save a BAP. 

The dialog box and BAP Definer windows close. 

25. From the Control window, bring up the General
Scheduler window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘General_Scheduler. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

Select an activity and ‘Master Plan’. 

Enter/modify start/stop times as necessary. 

Click on ‘Schedule’ icon. 

Close dialog box. 

The ‘Tools’ window comes up, then closes. 

The General Scheduler window comes up. 

A dialog box indicates that the user is not authorized to 
schedule an activity. 

The dialog box closes. 
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26. From the Control window, bring up the Activity
Recycler window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Activity_Recycler’. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

In the ‘Timeline’ window, select an activity that
applies to the resource just selected, then click on 
the ‘Cut’ icon. 

In the Activity Recycler window, select the 
activity just recycled. 

In the Activity Recycler window, click on 
‘Schedule’. 

Close dialog box, Activity Recycler, and General 
Scheduler windows. 

The ‘Tools’ window comes up, then closes. 

The Activity Recycler and activity selection windows 
comes up. 

The activity selected for cutting disappears from the 
‘Timeline’ window and appears in the ‘Activity 
Recycler’ window. 

A dialog box indicates that the user is not authorized to 
schedule recycled activities. 

The dialog box, Activity Recycler, and General 
Scheduler windows close. 
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27. From the Control window, bring up the Constraint
Definer window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Constraint_Definer. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select a constraint definition. 

Click on ‘Save As’ under the ‘File’ pull-down 
menu, and enter another name for saving the
constraints. 

Close dialog box and Constraint Definer windows. 

The ‘Tools’ window comes up, then closes. 

The Constraint Definer and Open Constraint windows 
come up. 

A dialog box indicates that the user is not authorized to 
define constraints. 

The dialog box, Open Constraint, and Constraint 
Definer windows close. 

28. From the Control window, bring up the Contact
Scheduler window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Contact_Scheduler. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

Select an activity and ‘Master Plan’. 

Enter/modify start/stop times as necessary. 

Click on ‘Schedule’ icon. 

Close dialog box and Contact Scheduler windows. 

The ‘Tools’ window comes up, then closes. 

The Contact Scheduler window comes up. 

A dialog box indicates that the user is not authorized to 
schedule a contact. 

The dialog box and Contact Scheduler windows close. 
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29. From the Control window, bring up the Load
Generator window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Load_Generator’. 

Click the ‘DAS/ATC Load’ button and select
‘Master Plan’. 

Enter/modify start/stop times as necessary. 

Click on ‘Submit’ icon. 

Close dialog box, Load Generator, and Timeline
windows. 

Planning & Scheduling Tools (End) 

The ‘Tools’ window comes up, then closes. 

The Load Generator window comes up. 

A dialog box indicates that the user is not authorized to 
generate an ATC load. 

The dialog box, Load Generator, and Timeline windows 
close. 

30. From the Control window, bring up the ‘Room
Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Room_Builder’. 

In ‘Define Room’ window,: 

For ‘Name’, enter RubeRoom2 

Click on ‘Local’, ‘Default’, ‘Tile’, and 
‘Temporary’ buttons. 

Click on ‘OK’. 

Close dialog box and Define Room window. 

A ‘Define Room’ window comes up. 

The Event Display closes, then reopens with no events. 

The ‘Define Room’ window closes. 

A dialog box indicates that the user is not authorized to 
build a Room. 
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31. Close the Event Display window. The Event Display window then closes. 

32. Read-Only Privileges (IST) (No expected result/output; information only) 

33. Execute the steps under ‘Read-Only Privileges 
(EOC)’ with the following exception: 

There is no ‘Command_Control’ selection in the
‘Tools’ menu. 

The user successfully connects to String 100. 

The user is not authorized for Ground Control or 
Command privilege. 

The user is not authorized to create, generate, save, or 
schedule using the following tools: 

Command Request; 

Binary Load Builder; 

RTS Load Builder; 

Activity Definer; 

BAP Definer; 

Activity Recycler; 

Constraint Definer; 

General Scheduler; 

Contact Scheduler; 

Load Generator; 

Room Builder. 

34. DBA Privileges (EOC) (No expected result/output; information only) 
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35. Change the user role to Database Administrator
(DBA). 

In the ‘Control Window’, click on the ‘Roles’ 
button. 

In User Roles window, select ‘Database 
Administrator’. 

The User Roles window comes up, then closes after 
user selection. 

36. Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display- 
Global’. 

The ‘Tools’ menu comes up, then closes. 

The ‘Event Display’ comes up. 

37. Connect mirrored to logical String 100. Enter the 
following ECL directive: 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

(Wait for string connection to complete) 

The following event message appears (after several
minutes): 

‘Successfully connected to String 100 as Mirrored’. 

38. Attempt to take ground control for String 100. 
Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

The following event message appears: 

‘<EOC user name> is not authorized for Ground
Control Privilege.’ 

39. Attempt to take command for String 100. Enter 
the following ECL directive: 

ECL> TAKE COMMAND STRING=100 

The following event message appears: 

‘<EOC user name> is not authorized for Command
Authority Privilege.’ 
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40. From the Control window, bring up the
‘Command Control Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Control’ 

In the Command Control dialog box, enter the
following: 

String ID: 100 

Spacecraft ID: AM1 

Close the Command Monitor Window 

The ‘Tools’ window comes up, then closes. 

The Command Monitor Window comes up, then closes. 

41. From the Control window, bring up the
‘Command Request Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Request’. 

Click on ‘Create’ button. 

Close ‘Command Request Creation’ and
‘Command Request’ windows. 

The ‘Tools’ window comes up, then closes. 

The Command Request window comes up. 

‘Command Request Creation’ window comes up. 

‘Command Request Creation’, and ‘Command Request’ 
windows close. 
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42. From the Control window, bring up the ‘Binary
Load Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

I n  t h e  ‘ T o o l s ’  m e n u ,  s e l e c t  
‘Binary_Load_Builder’. 

In the Binary Load Builder window, select a Load 
Contents file. 

Click on ‘Generate’. 

Close Binary Load Builder window. 

The ‘Tools’ window comes up, then closes. 

The Binary Load Builder window comes up then closes. 

Binary load generation starts, i.e., there is no error 
dialog that indicates the user is not authorized to 
generate a binary load. 

43. From the Control window, bring up the ‘RTS
Load Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘RTS_Load_Builder’. 

In the RTS Load Builder window, under File pull- 
down menu, select ‘Open’. 

Select an RTS load contents file from the ‘Open’
dialog box. 

In the ‘Open’ dialog box, click on ‘OK’. 

in the RTS Load Builder window, click on 
‘Generate’. 

Close RTS Load Builder window. 

The ‘Tools’ window comes up, then closes. 

The RTS Load Builder window comes up, then closes. 

RTS load generation starts, i.e., there is no error dialog 
that indicates the user is not authorized to generate an 
RTS. 
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44. From the Control window, bring up the ‘Room
Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Room_Builder’. 

In ‘Define Room’ window,: 

For ‘Name’, enter RubeRoom2 

Click on ‘Local’, ‘Default’, ‘Tile’, and 
‘Temporary’ buttons. 

Click on ‘OK’. 

A ‘Define Room’ window comes up. 

There is no error dialog that indicates the user is not 
authorized to generate a room. 

The ‘Define Room’ window closes. 

45. Close the Event Display window. The Event Display window then closes. 

46. Generic User Privileges (EOC) (No expected result/output; information only) 

47. Change the user role to Generic User. 

In the ‘Control Window’, click on the ‘Roles’ 
button. 

In the User Roles window, select ‘Generic User’. 

The User Roles window comes up, then closes after 
user selection. 

48. Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display- 
Global’. 

The ‘Tools’ menu comes up, then closes. 

The ‘Event Display’ comes up. 
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49. Attempt to take ground control for String 100. 
Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

The following event message appears: 

‘<EOC user name> is not authorized for Ground
Control privilege.’ 

50. Attempt to take command for String 100. Enter 
the following ECL directive: 

ECL> TAKE COMMAND STRING=100 

The following event message appears: 

‘<EOC user name> is not authorized for Command
privilege.’ 

51. From the Control window, bring up the
‘Command Control Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Control’ 

In the Command Control dialog box, enter the
following: 

String ID: 100 

Spacecraft ID: AM1 

Close Command Monitor Window 

The ‘Tools’ window comes up, then closes. 

The Command Monitor Window comes up, then closes. 
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52. From the Control window, bring up the
‘Command Request Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Request’. 

Click on ‘Create’ button. 

Close ‘Command Request Creation’ and
‘Command Request’ windows. 

The ‘Tools’ window comes up, then closes. 

The Command Request window comes up. 

‘Command Request Creation’ window comes up. 

‘Command Request Creation’, and ‘Command Request’ 
windows close. 

53. From the Control window, bring up the ‘Binary
Load Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

I n  t h e  ‘ T o o l s ’  m e n u ,  s e l e c t  
‘Binary_Load_Builder’ 

In the Binary Load Builder window, select a Load 
Contents file. 

Click on ‘Generate’. 

Close dialog box and Binary Load Builder 
window. 

The ‘Tools’ window comes up, then closes. 

The Binary Load Builder window comes up. 

A dialog box indicates that the user does not have 
authorization to generate a binary load. 

The dialog box and Binary Load Builder windows 
close. 
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54. From the Control window, bring up the ‘RTS
Load Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘RTS_Load_Builder’. 

In the RTS Load Builder window, under File pull- 
down menu, select ‘Open’. 

Select an RTS load contents file from the ‘Open’
dialog box. 

In the ‘Open’ dialog box, click on ‘OK’. 

in the RTS Load Builder window, click on 
‘Generate’. 

Close dialog box and RTS Load Builder window. 

The ‘Tools’ window comes up, then closes. 

The RTS Load Builder window comes up. 

An ‘Open’ dialog box comes up, then closes after user 
selection. 

Command information is displayed in the large area in 
the RTS Load Builder window. 

A dialog box indicates that the user does not have 
authorization to generate an RTS load. 

The dialog box and RTS Load Builder windows close. 

55. From the Control window, bring up the ‘Room
Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Room_Builder’. 

In ‘Define Room’ window,: 

For ‘Name’, enter RubeRoom2 

Click on ‘Local’, ‘Default’, ‘Tile’, and 
‘Temporary’ buttons. 

Click on ‘OK’. 

A ‘Define Room’ window comes up. 

There is no  error dialog that indicates user is not 
authorized to generate a room. 

The ‘Define Room’ window closes. 

56. Close the Event Display window. The Event Display window then closes. 
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57. Instrument Controller Privileges (EOC) (No expected result/output; information only) 

58. Execute the steps under ‘DBA Privileges (EOC)’
with the following exception: 

In the User Roles window, select ‘Instrument
Controller’. 

The user is not authorized for Ground Control or 
Command privilege. 

The following tools come up: 

Event Display; 

Command Monitor Window; 

Command Request; 

Binary Load Builder; 

RTS Load Builder; 

Room Builder. 

59. Read-Only Privileges (EOC) (2) (No expected result/output; information only) 

60. Change the user role to Read-Only. 

In the ‘Control Window’, click on the ‘Roles’ 
button. 

In the User Roles window, select ‘Read Only’. 

The User Roles window comes up, then closes after 
user selection. 

61. PAS Definer Privileges (EOC) (No expected result/output; information only) 
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62. Execute the steps under ‘DBA Privileges (EOC)’
with the following exception: 

In the User Roles window, select ‘PAS Definer’. 

The user is not authorized for Ground Control or 
Command privilege. 

The following tools come up: 

Event Display; 

Command Monitor Window; 

Command Request; 

Binary Load Builder; 

RTS Load Builder; 

Room Builder. 

63. Planning & Scheduling Tools (Start) 

From the Control window, bring up the Timeline
window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Timeline’. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the Master Plan. 

Enter start/stop times as necessary. 

Click on ‘OK’ button. 

The ‘Tools’ window comes up, then closes. 

The Timeline and Open Plan windows comes up. 

The Open Plan window closes. 

The timeline updates with the requested time period and 
plan name as Master Plan:1. 
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64. From the Control window, bring up the Activity
Definer window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Activity_Definer’. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

Select an activity. 

Click on ‘Save As’ under the ‘File’ pull-down 
menu, and enter another name for saving the
activity. 

Close Activity Definer window. 

The ‘Tools’ window comes up, then closes. 

The Activity Definer and activity selection windows 
comes up. 

Saving the activity definition starts, i.e., there is no error 
dialog that indicates the user is not authorized to save 
an activity definition. 

The Activity Definer window closes. 

65. From the Control window, bring up the BAP
Definer window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘BAP_Definer’. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1’ resource, or another resource 
that contains existing BAPs. 

Select a BAP. 

Click on ‘Save As’ under the ‘File’ pull-down 
menu, and enter another name for saving the BAP. 

Close BAP Definer window. 

The ‘Tools’ window comes up, then closes. 

The BAP Definer and BAP selection windows comes 
up. 

Saving the BAP definition starts, i.e., there is no error 
dialog that indicates the user is not authorized to save a 
BAP definition. 

The BAP Definer window closes. 
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66. From the Control window, bring up the General
Scheduler window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘General_Scheduler. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

Select an activity and ‘Master Plan’. 

Enter/modify start/stop times as necessary. 

Click on ‘Schedule’ icon. 

The ‘Tools’ window comes up, then closes. 

The General Scheduler window comes up. 

Activity scheduling starts, i.e., there is no error dialog 
that indicates the user is not authorized to schedule an 
activity. 

4-356
 322-CD-100-001/ 
411-CD-100-001 



67. From the Control window, bring up the Activity
Recycler window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Activity_Recycler’. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

In the ‘Timeline’ window, select an activity that
applies to the resource just selected, then click on 
the ‘Cut’ icon. 

In the Activity Recycler window, select the 
activity just recycled. 

In the Activity Recycler window, click on 
‘Schedule’. 

Close Activity Recycler and General Scheduler 
windows. 

The ‘Tools’ window comes up, then closes. 

The Activity Recycler and activity selection windows 
comes up. 

The activity selected for cutting disappears from the 
‘Timeline’ window and appears in the ‘Activity 
Recycler’ window. 

The recycled activity that has just been scheduled 
reappears in the ‘Timeline’ window. 

The Activity Recycler and General Scheduler windows 
close. 

4-357
 322-CD-100-001/ 
411-CD-100-001 



68. From the Control window, bring up the Constraint
Definer window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Constraint_Definer. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select an existing constraint. 

Click on ‘Apply’. 

Click on ‘Save As’ under the ‘File’ pull-down 
menu, and enter another name for saving the
constraints. 

Close Constraint Definer window. 

The ‘Tools’ window comes up, then closes. 

The Constraint Definer and Open Constraint windows 
come up. 

Saving constraint definitions starts, i.e., there is no error 
dialog that indicates the user is not authorized to save 
constraint definitions. 

The Open Constraint and Constraint Definer windows 
close. 

69. From the Control window, bring up the Contact
Scheduler window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Contact_Scheduler. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

Select an activity and ‘Master Plan’. 

Enter/modify start/stop times as necessary. 

Click on ‘Schedule’ icon. 

Close Contact Scheduler window. 

The ‘Tools’ window comes up, then closes. 

The Contact Scheduler window comes up. 

Contact scheduling starts, i.e., there is no error dialog 
that indicates the user is not authorized to schedule a 
contact. 

The Contact Scheduler window closes. 
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70. From the Control window, bring up the Load
Generator window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Load_Generator’. 

Click the ‘DAS/ATC Load’ button and select
‘Master Plan’. 

Enter/modify start/stop times as necessary. 

Click on ‘Submit’ icon. 

Close Load Generator and Timeline windows. 

Planning & Scheduling Tools (End) 

The ‘Tools’ window comes up, then closes. 

The Load Generator window comes up. 

ATC load generation starts, i.e., there is no error dialog 
that indicates the user is not authorized to generate an 
ATC load. 

The Load Generator and Timeline windows close. 

71. Read-Only Privileges (EOC) (3) (No expected result/output; information only) 

72. Change the user role to Read-Only. 

In the ‘Control Window’, click on the ‘Roles’ 
button. 

In the User Roles window, select ‘Read Only’. 

The User Roles window comes up, then closes after 
user selection. 

73. PAS Scheduler Privileges (EOC) (No expected result/output; information only) 
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74. Execute the steps under ‘DBA Privileges (EOC)’
with the following exception: 

In the User Roles window, select ‘PAS 
Scheduler’. 

The user is not authorized for Ground Control or 
Command privilege. 

The following tools come up: 

Event Display; 

Command Monitor Window; 

Command Request; 

Binary Load Builder; 

RTS Load Builder; 

Room Builder. 

75. Planning & Scheduling Tools (Start) 

From the Control window, bring up the Timeline
window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Timeline’. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the Master Plan. 

Enter start/stop times as necessary. 

Click on ‘OK’ button. 

The ‘Tools’ window comes up, then closes. 

The Timeline and Open Plan windows comes up. 

The Open Plan window closes. 

The timeline updates with the requested time period and 
plan name as Master Plan:1. 
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76. From the Control window, bring up the Activity
Definer window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Activity_Definer’. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

Select an activity. 

Click on ‘Save As’ under the ‘File’ pull-down 
menu, and enter another name for saving the
activity. 

Close dialog box and Activity Definer windows. 

The ‘Tools’ window comes up, then closes. 

The Activity Definer and activity selection windows 
comes up. 

A dialog box indicates that the user is not authorized to 
save an activity. 

The dialog box and Activity Definer windows close. 

77. From the Control window, bring up the BAP
Definer window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘BAP_Definer’. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1’ resource, or another resource 
that contains existing BAPs. 

Select a BAP. 

Click on ‘Save As’ under the ‘File’ pull-down 
menu, and enter another name for saving the BAP. 

Close BAP Definer window. 

The ‘Tools’ window comes up, then closes. 

The BAP Definer and BAP selection windows comes 
up. 

Saving the BAP definition starts, i.e., there is no error 
dialog that indicates the user is not authorized to save a 
BAP definition. 

The BAP Definer window closes. 
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78. From the Control window, bring up the General
Scheduler window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘General_Scheduler. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

Select an activity and ‘Master Plan’. 

Enter/modify start/stop times as necessary. 

Click on ‘Schedule’ icon. 

The ‘Tools’ window comes up, then closes. 

The General Scheduler window comes up. 

Activity scheduling starts, i.e., there is no error dialog 
that indicates the user is not authorized to schedule an 
activity. 
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79. From the Control window, bring up the Activity
Recycler window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Activity_Recycler’. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

In the ‘Timeline’ window, select an activity that
applies to the resource just selected, then click on 
the ‘Cut’ icon. 

In the Activity Recycler window, select the 
activity just recycled. 

In the Activity Recycler window, click on 
‘Schedule’. 

Close Activity Recycler and General Scheduler 
windows. 

The ‘Tools’ window comes up, then closes. 

The Activity Recycler and activity selection windows 
comes up. 

The activity selected for cutting disappears from the 
‘Timeline’ window and appears in the ‘Activity 
Recycler’ window. 

The recycled activity that has just been scheduled 
reappears in the ‘Timeline’ window. 

The Activity Recycler and General Scheduler windows 
close. 
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80. From the Control window, bring up the Constraint
Definer window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Constraint_Definer. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select an existing constraint. 

Click on ‘Apply’. 

Click on ‘Save As’ under the ‘File’ pull-down 
menu, and enter another name for saving the
constraints. 

Close dialog box and Constraint Definer windows. 

The ‘Tools’ window comes up, then closes. 

The Constraint Definer and Open Constraint windows 
come up. 

A dialog box indicates that the user is not authorized to 
define constraints. 

The dialog box, Open Constraint, and Constraint 
Definer windows close. 

81. From the Control window, bring up the Contact
Scheduler window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Contact_Scheduler. 

Click on ‘Open’ under the ‘File’ pull-down menu. 

Select the ‘AM1 ASTER’ resource, or another 
resource that contains existing activities. 

Select an activity and ‘Master Plan’. 

Enter/modify start/stop times as necessary. 

Click on ‘Schedule’ icon. 

Close Contact Scheduler window. 

The ‘Tools’ window comes up, then closes. 

The Contact Scheduler window comes up. 

Contact scheduling starts, i.e., there is no error dialog 
that indicates the user is not authorized to schedule a 
contact. 

The Contact Scheduler window closes. 
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82. From the Control window, bring up the Load
Generator window. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Load_Generator’. 

Click the ‘DAS/ATC Load’ button and select
‘Master Plan’. 

Enter/modify start/stop times as necessary. 

Click on ‘Submit’ icon. 

Close Load Generator and Timeline windows. 

Planning & Scheduling Tools (End) 

The ‘Tools’ window comes up, then closes. 

The Load Generator window comes up. 

ATC load generation starts, i.e., there is no error dialog 
that indicates the user is not authorized to generate an 
ATC load. 

The Load Generator and Timeline windows close. 

83. Read-Only Privileges (EOC) (4) (No expected result/output; information only) 

84. Change the user role to Read-Only. 

In the ‘Control Window’, click on the ‘Roles’ 
button. 

In the User Roles window, select ‘Read Only’. 

The User Roles window comes up, then closes after 
user selection. 

85. CAC & Operations Controller User Role Setup 
(EOC) 

(No expected result/output; information only) 

86. EOC -- Execute applicable steps of the ‘FOS 
Server and User Station Startup and Shutdown’ 
(SYS-2000B) test procedure to shutdown an EOC 
user station. 

In the User Roles window, select ‘Read-Only’. 

(Wait for completion of user station startup) 

User station shutdown is complete when there are no 
FOS processes and no endpoints for this user station. 
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87. Update database table for this user name for CAC 
& Operations Controller roles (user_type) at the 
EOC. 

1> insert into user_roles values (‘<EOC 
user name>‘, 1, 2, 2, 1, ‘<this user 
station>‘) 

2> insert into user_roles values (‘<EOC 
user name>‘, 1, 2, 5, 1, ‘<this user 
station>‘) 

3> go 

1> select * from user_roles where 
user_name=’<EOC user name>‘ 

2> go 

The ‘user_roles’ database table is updated and 
displayed. 
(including CAC & Operations Controller) for this user 
name at the EOC. 

88. EOC -- Execute applicable steps of the ‘FOS 
Server and User Station Startup and Shutdown’ 
(SYS-2000B) test procedure to bring up an EOC 
user station. 

In the User Roles window, select ‘Operations 
Controller’. 

(Wait for completion of user station startup) 

User station startup is complete when the Control 
Window comes up. 

89. Operations Controller Privileges (EOC) (No expected result/output; information only) 

Enter the following sql commands: 
It includes all 8 user roles (user_type) 
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90. Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display- 
Global’. 

The ‘Tools’ menu comes up, then closes. 

The ‘Event Display’ comes up. 

91. Connect mirrored to logical String 100. 
following ECL directive: 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

(Wait for string connection to complete) 

The following event message appears (after several
minutes): 

‘Successfully connected to String 100 as Mirrored’. 

92. Attempt to take ground control for String 100. 
Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

The following event message appears: 

‘Ground Control Authority has changed from <former
user or EcDNull> to <EOC user name> for string 100‘ 

93. Attempt to take command for String 100. 
the following ECL directive: 

ECL> TAKE COMMAND STRING=100 

The following event message appears: 

‘Command Authority has changed from <former user or
EcDNull> to <EOC user name> for string 100‘ 

Enter the 

Enter 
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94. From the Control window, bring up the
‘Command Control Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Control’ 

In the Command Control dialog box, enter the
following: 

String ID: 100 

Spacecraft ID: AM1 

Close Command Control Window 

The ‘Tools’ window comes up, then closes. 

The Command Control Window comes up, then closes. 

95. From the Control window, bring up the
‘Command Request Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Request’. 

Click on ‘Create’ button. 

In ‘Command Request Creation’ window, click on
‘AddCmds’ button. 

In ‘Command Builder’ window, select a
command. 

Click on ‘Submit’. 

Close ‘Command Builder’, ‘Command Request
Creation’, and ‘Command Request’ windows. 

The ‘Tools’ window comes up, then closes. 

The Command Request window comes up. 

‘Command Request Creation’ window and ‘Command 
Builder’ window comes up. 

Command selected is displayed in ‘Command Request 
Creation’ window. 

‘Command Builder’, ‘Command Request Creation’, and 
‘Command Request’ windows close. 

A dialog box indicates a Command Request has been 
submitted. 
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96. From the Control window, bring up the ‘Binary
Load Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select
‘Binary_Load_Builder’ 

In the Binary Load Builder window, select a Load 
Contents file. 

Click on ‘Generate’. 

Close Binary Load Builder window. 

The ‘Tools’ window comes up, then closes. 

The Binary Load Builder window comes up then closes. 

Binary load generation starts, i.e., there is no error 
dialog that indicates the user is not authorized to 
generate a binary load. 

97. From the Control window, bring up the ‘RTS
Load Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘RTS_Load_Builder’. 

In the RTS Load Builder window, under File pull- 
down menu, select ‘Open’. 

Select an RTS load contents file from the ‘Open’
dialog box. 

In the ‘Open’ dialog box, click on ‘OK’. 

in the RTS Load Builder window, click on 
‘Generate’. 

Close RTS Load Builder window. 

The ‘Tools’ window comes up, then closes. 

The RTS Load Builder window comes up, then closes. 

RTS load generation starts, i.e., there is no error dialog 
that indicates the user is not authorized to generate an 
RTS. 
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98. From the Control window, bring up the ‘Room
Builder’ tool. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Room_Builder’. 

In ‘Define Room’ window,: 

For ‘Name’, enter RubeRoom2 

Click on ‘Local’, ‘Default’, ‘Tile’, and 
‘Temporary’ buttons. 

Click on ‘OK’. 

A ‘Define Room’ window comes up. 

There is no error dialog that indicates the user is not 
authorized to generate a room. 

The ‘Define Room’ window closes. 

99. Close the Event Display window. The Event Display window then closes. 

100. Read-Only Privileges (EOC) (5) (No expected result/output; information only) 

101. Change the user role to Read-Only. 

In the ‘Control Window’, click on the ‘Roles’ 
button. 

In the User Roles window, select ‘Read Only’. 

The User Roles window comes up, then closes after 
user selection. 

102. Command Activity Controller (CAC) 
Privileges (EOC) 

(No expected result/output; information only) 
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103. Execute the steps under ‘Operations Controller 
Privileges (EOC)’ with the following exception: 

In the User Roles window, select ‘Command
Activity Controller’. 

The user already has Ground Control and Command 
privilege. 

The following tools come up: 

Event Display; 

Command Control Window; 

Command Request (There is no dialog box that 
indicates a Command Request has been submitted); 

Binary Load Builder; 

RTS Load Builder; 

Room Builder. 

104. User Roles Reset (IST & EOC) (No expected result/output; information only) 
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105. Delete from the user_roles table those rows that 
were inserted by this test procedure. 

1> delete from user_roles where 
user_name=’<IST user name>‘ 

2> delete from user_roles where 
user_name=’<EOC user name>‘ 

3> go 

Display the contents of the user_roles table for 
these IST and EOC user names. 

1> select * from user_roles where 
user_name=’<IST user name>‘ 

2> select * from user_roles where 
user_name=’<EOC user name>‘ 

3> go 

The ‘user_roles’ table shows there are no rows for these 
IST and EOC user names 
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106. Using the user-roles configuration noted near the 
beginning of this test procedure, insert into the 
user_roles table, as necessary, those rows that 
were deleted. 

1> insert into user_roles values (‘<IST 
user name>‘, 1, 0, x, x, ’<IST host>‘ 

2> insert into user_roles values (‘<EOC 
user name>‘, 1, 2, x, x, ’<EOC user 
station>‘ 

x> go 

Display the contents of the user_roles table for 
these EOC and IST user names. 

1> select * from user_roles where 
user_name=’<IST user name>‘ 

2> select * from user_roles where 
user_name=’<EOC user name>‘ 

3> go 

Display the contents of the entire user_roles table. 

1> select * from user_roles 

2> go 

1> quit 

The ‘user_roles’ table is reset to its former contents for 
these IST and EOC user names and displayed. 

The ‘user_roles’ table is displayed and contains the 
same contents as prior to execution of this test 
procedure. 

107. End of test. 
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Generic String Management Test Procedure


Test Case No:  SYS-3050FPB 

Test Configuration:  See Appendix G 

Test Support: Powered-up FOS servers including two Real-Time servers; EOC LAN; FOS Server and User Station startup 
scripts; ‘sc’ CLCW driver; and pre-built display page containing SYS mnemonics. 

Test Case Description: 

This test is designed to verify that string-related FOS functions conform to the new Generic String Manager. 
confirms that the ‘user_roles’ database table is utilized for ground control and command authorization. 
conformance to the new Generic String Manager is demonstrated for string-related processes of telemetry and telemetry 
archiving, spacecraft activity log monitoring, ground control and command authorization, NCC reconfiguration, commanding 
and ground script control, logical string manipulation, and backup string creation. 

Success Criteria: 

This test is successful when string-related processes of telemetry and archiving, spacecraft activity log monitoring, ground 
control and command authorization, NCC reconfiguration, commanding and ground script control, logical string manipulation, 
and backup string creation conform to the new Generic String Manager; and the ‘user_roles’ database table is used for granting 
ground control and command authority. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. FOS Server and User Station Startup and 
Telemetry Archiving and Activity Log 
Conformance 

(No expected result/output; information only) 

The test also 
Fundamental 
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2. Log in to an EOC user station, using UNIX login 
procedure, by entering User Name and Password 

Username: <user name> 

Password: ******** 

The login is accepted and two UNIX cmdtool windows 
appear 

3. Execute applicable portions of the ‘FOS Server 
and User Station Startup and Shutdown’ test 
procedure (SYS-2000B) to bring up FOS Data 
Server. 

(Wait for initialization of the Data Server to 
complete before going to the next step) 

The FOS Data Server is properly initialized 

4. Execute applicable steps of the ‘FOS Server and 
User Station Startup and Shutdown’ (SYS-2000B) 
test procedure to bring up the EOC user stations 

(Wait for completion of user station startup) 

User station startup is complete when the Control 
Window comes up 

5. Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display- 
Global’ 

The ‘Tools’ menu comes up, then closes. 

The ‘Event Display’ comes up. 
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6. Execute applicable steps of the ‘FOS Server and 
User Station Startup and Shutdown’ (SYS-2000B) 
procedure to bring up the active Real-Time Server 

(Wait for completion of Real-Time Server startup 
before going to the next step.) 

Active Real-Time Server Startup is complete when the 
following message appears in the Event Display: 

‘Active processing for String 100 was created.’ 

6 Telemetry Archiver (FdArTlmArchiver) and 1 
Activity Log Monitor (FaAlActivityLogMonitor) 
processes initialize normally. 

7. Connect mirrored to logical String 100. 
following ECL directive: 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

(Wait for string connection to complete) 

The following event message appears (after several
minutes): 

‘Successfully connected to String 100 as Mirrored’. 

8. Ground Control & Command Privileges (No expected result/output; information only) 

9. Remove user’s privileges from database table 

Display the database table containing user roles 
information by entering the following in a 
cmdtool window: 

%: isql -Ufos_dba -Pfos_dba (sql is alias) 

1> use am1_fos_ops 

2> go 

1> select * from user_roles 

2> go 

The ‘user_roles’ database table is displayed 

Enter the 
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10. Search the user_roles table to see if the logged on 
user name has ground control and command 
privileges for AM1 for Operations, Test, or 
Training modes (strings) on any user_station. 
Enter the following sql commands: 

1> select * from user_roles where 
user_name=‘<this user name>‘ and 
spacecraft=1 and user_type=2 

2> go 

Note in particular all rows where: 

Column 1 (user_name) = this user name, and 

Column 2 (spacecraft) = 1, and 

Column 4 (user_type) = 2. 

A list of all rows for this user for AM1 and for Ground 
Control and Command privileges are displayed. 

11. Note: 
before proceeding with this step. 

Delete all rows that meet the Columns 1/2/4 
criteria specified in the previous step. 
following sql commands, as necessary: 

1> delete from user_roles where 
user_name=’<this user name>‘ and 
spacecraft=1 and user_type=2 

2> go 

1> select * from user_roles 

2> go 

The ‘user_roles’ database table is updated and 
displayed. not include the combination of 
Ground Control and Command privileges for AM1 for 
any mode (string) and for this user. 

Check with other users on the system 

Enter the 

It does 

4-377
 322-CD-100-001/ 
411-CD-100-001 



12. Attempt to take Ground Control & Command 

Attempt to take ground control for String 100. 
Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

The following event messages appear: 

‘<User #1> is not authorized for Ground Control 
Privilege’; 

‘Both User <User #1> and Workstation <User Station 
#1> must be authorized for Ground Control Authority
privilege’. 

13. Attempt to take command for String 100. Enter 
the following ECL directive: 

ECL> TAKE COMMAND STRING=100 

The following event message appears: 

‘<User #1> is not authorized for Command Authority
Privilege’; 

‘Both User <User #1> and Workstation <User Station 
#1> must be authorized for Command Authority
privilege’. 
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14. Search the user_roles table to see if any user name 
has ground control and command privileges for 
AM1 for Operations mode (string) on this user 
station. 

1> select * from user_roles where 
spacecraft=1 and user_type=2 and 
mode=1 and host=‘<this user station>‘ 

2> go 

This shows all rows where: 

Column 2 (spacecraft) = 1, and 

Column 4 (user_type) = 2, and 

Column 5 (mode) = 1, and 

Column 6 (host) = this user station. 

Note carefully the current contents of the 
user_roles table prior to making deletions in the 
next step. 

A list of all rows for AM1 for Ground Control and 
Command privileges for the Operations mode (string) 
and for this user station are displayed. 

Enter the following sql commands: 
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15. Note: 
before proceeding with this step. 

Delete all rows that meet the Columns 2/4/5/6 
criteria specified above. 
commands, as necessary: 

1> delete from user_roles where 
spacecraft=1 and user_type=2 and 
mode=1 and host=‘<this user station>‘ 

2> go 

1> select * from user_roles 

2> go 

Re-insert all rows deleted previously that were 
associated with this user name for AM1 for the 
Operations mode (string), but only for other user 
stations. 

1> insert into user_roles values (‘<this 
user name>‘, 1, x, 2, 1, ‘<other user 
station>‘) 

Repeat the insert commands as necessary. 

2> go 

1> select * from user_roles 

2> go 

The ‘user_roles’ database table is updated and 
displayed. not include the combination of 
Ground Control and Command privileges for AM1 for 
the Operations mode (string) and for this user station. 

It does, however, include the combination of Ground 
Control and Command privileges for AM1 for the 
Operations mode (string) for this user name and for 
other user stations. 

Check with other users on the system 

Enter the following sql 

Enter the following sql commands: 

It does 
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16. Attempt to take Ground Control & Command 

Attempt to take ground control for String 100. 
Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

The following event messages appear: 

‘User station <User station #1> is not authorized for 
Ground Control privilege’; 

‘Both User <User #1> and Workstation <User Station 
#1> must be authorized for Ground Control Authority
privilege’. 

17. Attempt to take command for String 100. Enter 
the following ECL directive: 

ECL> TAKE COMMAND STRING=100 

The following event messages appear: 

‘User station <User station #1> is not authorized for 
Command Authority privilege’; 

‘Both User <User #1> and Workstation <User Station 
#1> must be authorized for Command Authority
privilege’. 

18. Update database table containing privileges 

Re-insert all rows deleted previously for other 
users that have not yet been re-inserted. 

1> insert into user_roles values (‘<other 
user name>‘, 1, x, 2, 1, ‘<this user 
station>‘) 

Repeat the insert commands as necessary. 

2> go 

1> select * from user_roles 

2> go 

The ‘user_roles’ database table is updated and 
displayed. It is identical to the table contents prior to 
deleting rows in preceding steps except that rows 
inserted in the last several steps appear at the bottom of 
the table. 
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19. Take Ground Control &Command (String 100) 

Take ground control for String 100. Enter the 
following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

The following event message appears: 

‘Ground Control Authority has changed from <former
user or EcDNull> to <User #1> for string 100‘ 

20. Take command for String 100. Enter the 
following ECL directive: 

ECL> TAKE COMMAND STRING=100 

The following event message appears: 

‘Command Authority has changed from <former user or
EcDNull> to <User #1> for string 100‘ 

21. Bring up the ‘Failover-Monitoring’ display page. 

In the ‘Control Window’, click on the ‘TlmWins’ 
button. 

In the ‘Tlm Wins’ menu, select ‘Failover-
Monitoring. 

The Failover Monitoring page appears and includes the 
following system parameter values: 

SYS_STRING_ID = 100 

SYS_DATA_SRC = Realtime 

SYS_MODE = OPS 

SYS_CMD_AUTHOR_ID = <User #1> 

SYS_CMD_AUTHOR_WS_ID = <This user station> 

SYS_GRND_CNTRL_ID = <User #1> 

SYS_GRND_CNTRL_WS_ID = <This user station> 

SYS_RTS_ID = 1 

SYS_BACKUP_RTS_ID = 0 

SYS_INACTIVE_RTS_ID = 0 

22. Telemetry Conformance (No expected result/output; information only) 
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23. Turn off the decommutation of telemetry for 
String 100 by entering the following in the ECL 
directive line of the Control window: 

ECL> DECOM SEL=ALL MODE=OFF 
STRING=100 

Event message indicates successful reconfiguration of 
telemetry decommutation process. 

24. Turn off the decommutation of telemetry for 
String 100 by entering the following in the ECL 
directive line of the Control window: 

ECL> DECOM SEL=ALL MODE=ON 
STRING=100 

Event message indicates successful reconfiguration of 
telemetry decommutation process. 

25. RCM Conformance (No expected result/output; information only) 

26. Change the reconfiguration of TDRS id. Enter the 
following ECL directive in the Control window. 

ECL> RCCONFIG STRING=100 
TDRS=E00 

Event message indicates TDRS re-configured to E00. 

27. Command & Ground Script 
Conformance 

(No expected result/output; information only) 
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28. Start ‘sc’ driver to emulate CLCWs 

User Station #1 – Remotely log in to the Real-
Time Server by entering the following in a new
cmdtool window. 

%: rlogin <RealTimeServer> 

At the Real-Time Server prompt, enter the
following: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: setenv SCRIPT RealTimeServer 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/sun_sparc_5-5 
(bin is alias) 

%: sc AM1 100 Ops 

User Station #1 -- The remote login to the Real-Time
Server is successful. 

The following message appears repeatedly in the Real-
Time Server cmdtool window: 

‘sc Waiting for messages’ 

29. Perform command initialization 

From the Control window, bring up the
‘Command Control Window’. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Control’ 

In the Command Control dialog box, enter the
following: 

String ID: 100 

Spacecraft ID: AM1 

The ‘Tools’ menu comes up, then closes after user 
selection. 

The Command Control dialog box comes up, then 
closes after user input. 

A working dialog box comes up, stating that the user 
should wait. 

The working dialog box closes when the ‘Command 
Control Window’ comes up. 
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30. Configure Frame Operation Procedure (FOP) 

In the ‘Config’ pull-down menu of the ‘Command
Control Window’, set the following: 

Cmd Verification (CV): Off 

Tlm Verification (TV): Off 

In the ‘Command Control Window’, enter the
following in the CMD field: 

FOP INIT CHECK 

Hit ‘return/enter’ key on keyboard. 

Click on ‘Resume’ button 

Click on ‘Send’ button 

Click on ‘Suspend’ button 

In the ‘Command Control Window’, the following
occurs: 

The ‘CV’ and ‘TV’ indicators are both ‘Off’. 

The ‘DIRECTIVE’ column contains ‘FOP INIT
CHECK’. 

After the ‘Resume’ button is clicked, the Send/Cancel
options are activated. 

After the ‘Send’ button is clicked, the STATUS column
includes ‘Processed -2 | Sent to subsys’. 

The following event message appears: 

‘Protocol Info: FOP INIT with CLCW check 
successful’. 
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31. Execute a real-time command 

In the ‘Command Control Window’, enter the
following real-time command in the CMD field: 

/AST_TURN_OFF_C_SDP 

Hit ‘return/enter’ key on keyboard. 

Click on ‘Resume’ button 

Click on ‘Send’ button 

Click on ‘Override’ button if necessary 

Click on ‘Suspend’ button. 

The /AST_TURN_OFF_C_SDP’ command is inserted
in the ‘Directive’ column. 

After the ‘Resume’ button is clicked, the Send/Cancel
options are activated. 

The following event messages appear: 

‘Command XXXXXXXXXX was successfully build
with binary = ...’; 

‘CLTU id XXXXXXXXXX placed in command data
block number x’; 

‘Command Data Block number x sent to EDOS’; 

‘Command XXXXXXXXXX timed out -- verification
failure.’ 

The STATUS column includes processing status
information, such as ‘TV Fail -3 | CV Pass -2 |
Processed -2 | Sent to FOP | Sent to subsys’. 

32. In the window containing the remote login to the
Real-Time Server for the ‘sc’ tool, depress the
following two keys simultaneously: 

Ctrl C 

The ‘sc’ tool quits, and a UNIX prompt is received from
the Real-Time Server. 

33. Logical String Manipulation (No expected result/output; information only) 

34. Create a Simulation/Training String (101) 

Attempt to create a Simulation/Training string. 
Enter the following ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 
MODE=TRAINING SERVER=1 

The following event messages appear: 

‘User does not have ground control authority’; 

‘<User #1> is not authorized for GroundControl 
Privilege’. 
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35. Update database table containing Ground Control 
and Command privileges for this user name, for 
AM1, for the Training mode (string). 
following sql commands: 

1> insert into user_roles values (‘<this 
user name>‘, 1, 2, 2, 3, ‘<this user 
station>‘) 

2> go 

1> select * from user_roles 

2> go 

The ‘user_roles’ database table is updated and 
displayed. 
Control and Command privileges for this user name for 
AM1 for the Training mode (string). 

36. Create a Simulation/Training string. 
following ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 
MODE=TRAINING SERVER=1 

The following event message appears: 

‘Active Processing for string 101 was Created.’ 

37. Command Preparation for String 101 

Connect mirrored to logical String 101. 
following ECL directive: 

ECL> STRING CONNECT STRING=101 
CONFIG=MIRROR 

(Wait for string connection to complete) 

The following event message appears (after several
minutes): 

‘Successfully connected to String 101 as Mirrored’. 

A ‘status’ window containing several SYS parameters
comes up. 

38. Take ground control for String 101. 
following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=101 

The following event message appears: 

‘Ground Control Authority has changed from <former
user or EcDNull> to <User #1> for string 101‘ 

Enter the 
It includes the combination of Ground 

Enter the 

Enter the 

Enter the 
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39. Take command for String 101. Enter the 
following ECL directive: 

ECL> TAKE COMMAND STRING=101 

User Station #1 -- The following event message 
appears: 

‘Command Authority has changed from <former user or
EcDNull> to <User #1> for string 101‘ 

40. Bring up the ‘Failover-Monitoring’ display page. 

In the ‘Control Window’, click on the ‘TlmWins’ 
button. 

In the ‘Tlm Wins’ menu, select ‘Failover-
Monitoring. 

The Failover Monitoring page appears and includes the 
following system parameter values: 

SYS_STRING_ID = 101 

SYS_DATA_SRC = Simulation 

SYS_MODE = TRAINING 

SYS_CMD_AUTHOR_ID = <User #1> 

SYS_CMD_AUTHOR_WS_ID = <This user station> 

SYS_GRND_CNTRL_ID = <User #1> 

SYS_GRND_CNTRL_WS_ID = <This user station> 

SYS_RTS_ID = 1 

SYS_BACKUP_RTS_ID = 0 

SYS_INACTIVE_RTS_ID = 0 

41. Delete String 101 

Attempt to delete String 101. Enter the following 
ECL directive: 

ECL> STRING DELETE STRING=101 

The following event message appears: 

‘Unable to delete String 101 when users are connected. 
Suggest notifying users to disconnect from String.’ 
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42. Disconnect from String 101. Enter the following 
ECL directive: 

ECL> STRING DISCONNECT 
STRING=101 

The following event messages appear: 

‘User successfully disconnected from String 101’ 

43. Update database table containing Ground Control 
and Command privileges for this user name, for 
AM1, for the Training mode (string). Enter the 
following sql commands: 

1> delete from user_roles where 
user_name=‘<this user name>‘ and 
spacecraft=1 and user_type=2 and 
mode=3 

2> go 

1> select * from user_roles 

2> go 

The ‘user_roles’ database table is updated and 
displayed. It does not include the combination of 
Ground Control and Command privileges for for this 
user name for AM1 for the Training mode (string). 

44. Attempt to delete String 101. Enter the following 
ECL directive: 

ECL> STRING DELETE STRING=101 

The following event message appears: 

‘User is not the Ground Controller for string 101. User 
must have Ground Control Authority before requesting
this service.’ 
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45. Update database table containing Ground Control 
and Command privileges for this user name, for 
AM1, for the Training mode (string). 
following sql commands: 

1> insert into user_roles values (‘<this 
user name>‘, 1, 2, 2, 3, ‘<this user 
station>‘) 

2> go 

1> select * from user_roles 

2> go 

The ‘user_roles’ database table is updated and 
displayed. 
Control and Command privileges for this user name for 
AM1 for the Training mode (string) and for this 
user_station 

46. Delete String 101. 
directive: 

ECL> STRING DELETE STRING=101 

The following event message appears: 

‘Active processing for String 101 was deleted.’ 

47. Attempt to connect mirrored to String 101. Enter 
the following ECL directive: 

ECL> STRING CONNECT STRING=101 
CONFIG=MIRROR 

The following event message appears: 

‘Unable to locate string 101. 
directive contains correct string ID.’ 

48. Create a Simulation/Test String (101) 

Attempt to create a Simulation/Test string. 
the following ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 MODE=TEST 
SERVER=1 

The following event messages appear: 

‘User does not have ground control authority’; 

‘<User #1> is not authorized for GroundControl 
Privilege’. 

Enter the 
It includes the combination of Ground 

Enter the following ECL 

User should make sure

Enter 
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49. Update database table containing Ground Control 
and Command privileges for this user name, for 
the Test mode (string). 
commands: 

1> insert into user_roles values (‘<this 
user name>‘, 1, 2, 2, 2, ‘<this user 
station>‘) 

2> go 

1> select * from user_roles 

2> go 

The ‘user_roles’ database table is updated and 
displayed. 
Control and Command privileges for this user name for 
the Test mode (string) for this user station. 

50. Create a Simulation/Test string Enter the 
following ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 MODE=TEST 
SERVER=1 

The following event message appears: 

‘Active Processing for string 101 was Created.’ 

51. Execute the ‘Command Preparation for String 
101’ subprocedure 

Ground control and command authority are authorized. 

The Failover Monitoring page includes the following 
system parameter values: 

SYS_STRING_ID = 101 

SYS_DATA_SRC = Simulation 

SYS_MODE = TEST 

Enter the following sql 
It includes the combination of Ground 
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52. Execute the ‘Delete String 101’ subprocedure with 
the following exceptions: 

Enter the following sql commands in the 
applicable steps for the test mode (string): 

1> delete from user_roles where 
user_name=‘<user name>‘ and 
user_type=2 and mode=2 

1> insert into user_roles values (‘<user 
name>‘, 1, 2, 2, 2, ‘<user station>‘) 

The ‘user_roles’ database table is updated and 
displayed. 

Event messages as indicated in the ‘Delete String 101’
subprocedure. 

53. Exit from the ‘user_roles’ database table. 

Enter the following sql command: 

1> quit 

A UNIX prompt is received 

54. Create a Real-Time/Test String (101) 

Enter the following ECL directive: 

ECL> STRING CREATE REALTIME 
SPACECRAFTID=AM1 MODE=TEST 
SERVER=1 

The following event message appears: 

‘Active processing for string 101 was Created.’ 

55. Execute the ‘Command Preparation for String 
101’ subprocedure 

Ground control and command authority are authorized. 

The Failover Monitoring page includes the following 
system parameter values: 

SYS_STRING_ID = 101 

SYS_DATA_SRC = Realtime 

SYS_MODE = TEST 
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56. Disconnect from String 101. Enter the following 
ECL directive: 

ECL> STRING DISCONNECT 
STRING=101 

The following event messages appear: 

‘User successfully disconnected from String 101’ 

57. Delete String 101. Enter the following ECL 
directive: 

ECL> STRING DELETE STRING=101 

The following event message appears: 

‘Active processing for String 101 was deleted.’ 

58. Backup String Creation (No expected result/output; information only) 

59. Search the configuration file identifying the Real- 
Time Server(s) and user stations to see if a backup 
Real-Time Server has been specified. Enter the 
following in a cmdtool window. 

%: cd /fosb/test/am1/config 

%: more FrCfRmsAuthorityInfo.cnfg 

Look for an entry that contains a backup Real- 
Time Server, i.e., a server with ROLE=2 and 
ID=2. 

The user determines if a backup Real-Time Server needs 
to be specified. 
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60. If the backup Real-Time Server is already 
included in the ‘FrCfRmsAuthorityInfo.cnfg’ file, 
go to the next step. 
specify a backup Real-Time Server by entering 
the following in a cmdtool window: 

[<backup Real-Time Server name>, 1296] 

ROLE 

ID 

[<backup Real-Time Server name>] 

Display the ‘FrCfRmsAuthorityInfo.cnfg’ file: 

%: more FrCfRmsAuthorityInfo.cnfg 

The ‘FrCfRmsAuthorityInfo.cnfg’ file is updated and 
displayed 

61. Execute applicable steps of the ‘FOS Server and 
User Station Startup and Shutdown’ (SYS-2000B) 
procedure to bring up the non-active Real-Time 
Server 

(Wait for completion of Real-Time Server startup 
before going to the next step.) 

Non-active Real-Time Server Startup is complete when 
the following message appears in the Event Display: 

‘Successfully performed nameserver register on RMS 
PtToPt Endpoint’ 

62. Bring up the Failover-Monitoring display page for 
String 100. 

In the ‘Control Window’, click on the ‘TlmWins’ 
button. 

In the ‘Tlm Wins’ menu, select ‘Failover-
Monitoring. 

The Failover Monitoring page and includes the 
following Real-Time Server values: 

SYS_RTS_ID = 1 

SYS_BACKUP_RTS_ID = 0 

SYS_INACTIVE_RTS_ID = 0 

Otherwise, edit this file to 

2 

2 
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63. Try to create a backup logical string on the active 
Real-Time Server by entering the following in the 
ECL directive line of the Control Window: 

ECL> STRING CREATE BACKUP 
SERVER=1 STRING=100 

The backup string is not created (since the active server 
cannot simultaneously be the backup server), and the 
following message appears on the Event Display: 

‘Unable to create Backup String on RTS <Real-Time 
Server name> because active string processing exists on 
this RTS.’ 

64. Create a backup logical string on the non-active 
Real-Time Server by entering the following in the 
ECL directive line of the Control Window: 

ECL> STRING CREATE BACKUP 
SERVER=2 STRING=100 

(Wait for completion of backup directive before 
going to the next step.) 

The backup string is created, and the following message 
appears on the Event Display: 

‘Successfully created backup processing for string 100.’ 

The Failover-Monitoring display page includes the 
following Real-Time Server values: 

SYS_RTS_ID = 1 

SYS_BACKUP_RTS_ID = 2 

SYS_INACTIVE_RTS_ID = 0 

65. Display the number of endpoints for the backup 
Real-Time Server by entering the following in a 
cmdtool window. 

%: show.sh 

Note the number of endpoints. 

There are 33 endpoints on the backup Real-Time Server: 
‘(33 rows affected)’ 
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66. Simulate a software failure by gracefully 
terminating the Ground Script Controller process 
on the active Real Time Server for String 100. 
Enter the following in a cmdtool window: 

%: ps -ea 

%: kill -9 <Ground Script Controller 
process id> 

Within 60 seconds, an event message indicates that the 
Ground Script Controller process has been terminated: 

‘Active strand for string 100 failed due to failure of 
<Ground Script Controller process name> process. 
Suggest failover.’ 

67. Initiate the failover from the active Real-Time 
Server to the backup Real-Time Server for String 
100 by entering the following in the ECL directive 
line of the Control Window: 

ECL> STRING FAILOVER STRING=100 

(Wait 60 seconds before executing the next step.) 

Within 60 seconds, the following occur: 

The Real-Time Server 1 is temporarily the inactive 
server until failover is complete. 

Event messages appear indicating that Real-Time Server 
2 is coming up as the active server and the failover was 
successful. 

Note: If failover is unsuccessful (i.e., backup and 
inactive servers are not both 0), an event message will 
appear notifying the user to delete string 100. 

68. Close the existing Failover Monitoring display 
page, and bring up a new Failover-Monitoring 
display page. 

In the ‘Control Window’, click on the ‘TlmWins’ 
button. 

In the ‘Tlm Wins’ menu, select ‘Failover- 
Monitoring. 

The existing Failover Monitoring page closes, and the 
new Failover Monitoring display page appears. 

The Failover-Monitoring display page includes the 
following Real-Time Server values: 

SYS_RTS_ID = 2 

SYS_BACKUP_RTS_ID = 0 

SYS_INACTIVE_RTS_ID = 0 

69. End of test. 
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Tivoli Test Procedure


Test Case No:  SYS-3060FPB 

Test Configuration:  See Appendix G 

Test Support: Powered-up FOS servers; two user stations; EOC LAN; and FOS Server and User Station startup scripts. 

Test Case Description: 

This test is designed to verify that the EOC monitors periodically monitors system resource levels and provides user notification, 
via Tivoli event messages, when there is a change in status of certain system components and when pre-defined system 
resources exceed or are less than configurable thresholds. 
resource parameters are re-configured in Tivoli, which generates system monitoring event messages. d 
the Data Server are unplugged, brought down, re-plugged, and re-initialized to trigger applicable event messages. 

Note: 
the current settings, which are established during this test. 

Success Criteria: 

This test is successful when monitoring thresholds and associated frequencies of certain EOC system resource parameters can be 
reconfigured; Tivoli compares values for these parameters with the reconfigured thresholds at the reconfigured frequencies; and 
Tivoli generates event messages when the values of these parameters exceed or are less than the reconfigured thresholds and 
upon change in status of certain system components. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. FOS Server and User Station Startup (No expected result/output; information only) 

Thresholds and associated monitoring frequency of certain system 
A printer, user station, an

The Tivoli event messages reflect the predefined parameter settings, although the event messages are triggered based on 
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2. Log in to an EOC user station, using UNIX login 
procedure, by entering User Name and Password 

Username: <user name> 

Password: ******** 

The login is accepted and two UNIX cmdtool windows 
appear 

3. Note: 
Server is not up. 

Execute applicable portions of the ‘FOS Server 
and User Station Startup and Shutdown’ test 
procedure (SYS-2000B) to bring up FOS Data 
Server. 

(Wait for initialization of the Data Server to 
complete before going to the next step) 

The FOS Data Server is properly initialized 

4. Execute applicable steps of the ‘FOS Server and 
User Station Startup and Shutdown’ (SYS-2000B) 
test procedure to bring up the EOC user station. 

(Wait for completion of user station startup) 

User station startup is complete when the Control 
Window comes up 

5. Invoke the Global Event Display. 

In the ‘Control Window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display- 
Global’ 

The ‘Tools’ menu comes up, then closes. 

The ‘Event Display’ comes up. 

This step is necessary only if the Data 
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6. Note: 
Server is not up. 

Execute applicable steps of the ‘FOS Server and 
User Station Startup and Shutdown’ (SYS-2000B) 
procedure to bring up the Real-Time Server 

(Wait for completion of Real-Time Server startup 
before going to the next step.) 

Real-Time Server Startup is complete when the 
following message appears in the Event Display: 

‘Active processing for String 100 was created.’ 

7. Tivoli Management Environment (TME) Setup (No expected result/output; information only) 

8. Enter the following in a new cmdtool window: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: xhost + 

%: source /etc/Tivoli/setup_env.csh 

%: tivoli 

The TME Desktop window comes up with several icons 

9. In the TME window, double-click on 
‘Administrators’ icon 

In ‘Administrators’ window, select ‘Root EOC 
Support’. 

In ‘Root EOC Support’ window, select ‘EOC- 
Support’. 

A ‘Policy Region: EOC-Support’ window comes up 
with many icons, including one icon for each host on the 
network and several Profile Manager icons 

10. In the ‘Policy Region: EOC-Support’ window, 
double-click on the icon associated with this user 
station 

A window associated with this user station comes up 
with several icons 

This step is necessary only if the Data 
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11. Configure Tivoli Space Threshold and 
Frequency (F-FOS-00735) 

(No expected result/output; information only) 

12. In the window associated with this user station, 
double-click ‘FOSGeneralProfile’ icon 

A ‘Sentry Profile Properties’ window comes up with
one or more entries (rows) of information 

13. In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Tivoli DB free space’ 

An ‘Edit Sentry Monitor’ window comes up with
editable fields 

14. In the ‘Edit Sentry Monitor’ window: 

Note the current triggering mechanism and 
threshold so they can be reset at the end of this 
test procedure. 

After ‘trigger when’, select ‘Less than’ 

Before ‘(Mbytes)’, enter: 

1000000 

Click ‘Set Monitoring Schedule’ button 

A ‘Set Monitoring Schedule’ window comes up with
editable fields 

15. In the ‘Set Monitoring Schedule’ window: 

Note the current schedule frequency so it can be 
reset at the end of this test procedure. 

After ‘Check monitor every’, enter: 

2 

Select ‘minutes’ 

Click ‘Change & Close’ button 

The ‘Set Monitoring Schedule’ window closes 
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16. In the ‘Edit Sentry Monitor’ window: 

Click ‘Change & Close’ button 

The ‘Edit Sentry Monitor’ window closes. 

The ‘Sentry Profile Properties’ window shows a 
schedule of every 2 minutes for the reconfigured row. 

An ‘exclamation point’ symbol appears next to the
affected entry. 

17. In the ‘Sentry Profile Properties’ window, under 
the ‘Profile’ pull-down menu, select ‘Save’. 

When the ‘Save’ is complete, select ‘Distribute’ 
under the ‘Profile’ pull-down menu. 

The ‘exclamation point’ symbol disappears after the
Save is complete. 

A ‘Distribute Profile’ window comes up. 

18. In the ‘Distribute Profile’ window, click on 
‘Merge profile with configuration file(s) button. 

Click ‘Distribute & Close’ button. 

In the ‘Sentry Profile Properties’ window, under 
‘Profile’ pull-down menu, select ‘Close’. 

The ‘Distribute Profile’ window closes. 

The ‘Sentry Profile Properties’ window closes. 

19. Configure NFS Bad Calls Threshold and 
Frequency (F-FOS-00705 c) 

(No expected result/output; information only) 

4-401
 322-CD-100-001/ 
411-CD-100-001 



20. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, in 
the ‘Profiles’ section of the ‘Profile Manager’ 
window, double-click on ‘Network Profile’ icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘NFS bad calls’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Greater than’ 

Before ‘(calls)’, enter: 

0 

The following windows come up and then close: 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured row shows a schedule of every 2 
minutes in ‘Sentry Profile Properties’ window. 

21. Configure Available Swap Space Threshold 
and Frequency (F-FOS-00715 a) 

(No expected result/output; information only) 
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22. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, 
double-click on ‘System Profile’ icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Available swap 
space’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Greater than’ 

Before ‘Mbytes’, enter: 

2 

The following windows come up and then close: 

‘Sentry Profile Properties’ window; 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured row shows a schedule of every 2 
minutes in ‘Sentry Profile Properties’ window. 

23. Configure Number of Zombie Processes 
Threshold and Frequency (F-FOS-00715 c) 

(No expected result/output; information only) 
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24. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, 
double-click on ‘System Profile’ icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Lingering terminated 
processes’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Not equal to’ 

Then enter: 

10 

The following windows come up and then close: 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured row shows a schedule of every 2 
minutes in ‘Sentry Profile Properties’ window. 

25. Configure Number of Pageouts Threshold and 
Frequency (F-FOS-00715 b) 

(No expected result/output; information only) 

26. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, 
double-click on ‘System Profile’ icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Page-outs’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Not equal to’ 

Before ‘Kbytes/sec’, enter: 

99 

The following windows come up and then close: 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured row shows a schedule of every 2 
minutes in ‘Sentry Profile Properties’ window. 
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27. Configure Number of Inodes Threshold and 
Frequency (F-FOS-00705 a) 

(No expected result/output; information only) 

28. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, 
double-click on ‘FOS Client Profile’ icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Inodes free (/data)’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Greater than’ 

Before ‘inodes’, enter: 

1 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Inodes free (/usr)’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Greater than’ 

Before ‘inodes’, enter: 

1 

The following windows come up and then close: 

‘Sentry Profile Properties’ window; 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured rows show a schedule of every 2 
minutes in ‘Sentry Profile Properties’ window. 

29. Configure Free Space Threshold and 
Frequency (F-FOS-00705 b) 

(No expected result/output; information only) 

4-405
 322-CD-100-001/ 
411-CD-100-001 



30. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, 
double-click on ‘FOS Client Profile’ icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Space free (/data)’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Greater than’ 

Before ‘Mbytes’, enter: 

3 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Space free (/usr)’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Greater than’ 

Before ‘Mbytes’, enter: 

3 

The following windows come up and then close: 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured rows show a schedule of every 2 
minutes in ‘Sentry Profile Properties’ window. 

31. Configure CPU Utilization Threshold and 
Frequency (F-FOS-00700) 

(No expected result/output; information only) 
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32. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, 
double-click on ‘FOS Client Profile’ icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Numeric script (...)’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Greater than’ 

Then enter: 

1 

The following windows come up and then close: 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured row shows a schedule of every 2 
minutes in ‘Sentry Profile Properties’ window. 

33. Configure Print Queue Status Threshold and 
Frequency (F-FOS-00725) 

(No expected result/output; information only) 

34. In the ‘Policy Region: EOC-Support’ window, 
double-click on ‘FOSServerProfileMgrint’ 

A ‘Profile Manager’ window comes up with several
icons contained in two sections. 
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35. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, in 
the ‘Profiles’ section of the ‘Profile Manager’ 
window, double-click on ‘FOS Server Profile’ 
icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Status of print 
queue’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Becomes unavailable’ 

The following windows come up and then close: 

‘Sentry Profile Properties’ window; 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured row shows a schedule of every 1 
minute in ‘Sentry Profile Properties’ window. 

36. Configure Host Status Threshold and 
Frequency (F-FOS-00730) 

(No expected result/output; information only) 

37. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, 
double-click on ‘FOS Server Profile’ icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Host status (<host 
name>)’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Becomes unavailable’ 

The following windows come up and then close: 

‘Sentry Profile Properties’ window; 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured row shows a schedule of every 1 
minute in ‘Sentry Profile Properties’ window. 

38. Configure Daemon Status Threshold and 
Frequency (F-FOS-00720) 

(No expected result/output; information only) 
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39. Repeat the ‘Configure Tivoli Space Threshold and 
Frequency’ steps with the following exceptions: 

In the window associated with this user station, 
double-click on ‘Data Server Profile’ icon. 

In the ‘Sentry Profile Properties’ window, double- 
click on the row containing ‘Daemon status’. 

In the ‘Edit Sentry Monitor’ window: 

After ‘trigger when’, select ‘Becomes unavailable’ 

The following windows come up and then close: 

‘Sentry Profile Properties’ window; 

‘Edit Sentry Monitor’ window; 

‘Set Monitoring Schedule’ window; 

‘Distribute Profile’ window. 

The reconfigured row shows a schedule of every 1 
minute in ‘Sentry Profile Properties’ window. 

40. Monitor Tivoli Event Messages (No expected result/output; information only) 

41. Filter out all event irrelevant event messages. 

In the Event Display, under the ‘Filter’ pull-down 
menu, select ‘Event Type’. 

In the pop-up menu, click on (de-select) all Event 
Types, except ‘SYS’ and ‘RMS’ (which remain 
selected). 

Click on ‘Apply’. 

Click on ‘Close’. 

The Event Display contains only SYS and RMS events. 

Tivoli event messages are displayed for each
reconfigured system resource parameter whose value
meets the re-defined criteria. Thus, there is an event 
message for the following: 

Tivoli database free space; 

NFS bad calls; 

Available swap space; 

Lingering terminated processes; 

Page-outs; 

Inodes; 

Free space; 

CPU utilization. 
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42. Print event messages. 

In a new cmdtool window, enter the following: 

%: snap 

The Event Display is printed. 

43. Monitor hardware status changes: (No expected result/output; information only) 

44. Emulate print queue unavailability by pulling the 
plug connected to the printer. 

Within 2 minutes, an event message appears indicating 
print queue unavailability. 

45. Emulate print queue availability by reinserting the 
plug connected to the printer. 

Within 2 minutes, an event message appears indicating 
print queue availability. 

46. Execute applicable steps of the ‘FOS Server and 
User Station Startup and Shutdown’ (SYS-2000B) 
test procedure to bring up another EOC user 
station. 

(Wait for completion of user station startup) 

User station startup is complete when the Control 
Window comes up 

47. Emulate a hardware failure by pulling the plug 
connected to the LAN on this ‘other’ user station. 

Within 2 minutes, an event message appears indicating 
user station failure. 

The following message appears in the cmdtool 
(console) window: 

‘le0: No carrier - cable disconnected or hub link test 
disabled?’ (Operational LAN), or 

‘le1: NFS server opsraid OK’ (Support LAN). 
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48. Re-insert the plug and terminate all FOS processes 
on this ‘other’ user station by entering the 
following in a cmdtool window: 

%: MyKill 

(Wait until all processes terminate.) 

Enter the following in a cmdtool window: 

%: rm.sh 

The following message appears in the cmdtool 
(console) window: 

‘le0: NFS server opsraid OK’ (Operational LAN), or 

‘le1: NFS server opsraid OK’ (Support LAN). 

All processes and endpoints are terminated. 

49. Execute applicable steps of the ‘FOS Server and 
User Station Startup’ (SYS-2000B) test procedure 
to bring up this ‘other’ user station. 

(Wait for completion of user station startup) 

User station startup is complete when the Control 
Window appears on this ‘other’ user station. 

Within 2 minutes of user station startup completion, an 
event message appears indicating this ‘other’ user 
station has come back up. 

50. Reconfigure Tivoli Parameters: (No expected result/output; information only) 

51. Reconfigure Tivoli parameters to their previous 
values by repeating the ‘Configure Tivoli Space 
Threshold and Frequency’ steps for all modified 
parameters. 

After several minutes, there are fewer Tivoli event 
messages, reflecting the pre-test Tivoli configuration. 

52. End of test. 
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Appendix A. FOS Test Dataset Definitions


Data Set Release Data Set Description 

Spacecraft database 
provided by Martin 
Marietta Corporation 
(MMC). 

A - Prelim. 

B 

constraint 
definitions 

Spacecraft database contains both spacecraft and instrument 
information. Should contain s/c health & safety, housekeeping 
telemetry parameter descriptions including EU, limit definitions. 
Spacecraft/instrument command descriptions should contain 
constraint records, command syntax rules, command validation 
parameters. Activity Constraint definitions should also be 
included. 

Housekeeping; 
health & safety; 
standby telemetry 

A Housekeeping/health & safety; diagnostic packets must 
contain valid spacecraft and MODIS, MOPITT, MISR, CERES 
parameter values (i.e. most of raw values in bounds); all APIDs 
supported. Raw data for 95% of parameters should not result 
in conversion errors. 

SSR dump data B Raw data for 95% of parameters should not result in 
conversion errors. 

SCC/instrument 
microprocessor 
dump data 

B Scriptable, addresses variable and scriptable to allow for 
verification of ground image. 

EDOS CODA and 
CODA Report files 

B Provided by EDOS 

Operational Data 
Messages 

B Provided by NCC 

Return Channel 
Time Delay 
Messages 

B Provided by NCC 

Time Transfer 
Messages 

B Provided by NCC 
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Data Set Release Data Set Description 

FDF planning aids B FDF Planning Aid files should include one or more of the 
following: 

a. Real-time Coarse Attitude Determination 
b. EOS Mission Star Catalog 
c. Star Density Profile 
d. Star Interference 
e. ESA Sun-Moon Interference 
f. TDRS State Vectors and Availability Times 
g. EOS Brouwer-Lyddane Elements 
h. TDRS Brouwer-Lyddane Elements 
i. EOS Repaired Ephemeris 
j. Simulated Spacecraft Ephemeris 
k. Filter Tuning Parameters for TONS filter 
l. Omni to TDRS Viewing Times 
m. HGA to TDRSS Viewing Times 
n. Omni to Ground Station Viewing Times: 
o. HGA Gimbal Angles 
p. Predicted Ephemeris 
q. Orbit Adjust Maneuver Request 
r. Orbit Adjust Burn Times and Duration 
s. TDRS Navigation Contact Guidelines 

MODIS, MOPITT, 
MISR, CERES 
Activity definitions. 
Preliminary 
Resource schedule. 

B BAP files should contain activity definitions with time identifiers 
and/or offsets. PRS should contain events pertaining to the 
same contact as those in the instrument BAPs being 
updated/displayed. 

NCC message data; 
TDRSS availability 
schedule files. 

A - GCM 
Status and 
disposition 
Messages. 
B1 -
Complete 

NCC message files may include one or more of the following: 

a. Communication test message 
b. User Performance Data Request 
c. User Schedule - Normal support 
d. User Schedule - Premium support 
e. User schedule - simulation support 
f. GCM status 
g. GCM Disposition 
h. Schedule Deletion Notification Message 
i. Schedule Result Message 
j. Schedule Add Request 
k. Schedule Delete Request Message 
l. Acknowledgment 

Preliminary resource 
schedule; TDRSS 
availability schedules 

A Resource schedules contain activities causing TDRSS 
scheduling conflict. 
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Data Set Release Data Set Description 

TDRSS availability 
schedule. 

A Must be available despite unavailability of NCC for transmitting 
the schedule until Release B. 

Spacecraft/ 
instrument 
commands 

A - limited 
B 

Command data should support the following command 
capabilities: 
a. Initiate Load dump 
b. Reset load dump 
c. Set/Inhibit Stored command ID 
d. Activate/Abort RTC Sequences 
e. Insert NOOP, JUMP, and HALT commands 
f. Mode Transition 

Discrete Commands A - limited 
B 

a. Accept power up/down SCC 
b. Change mode of SCC 
c. Change mode of GN&C Subsystem 
d. Change mode of CT&C Subsystem 
e. Change mode of the EPS 
f. Change mode of the instruments 
g. Enable/disable the SSR 
h. Begin playback of the SSR 

EDOS Simulation A; GSFC 
testing only 

Simulation of EDOS for receipt of EDU/CCSDS command 
packets transmitted by EOC 

Spacecraft Flight 
Software Loads 

B Includes accepting flight software and data table loads from the 
SDVF 

Spacecraft/ 
instrument 
microprocessor 
loads. 

A Spacecraft and instrument table and microprocessor loads 
and commands called for in the DAS must be supported by the 
FOS operational database 

MISR, MODIS, 
MOPITT, CERES 
microprocessor table 
loads. 

B Loads specified by either address locations or table name; 
Also the capabilities to abort or reject a load anytime before 
completion 

Discrete/non

discrete spacecraft 
and instrument 
commands. 

A Several examples for each; commands called for in the DAS 
must be supported by the FOS operational database 

Spacecraft/ 
instrument command 
groups 

A All command groups transmitted to the EOC for inclusion into 
the schedule must be supported by the FOS operational data 
base. 

LTIP and LTSP B LTIP and LTSP files must be resident at the EOC despite 
availability of the SMC to transmit the files during the Release 
A timeframe 

Telemetry and 
Ground Telemetry 
Archive Files 

A - limited 
B - full 

Used for the verification of analysis products. Raw data for 
95% of parameters should not result in conversion errors. 

Relative Time 
Command (RTC) 
Sequence load data 
sets 

A RTS load contents available in the EOC for Command 
Management Subsystem (CMS) testing 
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Data Set Release Data Set Description 

Table Load data 
set 

A Table load contents available in the EOC for Command 
Management Subsystem (CMS) testing 

Flight Software 
Load data set 

B Flight Software load contents available in the EOC for 
Command Management Subsystem (CMS) testing 

SDVF transfer of 
flight software load 

B Software Development & Verification Facility (SDVF) 
simulation for verification of flight software transfer to the EOC. 

Science Computing 
Facility (SCF) 
transfer of 
instrument 
microprocessor load 

B SCF simulation for verification of instrument microprocesor 
load transfer to the EOC. 

ASTER ICC/IST 
Simulation; ASTER 
instrument activity 
transfer to the EOC 

B ASTER ICC/IST simulation for verification of connectivity and 
transfer of ASTER instrument activities to the EOC. 
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Appendix B. Level 4 Requirements to Test Case

Mapping


The following matrix maps each applicable level 4 requirement to the associated functional test 
case or set of test cases in which they are verified. 

Level 4 ID Test Case 

F-ANA-01010 ANA-2000B 

F-ANA-01015 NCC-2040B 

F-ANA-01020 ANA-2110B 

F-ANA-01025 ANA-2100B 

F-ANA-01025 IST-2010B 

F-ANA-01030 ANA-2120B 

F-ANA-01030 IST-2010B 

F-ANA-01040 FDF-2000B 

F-ANA-01050 NCC-2040B 

F-ANA-01060 CONT-2030B 

F-ANA-01070 POST-B 

F-ANA-01080 POST-B 

F-ANA-02010 ANA-2090B 

F-ANA-02030 ANA-2090B 

F-ANA-02030 IST-2010B 

F-ANA-02040 ANA-2090B 

F-ANA-02050 ANA-2090B 

F-ANA-02050 IST-2010B 

F-ANA-03010 ANA-2000B 

F-ANA-03012 EDOS-2001B 

F-ANA-03012 NCC-2040B 

F-ANA-03015 ANA-2110B 

F-ANA-03020 ANA-2090B 

F-ANA-03030 ANA-2110B 

F-ANA-03040 ANA-2090B 

F-ANA-03050 ANA-2090B 

F-ANA-03060 ANA-2090B 

F-ANA-03070 ANA-2110B 

F-ANA-03080 ANA-2110B 

F-ANA-03100 ANA-2100B 

F-ANA-03100 IST-2010B 

F-ANA-03110 ANA-2100B 

F-ANA-03110 IST-2010B 
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Level 4 ID Test Case 

F-ANA-03120 ANA-2100B 

F-ANA-03120 IST-2010B 

F-ANA-03125 ANA-2100B 

F-ANA-03125 IST-2010B 

F-ANA-03130 ANA-2100B 

F-ANA-03130 IST-2010B 

F-ANA-03135 ANA-2000B 

F-ANA-03140 ANA-2090B 

F-ANA-03150 ANA-2090B 

F-ANA-03160 ANA-2090B 

F-ANA-03170 ANA-2090B 

F-ANA-03180 ANA-2100B 

F-ANA-03180 IST-2010B 

F-ANA-03190 ANA-2100B 

F-ANA-03190 IST-2010B 

F-ANA-03200 ANA-2070B 

F-ANA-03200 IST-2010B 

F-ANA-03210 ANA-2070B 

F-ANA-03210 IST-2010B 

F-ANA-04010 ANA-2000B 

F-ANA-04020 ANA-2000B 

F-ANA-04020 IST-2010B 

F-ANA-04025 ANA-2100B 

F-ANA-04030 FDF-2000B 

F-ANA-04035 EDOS-2001B 

F-ANA-04035 NCC-2040B 

F-ANA-04040 ANA-2120B 

F-ANA-04040 IST-2010B 

F-ANA-04050 ANA-2040B 

F-ANA-04050 IST-2010B 

F-ANA-04060 OPR-2000B 

F-ANA-04070 ANA-2000B 

F-ANA-04080 ANA-2000B 

F-ANA-04090 ANA-2000B 

F-ANA-04100 ANA-2000B 

F-ANA-04110 ANA-2000B 

F-ANA-04120 ANA-2000B 

F-ANA-04120 IST-2010B 

F-ANA-04130 ANA-2000B 

F-ANA-04140 POST-B 

F-ANA-04150 POST-B 

F-ANA-04200 CONT-2010B 
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Level 4 ID Test Case 

F-ANA-04210 CONT-2010B 

F-ANA-04220 CONT-2010B 

F-ANA-04310 ANA-2100B 

F-ANA-04310 IST-2010B 

F-ANA-04315 ANA-2120B 

F-ANA-04320 ANA-2120B 

F-ANA-04330 ANA-2120B 

F-ANA-04340 ANA-2120B 

F-ANA-04350 ANA-2060B 

F-ANA-04360 ANA-2060B 

F-ANA-04360 IST-2010B 

F-ANA-04370 ANA-2060B 

F-ANA-04375 ANA-2060B 

F-ANA-04380 ANA-2060B 

F-ANA-04390 ANA-2060B 

F-ANA-04400 ANA-2060B 

F-ANA-04410 ANA-2070B 

F-ANA-04415 ANA-2070B 

F-ANA-04420 ANA-2070B 

F-ANA-04430 ANA-2070B 

F-ANA-04510 EDOS-2010B 

F-ANA-04520 EDOS-2010B 

F-ANA-04530 EDOS-2010B 

F-ANA-05010 ANA-2100B 

F-ANA-05020 ANA-2100B 

F-ANA-05030 ANA-2100B 

F-ANA-05031 ANA-2100B 

F-ANA-05032 ANA-2100B 

F-ANA-05033 ANA-2100B 

F-ANA-05034 ANA-2100B 

F-ANA-05040 ANA-2100B 

F-ANA-05050 ANA-2100B 

F-ANA-05060 ANA-2100B 

F-ANA-05070 ANA-2100B 

F-ANA-05080 ANA-2100B 

F-ANA-05090 ANA-2100B 

F-ANA-05100 ANA-2100B 

F-ANA-05110 ANA-2100B 

F-ANA-05120 ANA-2100B 

F-ANA-05130 ANA-2100B 

F-ANA-05140 ANA-2100B 

F-ANA-05150 ANA-2100B 
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Level 4 ID Test Case 

F-ANA-05160 FDF-2000B 

F-ANA-05170 FDF-2000B 

F-ANA-05180 FDF-2000B 

F-ANA-05190 FDF-2000B 

F-ANA-05210 ANA-2100B 

F-ANA-05220 ANA-2110B 

F-ANA-05250 ANA-2100B 

F-ANA-06020 ANA-2040B 

F-ANA-06020 IST-2010B 

F-ANA-06021 ANA-2040B 

F-ANA-06021 IST-2010B 

F-ANA-06022 ANA-2040B 

F-ANA-06022 IST-2010B 

F-ANA-06023 ANA-2040B 

F-ANA-06023 IST-2010B 

F-ANA-06030 ANA-2040B 

F-ANA-06030 ANA-2100B 

F-ANA-06030 CONT-2010B 

F-ANA-06030 CONT-2030B 

F-ANA-06030 CONT-2040B 

F-ANA-06040 ANA-2040B 

F-ANA-06040 IST-2010B 

F-ANA-06045 ANA-2040B 

F-ANA-06050 ANA-2040B 

F-ANA-06050 IST-2010B 

F-ANA-07010 EDOS-2001B 

F-ANA-07010 NCC-2040B 

F-ANA-07020 EDOS-2001B 

F-ANA-07020 NCC-2040B 

F-ANA-07030 EDOS-2001B 

F-ANA-07030 NCC-2040B 

F-ANA-07110 ANA-2020B 

F-ANA-07120 ANA-2020B 

F-ANA-07130 ANA-2020B 

F-ANA-07160 ANA-2020B 

F-ANA-07180 ANA-2020B 

F-ANA-07210 ANA-2030B 

F-ANA-07215 ANA-2030B 

F-ANA-07220 ANA-2030B 

F-ANA-07230 ANA-2030B 

F-ANA-07240 ANA-2030B 

F-ANA-07250 ANA-2030B 
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Level 4 ID Test Case 

F-ANA-07260 ANA-2030B 

F-ANA-07280 ANA-2030B 

F-ANA-07300 ANA-2020B 

F-ANA-07310 ANA-2020B 

F-ANA-07310 ANA-2030B 

F-ANA-07320 ANA-2020B 

F-ANA-07320 ANA-2030B 

F-ANA-07330 ANA-2030B 

F-ANA-07400 CONT-2020B 

F-ANA-07420 CONT-2020B 

F-ANA-07430 CONT-2020B 

F-ANA-07440 CONT-2020B 

F-ANA-07500 POST-B 

F-ANA-07510 POST-B 

F-ANA-07520 POST-B 

F-ANA-07530 POST-B 

F-ANA-07540 POST-B 

F-ANA-07550 POST-B 

F-ANA-08010 ANA-2120B 

F-ANA-08020 ANA-2120B 

F-ANA-08030 ANA-2120B 

F-ANA-08040 ANA-2120B 

F-ANA-08050 ANA-2120B 

F-ANA-08060 ANA-2120B 

F-ANA-08060 IST-2010B 

F-ANA-08070 ANA-2000B 

F-ANA-09010 POST-B 

F-ANA-09020 POST-B 

F-ANA-09030 POST-B 

F-ANA-09040 POST-B 

F-ANA-09050 POST-B 

F-ANA-09060 POST-B 

F-ANA-09070 CONT-2010B 

F-ANA-09080 CONT-2010B 

F-ANA-09090 CONT-2010B 

F-ANA-09100 CONT-2010B 

F-ANA-09110 CONT-2010B 

F-ANA-09120 CONT-2010B 

F-ANA-09130 CONT-2010B 

F-ANA-09140 CONT-2010B 

F-ANA-09150 CONT-2010B 

F-ANA-09160 CONT-2010B 
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Level 4 ID Test Case 

F-ANA-09300 CONT-2010B 

F-ANA-09305 CONT-2010B 

F-ANA-09310 CONT-2010B 

F-ANA-09315 CONT-2010B 

F-ANA-17010 CONT-2030B 

F-ANA-17020 CONT-2030B 

F-ANA-17030 CONT-2030B 

F-ANA-17040 CONT-2030B 

F-ANA-17050 CONT-2030B 

F-ANA-17060 CONT-2030B 

F-CMD-01120 ETE-2010B 

F-CMD-01125 ETE-2010B 

F-CMD-01140 POST-B 

F-CMD-01150 CMS-2000B 

F-CMD-01160 ETE-2010B 

F-CMD-01165 CMD-2070B 

F-CMD-01180 CMD-2030B 

F-CMD-01185 EDOS-2002B 

F-CMD-01230 CMD-2070B 

F-CMD-01250 ETE-2010B 

F-CMD-01310 CMD-2070B 

F-CMD-01315 FUI-2060B 

F-CMD-01317 CMD-2015B 

F-CMD-01320 CMD-2070B 

F-CMD-01325 CMD-2050B 

F-CMD-01330 CMD-2050B 

F-CMD-01335 CMD-2050B 

F-CMD-01340 CMD-2050B 

F-CMD-01345 CMD-2050B 

F-CMD-02110 CMD-2001B 

F-CMD-02120 CMD-2001B 

F-CMD-02125 CMD-2001B 

F-CMD-02130 CMD-2001B 

F-CMD-02135 CMD-2001B 

F-CMD-02140 CMD-2001B 

F-CMD-02210 CMD-2030B 

F-CMD-02215 CMD-2030B 

F-CMD-02215 IST-2010B 

F-CMD-02220 CMD-2030B 

F-CMD-02225 CMD-2030B 

F-CMD-02230 CMD-2030B 

F-CMD-02235 CMD-2030B 
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Level 4 ID Test Case 

F-CMD-02240 CMD-2030B 

F-CMD-02245 CMD-2030B 

F-CMD-02250 CMD-2030B 

F-CMD-02255 CMD-2030B 

F-CMD-02260 CMD-2030B 

F-CMD-02265 CMD-2030B 

F-CMD-03110 CMD-2030B 

F-CMD-03115 CMD-2030B 

F-CMD-03125 CMD-2030B 

F-CMD-03127 CMD-2030B 

F-CMD-03130 CMD-2030B 

F-CMD-03133 CMD-2030B 

F-CMD-03135 CMD-2030B 

F-CMD-03210 CMD-2030B 

F-CMD-03215 CMD-2030B 

F-CMD-03215 FUI-2060B 

F-CMD-03220 CMD-2050B 

F-CMD-03225 CMD-2030B 

F-CMD-03230 CMD-2030B 

F-CMD-03310 CMD-2050B 

F-CMD-03315 CMD-2050B 

F-CMD-03320 CMS-2040B 

F-CMD-03320 CMS-2060B 

F-CMD-03320 CMS-2170B 

F-CMD-03410 CMD-2030B 

F-CMD-04110 ETE-2000B 

F-CMD-04115 CMD-2030B 

F-CMD-04120 CMD-2030B 

F-CMD-04120 CMD-2070B 

F-CMD-04130 CMD-2050B 

F-CMD-04210 CMD-2070B 

F-CMD-04215 CMD-2070B 

F-CMD-04220 CMD-2070B 

F-CMD-04225 CMD-2070B 

F-CMD-04230 CMD-2070B 

F-CMD-05110 CMD-2080B 

F-CMD-05115 CMD-2030B 

F-CMD-05115 CMD-2080B 

F-CMD-05120 CMD-2070B 

F-CMD-05120 CMD-2080B 

F-CMD-05220 CMD-2080B 

F-CMD-05225 CMD-2080B 
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Level 4 ID Test Case 

F-CMD-05230 CMD-2080B 

F-CMD-05235 CMD-2080B 

F-CMD-05245 CMD-2080B 

F-CMD-05247 CMD-2080B 

F-CMD-05250 CMD-2050B 

F-CMD-05255 CMD-2050B 

F-CMD-05310 IST-2010B 

F-CMD-05410 IST-2010B 

F-CMD-05510 CMD-2050B 

F-CMD-06100 EDOS-2002B 

F-CMD-06110 EDOS-2002B 

F-CMD-06120 EDOS-2002B 

F-CMD-11210 CMD-2070B 

F-CMD-11211 CMD-2070B 

F-CMD-11212 CMD-2070B 

F-CMD-11215 CMD-2070B 

F-CMD-11226 CMD-2001B 

F-CMD-12130 CMD-2070B 

F-CMD-12240 CMD-2001B 

F-CMD-12245 CMD-2001B 

F-CMD-13230 CMD-2001B 

F-CMD-14310 CMD-2070B 

F-CMD-14313 CMD-2001B 

F-CMD-14315 CMD-2070B 

F-CMD-15245 CMD-2080B 

F-CMD-15515 CMD-2050B 

F-CMD-15520 CMD-2050B 

F-CMS-00105 PAS-2200B 

F-CMS-00110 CMS-2090B 

F-CMS-00115 CMS-2090B 

F-CMS-00118 CMS-2090B 

F-CMS-00120 CMS-2090B 

F-CMS-00125 CMS-2090B 

F-CMS-00130 CMS-2090B 

F-CMS-00140 CMS-2100B 

F-CMS-00205 CMS-2090B 

F-CMS-00210 CMS-2090B 

F-CMS-00215 CMS-2090B 

F-CMS-00220 CMS-2090B 

F-CMS-00230 CMS-2090B 

F-CMS-00235 PAS-2180B 

F-CMS-00240 CMS-2090B 
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Level 4 ID Test Case 

F-CMS-00243 CMS-2090B 

F-CMS-00245 CMS-2090B 

F-CMS-00250 CMS-2100B 

F-CMS-00305 PAS-2110B 

F-CMS-00405 PAS-2110B 

F-CMS-00425 CMS-2100B 

F-CMS-00510 CMS-2100B 

F-CMS-00530 CMS-2100B 

F-CMS-00550 CMS-2100B 

F-CMS-00610 PAS-2200B 

F-CMS-00615 PAS-2200B 

F-CMS-00620 PAS-2200B 

F-CMS-00625 PAS-2200B 

F-CMS-00630 PAS-2200B 

F-CMS-00635 PAS-2200B 

F-CMS-00640 CMS-2090B 

F-CMS-00660 PAS-2110B 

F-CMS-00670 PAS-2200B 

F-CMS-00675 PAS-2200B 

F-CMS-00710 CMS-2170B 

F-CMS-00720 CMS-2170B 

F-CMS-00720 IST-2010B 

F-CMS-00725 IST-2010B 

F-CMS-00728 IST-2010B 

F-CMS-00729 IST-2010B 

F-CMS-00730 CMS-2170B 

F-CMS-00730 IST-2010B 

F-CMS-00735 CMS-2170B 

F-CMS-00740 CMS-2170B 

F-CMS-00745 CMS-2170B 

F-CMS-00750 CMS-2170B 

F-CMS-00755 CMS-2170B 

F-CMS-00810 CMS-2170B 

F-CMS-00820 CMS-2170B 

F-CMS-00830 CMS-2170B 

F-CMS-00840 CMS-2170B 

F-CMS-00850 CMS-2170B 

F-CMS-00850 IST-2010B 

F-CMS-00860 CMS-2170B 

F-CMS-00910 CMS-2180B 

F-CMS-00915 CMS-2180B 

F-CMS-00915 IST-2010B 
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Level 4 ID Test Case 

F-CMS-00920 CMS-2180B 

F-CMS-00925 CMS-2180B 

F-CMS-00930 CMS-2180B 

F-CMS-00930 IST-2010B 

F-CMS-00935 CMS-2180B 

F-CMS-00940 CMS-2180B 

F-CMS-00950 CMS-2180B 

F-CMS-00950 IST-2010B 

F-CMS-01010 CMS-2040B 

F-CMS-01020 CMS-2040B 

F-CMS-01025 IST-2010B 

F-CMS-01028 FDF-2000B 

F-CMS-01029 FDF-2000B 

F-CMS-01030 CMS-2040B 

F-CMS-01110 CMS-2040B 

F-CMS-01120 CMS-2040B 

F-CMS-01130 CMS-2040B 

F-CMS-01140 FDF-2000B 

F-CMS-01150 CMS-2040B 

F-CMS-01150 IST-2010B 

F-CMS-01160 CMS-2040B 

F-CMS-01210 CMS-2190B 

F-CMS-01215 CMS-2190B 

F-CMS-01215 IST-2010B 

F-CMS-01220 CMS-2190B 

F-CMS-01225 CMS-2190B 

F-CMS-01225 IST-2010B 

F-CMS-01305 IST-2010B 

F-CMS-01310 CMS-2060B 

F-CMS-01320 CMS-2060B 

F-CMS-01325 CMS-2060B 

F-CMS-01330 CMS-2060B 

F-CMS-01330 IST-2010B 

F-CMS-01340 CMS-2060B 

F-CMS-01350 CMS-2060B 

F-CMS-01360 CMS-2060B 

F-CMS-01360 IST-2010B 

F-CMS-01405 IST-2010B 

F-CMS-01410 IST-2010B 

F-CMS-01420 CMS-2060B 

F-CMS-01425 CMS-2060B 

F-CMS-01430 CMS-2060B 
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Level 4 ID Test Case 

F-CMS-01430 IST-2010B 

F-CMS-01440 CMS-2060B 

F-CMS-01450 CMS-2060B 

F-CMS-01460 CMS-2060B 

F-CMS-01460 IST-2010B 

F-CMS-01505 IST-2010B 

F-CMS-01505 PAS-2200B 

F-CMS-01512 CONT-2040B 

F-CMS-01610 PAS-2200B 

F-CMS-01630 PAS-2180B 

F-CMS-01710 CMS-2000B 

F-CMS-01715 CMS-2000B 

F-CMS-01720 CMS-2000B 

F-CMS-01725 IST-2010B 

F-CMS-01730 IST-2010B 

F-CMS-01735 CMS-2000B 

F-CMS-01740 CMS-2000B 

F-CMS-01743 CMS-2000B 

F-CMS-01745 CMS-2000B 

F-CMS-01750 CMS-2000B 

F-CMS-01760 CMS-2000B 

F-CMS-01765 CMS-2000B 

F-CMS-01770 CMS-2000B 

F-CMS-01775 CMS-2000B 

F-CMS-01820 FUI-2050B 

F-CMS-01820 IST-2010B 

F-CMS-01825 FUI-2050B 

F-CMS-01825 IST-2010B 

F-CMS-01830 FUI-2050B 

F-CMS-01835 FUI-2050B 

F-CMS-01840 FUI-2050B 

F-CMS-10110 CMS-2090B 

F-CMS-10120 CMS-2090B 

F-CMS-10125 CMS-2090B 

F-CMS-10130 CMS-2100B 

F-CMS-10210 CMS-2100B 

F-CMS-10220 CMS-2100B 

F-CMS-10240 PAS-2180B 

F-CMS-10250 CMS-2090B 

F-CMS-10255 CMS-2090B 

F-CMS-10410 CMS-2100B 

F-CMS-10420 CMS-2100B 
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Level 4 ID Test Case 

F-CMS-10510 IST-2010B 

F-CMS-10600 CMS-2090B 

F-CMS-10710 CMS-2170B 

F-CMS-10720 CMS-2170B 

F-CMS-10725 CMS-2180B 

F-CMS-10730 CMS-2170B 

F-CMS-10740 CMS-2170B 

F-CMS-10750 IST-2010B 

F-CMS-11170 CMS-2040B 

F-CMS-11170 CMS-2060B 

F-CMS-11170 CMS-2090B 

F-CMS-11170 CMS-2170B 

F-CMS-11180 CMS-2190B 

F-CMS-11185 CMS-2040B 

F-CMS-11190 CMS-2040B 

F-CMS-11310 CMS-2060B 

F-CMS-11320 CMS-2060B 

F-CMS-11330 CMS-2060B 

F-CMS-11340 CMS-2060B 

F-CMS-11410 CMD-2070B 

F-CMS-11420 CMS-2060B 

F-CMS-11510 IST-2010B 

F-CMS-11720 CMS-2000B 

F-DMS-00110 DBS-2000B 

F-DMS-00120 DBS-2000B 

F-DMS-00130 DBS-2000B 

F-DMS-00140 DBS-2000B 

F-DMS-00150 PAS-2000B 

F-DMS-00160 PAS-2000B 

F-DMS-00170 DBS-2000B 

F-DMS-00180 DBS-2000B 

F-DMS-00205 DBS-2030B 

F-DMS-00205 IST-2010B 

F-DMS-00210 DBS-2030B 

F-DMS-00210 IST-2010B 

F-DMS-00215 DBS-2030B 

F-DMS-00215 IST-2010B 

F-DMS-00220 DBS-2030B 

F-DMS-00220 IST-2010B 

F-DMS-00225 DBS-2030B 

F-DMS-00225 IST-2010B 

F-DMS-00230 DBS-2030B 
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Level 4 ID Test Case 

F-DMS-00230 IST-2010B 

F-DMS-00231 DBS-2030B 

F-DMS-00232 DBS-2030B 

F-DMS-00233 DBS-2030B 

F-DMS-00235 IST-2010B 

F-DMS-00235 PAS-2000B 

F-DMS-00240 IST-2010B 

F-DMS-00240 PAS-2000B 

F-DMS-00245 IST-2010B 

F-DMS-00245 PAS-2000B 

F-DMS-00250 DBS-2030B 

F-DMS-00250 IST-2010B 

F-DMS-00255 DBS-2030B 

F-DMS-00255 IST-2010B 

F-DMS-00260 DBS-2030B 

F-DMS-00260 IST-2010B 

F-DMS-00265 DBS-2030B 

F-DMS-00270 DBS-2000B 

F-DMS-00310 DBS-2000B 

F-DMS-00320 DBS-2000B 

F-DMS-00330 PAS-2000B 

F-DMS-00340 DBS-2000B 

F-DMS-00350 DBS-2000B 

F-DMS-00360 DBS-2000B 

F-DMS-00370 DBS-3100FPB 

F-DMS-00375 DBS-3100FPB 

F-DMS-00410 DBS-2020B 

F-DMS-00420 DBS-2020B 

F-DMS-00510 DBS-2010B 

F-DMS-00520 DBS-2010B 

F-DMS-00530 DBS-2010B 

F-DMS-00540 DBS-2010B 

F-DMS-00550 DBS-2010B 

F-DMS-00610 DBS-2000B 

F-DMS-00610 TLM-2170B 

F-DMS-00620 DBS-2000B 

F-DMS-00630 DBS-2000B 

F-DMS-00640 DBS-2000B 

F-DMS-00650 DBS-2000B 

F-DMS-00710 TLM-2160B 

F-DMS-00720 TLM-2160B 

F-DMS-00730 TLM-2160B 
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Level 4 ID Test Case 

F-DMS-00740 ANA-2100B 

F-DMS-00750 ANA-2100B 

F-DMS-00760 ANA-2100B 

F-DMS-00770 ANA-2110B 

F-DMS-00780 TLM-2190B 

F-DMS-00790 ANA-2110B 

F-DMS-00810 TLM-2160B 

F-DMS-00820 TLM-2160B 

F-DMS-00830 TLM-2160B 

F-DMS-00840 ANA-2100B 

F-DMS-00910 EVT-2020B 

F-DMS-00920 EVT-2020B 

F-DMS-00930 EVT-2020B 

F-DMS-00940 EVT-2020B 

F-DMS-00950 POST-B 

F-DMS-00960 POST-B 

F-DMS-01010 ANA-2110B 

F-DMS-01020 ANA-2100B 

F-DMS-01020 ANA-2110B 

F-DMS-01021 EDOS-2010B 

F-DMS-01021 PAS-2035B 

F-DMS-01022 POST-B 

F-DMS-01110 POST-B 

F-DMS-01120 POST-B 

F-DMS-01130 POST-B 

F-DMS-01140 POST-B 

F-DMS-01150 OPR-2000B 

F-DMS-01210 EVT-2000B 

F-DMS-01220 EVT-2010B 

F-DMS-01230 EVT-2000B 

F-DMS-01230 EVT-2010B 

F-DMS-01240 EVT-2020B 

F-DMS-01250 EVT-2030B 

F-DMS-01260 EVT-2030B 

F-DMS-01270 EVT-2000B 

F-DMS-01270 SYS-2030B 

F-DMS-01280 EVT-2000B 

F-DMS-01280 SYS-2030B 

F-DMS-01285 POST-B 

F-DMS-01290 EVT-2000B 

F-DMS-01290 IST-2010B 

F-DMS-01295 POST-B 
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Level 4 ID Test Case 

F-DMS-01310 DBS-2000B 

F-DMS-01320 DBS-2000B 

F-DMS-01330 DBS-2000B 

F-DMS-01400 IST-2010B 

F-DMS-01405 CMS-2040B 

F-DMS-01405 CMS-2060B 

F-DMS-01405 CMS-2090B 

F-DMS-01405 CMS-2170B 

F-DMS-01410 POST-B 

F-DMS-01420 EDOS-2010B 

F-DMS-01430 POST-B 

F-DMS-01435 POST-B 

F-DMS-01450 FDF-2000B 

F-DMS-01451 FDF-2000B 

F-DMS-01452 FDF-2000B 

F-DMS-01455 FDF-2000B 

F-DMS-01460 POST-B 

F-DMS-01465 FDF-3100FPB 

F-DMS-01475 FUI-2120B 

F-DMS-01480 FUI-2120B 

F-DMS-01485 FDF-2000B 

F-DMS-01490 FDF-2000B 

F-DMS-10110 TLM-2020B 

F-DMS-10710 EDOS-2030B 

F-DMS-10720 EDOS-2030B 

F-DMS-11010 EDOS-2030B 

F-DMS-11030 CONT-2020B 

F-FOS-00010 ETE-2010B 

F-FOS-00015 ETE-2010B 

F-FOS-00017 POST-B 

F-FOS-00020 EDOS-2000B 

F-FOS-00020 ETE-2010B 

F-FOS-00020 TLM-2000B 

F-FOS-00020 TLM-2010B 

F-FOS-00025 ETE-2010B 

F-FOS-00035 SYS-2020B 

F-FOS-00040 OPR-2000B 

F-FOS-00045 OPR-2000B 

F-FOS-00070 SYS-2000B 

F-FOS-00075 OPR-2000B 

F-FOS-00080 OPR-2000B 

F-FOS-00085 OPR-2000B 
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F-FOS-00090 OPR-2000B 

F-FOS-00095 OPR-2000B 

F-FOS-00098 SYS-2030B 

F-FOS-00110 OPR-2000B 

F-FOS-00115 OPR-2000B 

F-FOS-00120 OPR-2000B 

F-FOS-00125 OPR-2000B 

F-FOS-00130 OPR-2000B 

F-FOS-00140 OPR-2000B 

F-FOS-00145 OPR-2000B 

F-FOS-00155 OPR-2000B 

F-FOS-00160 OPR-2000B 

F-FOS-00165 OPR-2000B 

F-FOS-00175 IST-2000B 

F-FOS-00180 IST-2000B 

F-FOS-00200 ETE-2000B 

F-FOS-00220 OPR-2000B 

F-FOS-00225 OPR-2000B 

F-FOS-00230 ETE-2000B 

F-FOS-00240 EVT-2010B 

F-FOS-00245 EVT-2010B 

F-FOS-00250 EVT-2000B 

F-FOS-00250 EVT-2010B 

F-FOS-00255 EVT-2000B 

F-FOS-00260 ETE-2000B 

F-FOS-00300 OPR-2000B 

F-FOS-00305 ETE-2000B 

F-FOS-00308 SAS-2000B 

F-FOS-00310 TLM-2170B 

F-FOS-00315 CMD-2001B 

F-FOS-00317 IST-2010B 

F-FOS-00318 IST-2010B 

F-FOS-00320 CMD-2070B 

F-FOS-00320 ETE-2010B 

F-FOS-00320 FDF-2000B 

F-FOS-00320 NCC-2020B 

F-FOS-00320 NCC-2030B 

F-FOS-00320 PAS-2040B 

F-FOS-00320 TLM-2000B 

F-FOS-00320 TLM-2010B 

F-FOS-00321 POST-B 

F-FOS-00322 SAS-2000B 
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F-FOS-00325 FDF-2000B 

F-FOS-00327 POST-B 

F-FOS-00330 FDF-2000B 

F-FOS-00335 NCC-2030B 

F-FOS-00340 NCC-2020B 

F-FOS-00340 NCC-2030B 

F-FOS-00340 PAS-2040B 

F-FOS-00345 POST-B 

F-FOS-00347 CMD-2070B 

F-FOS-00350 TLM-2010B 

F-FOS-00350 TLM-2170B 

F-FOS-00420 FUI-2090B 

F-FOS-00430 FUI-2090B 

F-FOS-00430 IST-2010B 

F-FOS-00450 HRD-2000B 

F-FOS-00455 HRD-2000B 

F-FOS-00460 HRD-2000B 

F-FOS-00465 IST-2010B 

F-FOS-00470 IST-2010B 

F-FOS-00475 IST-2010B 

F-FOS-00480 IST-2010B 

F-FOS-00490 SYS-2000B 

F-FOS-00490 SYS-2030B 

F-FOS-00500 OPR-2000B 

F-FOS-00505 OPR-2000B 

F-FOS-00510 OPR-2000B 

F-FOS-00510 SYS-2030B 

F-FOS-00515 OPR-2000B 

F-FOS-00520 OPR-2000B 

F-FOS-00550 POST-B 

F-FOS-00560 POST-B 

F-FOS-00570 SYS-2000B 

F-FOS-00605 IST-2000B 

F-FOS-00700 SYS-3060FPB 

F-FOS-00705 SYS-3060FPB 

F-FOS-00715 SYS-3060FPB 

F-FOS-00720 SYS-3060FPB 

F-FOS-00725 SYS-3060FPB 

F-FOS-00730 SYS-3060FPB 

F-FOS-00735 SYS-3060FPB 

F-FOS-10150 PAS-2040B 

F-FOS-10200 ETE-2000B 
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F-FOS-10205 ETE-2000B 

F-FOS-10210 IST-2000B 

F-FOS-10215 IST-2000B 

F-FOS-10220 IST-2000B 

F-FOS-10225 IST-2000B 

F-FOS-10230 IST-2000B 

F-FOS-10240 POST-B 

F-FOS-10245 POST-B 

F-FOS-10270 FUI-3000FPB 

F-FOS-10305 SAS-2000B 

F-FUI-01100 FUI-2100B 

F-FUI-01105 FUI-2100B 

F-FUI-01110 FUI-2100B 

F-FUI-01115 FUI-2100B 

F-FUI-01120 FUI-2100B 

F-FUI-01120 IST-2010B 

F-FUI-01125 FUI-2100B 

F-FUI-01125 IST-2010B 

F-FUI-01130 FUI-2100B 

F-FUI-01135 FUI-2100B 

F-FUI-01140 FUI-2100B 

F-FUI-01145 FUI-2100B 

F-FUI-01150 FUI-2100B 

F-FUI-01150 IST-2010B 

F-FUI-01155 FUI-2100B 

F-FUI-01160 FUI-2100B 

F-FUI-01165 FUI-2100B 

F-FUI-01170 FUI-2100B 

F-FUI-01170 IST-2010B 

F-FUI-01175 FUI-2100B 

F-FUI-01175 IST-2010B 

F-FUI-01180 FUI-2100B 

F-FUI-01180 IST-2010B 

F-FUI-01185 ETE-2010B 

F-FUI-01200 FUI-2020B 

F-FUI-01200 IST-2010B 

F-FUI-01205 FUI-2020B 

F-FUI-01205 IST-2010B 

F-FUI-01215 FUI-2020B 

F-FUI-01215 IST-2010B 

F-FUI-01220 FUI-2020B 

F-FUI-01220 IST-2010B 
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F-FUI-01225 FUI-2020B 

F-FUI-01225 IST-2010B 

F-FUI-01230 FUI-2020B 

F-FUI-01230 IST-2010B 

F-FUI-01235 FUI-2020B 

F-FUI-01305 FUI-2000B 

F-FUI-01310 FUI-2000B 

F-FUI-01315 FUI-2000B 

F-FUI-01320 EVT-2000B 

F-FUI-01325 EVT-2010B 

F-FUI-01330 FUI-2000B 

F-FUI-01335 FUI-2000B 

F-FUI-01340 FUI-2000B 

F-FUI-01340 IST-2010B 

F-FUI-01400 FUI-2090B 

F-FUI-01400 IST-2010B 

F-FUI-01405 FUI-2090B 

F-FUI-01405 IST-2010B 

F-FUI-01410 FUI-2090B 

F-FUI-01415 FUI-2090B 

F-FUI-01415 IST-2010B 

F-FUI-01420 IST-2010B 

F-FUI-01425 FUI-2090B 

F-FUI-01430 IST-2010B 

F-FUI-01435 FUI-2090B 

F-FUI-01440 IST-2010B 

F-FUI-01445 FUI-2090B 

F-FUI-01500 FUI-2040B 

F-FUI-01505 FUI-2040B 

F-FUI-01510 FUI-2050B 

F-FUI-01515 FUI-2050B 

F-FUI-01520 FUI-2050B 

F-FUI-01525 FUI-2050B 

F-FUI-01530 FUI-2050B 

F-FUI-01535 FUI-2050B 

F-FUI-01538 FUI-2050B 

F-FUI-01540 FUI-2050B 

F-FUI-01545 FUI-2050B 

F-FUI-01550 FUI-2050B 

F-FUI-01555 FUI-2050B 

F-FUI-01560 FUI-2050B 

F-FUI-01565 FUI-2060B 
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F-FUI-01565 IST-2010B 

F-FUI-01570 FUI-2050B 

F-FUI-01580 FUI-2040B 

F-FUI-01580 IST-2010B 

F-FUI-01585 FUI-2050B 

F-FUI-01590 FUI-2050B 

F-FUI-01591 FUI-2050B 

F-FUI-01595 FUI-2040B 

F-FUI-01600 FUI-2020B 

F-FUI-01600 IST-2010B 

F-FUI-01605 FUI-2020B 

F-FUI-01605 IST-2010B 

F-FUI-01610 FUI-2020B 

F-FUI-01610 IST-2010B 

F-FUI-01615 FUI-2020B 

F-FUI-01615 IST-2010B 

F-FUI-01620 FUI-2020B 

F-FUI-01620 IST-2010B 

F-FUI-02100 FUI-2140B 

F-FUI-02100 IST-2010B 

F-FUI-02110 FUI-2140B 

F-FUI-02115 EVT-2020B 

F-FUI-02200 FUI-2025B 

F-FUI-02202 FUI-2025B 

F-FUI-02202 IST-2010B 

F-FUI-02205 IST-2010B 

F-FUI-02210 FUI-2025B 

F-FUI-02210 IST-2010B 

F-FUI-02215 FUI-2025B 

F-FUI-02215 IST-2010B 

F-FUI-02220 IST-2010B 

F-FUI-02225 FUI-2025B 

F-FUI-02230 IST-2010B 

F-FUI-02235 FUI-2025B 

F-FUI-02235 IST-2010B 

F-FUI-02240 FUI-2025B 

F-FUI-02240 IST-2010B 

F-FUI-02300 EDOS-2001B 

F-FUI-02300 TLM-2190B 

F-FUI-02305 EDOS-2001B 

F-FUI-02305 TLM-2190B 

F-FUI-02310 EDOS-2001B 
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F-FUI-02310 TLM-2190B 

F-FUI-02315 EDOS-2001B 

F-FUI-02315 IST-2010B 

F-FUI-02315 TLM-2190B 

F-FUI-02320 EDOS-2001B 

F-FUI-02320 IST-2010B 

F-FUI-02320 TLM-2190B 

F-FUI-02325 EDOS-2001B 

F-FUI-02325 IST-2010B 

F-FUI-02325 TLM-2190B 

F-FUI-02330 EDOS-2001B 

F-FUI-02330 IST-2010B 

F-FUI-02330 TLM-2190B 

F-FUI-02335 EDOS-2001B 

F-FUI-02335 IST-2010B 

F-FUI-02335 TLM-2190B 

F-FUI-02400 FUI-2120B 

F-FUI-02410 FUI-2120B 

F-FUI-02415 FUI-2120B 

F-FUI-02420 FUI-2120B 

F-FUI-02425 FUI-2120B 

F-FUI-02430 FUI-2120B 

F-FUI-02435 FUI-2120B 

F-FUI-02440 FUI-2120B 

F-FUI-02445 FUI-2120B 

F-FUI-02450 FUI-2120B 

F-FUI-02500 FUI-2130B 

F-FUI-02505 FUI-2130B 

F-FUI-02510 FUI-2130B 

F-FUI-02515 FUI-2130B 

F-FUI-02520 FUI-2130B 

F-FUI-02525 FUI-2130B 

F-FUI-02530 FUI-2130B 

F-FUI-02535 FUI-2130B 

F-FUI-02540 FUI-2130B 

F-FUI-02545 FUI-2130B 

F-FUI-02550 FUI-2130B 

F-FUI-02600 FUI-2030B 

F-FUI-02600 FUI-2110B 

F-FUI-02600 IST-2010B 

F-FUI-02605 FUI-2030B 

F-FUI-02605 FUI-2110B 
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F-FUI-02610 FUI-2110B 

F-FUI-02610 FUI-2115B 

F-FUI-02625 FUI-2030B 

F-FUI-02630 FUI-2030B 

F-FUI-02630 FUI-2110B 

F-FUI-02635 FUI-2030B 

F-FUI-02635 FUI-2110B 

F-FUI-02640 FUI-2030B 

F-FUI-02640 FUI-2110B 

F-FUI-02700 FUI-2150B 

F-FUI-02705 FUI-2150B 

F-FUI-02710 FUI-2150B 

F-FUI-02715 FUI-2150B 

F-FUI-02720 FUI-2150B 

F-FUI-02725 FUI-2150B 

F-FUI-02800 FUI-2050B 

F-FUI-02805 FUI-2050B 

F-FUI-02810 FUI-2050B 

F-FUI-02815 FUI-2050B 

F-FUI-02820 FUI-2050B 

F-FUI-02825 FUI-2050B 

F-FUI-02830 FUI-2050B 

F-FUI-02835 FUI-2050B 

F-FUI-02840 FUI-2050B 

F-FUI-02840 IST-2010B 

F-FUI-02845 FUI-2050B 

F-FUI-02850 FUI-2050B 

F-FUI-02855 FUI-2050B 

F-FUI-02860 FUI-2050B 

F-FUI-02860 IST-2010B 

F-FUI-02865 FUI-2050B 

F-FUI-02870 FUI-2050B 

F-FUI-02875 FUI-2050B 

F-FUI-02880 FUI-2050B 

F-FUI-02885 FUI-2050B 

F-FUI-02890 FUI-2050B 

F-FUI-02895 FUI-2050B 

F-FUI-02920 ANA-2060B 

F-FUI-02920 IST-2010B 

F-FUI-02926 POST-B 

F-FUI-02950 ANA-2060B 

F-FUI-02950 IST-2010B 
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F-FUI-02955 ANA-2060B 

F-FUI-02955 IST-2010B 

F-FUI-02960 ANA-2060B 

F-FUI-02960 IST-2010B 

F-FUI-02961 ANA-2060B 

F-FUI-02962 ANA-2060B 

F-FUI-02963 ANA-2060B 

F-FUI-02964 ANA-2060B 

F-FUI-02965 ANA-2060B 

F-FUI-02967 ANA-2060B 

F-FUI-02970 ANA-2060B 

F-FUI-02975 ANA-2060B 

F-FUI-02980 ANA-2060B 

F-FUI-02980 IST-2010B 

F-FUI-02985 ANA-2060B 

F-FUI-02990 ANA-2060B 

F-FUI-02990 IST-2010B 

F-FUI-02991 ANA-2060B 

F-FUI-02991 IST-2010B 

F-FUI-02995 ANA-2060B 

F-FUI-02995 IST-2010B 

F-FUI-03000 ANA-2060B 

F-FUI-03000 IST-2010B 

F-FUI-03005 ANA-2060B 

F-FUI-03005 IST-2010B 

F-FUI-03010 ANA-2060B 

F-FUI-03025 ANA-2060B 

F-FUI-03025 IST-2010B 

F-FUI-03030 ANA-2060B 

F-FUI-03030 IST-2010B 

F-FUI-03035 ANA-2060B 

F-FUI-03035 IST-2010B 

F-FUI-03040 ANA-2060B 

F-FUI-03040 IST-2010B 

F-FUI-03045 ANA-2060B 

F-FUI-03045 IST-2010B 

F-FUI-03050 ANA-2060B 

F-FUI-03050 IST-2010B 

F-FUI-03055 ANA-2060B 

F-FUI-03055 IST-2010B 

F-FUI-03060 ANA-2060B 

F-FUI-03060 IST-2010B 
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F-FUI-03061 ANA-2060B 

F-FUI-03061 IST-2010B 

F-FUI-03100 ANA-2000B 

F-FUI-03105 FUI-2110B 

F-FUI-03110 ANA-2010B 

F-FUI-03200 ANA-2120B 

F-FUI-03200 EVT-2010B 

F-FUI-03205 ANA-2120B 

F-FUI-03205 EVT-2010B 

F-FUI-03210 EVT-2010B 

F-FUI-03215 ANA-2120B 

F-FUI-03215 EVT-2010B 

F-FUI-03220 ANA-2120B 

F-FUI-03220 EVT-2010B 

F-FUI-03225 ANA-2120B 

F-FUI-03225 EVT-2010B 

F-FUI-03230 ANA-2120B 

F-FUI-04000 PAS-2030B 

F-FUI-04010 PAS-2030B 

F-FUI-04020 PAS-2030B 

F-FUI-04030 PAS-2030B 

F-FUI-04040 PAS-2030B 

F-FUI-04050 IST-2010B 

F-FUI-04050 PAS-2035B 

F-FUI-04060 PAS-2030B 

F-FUI-04070 PAS-2030B 

F-FUI-04080 PAS-2030B 

F-FUI-04090 IST-2010B 

F-FUI-04090 PAS-2200B 

F-FUI-04100 IST-2010B 

F-FUI-04100 PAS-2050B 

F-FUI-04110 PAS-2190B 

F-FUI-04120 PAS-2030B 

F-FUI-04130 IST-2010B 

F-FUI-04130 PAS-2110B 

F-FUI-04140 IST-2010B 

F-FUI-04140 PAS-2030B 

F-FUI-04280 IST-2010B 

F-FUI-04280 PAS-2030B 

F-FUI-04290 PAS-2030B 

F-FUI-04300 PAS-2030B 

F-FUI-05100 CMS-2040B 
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F-FUI-05105 CMS-2040B 

F-FUI-05105 IST-2010B 

F-FUI-05110 CMS-2040B 

F-FUI-05115 CMS-2040B 

F-FUI-05120 CMS-2040B 

F-FUI-05125 CMS-2040B 

F-FUI-05130 CMS-2040B 

F-FUI-05200 CMS-2170B 

F-FUI-05200 IST-2010B 

F-FUI-05205 CMS-2170B 

F-FUI-05205 IST-2010B 

F-FUI-05210 CMS-2170B 

F-FUI-05215 CMS-2170B 

F-FUI-05220 CMS-2170B 

F-FUI-05300 CMD-2010B 

F-FUI-05315 CMD-2010B 

F-FUI-05315 IST-2010B 

F-FUI-05335 CMD-2010B 

F-FUI-05340 CMD-2010B 

F-FUI-05340 IST-2010B 

F-FUI-05400 CMS-2100B 

F-FUI-05400 IST-2010B 

F-FUI-05405 CMS-2100B 

F-FUI-05500 CMS-2180B 

F-FUI-05500 IST-2010B 

F-FUI-05505 CMS-2180B 

F-FUI-05510 CMS-2180B 

F-FUI-05515 CMS-2180B 

F-FUI-05600 CMS-2060B 

F-FUI-05600 CMS-2180B 

F-FUI-05600 CMS-2190B 

F-FUI-05605 CMS-2100B 

F-FUI-05605 CMS-2180B 

F-FUI-05605 CMS-2190B 

F-FUI-05605 IST-2010B 

F-FUI-05700 CMS-2040B 

F-FUI-05700 CMS-2060B 

F-FUI-05700 CMS-2090B 

F-FUI-05700 CMS-2170B 

F-FUI-05700 PAS-2110B 

F-FUI-05705 CMS-2040B 

F-FUI-05705 CMS-2060B 
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F-FUI-05705 CMS-2090B 

F-FUI-05705 CMS-2170B 

F-FUI-05705 IST-2010B 

F-FUI-05710 CMS-2040B 

F-FUI-05710 CMS-2060B 

F-FUI-05710 CMS-2090B 

F-FUI-05710 CMS-2170B 

F-FUI-05720 CMS-2040B 

F-FUI-05720 CMS-2060B 

F-FUI-05720 CMS-2090B 

F-FUI-05720 CMS-2170B 

F-FUI-05725 CMS-2060B 

F-FUI-05725 IST-2010B 

F-FUI-05730 IST-2010B 

F-FUI-06100 FUI-2060B 

F-FUI-06105 FUI-2060B 

F-FUI-06110 FUI-2060B 

F-FUI-06115 FUI-2060B 

F-FUI-06115 IST-2010B 

F-FUI-06120 FUI-2060B 

F-FUI-06120 IST-2010B 

F-FUI-06125 FUI-2060B 

F-FUI-06130 FUI-2060B 

F-FUI-06130 IST-2010B 

F-FUI-06135 FUI-2060B 

F-FUI-06135 IST-2010B 

F-FUI-06200 IST-2010B 

F-FUI-06205 IST-2010B 

F-FUI-06210 IST-2010B 

F-FUI-06215 IST-2010B 

F-FUI-06220 IST-2010B 

F-FUI-06225 IST-2010B 

F-FUI-06230 IST-2010B 

F-FUI-06235 IST-2010B 

F-FUI-06300 CMD-2010B 

F-FUI-06305 CMD-2010B 

F-FUI-06310 CMD-2015B 

F-FUI-06315 CMD-2010B 

F-FUI-06320 CMD-2010B 

F-FUI-06330 CMD-2010B 

F-FUI-06330 IST-2010B 

F-FUI-06335 CMD-2015B 
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F-FUI-06337 CMD-2015B 

F-FUI-06340 CMD-2015B 

F-FUI-06345 CMD-2015B 

F-FUI-06350 CMD-2015B 

F-FUI-06355 CMD-2015B 

F-FUI-06360 CMD-2010B 

F-FUI-06365 CMD-2010B 

F-FUI-06370 CMD-2010B 

F-FUI-06375 CMD-2010B 

F-FUI-06380 CMD-2015B 

F-FUI-06385 CMD-2015B 

F-FUI-06390 CMD-2015B 

F-FUI-06395 CMD-2010B 

F-FUI-06400 CMD-2010B 

F-FUI-06405 CMD-2010B 

F-FUI-06410 CMD-2010B 

F-FUI-06415 CMD-2010B 

F-FUI-06420 CMD-2010B 

F-FUI-06425 CMD-2010B 

F-FUI-06430 CMD-2010B 

F-FUI-06435 CMD-2010B 

F-FUI-06440 CMD-2010B 

F-FUI-06445 CMD-2010B 

F-FUI-06450 CMD-2010B 

F-FUI-06455 CMD-2010B 

F-FUI-06460 CMD-2010B 

F-FUI-06465 CMD-2010B 

F-FUI-06470 CMD-2010B 

F-FUI-06470 CMD-2030B 

F-FUI-07100 FUI-2030B 

F-FUI-07100 IST-2010B 

F-FUI-07120 FUI-2030B 

F-FUI-07120 IST-2010B 

F-FUI-07125 FUI-2030B 

F-FUI-07125 IST-2010B 

F-FUI-07130 FUI-2030B 

F-FUI-07130 IST-2010B 

F-FUI-07135 FUI-2030B 

F-FUI-07140 FUI-2030B 

F-FUI-07200 FUI-2030B 

F-FUI-07200 IST-2010B 

F-FUI-07200 TLM-2070B 
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F-FUI-07200 TLM-2080B 

F-FUI-07200 TLM-2090B 

F-FUI-07200 TLM-2100B 

F-FUI-07205 FUI-2030B 

F-FUI-07210 FUI-2030B 

F-FUI-07215 FUI-2030B 

F-FUI-07215 IST-2010B 

F-FUI-07220 FUI-2030B 

F-FUI-07220 IST-2010B 

F-FUI-07225 FUI-2030B 

F-FUI-07230 FUI-2030B 

F-FUI-07235 FUI-2030B 

F-FUI-07240 FUI-2030B 

F-FUI-07245 FUI-2030B 

F-FUI-07245 IST-2010B 

F-FUI-07250 FUI-2030B 

F-FUI-07250 IST-2010B 

F-FUI-07255 FUI-2030B 

F-FUI-07255 IST-2010B 

F-FUI-07300 ANA-2060B 

F-FUI-07300 FUI-2110B 

F-FUI-07300 IST-2010B 

F-FUI-07305 ANA-2060B 

F-FUI-07305 FUI-2110B 

F-FUI-07305 IST-2010B 

F-FUI-07310 ANA-2060B 

F-FUI-07310 FUI-2110B 

F-FUI-07310 IST-2010B 

F-FUI-07311 IST-2010B 

F-FUI-07311 POST-B 

F-FUI-07315 ANA-2060B 

F-FUI-07315 FUI-2110B 

F-FUI-07315 IST-2010B 

F-FUI-07320 ANA-2060B 

F-FUI-07320 FUI-2110B 

F-FUI-07320 IST-2010B 

F-FUI-07325 ANA-2060B 

F-FUI-07325 FUI-2110B 

F-FUI-07325 IST-2010B 

F-FUI-07330 FUI-2110B 

F-FUI-07330 IST-2010B 

F-FUI-07330 TLM-2000B 
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F-FUI-07330 TLM-2010B 

F-FUI-07330 TLM-2070B 

F-FUI-07330 TLM-2190B 

F-FUI-07335 ANA-2060B 

F-FUI-07335 FUI-2110B 

F-FUI-07340 ANA-2060B 

F-FUI-07340 FUI-2110B 

F-FUI-07345 ANA-2060B 

F-FUI-07345 FUI-2110B 

F-FUI-07345 IST-2010B 

F-FUI-07350 ANA-2060B 

F-FUI-07350 FUI-2110B 

F-FUI-07355 ANA-2060B 

F-FUI-07355 FUI-2110B 

F-FUI-07360 ANA-2060B 

F-FUI-07360 FUI-2110B 

F-FUI-07360 IST-2010B 

F-FUI-07365 ANA-2060B 

F-FUI-07365 FUI-2110B 

F-FUI-07365 IST-2010B 

F-FUI-07370 FUI-2110B 

F-FUI-07370 FUI-2115B 

F-FUI-07370 IST-2010B 

F-FUI-07375 ANA-2060B 

F-FUI-07375 FUI-2110B 

F-FUI-07375 IST-2010B 

F-FUI-07380 ANA-2060B 

F-FUI-07380 FUI-2110B 

F-FUI-07385 ANA-2060B 

F-FUI-07385 FUI-2110B 

F-FUI-07388 ANA-2060B 

F-FUI-07388 FUI-2110B 

F-FUI-07388 IST-2010B 

F-FUI-07390 ANA-2060B 

F-FUI-07390 FUI-2110B 

F-FUI-07391 ANA-2060B 

F-FUI-07391 FUI-2110B 

F-FUI-07392 ANA-2060B 

F-FUI-07392 FUI-2110B 

F-FUI-07394 ANA-2060B 

F-FUI-07394 FUI-2110B 

F-FUI-07394 IST-2010B 
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F-FUI-07396 ANA-2060B 

F-FUI-07396 FUI-2110B 

F-FUI-07396 IST-2010B 

F-FUI-07398 ANA-2060B 

F-FUI-07398 FUI-2110B 

F-FUI-07400 ANA-2060B 

F-FUI-07400 FUI-2110B 

F-FUI-07400 IST-2010B 

F-FUI-07410 FUI-2110B 

F-FUI-07415 ANA-2060B 

F-FUI-07415 FUI-2110B 

F-FUI-07415 IST-2010B 

F-FUI-07425 FUI-2110B 

F-FUI-07425 IST-2010B 

F-FUI-07425 TLM-2000B 

F-FUI-07425 TLM-2010B 

F-FUI-07425 TLM-2070B 

F-FUI-07425 TLM-2190B 

F-FUI-07500 FUI-2115B 

F-FUI-07505 FUI-2115B 

F-FUI-07510 FUI-2115B 

F-FUI-07515 FUI-2115B 

F-FUI-07520 FUI-2115B 

F-FUI-07525 FUI-2115B 

F-FUI-07600 IST-2010B 

F-FUI-07600 TLM-2100B 

F-FUI-07605 IST-2010B 

F-FUI-07605 TLM-2100B 

F-FUI-07700 TLM-2100B 

F-FUI-07710 TLM-2100B 

F-FUI-07720 IST-2010B 

F-FUI-07720 SYS-2020B 

F-FUI-08100 SYS-2020B 

F-FUI-08100 TLM-2190B 

F-FUI-08105 SYS-2030B 

F-FUI-08110 SYS-2030B 

F-FUI-08115 SYS-2030B 

F-FUI-09100 ANA-2000B 

F-FUI-09105 ANA-2000B 

F-FUI-09110 ANA-2100B 

F-FUI-09110 ANA-2110B 

F-FUI-09112 ANA-2040B 
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F-FUI-09112 IST-2010B 

F-FUI-09115 ANA-2010B 

F-FUI-09115 IST-2010B 

F-FUI-09120 ANA-2000B 

F-FUI-09125 ANA-2000B 

F-FUI-09130 ANA-2000B 

F-FUI-09140 ANA-2120B 

F-FUI-09140 IST-2010B 

F-FUI-09145 ANA-2120B 

F-FUI-09145 IST-2010B 

F-FUI-09150 ANA-2120B 

F-FUI-09150 IST-2010B 

F-FUI-09160 ANA-2120B 

F-FUI-09160 IST-2010B 

F-FUI-09170 ANA-2000B 

F-FUI-09200 ANA-2060B 

F-FUI-09200 IST-2010B 

F-FUI-09205 ANA-2090B 

F-FUI-09210 ANA-2090B 

F-FUI-09210 IST-2010B 

F-FUI-09215 ANA-2090B 

F-FUI-09215 IST-2010B 

F-FUI-09220 ANA-2090B 

F-FUI-09220 IST-2010B 

F-FUI-09225 ANA-2120B 

F-FUI-09225 IST-2010B 

F-FUI-09300 ANA-2010B 

F-FUI-09300 IST-2010B 

F-FUI-09305 ANA-2010B 

F-FUI-09305 IST-2010B 

F-FUI-09310 ANA-2010B 

F-FUI-09310 IST-2010B 

F-FUI-09315 ANA-2010B 

F-FUI-09315 IST-2010B 

F-FUI-09350 ANA-2010B 

F-FUI-09350 IST-2010B 

F-FUI-09355 ANA-2010B 

F-FUI-09355 IST-2010B 

F-FUI-09360 ANA-2010B 

F-FUI-09360 IST-2010B 

F-FUI-09363 ANA-2010B 

F-FUI-09363 IST-2010B 
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F-FUI-09365 ANA-2010B 

F-FUI-09365 IST-2010B 

F-FUI-09370 ANA-2010B 

F-FUI-09370 IST-2010B 

F-FUI-09375 ANA-2010B 

F-FUI-09375 IST-2010B 

F-FUI-09410 ANA-2120B 

F-FUI-09410 IST-2010B 

F-FUI-09415 ANA-2120B 

F-FUI-09415 IST-2010B 

F-FUI-09500 ANA-2040B 

F-FUI-09500 IST-2010B 

F-FUI-09510 ANA-2040B 

F-FUI-09510 IST-2010B 

F-FUI-09515 ANA-2040B 

F-FUI-09515 IST-2010B 

F-FUI-09530 CONT-2010B 

F-FUI-09530 IST-2010B 

F-FUI-09600 IST-2010B 

F-FUI-09605 EVT-2020B 

F-FUI-09610 EVT-2000B 

F-FUI-09615 EVT-2000B 

F-FUI-09620 EVT-2000B 

F-FUI-09625 EVT-2000B 

F-FUI-09630 EVT-2000B 

F-FUI-09635 EVT-2000B 

F-FUI-09640 EVT-2020B 

F-FUI-09640 IST-2010B 

F-FUI-09645 EVT-2000B 

F-FUI-09645 IST-2010B 

F-FUI-09650 EVT-2030B 

F-FUI-09650 IST-2010B 

F-FUI-09655 EVT-2030B 

F-FUI-09655 IST-2010B 

F-FUI-09660 EVT-2030B 

F-FUI-09660 IST-2010B 

F-FUI-09663 EVT-2000B 

F-FUI-09663 IST-2010B 

F-FUI-09665 EVT-2000B 

F-FUI-09665 IST-2010B 

F-FUI-09700 EVT-2020B 

F-FUI-09700 IST-2010B 
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F-FUI-09705 EVT-2020B 

F-FUI-09705 IST-2010B 

F-FUI-09710 EVT-2020B 

F-FUI-11200 EDOS-2030B 

F-FUI-12310 IST-2010B 

F-FUI-12310 TLM-2190B 

F-FUI-12610 FUI-2030B 

F-FUI-12800 FUI-2080B 

F-FUI-14005 CONT-2030B 

F-FUI-14005 IST-2010B 

F-FUI-14010 CONT-2030B 

F-FUI-17200 TLM-2000B 

F-FUI-17265 CMS-2180B 

F-FUI-17265 IST-2010B 

F-FUI-17270 CONT-2020B 

F-FUI-17600 TLM-2100B 

F-FUI-17700 TLM-2000B 

F-FUI-17800 CONT-2030B 

F-FUI-17810 CONT-2030B 

F-FUI-17820 CONT-2030B 

F-FUI-19550 CONT-2020B 

F-HRD-00005 HRD-2000B 

F-HRD-00010 HRD-2000B 

F-HRD-00015 HRD-2000B 

F-HRD-00020 HRD-2000B 

F-HRD-00025 HRD-2000B 

F-HRD-00030 HRD-2000B 

F-HRD-00035 HRD-2000B 

F-HRD-00040 HRD-2000B 

F-HRD-00045 HRD-2000B 

F-HRD-00050 HRD-2000B 

F-HRD-00055 HRD-2000B 

F-HRD-00060 HRD-2000B 

F-HRD-00065 HRD-2000B 

F-HRD-00070 HRD-2000B 

F-HRD-00075 HRD-2000B 

F-HRD-00090 HRD-2000B 

F-HRD-00095 HRD-2000B 

F-HRD-00100 HRD-2000B 

F-HRD-01005 HRD-2000B 

F-HRD-01010 HRD-2000B 

F-HRD-01015 HRD-2000B 
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F-HRD-01020 HRD-2000B 

F-HRD-01025 HRD-2000B 

F-HRD-01030 HRD-2000B 

F-HRD-01035 HRD-2000B 

F-HRD-01040 HRD-2000B 

F-HRD-01045 HRD-2000B 

F-HRD-02005 HRD-2000B 

F-HRD-02010 HRD-2000B 

F-HRD-02015 HRD-2000B 

F-HRD-02020 HRD-2000B 

F-HRD-02025 HRD-2000B 

F-HRD-02030 HRD-2000B 

F-HRD-02035 HRD-2000B 

F-HRD-02040 HRD-2000B 

F-HRD-02045 HRD-2000B 

F-HRD-02050 HRD-2000B 

F-HRD-02055 HRD-2000B 

F-HRD-02060 HRD-2000B 

F-HRD-02065 HRD-2000B 

F-HRD-02070 HRD-2000B 

F-HRD-02075 HRD-2000B 

F-HRD-02080 HRD-2000B 

F-HRD-02095 HRD-2000B 

F-HRD-02100 HRD-2000B 

F-HRD-02105 HRD-2000B 

F-HRD-03005 HRD-2000B 

F-HRD-03010 HRD-2000B 

F-HRD-03015 HRD-2000B 

F-HRD-03020 HRD-2000B 

F-HRD-03025 HRD-2000B 

F-HRD-03030 HRD-2000B 

F-HRD-03035 HRD-2000B 

F-HRD-03040 HRD-2000B 

F-HRD-03045 HRD-2000B 

F-HRD-04005 HRD-2000B 

F-HRD-04010 HRD-2000B 

F-HRD-04015 HRD-2000B 

F-HRD-04020 HRD-2000B 

F-HRD-04025 HRD-2000B 

F-HRD-04030 HRD-2000B 

F-HRD-05005 HRD-2000B 

F-HRD-05010 HRD-2000B 
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F-HRD-05015 HRD-2000B 

F-HRD-05020 HRD-2000B 

F-HRD-05025 HRD-2000B 

F-HRD-06005 HRD-2000B 

F-HRD-06010 HRD-2000B 

F-HRD-06015 HRD-2000B 

F-HRD-07005 HRD-2000B 

F-HRD-07010 HRD-2000B 

F-HRD-07015 HRD-2000B 

F-HRD-07017 HRD-2000B 

F-HRD-07020 HRD-2000B 

F-HRD-07025 HRD-2000B 

F-PAS-00020 PAS-2030B 

F-PAS-00025 PAS-2030B 

F-PAS-00030 PAS-2030B 

F-PAS-00035 PAS-2030B 

F-PAS-00100 IST-2010B 

F-PAS-00100 PAS-2030B 

F-PAS-00103 IST-2010B 

F-PAS-00103 PAS-2035B 

F-PAS-00105 IST-2010B 

F-PAS-00105 PAS-2020B 

F-PAS-00115 PAS-2020B 

F-PAS-00120 PAS-2035B 

F-PAS-00135 PAS-2020B 

F-PAS-00137 FDF-2000B 

F-PAS-00138 FDF-2000B 

F-PAS-00138 IST-2010B 

F-PAS-00140 IST-2010B 

F-PAS-00140 PAS-2020B 

F-PAS-00145 FDF-2000B 

F-PAS-00150 PAS-2020B 

F-PAS-00153 PAS-2020B 

F-PAS-00155 POST-B 

F-PAS-00160 IST-2010B 

F-PAS-00160 PAS-2190B 

F-PAS-00165 IST-2010B 

F-PAS-00165 PAS-2190B 

F-PAS-00170 IST-2010B 

F-PAS-00170 PAS-2190B 

F-PAS-00175 IST-2010B 

F-PAS-00175 PAS-2190B 
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F-PAS-00180 IST-2010B 

F-PAS-00180 PAS-2190B 

F-PAS-00185 IST-2010B 

F-PAS-00185 PAS-2190B 

F-PAS-00195 IST-2010B 

F-PAS-00195 PAS-2190B 

F-PAS-00200 PAS-2000B 

F-PAS-00205 PAS-2000B 

F-PAS-00210 PAS-2000B 

F-PAS-00215 PAS-2000B 

F-PAS-00220 PAS-2000B 

F-PAS-00300 PAS-2020B 

F-PAS-00310 PAS-2020B 

F-PAS-00315 PAS-2020B 

F-PAS-00330 PAS-2000B 

F-PAS-00335 IST-2010B 

F-PAS-00335 PAS-2020B 

F-PAS-00340 IST-2010B 

F-PAS-00340 PAS-2020B 

F-PAS-00350 PAS-2020B 

F-PAS-00355 IST-2010B 

F-PAS-00355 PAS-2020B 

F-PAS-00360 PAS-2020B 

F-PAS-00365 IST-2010B 

F-PAS-00365 PAS-2020B 

F-PAS-00400 PAS-2000B 

F-PAS-00405 PAS-2020B 

F-PAS-00410 PAS-2020B 

F-PAS-00415 PAS-2000B 

F-PAS-00420 IST-2010B 

F-PAS-00420 PAS-2020B 

F-PAS-00425 IST-2010B 

F-PAS-00425 PAS-2020B 

F-PAS-00500 PAS-2010B 

F-PAS-00503 PAS-2010B 

F-PAS-00505 PAS-2010B 

F-PAS-00510 IST-2010B 

F-PAS-00510 PAS-2020B 

F-PAS-00600 CONT-2030B 

F-PAS-00605 PAS-2030B 

F-PAS-00610 PAS-2030B 

F-PAS-00700 PAS-2040B 
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F-PAS-00705 PAS-2040B 

F-PAS-00800 PAS-2200B 

F-PAS-00805 PAS-2200B 

F-PAS-00810 PAS-2200B 

F-PAS-00815 PAS-2200B 

F-PAS-00820 PAS-2030B 

F-PAS-00835 PAS-2200B 

F-PAS-00840 PAS-2200B 

F-PAS-00860 POST-B 

F-PAS-00900 IST-2010B 

F-PAS-00900 PAS-2050B 

F-PAS-00905 IST-2010B 

F-PAS-00905 PAS-2050B 

F-PAS-00910 IST-2010B 

F-PAS-00910 PAS-2050B 

F-PAS-00915 PAS-2030B 

F-PAS-00920 CONT-2030B 

F-PAS-00920 PAS-2030B 

F-PAS-00925 IST-2010B 

F-PAS-00925 PAS-2030B 

F-PAS-00930 POST-B 

F-PAS-00935 POST-B 

F-PAS-00940 IST-2010B 

F-PAS-00940 PAS-2035B 

F-PAS-00945 IST-2010B 

F-PAS-00945 PAS-2050B 

F-PAS-00950 IST-2010B 

F-PAS-00950 PAS-2050B 

F-PAS-01000 PAS-2020B 

F-PAS-01035 PAS-2200B 

F-PAS-01040 PAS-2040B 

F-PAS-01120 PAS-2040B 

F-PAS-01125 PAS-2040B 

F-PAS-01200 IST-2010B 

F-PAS-01200 PAS-2110B 

F-PAS-01205 IST-2010B 

F-PAS-01205 PAS-2110B 

F-PAS-01210 IST-2010B 

F-PAS-01210 PAS-2110B 

F-PAS-01215 IST-2010B 

F-PAS-01215 PAS-2110B 

F-PAS-01220 IST-2010B 
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F-PAS-01220 PAS-2110B 

F-PAS-01300 IST-2010B 

F-PAS-01300 PAS-2030B 

F-PAS-01305 IST-2010B 

F-PAS-01305 PAS-2030B 

F-PAS-01310 IST-2010B 

F-PAS-01310 PAS-2030B 

F-PAS-10009 IST-2010B 

F-PAS-10010 ASTR-2000B 

F-PAS-10100 ASTR-2000B 

F-PAS-10105 ASTR-2000B 

F-PAS-10110 ASTR-2000B 

F-PAS-10300 ASTR-2000B 

F-PAS-10305 ASTR-2000B 

F-PAS-10305 IST-2010B 

F-PAS-10310 CONT-2030B 

F-PAS-10312 ASTR-2000B 

F-PAS-10400 PAS-2040B 

F-PAS-10405 PAS-2040B 

F-PAS-10410 OPR-2000B 

F-PAS-10415 OPR-2000B 

F-PAS-10436 PAS-2040B 

F-PAS-10437 PAS-2040B 

F-PAS-10440 POST-B 

F-PAS-10441 POST-B 

F-PAS-10442 POST-B 

F-PAS-10445 PAS-2040B 

F-PAS-10446 CONT-2030B 

F-PAS-10447 PAS-2040B 

F-PAS-10448 PAS-2040B 

F-PAS-10449 FDF-2000B 

F-PAS-10450 ASTR-2000B 

F-PAS-10455 PAS-2180B 

F-PAS-10500 PAS-2040B 

F-PAS-10505 PAS-2040B 

F-PAS-10510 PAS-2040B 

F-PAS-10515 PAS-2040B 

F-PAS-10530 CONT-2030B 

F-PAS-10535 PAS-2035B 

F-PAS-10560 IST-2010B 

F-PAS-10565 IST-2010B 

F-PAS-10570 ASTR-2000B 
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F-PAS-10575 ASTR-2000B 

F-PAS-10605 IST-2010B 

F-PAS-10605 PAS-2035B 

F-PAS-10610 POST-B 

F-PAS-10620 POST-B 

F-PAS-10623 IST-2010B 

F-PAS-10623 PAS-2035B 

F-PAS-10625 IST-2010B 

F-PAS-10625 PAS-2035B 

F-PAS-10630 POST-B 

F-PAS-10700 IST-2010B 

F-PAS-10700 PAS-2110B 

F-PAS-10705 IST-2010B 

F-PAS-10705 PAS-2110B 

F-RMS-00010 POST-B 

F-RMS-00020 SYS-2020B 

F-RMS-00030 SYS-2020B 

F-RMS-00035 ANA-2090B 

F-RMS-00035 TLM-2190B 

F-RMS-00040 SYS-2020B 

F-RMS-00050 SYS-2020B 

F-RMS-00060 SYS-2020B 

F-RMS-00070 TLM-2000B 

F-RMS-00070 TLM-2020B 

F-RMS-00080 TLM-2190B 

F-RMS-00090 TLM-2000B 

F-RMS-00100 TLM-2040B 

F-RMS-00110 TLM-2070B 

F-RMS-00130 IST-2010B 

F-RMS-00130 TLM-2020B 

F-RMS-00140 IST-2010B 

F-RMS-00150 IST-2010B 

F-RMS-00160 IST-2010B 

F-RMS-00170 IST-2010B 

F-RMS-01010 CMD-2000B 

F-RMS-01020 CMD-2000B 

F-RMS-01030 CMD-2000B 

F-RMS-01060 SYS-2020B 

F-RMS-01070 SYS-2020B 

F-RMS-02010 SYS-2030B 

F-RMS-02020 SYS-2030B 

F-RMS-03010 SYS-2030B 
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F-RMS-03030 SYS-2030B 

F-RMS-03040 SYS-2030B 

F-RMS-03050 SYS-2030B 

F-RMS-03060 IST-2010B 

F-RMS-03070 SYS-2030B 

F-RMS-03080 SYS-2030B 

F-RMS-03090 SYS-2030B 

F-RMS-03240 SYS-2030B 

F-RMS-04010 NCC-2030B 

F-RMS-04020 NCC-2020B 

F-RMS-04085 ANA-2030B 

F-RMS-04085 NCC-2030B 

F-RMS-04090 NCC-2020B 

F-RMS-04100 NCC-2020B 

F-RMS-04110 NCC-2020B 

F-RMS-04120 NCC-2020B 

F-RMS-05010 NCC-2040B 

F-RMS-05020 NCC-2040B 

F-RMS-05030 NCC-2040B 

F-RMS-05040 NCC-2040B 

F-RMS-05050 EDOS-2001B 

F-RMS-05060 EDOS-2001B 

F-RMS-05070 EDOS-2001B 

F-RMS-05080 EDOS-2001B 

F-TLM-00110 TLM-2010B 

F-TLM-00115 TLM-2000B 

F-TLM-00115 TLM-2010B 

F-TLM-00115 TLM-2160B 

F-TLM-00120 TLM-2160B 

F-TLM-00135 TLM-2000B 

F-TLM-00135 TLM-2010B 

F-TLM-00210 TLM-2000B 

F-TLM-00210 TLM-2010B 

F-TLM-00215 TLM-2000B 

F-TLM-00215 TLM-2010B 

F-TLM-00220 TLM-2000B 

F-TLM-00220 TLM-2010B 

F-TLM-00310 TLM-2070B 

F-TLM-00315 TLM-2060B 

F-TLM-00315 TLM-2070B 

F-TLM-00410 TLM-2000B 

F-TLM-00410 TLM-2010B 
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Level 4 ID Test Case 

F-TLM-00440 TLM-2000B 

F-TLM-00440 TLM-2010B 

F-TLM-00445 TLM-2150B 

F-TLM-00450 TLM-2000B 

F-TLM-00450 TLM-2010B 

F-TLM-00490 TLM-2000B 

F-TLM-00490 TLM-2010B 

F-TLM-00510 TLM-2010B 

F-TLM-00515 TLM-2010B 

F-TLM-00525 TLM-2010B 

F-TLM-00525 TLM-2030B 

F-TLM-00530 TLM-2010B 

F-TLM-00530 TLM-2030B 

F-TLM-00535 ETE-2000B 

F-TLM-00535 IST-2010B 

F-TLM-00540 ETE-2000B 

F-TLM-00540 IST-2010B 

F-TLM-00610 TLM-2000B 

F-TLM-00610 TLM-2020B 

F-TLM-00620 TLM-2150B 

F-TLM-00625 TLM-2150B 

F-TLM-00635 TLM-2000B 

F-TLM-00635 TLM-2020B 

F-TLM-00635 TLM-2050B 

F-TLM-00710 TLM-2050B 

F-TLM-00715 TLM-2050B 

F-TLM-00720 TLM-2050B 

F-TLM-00725 TLM-2050B 

F-TLM-00730 TLM-2050B 

F-TLM-00735 TLM-2050B 

F-TLM-00810 TLM-2020B 

F-TLM-00815 TLM-2020B 

F-TLM-00820 TLM-2020B 

F-TLM-00910 TLM-2030B 

F-TLM-00915 TLM-2040B 

F-TLM-00920 IST-2010B 

F-TLM-00920 TLM-2020B 

F-TLM-00925 IST-2010B 

F-TLM-00925 TLM-2040B 

F-TLM-00935 TLM-2030B 

F-TLM-00945 TLM-2030B 

F-TLM-00960 TLM-2030B 
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Level 4 ID Test Case 

F-TLM-00970 IST-2010B 

F-TLM-00970 TLM-2040B 

F-TLM-00985 IST-2010B 

F-TLM-00985 TLM-2030B 

F-TLM-00990 IST-2010B 

F-TLM-00990 TLM-2030B 

F-TLM-01010 TLM-2080B 

F-TLM-01015 TLM-2080B 

F-TLM-01020 IST-2010B 

F-TLM-01020 TLM-2080B 

F-TLM-01025 IST-2010B 

F-TLM-01025 TLM-2080B 

F-TLM-01030 IST-2010B 

F-TLM-01030 TLM-2080B 

F-TLM-01035 IST-2010B 

F-TLM-01035 TLM-2060B 

F-TLM-01035 TLM-2080B 

F-TLM-01040 TLM-2080B 

F-TLM-01045 TLM-2090B 

F-TLM-01050 TLM-2060B 

F-TLM-01050 TLM-2080B 

F-TLM-01050 TLM-2090B 

F-TLM-01055 TLM-2080B 

F-TLM-01055 TLM-2090B 

F-TLM-01110 TLM-2080B 

F-TLM-01115 TLM-2080B 

F-TLM-01120 IST-2010B 

F-TLM-01120 TLM-2090B 

F-TLM-01125 TLM-2080B 

F-TLM-01130 IST-2010B 

F-TLM-01130 TLM-2080B 

F-TLM-01130 TLM-2090B 

F-TLM-01135 TLM-2080B 

F-TLM-01140 TLM-2080B 

F-TLM-01145 IST-2010B 

F-TLM-01145 TLM-2080B 

F-TLM-01145 TLM-2090B 

F-TLM-01150 IST-2010B 

F-TLM-01150 TLM-2080B 

F-TLM-01150 TLM-2090B 

F-TLM-01155 IST-2010B 

F-TLM-01155 TLM-2080B 
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Level 4 ID Test Case 

F-TLM-01160 TLM-2080B 

F-TLM-01165 TLM-2080B 

F-TLM-01165 TLM-2090B 

F-TLM-01210 IST-2010B 

F-TLM-01210 TLM-2080B 

F-TLM-01215 IST-2010B 

F-TLM-01215 TLM-2100B 

F-TLM-01220 IST-2010B 

F-TLM-01220 TLM-2080B 

F-TLM-01225 TLM-2080B 

F-TLM-01225 TLM-2090B 

F-TLM-01230 TLM-2080B 

F-TLM-01235 TLM-2060B 

F-TLM-01310 IST-2010B 

F-TLM-01310 TLM-2060B 

F-TLM-01315 IST-2010B 

F-TLM-01315 TLM-2060B 

F-TLM-01320 IST-2010B 

F-TLM-01320 TLM-2060B 

F-TLM-01325 TLM-2060B 

F-TLM-01330 TLM-2060B 

F-TLM-01335 TLM-2060B 

F-TLM-01345 TLM-2060B 

F-TLM-01350 TLM-2060B 

F-TLM-01355 IST-2010B 

F-TLM-01355 TLM-2060B 

F-TLM-01360 TLM-2060B 

F-TLM-01365 TLM-2060B 

F-TLM-01410 TLM-2000B 

F-TLM-01410 TLM-2020B 

F-TLM-01415 IST-2010B 

F-TLM-01415 TLM-2060B 

F-TLM-01420 TLM-2030B 

F-TLM-01425 IST-2010B 

F-TLM-01425 TLM-2060B 

F-TLM-01430 TLM-2000B 

F-TLM-01430 TLM-2010B 

F-TLM-01510 TLM-2160B 

F-TLM-01515 ETE-2000B 

F-TLM-01520 ANA-2100B 

F-TLM-01540 ANA-2100B 

F-TLM-01545 TLM-2160B 
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Level 4 ID Test Case 

F-TLM-01610 TLM-2190B 

F-TLM-01625 TLM-2190B 

F-TLM-01630 TLM-2190B 

F-TLM-01635 IST-2010B 

F-TLM-01635 TLM-2190B 

F-TLM-01640 IST-2010B 

F-TLM-01640 TLM-2190B 

F-TLM-01710 CMS-2000B 

F-TLM-01715 CMS-2000B 

F-TLM-01720 CMS-2000B 

F-TLM-01725 CMS-2000B 

F-TLM-01730 CMS-2000B 

F-TLM-01825 FDF-2000B 

F-TLM-01830 CONT-2040B 

F-TLM-01830 FDF-2000B 

F-TLM-02110 CONT-2040B 

F-TLM-02115 CONT-2040B 

F-TLM-02120 CONT-2040B 

F-TLM-02125 CONT-2040B 

F-TLM-02130 CONT-2040B 

F-TLM-02135 CONT-2040B 

F-TLM-02140 CONT-2040B 

F-TLM-02210 EDOS-2010B 

F-TLM-02215 EDOS-2000B 

F-TLM-02217 POST-B 

F-TLM-02218 POST-B 

F-TLM-02250 EDOS-2000B 

F-TLM-02280 POST-B 

F-TLM-02281 POST-B 

F-TLM-02285 POST-B 

F-TLM-02286 POST-B 

F-TLM-02290 POST-B 

F-TLM-02291 POST-B 

F-TLM-02295 POST-B 

F-TLM-02296 POST-B 

F-TLM-02298 POST-B 

F-TLM-02299 POST-B 

F-TLM-10125 IST-2010B 

F-TLM-10125 TLM-2170B 

F-TLM-10130 TLM-2170B 

F-TLM-10410 TLM-2000B 

F-TLM-10415 TLM-2010B 
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Level 4 ID Test Case 

F-TLM-10420 TLM-2000B 

F-TLM-10425 TLM-2000B 

F-TLM-10430 TLM-2000B 

F-TLM-10435 TLM-2000B 

F-TLM-10440 TLM-2000B 

F-TLM-10440 TLM-2010B 

F-TLM-10445 TLM-2150B 

F-TLM-10455 TLM-2010B 

F-TLM-10460 TLM-2010B 

F-TLM-10465 TLM-2000B 

F-TLM-10470 TLM-2000B 

F-TLM-10475 TLM-2000B 

F-TLM-10490 TLM-2000B 

F-TLM-10490 TLM-2010B 

F-TLM-10525 TLM-2000B 

F-TLM-10525 TLM-2010B 

F-TLM-10535 IST-2010B 

F-TLM-10535 TLM-2010B 

F-TLM-10540 IST-2010B 

F-TLM-10540 TLM-2010B 

F-TLM-10550 TLM-2000B 

F-TLM-10555 TLM-2000B 

F-TLM-10560 IST-2010B 

F-TLM-10560 TLM-2000B 

F-TLM-10570 IST-2010B 

F-TLM-10570 TLM-2000B 

F-TLM-10575 TLM-2000B 

F-TLM-10580 IST-2010B 

F-TLM-10580 TLM-2000B 

F-TLM-10810 TLM-2020B 

F-TLM-10955 TLM-2030B 

F-TLM-11320 IST-2010B 

F-TLM-11320 TLM-2060B 

F-TLM-11515 TLM-2160B 

F-TLM-11520 ANA-2100B 

F-TLM-13000 CONT-2020B 
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Appendix C. Test Case to Level 4 Requirement Matrix


The following matrix delineates each of the FOS Release B Thread Test Case to the associated 
level 4 requirements which are verified by the test. 

Test Case Level 4 ID 

ANA-2000B F-ANA-04130 

ANA-2000B F-FUI-09170 

ANA-2000B F-FUI-09130 

ANA-2000B F-FUI-09125 

ANA-2000B F-FUI-09120 

ANA-2000B F-FUI-09105 

ANA-2000B F-FUI-09100 

ANA-2000B F-FUI-03100 

ANA-2000B F-ANA-04120 

ANA-2000B F-ANA-04110 

ANA-2000B F-ANA-04090 

ANA-2000B F-ANA-03010 

ANA-2000B F-ANA-04080 

ANA-2000B F-ANA-03135 

ANA-2000B F-ANA-04070 

ANA-2000B F-ANA-04010 

ANA-2000B F-ANA-04100 

ANA-2000B F-ANA-04020 

ANA-2000B F-ANA-01010 

ANA-2000B F-ANA-08070 

ANA-2010B F-FUI-09355 

ANA-2010B F-FUI-09310 

ANA-2010B F-FUI-09350 

ANA-2010B F-FUI-09360 

ANA-2010B F-FUI-09305 

ANA-2010B F-FUI-09370 

ANA-2010B F-FUI-09315 

ANA-2010B F-FUI-09300 

ANA-2010B F-FUI-09115 

ANA-2010B F-FUI-09365 

ANA-2010B F-FUI-09375 

ANA-2010B F-FUI-03110 

ANA-2010B F-FUI-09363 

ANA-2020B F-ANA-07300 
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Test Case Level 4 ID 

ANA-2020B F-ANA-07310 

ANA-2020B F-ANA-07320 

ANA-2020B F-ANA-07180 

ANA-2020B F-ANA-07110 

ANA-2020B F-ANA-07120 

ANA-2020B F-ANA-07130 

ANA-2020B F-ANA-07160 

ANA-2030B F-ANA-07310 

ANA-2030B F-RMS-04085 

ANA-2030B F-ANA-07230 

ANA-2030B F-ANA-07330 

ANA-2030B F-ANA-07320 

ANA-2030B F-ANA-07215 

ANA-2030B F-ANA-07220 

ANA-2030B F-ANA-07280 

ANA-2030B F-ANA-07260 

ANA-2030B F-ANA-07250 

ANA-2030B F-ANA-07240 

ANA-2030B F-ANA-07210 

ANA-2040B F-ANA-06021 

ANA-2040B F-FUI-09515 

ANA-2040B F-ANA-04050 

ANA-2040B F-FUI-09510 

ANA-2040B F-FUI-09500 

ANA-2040B F-FUI-09112 

ANA-2040B F-ANA-06050 

ANA-2040B F-ANA-06023 

ANA-2040B F-ANA-06030 

ANA-2040B F-ANA-06040 

ANA-2040B F-ANA-06020 

ANA-2040B F-ANA-06045 

ANA-2040B F-ANA-06022 

ANA-2060B F-FUI-07340 

ANA-2060B F-FUI-02991 

ANA-2060B F-FUI-07375 

ANA-2060B F-FUI-07365 

ANA-2060B F-FUI-07380 

ANA-2060B F-FUI-07355 

ANA-2060B F-FUI-07392 

ANA-2060B F-FUI-07350 

ANA-2060B F-FUI-07345 

ANA-2060B F-FUI-07360 
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Test Case Level 4 ID 

ANA-2060B F-FUI-07385 

ANA-2060B F-FUI-07388 

ANA-2060B F-FUI-07391 

ANA-2060B F-FUI-07394 

ANA-2060B F-FUI-07396 

ANA-2060B F-FUI-07398 

ANA-2060B F-FUI-07400 

ANA-2060B F-FUI-07415 

ANA-2060B F-FUI-09200 

ANA-2060B F-FUI-07390 

ANA-2060B F-FUI-02950 

ANA-2060B F-FUI-03000 

ANA-2060B F-FUI-02970 

ANA-2060B F-FUI-02967 

ANA-2060B F-FUI-02965 

ANA-2060B F-FUI-02964 

ANA-2060B F-FUI-02963 

ANA-2060B F-FUI-02962 

ANA-2060B F-FUI-02961 

ANA-2060B F-FUI-02980 

ANA-2060B F-FUI-02955 

ANA-2060B F-FUI-02985 

ANA-2060B F-FUI-02920 

ANA-2060B F-ANA-04400 

ANA-2060B F-ANA-04390 

ANA-2060B F-ANA-04380 

ANA-2060B F-ANA-04375 

ANA-2060B F-ANA-04370 

ANA-2060B F-ANA-04360 

ANA-2060B F-ANA-04350 

ANA-2060B F-FUI-02960 

ANA-2060B F-FUI-03045 

ANA-2060B F-FUI-07325 

ANA-2060B F-FUI-07320 

ANA-2060B F-FUI-07315 

ANA-2060B F-FUI-07310 

ANA-2060B F-FUI-07305 

ANA-2060B F-FUI-07300 

ANA-2060B F-FUI-03061 

ANA-2060B F-FUI-03060 

ANA-2060B F-FUI-02975 

ANA-2060B F-FUI-03050 
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Test Case Level 4 ID 

ANA-2060B F-FUI-07335 

ANA-2060B F-FUI-03040 

ANA-2060B F-FUI-03035 

ANA-2060B F-FUI-03025 

ANA-2060B F-FUI-03010 

ANA-2060B F-FUI-03005 

ANA-2060B F-FUI-02995 

ANA-2060B F-FUI-03030 

ANA-2060B F-FUI-02990 

ANA-2060B F-FUI-03055 

ANA-2070B F-ANA-04430 

ANA-2070B F-ANA-04420 

ANA-2070B F-ANA-04415 

ANA-2070B F-ANA-04410 

ANA-2070B F-ANA-03210 

ANA-2070B F-ANA-03200 

ANA-2090B F-ANA-03140 

ANA-2090B F-FUI-09205 

ANA-2090B F-FUI-09210 

ANA-2090B F-FUI-09215 

ANA-2090B F-FUI-09220 

ANA-2090B F-ANA-03170 

ANA-2090B F-ANA-03150 

ANA-2090B F-ANA-03060 

ANA-2090B F-ANA-03050 

ANA-2090B F-ANA-03020 

ANA-2090B F-RMS-00035 

ANA-2090B F-ANA-03040 

ANA-2090B F-ANA-02040 

ANA-2090B F-ANA-02030 

ANA-2090B F-ANA-02010 

ANA-2090B F-ANA-02050 

ANA-2090B F-ANA-03160 

ANA-2100B F-ANA-05032 

ANA-2100B F-ANA-05070 

ANA-2100B F-ANA-05060 

ANA-2100B F-ANA-05040 

ANA-2100B F-ANA-05033 

ANA-2100B F-ANA-05031 

ANA-2100B F-DMS-00840 

ANA-2100B F-DMS-00760 

ANA-2100B F-DMS-00750 
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Test Case Level 4 ID 

ANA-2100B F-DMS-00740 

ANA-2100B F-ANA-05030 

ANA-2100B F-ANA-05034 

ANA-2100B F-ANA-05050 

ANA-2100B F-FUI-09110 

ANA-2100B F-ANA-06030 

ANA-2100B F-ANA-05250 

ANA-2100B F-ANA-05210 

ANA-2100B F-ANA-05150 

ANA-2100B F-ANA-05140 

ANA-2100B F-ANA-05080 

ANA-2100B F-ANA-05120 

ANA-2100B F-ANA-05090 

ANA-2100B F-DMS-01020 

ANA-2100B F-ANA-05020 

ANA-2100B F-TLM-01520 

ANA-2100B F-ANA-05110 

ANA-2100B F-ANA-05100 

ANA-2100B F-TLM-01540 

ANA-2100B F-ANA-05130 

ANA-2100B F-ANA-01025 

ANA-2100B F-ANA-03110 

ANA-2100B F-ANA-03120 

ANA-2100B F-ANA-05010 

ANA-2100B F-ANA-03125 

ANA-2100B F-ANA-04310 

ANA-2100B F-ANA-03130 

ANA-2100B F-ANA-03180 

ANA-2100B F-TLM-11520 

ANA-2100B F-ANA-03190 

ANA-2100B F-ANA-03100 

ANA-2100B F-ANA-04025 

ANA-2110B F-ANA-03030 

ANA-2110B F-ANA-05220 

ANA-2110B F-ANA-03080 

ANA-2110B F-FUI-09110 

ANA-2110B F-DMS-01020 

ANA-2110B F-ANA-03015 

ANA-2110B F-DMS-01010 

ANA-2110B F-DMS-00790 

ANA-2110B F-DMS-00770 

ANA-2110B F-ANA-01020 
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Test Case Level 4 ID 

ANA-2110B F-ANA-03070 

ANA-2120B F-ANA-08040 

ANA-2120B F-FUI-03200 

ANA-2120B F-FUI-09225 

ANA-2120B F-ANA-08050 

ANA-2120B F-FUI-09140 

ANA-2120B F-FUI-03230 

ANA-2120B F-FUI-09160 

ANA-2120B F-ANA-01030 

ANA-2120B F-FUI-03225 

ANA-2120B F-ANA-08030 

ANA-2120B F-ANA-08020 

ANA-2120B F-ANA-08010 

ANA-2120B F-ANA-04340 

ANA-2120B F-FUI-09150 

ANA-2120B F-FUI-03205 

ANA-2120B F-ANA-04330 

ANA-2120B F-FUI-09145 

ANA-2120B F-ANA-08060 

ANA-2120B F-FUI-03215 

ANA-2120B F-ANA-04040 

ANA-2120B F-FUI-09410 

ANA-2120B F-ANA-04315 

ANA-2120B F-FUI-03220 

ANA-2120B F-ANA-04320 

ANA-2120B F-FUI-09415 

ASTR-2000B F-PAS-10575 

ASTR-2000B F-PAS-10570 

ASTR-2000B F-PAS-10100 

ASTR-2000B F-PAS-10450 

ASTR-2000B F-PAS-10312 

ASTR-2000B F-PAS-10305 

ASTR-2000B F-PAS-10300 

ASTR-2000B F-PAS-10010 

ASTR-2000B F-PAS-10105 

ASTR-2000B F-PAS-10110 

CMD-2000B F-RMS-01020 

CMD-2000B F-RMS-01010 

CMD-2000B F-RMS-01030 

CMD-2001B F-CMD-02140 

CMD-2001B F-FOS-00315 

CMD-2001B F-CMD-02110 
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Test Case Level 4 ID 

CMD-2001B F-CMD-02120 

CMD-2001B F-CMD-02125 

CMD-2001B F-CMD-02135 

CMD-2001B F-CMD-12240 

CMD-2001B F-CMD-14313 

CMD-2001B F-CMD-12245 

CMD-2001B F-CMD-11226 

CMD-2001B F-CMD-02130 

CMD-2001B F-CMD-13230 

CMD-2010B F-FUI-06410 

CMD-2010B F-FUI-06460 

CMD-2010B F-FUI-06455 

CMD-2010B F-FUI-06450 

CMD-2010B F-FUI-06445 

CMD-2010B F-FUI-06440 

CMD-2010B F-FUI-06435 

CMD-2010B F-FUI-06430 

CMD-2010B F-FUI-06425 

CMD-2010B F-FUI-06465 

CMD-2010B F-FUI-06415 

CMD-2010B F-FUI-06470 

CMD-2010B F-FUI-06405 

CMD-2010B F-FUI-06400 

CMD-2010B F-FUI-06360 

CMD-2010B F-FUI-06365 

CMD-2010B F-FUI-06370 

CMD-2010B F-FUI-06375 

CMD-2010B F-FUI-05300 

CMD-2010B F-FUI-06395 

CMD-2010B F-FUI-06420 

CMD-2010B F-FUI-05315 

CMD-2010B F-FUI-06330 

CMD-2010B F-FUI-05335 

CMD-2010B F-FUI-05340 

CMD-2010B F-FUI-06320 

CMD-2010B F-FUI-06315 

CMD-2010B F-FUI-06305 

CMD-2010B F-FUI-06300 

CMD-2015B F-CMD-01317 

CMD-2015B F-FUI-06340 

CMD-2015B F-FUI-06310 

CMD-2015B F-FUI-06345 
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Test Case Level 4 ID 

CMD-2015B F-FUI-06385 

CMD-2015B F-FUI-06335 

CMD-2015B F-FUI-06337 

CMD-2015B F-FUI-06390 

CMD-2015B F-FUI-06380 

CMD-2015B F-FUI-06350 

CMD-2015B F-FUI-06355 

CMD-2030B F-CMD-02225 

CMD-2030B F-CMD-03135 

CMD-2030B F-CMD-03133 

CMD-2030B F-CMD-05115 

CMD-2030B F-CMD-02235 

CMD-2030B F-CMD-01180 

CMD-2030B F-CMD-02245 

CMD-2030B F-CMD-03410 

CMD-2030B F-CMD-03230 

CMD-2030B F-CMD-02220 

CMD-2030B F-CMD-02215 

CMD-2030B F-CMD-02210 

CMD-2030B F-CMD-04115 

CMD-2030B F-CMD-02230 

CMD-2030B F-CMD-02260 

CMD-2030B F-CMD-03225 

CMD-2030B F-CMD-02250 

CMD-2030B F-CMD-02255 

CMD-2030B F-CMD-03215 

CMD-2030B F-FUI-06470 

CMD-2030B F-CMD-03210 

CMD-2030B F-CMD-04120 

CMD-2030B F-CMD-03110 

CMD-2030B F-CMD-03115 

CMD-2030B F-CMD-02240 

CMD-2030B F-CMD-02265 

CMD-2030B F-CMD-03130 

CMD-2030B F-CMD-03127 

CMD-2030B F-CMD-03125 

CMD-2050B F-CMD-05510 

CMD-2050B F-CMD-05250 

CMD-2050B F-CMD-04130 

CMD-2050B F-CMD-03310 

CMD-2050B F-CMD-01325 

CMD-2050B F-CMD-15520 
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Test Case Level 4 ID 

CMD-2050B F-CMD-01330 

CMD-2050B F-CMD-01335 

CMD-2050B F-CMD-15515 

CMD-2050B F-CMD-01340 

CMD-2050B F-CMD-01345 

CMD-2050B F-CMD-05255 

CMD-2050B F-CMD-03220 

CMD-2050B F-CMD-03315 

CMD-2070B F-CMD-04220 

CMD-2070B F-CMD-11210 

CMD-2070B F-CMD-11211 

CMD-2070B F-CMD-11215 

CMD-2070B F-CMD-14315 

CMD-2070B F-CMD-12130 

CMD-2070B F-CMS-11410 

CMD-2070B F-CMD-14310 

CMD-2070B F-CMD-11212 

CMD-2070B F-FOS-00347 

CMD-2070B F-CMD-04230 

CMD-2070B F-CMD-01310 

CMD-2070B F-CMD-01320 

CMD-2070B F-FOS-00320 

CMD-2070B F-CMD-01165 

CMD-2070B F-CMD-05120 

CMD-2070B F-CMD-01230 

CMD-2070B F-CMD-04120 

CMD-2070B F-CMD-04225 

CMD-2070B F-CMD-04210 

CMD-2070B F-CMD-04215 

CMD-2080B F-CMD-05247 

CMD-2080B F-CMD-15245 

CMD-2080B F-CMD-05245 

CMD-2080B F-CMD-05110 

CMD-2080B F-CMD-05115 

CMD-2080B F-CMD-05120 

CMD-2080B F-CMD-05220 

CMD-2080B F-CMD-05235 

CMD-2080B F-CMD-05230 

CMD-2080B F-CMD-05225 

CMS-2000B F-CMS-01745 

CMS-2000B F-TLM-01730 

CMS-2000B F-CMS-01775 

C-9
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

CMS-2000B F-CMS-01770 

CMS-2000B F-CMS-01765 

CMS-2000B F-CMS-01720 

CMS-2000B F-CMS-01750 

CMS-2000B F-CMS-01710 

CMS-2000B F-CMS-01743 

CMS-2000B F-CMS-01740 

CMS-2000B F-CMS-01735 

CMS-2000B F-CMS-01715 

CMS-2000B F-CMD-01150 

CMS-2000B F-CMS-01760 

CMS-2000B F-TLM-01715 

CMS-2000B F-TLM-01720 

CMS-2000B F-TLM-01725 

CMS-2000B F-CMS-11720 

CMS-2000B F-TLM-01710 

CMS-2040B F-FUI-05120 

CMS-2040B F-CMS-01020 

CMS-2040B F-CMS-01030 

CMS-2040B F-CMS-01110 

CMS-2040B F-CMS-01120 

CMS-2040B F-CMS-01130 

CMS-2040B F-DMS-01405 

CMS-2040B F-CMS-01160 

CMS-2040B F-CMS-01010 

CMS-2040B F-CMS-01150 

CMS-2040B F-FUI-05720 

CMS-2040B F-FUI-05125 

CMS-2040B F-FUI-05115 

CMS-2040B F-FUI-05110 

CMS-2040B F-FUI-05105 

CMS-2040B F-FUI-05100 

CMS-2040B F-FUI-05710 

CMS-2040B F-FUI-05700 

CMS-2040B F-CMS-11170 

CMS-2040B F-CMS-11185 

CMS-2040B F-CMS-11190 

CMS-2040B F-FUI-05705 

CMS-2040B F-FUI-05130 

CMS-2040B F-CMD-03320 

CMS-2060B F-FUI-05705 

CMS-2060B F-CMS-01340 

C-10
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

CMS-2060B F-CMS-01350 

CMS-2060B F-FUI-05720 

CMS-2060B F-CMS-01420 

CMS-2060B F-CMS-01430 

CMS-2060B F-CMS-01440 

CMS-2060B F-CMS-01450 

CMS-2060B F-FUI-05725 

CMS-2060B F-FUI-05710 

CMS-2060B F-CMS-01360 

CMS-2060B F-CMS-11420 

CMS-2060B F-CMS-11340 

CMS-2060B F-CMS-11330 

CMS-2060B F-CMS-11320 

CMS-2060B F-CMS-11310 

CMS-2060B F-CMS-11170 

CMS-2060B F-FUI-05700 

CMS-2060B F-CMS-01460 

CMS-2060B F-FUI-05600 

CMS-2060B F-CMS-01330 

CMS-2060B F-CMS-01325 

CMS-2060B F-CMS-01320 

CMS-2060B F-CMS-01310 

CMS-2060B F-CMD-03320 

CMS-2060B F-CMS-01425 

CMS-2060B F-DMS-01405 

CMS-2090B F-CMS-00118 

CMS-2090B F-CMS-00115 

CMS-2090B F-CMS-00110 

CMS-2090B F-CMS-11170 

CMS-2090B F-DMS-01405 

CMS-2090B F-CMS-00243 

CMS-2090B F-CMS-10255 

CMS-2090B F-CMS-10250 

CMS-2090B F-CMS-10600 

CMS-2090B F-CMS-00245 

CMS-2090B F-FUI-05705 

CMS-2090B F-CMS-00230 

CMS-2090B F-CMS-00125 

CMS-2090B F-FUI-05710 

CMS-2090B F-CMS-00240 

CMS-2090B F-CMS-00130 

CMS-2090B F-CMS-00205 

C-11
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

CMS-2090B F-CMS-00210 

CMS-2090B F-CMS-00215 

CMS-2090B F-CMS-10125 

CMS-2090B F-CMS-00220 

CMS-2090B F-CMS-00120 

CMS-2090B F-CMS-00640 

CMS-2090B F-CMS-10110 

CMS-2090B F-FUI-05720 

CMS-2090B F-CMS-10120 

CMS-2090B F-FUI-05700 

CMS-2100B F-CMS-00425 

CMS-2100B F-CMS-00250 

CMS-2100B F-FUI-05605 

CMS-2100B F-CMS-00530 

CMS-2100B F-CMS-00510 

CMS-2100B F-CMS-00550 

CMS-2100B F-FUI-05405 

CMS-2100B F-CMS-10420 

CMS-2100B F-CMS-00140 

CMS-2100B F-CMS-10410 

CMS-2100B F-CMS-10220 

CMS-2100B F-CMS-10210 

CMS-2100B F-CMS-10130 

CMS-2100B F-FUI-05400 

CMS-2170B F-FUI-05710 

CMS-2170B F-FUI-05200 

CMS-2170B F-CMS-00840 

CMS-2170B F-CMS-00830 

CMS-2170B F-CMS-00850 

CMS-2170B F-FUI-05720 

CMS-2170B F-FUI-05205 

CMS-2170B F-FUI-05210 

CMS-2170B F-FUI-05215 

CMS-2170B F-CMS-00820 

CMS-2170B F-FUI-05220 

CMS-2170B F-CMS-00860 

CMS-2170B F-DMS-01405 

CMS-2170B F-CMD-03320 

CMS-2170B F-CMS-00720 

CMS-2170B F-FUI-05700 

CMS-2170B F-CMS-10710 

CMS-2170B F-CMS-10720 

C-12
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

CMS-2170B F-CMS-10730 

CMS-2170B F-CMS-10740 

CMS-2170B F-CMS-00710 

CMS-2170B F-FUI-05705 

CMS-2170B F-CMS-11170 

CMS-2170B F-CMS-00750 

CMS-2170B F-CMS-00735 

CMS-2170B F-CMS-00810 

CMS-2170B F-CMS-00740 

CMS-2170B F-CMS-00745 

CMS-2170B F-CMS-00730 

CMS-2170B F-CMS-00755 

CMS-2180B F-CMS-00920 

CMS-2180B F-CMS-00925 

CMS-2180B F-FUI-17265 

CMS-2180B F-CMS-00915 

CMS-2180B F-CMS-00910 

CMS-2180B F-CMS-10725 

CMS-2180B F-FUI-05515 

CMS-2180B F-FUI-05605 

CMS-2180B F-FUI-05505 

CMS-2180B F-CMS-00950 

CMS-2180B F-FUI-05600 

CMS-2180B F-CMS-00930 

CMS-2180B F-CMS-00935 

CMS-2180B F-FUI-05500 

CMS-2180B F-CMS-00940 

CMS-2180B F-FUI-05510 

CMS-2190B F-CMS-11180 

CMS-2190B F-CMS-01210 

CMS-2190B F-FUI-05600 

CMS-2190B F-FUI-05605 

CMS-2190B F-CMS-01225 

CMS-2190B F-CMS-01220 

CMS-2190B F-CMS-01215 

CONT-2010B F-ANA-09130 

CONT-2010B F-ANA-09140 

CONT-2010B F-ANA-09160 

CONT-2010B F-ANA-04200 

CONT-2010B F-ANA-09120 

CONT-2010B F-ANA-04210 

CONT-2010B F-ANA-09150 

C-13
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

CONT-2010B F-ANA-09305 

CONT-2010B F-ANA-09310 

CONT-2010B F-FUI-09530 

CONT-2010B F-ANA-04220 

CONT-2010B F-ANA-06030 

CONT-2010B F-ANA-09315 

CONT-2010B F-ANA-09300 

CONT-2010B F-ANA-09080 

CONT-2010B F-ANA-09110 

CONT-2010B F-ANA-09070 

CONT-2010B F-ANA-09100 

CONT-2010B F-ANA-09090 

CONT-2020B F-FUI-17270 

CONT-2020B F-FUI-19550 

CONT-2020B F-ANA-07400 

CONT-2020B F-ANA-07430 

CONT-2020B F-ANA-07440 

CONT-2020B F-DMS-11030 

CONT-2020B F-TLM-13000 

CONT-2020B F-ANA-07420 

CONT-2030B F-ANA-17050 

CONT-2030B F-ANA-17040 

CONT-2030B F-ANA-17030 

CONT-2030B F-ANA-17020 

CONT-2030B F-ANA-17010 

CONT-2030B F-FUI-17810 

CONT-2030B F-FUI-17820 

CONT-2030B F-ANA-06030 

CONT-2030B F-PAS-00920 

CONT-2030B F-PAS-10446 

CONT-2030B F-FUI-14005 

CONT-2030B F-PAS-10310 

CONT-2030B F-ANA-17060 

CONT-2030B F-PAS-10530 

CONT-2030B F-PAS-00600 

CONT-2030B F-FUI-17800 

CONT-2030B F-ANA-01060 

CONT-2030B F-FUI-14010 

CONT-2040B F-TLM-01830 

CONT-2040B F-CMS-01512 

CONT-2040B F-ANA-06030 

CONT-2040B F-TLM-02110 

C-14
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

CONT-2040B F-TLM-02115 

CONT-2040B F-TLM-02125 

CONT-2040B F-TLM-02130 

CONT-2040B F-TLM-02135 

CONT-2040B F-TLM-02140 

CONT-2040B F-TLM-02120 

DBS-2000B F-DMS-00270 

DBS-2000B F-DMS-01310 

DBS-2000B F-DMS-00180 

DBS-2000B F-DMS-00170 

DBS-2000B F-DMS-00140 

DBS-2000B F-DMS-00310 

DBS-2000B F-DMS-00320 

DBS-2000B F-DMS-00130 

DBS-2000B F-DMS-00120 

DBS-2000B F-DMS-00340 

DBS-2000B F-DMS-00350 

DBS-2000B F-DMS-00360 

DBS-2000B F-DMS-00110 

DBS-2000B F-DMS-00610 

DBS-2000B F-DMS-00650 

DBS-2000B F-DMS-00640 

DBS-2000B F-DMS-00630 

DBS-2000B F-DMS-00620 

DBS-2000B F-DMS-01330 

DBS-2000B F-DMS-01320 

DBS-2010B F-DMS-00540 

DBS-2010B F-DMS-00530 

DBS-2010B F-DMS-00520 

DBS-2010B F-DMS-00510 

DBS-2010B F-DMS-00550 

DBS-2020B F-DMS-00410 

DBS-2020B F-DMS-00420 

DBS-2030B F-DMS-00220 

DBS-2030B F-DMS-00231 

DBS-2030B F-DMS-00205 

DBS-2030B F-DMS-00210 

DBS-2030B F-DMS-00215 

DBS-2030B F-DMS-00225 

DBS-2030B F-DMS-00232 

DBS-2030B F-DMS-00233 

DBS-2030B F-DMS-00250 

C-15
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

DBS-2030B F-DMS-00255 

DBS-2030B F-DMS-00260 

DBS-2030B F-DMS-00265 

DBS-2030B F-DMS-00230 

DBS-3100FPB F-DMS-00370 

DBS-3100FPB F-DMS-00375 

EDOS-2000B F-TLM-02250 

EDOS-2000B F-TLM-02215 

EDOS-2000B F-FOS-00020 

EDOS-2001B F-RMS-05080 

EDOS-2001B F-ANA-04035 

EDOS-2001B F-RMS-05050 

EDOS-2001B F-RMS-05070 

EDOS-2001B F-ANA-07030 

EDOS-2001B F-ANA-07020 

EDOS-2001B F-RMS-05060 

EDOS-2001B F-ANA-03012 

EDOS-2001B F-FUI-02305 

EDOS-2001B F-FUI-02310 

EDOS-2001B F-FUI-02315 

EDOS-2001B F-FUI-02320 

EDOS-2001B F-FUI-02325 

EDOS-2001B F-FUI-02330 

EDOS-2001B F-FUI-02335 

EDOS-2001B F-ANA-07010 

EDOS-2001B F-FUI-02300 

EDOS-2002B F-CMD-06110 

EDOS-2002B F-CMD-01185 

EDOS-2002B F-CMD-06100 

EDOS-2002B F-CMD-06120 

EDOS-2010B F-ANA-04510 

EDOS-2010B F-ANA-04520 

EDOS-2010B F-ANA-04530 

EDOS-2010B F-DMS-01021 

EDOS-2010B F-TLM-02210 

EDOS-2010B F-DMS-01420 

EDOS-2030B F-DMS-11010 

EDOS-2030B F-FUI-11200 

EDOS-2030B F-DMS-10720 

EDOS-2030B F-DMS-10710 

ETE-2000B F-FOS-00230 

ETE-2000B F-TLM-00540 

C-16
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

ETE-2000B F-TLM-00535 

ETE-2000B F-CMD-04110 

ETE-2000B F-FOS-10205 

ETE-2000B F-FOS-00305 

ETE-2000B F-FOS-00260 

ETE-2000B F-FOS-00200 

ETE-2000B F-TLM-01515 

ETE-2000B F-FOS-10200 

ETE-2010B F-CMD-01125 

ETE-2010B F-FOS-00010 

ETE-2010B F-FOS-00015 

ETE-2010B F-FOS-00020 

ETE-2010B F-FOS-00025 

ETE-2010B F-CMD-01250 

ETE-2010B F-CMD-01120 

ETE-2010B F-FOS-00320 

ETE-2010B F-FUI-01185 

ETE-2010B F-CMD-01160 

EVT-2000B F-FUI-01320 

EVT-2000B F-DMS-01280 

EVT-2000B F-FOS-00250 

EVT-2000B F-DMS-01290 

EVT-2000B F-FUI-09610 

EVT-2000B F-FOS-00255 

EVT-2000B F-FUI-09645 

EVT-2000B F-FUI-09635 

EVT-2000B F-FUI-09615 

EVT-2000B F-DMS-01210 

EVT-2000B F-FUI-09630 

EVT-2000B F-DMS-01230 

EVT-2000B F-FUI-09625 

EVT-2000B F-FUI-09663 

EVT-2000B F-FUI-09620 

EVT-2000B F-FUI-09665 

EVT-2000B F-DMS-01270 

EVT-2010B F-FUI-03225 

EVT-2010B F-FOS-00245 

EVT-2010B F-DMS-01230 

EVT-2010B F-FOS-00250 

EVT-2010B F-DMS-01220 

EVT-2010B F-FOS-00240 

EVT-2010B F-FUI-03200 

C-17
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

EVT-2010B F-FUI-03220 

EVT-2010B F-FUI-03215 

EVT-2010B F-FUI-03210 

EVT-2010B F-FUI-01325 

EVT-2010B F-FUI-03205 

EVT-2020B F-DMS-01240 

EVT-2020B F-DMS-00910 

EVT-2020B F-DMS-00920 

EVT-2020B F-DMS-00930 

EVT-2020B F-DMS-00940 

EVT-2020B F-FUI-09640 

EVT-2020B F-FUI-09700 

EVT-2020B F-FUI-09705 

EVT-2020B F-FUI-02115 

EVT-2020B F-FUI-09710 

EVT-2020B F-FUI-09605 

EVT-2030B F-DMS-01260 

EVT-2030B F-FUI-09650 

EVT-2030B F-FUI-09655 

EVT-2030B F-FUI-09660 

EVT-2030B F-DMS-01250 

FDF-2000B F-DMS-01490 

FDF-2000B F-DMS-01450 

FDF-2000B F-DMS-01451 

FDF-2000B F-DMS-01452 

FDF-2000B F-DMS-01455 

FDF-2000B F-DMS-01485 

FDF-2000B F-PAS-00145 

FDF-2000B F-ANA-05190 

FDF-2000B F-ANA-05170 

FDF-2000B F-ANA-05160 

FDF-2000B F-PAS-10449 

FDF-2000B F-CMS-01028 

FDF-2000B F-FOS-00325 

FDF-2000B F-CMS-01140 

FDF-2000B F-TLM-01830 

FDF-2000B F-PAS-00138 

FDF-2000B F-PAS-00137 

FDF-2000B F-TLM-01825 

FDF-2000B F-ANA-04030 

FDF-2000B F-ANA-05180 

FDF-2000B F-FOS-00320 

C-18
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

FDF-2000B F-CMS-01029 

FDF-2000B F-FOS-00330 

FDF-2000B F-ANA-01040 

FDF-3100FPB F-DMS-01465 

FUI-2000B F-FUI-01340 

FUI-2000B F-FUI-01305 

FUI-2000B F-FUI-01310 

FUI-2000B F-FUI-01315 

FUI-2000B F-FUI-01335 

FUI-2000B F-FUI-01330 

FUI-2020B F-FUI-01615 

FUI-2020B F-FUI-01200 

FUI-2020B F-FUI-01600 

FUI-2020B F-FUI-01205 

FUI-2020B F-FUI-01620 

FUI-2020B F-FUI-01605 

FUI-2020B F-FUI-01610 

FUI-2020B F-FUI-01215 

FUI-2020B F-FUI-01220 

FUI-2020B F-FUI-01225 

FUI-2020B F-FUI-01230 

FUI-2020B F-FUI-01235 

FUI-2025B F-FUI-02215 

FUI-2025B F-FUI-02202 

FUI-2025B F-FUI-02210 

FUI-2025B F-FUI-02235 

FUI-2025B F-FUI-02225 

FUI-2025B F-FUI-02200 

FUI-2025B F-FUI-02240 

FUI-2030B F-FUI-07245 

FUI-2030B F-FUI-12610 

FUI-2030B F-FUI-02635 

FUI-2030B F-FUI-07100 

FUI-2030B F-FUI-07230 

FUI-2030B F-FUI-07240 

FUI-2030B F-FUI-07220 

FUI-2030B F-FUI-07250 

FUI-2030B F-FUI-07215 

FUI-2030B F-FUI-07210 

FUI-2030B F-FUI-07205 

FUI-2030B F-FUI-07255 

FUI-2030B F-FUI-02640 

C-19
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

FUI-2030B F-FUI-02630 

FUI-2030B F-FUI-07225 

FUI-2030B F-FUI-02605 

FUI-2030B F-FUI-02600 

FUI-2030B F-FUI-07200 

FUI-2030B F-FUI-07140 

FUI-2030B F-FUI-07135 

FUI-2030B F-FUI-07235 

FUI-2030B F-FUI-07130 

FUI-2030B F-FUI-07125 

FUI-2030B F-FUI-07120 

FUI-2030B F-FUI-02625 

FUI-2040B F-FUI-01595 

FUI-2040B F-FUI-01580 

FUI-2040B F-FUI-01505 

FUI-2040B F-FUI-01500 

FUI-2050B F-FUI-01591 

FUI-2050B F-FUI-02860 

FUI-2050B F-FUI-01590 

FUI-2050B F-FUI-01585 

FUI-2050B F-FUI-02865 

FUI-2050B F-CMS-01840 

FUI-2050B F-CMS-01835 

FUI-2050B F-CMS-01830 

FUI-2050B F-CMS-01825 

FUI-2050B F-CMS-01820 

FUI-2050B F-FUI-01570 

FUI-2050B F-FUI-02855 

FUI-2050B F-FUI-01555 

FUI-2050B F-FUI-01560 

FUI-2050B F-FUI-01545 

FUI-2050B F-FUI-01540 

FUI-2050B F-FUI-01538 

FUI-2050B F-FUI-01535 

FUI-2050B F-FUI-01530 

FUI-2050B F-FUI-01525 

FUI-2050B F-FUI-01520 

FUI-2050B F-FUI-01515 

FUI-2050B F-FUI-01510 

FUI-2050B F-FUI-02870 

FUI-2050B F-FUI-02875 

FUI-2050B F-FUI-02825 

C-20
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

FUI-2050B F-FUI-02885 

FUI-2050B F-FUI-01550 

FUI-2050B F-FUI-02890 

FUI-2050B F-FUI-02850 

FUI-2050B F-FUI-02820 

FUI-2050B F-FUI-02830 

FUI-2050B F-FUI-02815 

FUI-2050B F-FUI-02835 

FUI-2050B F-FUI-02810 

FUI-2050B F-FUI-02805 

FUI-2050B F-FUI-02840 

FUI-2050B F-FUI-02895 

FUI-2050B F-FUI-02845 

FUI-2050B F-FUI-02800 

FUI-2050B F-FUI-02880 

FUI-2060B F-CMD-01315 

FUI-2060B F-FUI-06135 

FUI-2060B F-CMD-03215 

FUI-2060B F-FUI-06125 

FUI-2060B F-FUI-06120 

FUI-2060B F-FUI-06115 

FUI-2060B F-FUI-06110 

FUI-2060B F-FUI-01565 

FUI-2060B F-FUI-06105 

FUI-2060B F-FUI-06100 

FUI-2060B F-FUI-06130 

FUI-2080B F-FUI-12800 

FUI-2090B F-FOS-00430 

FUI-2090B F-FUI-01425 

FUI-2090B F-FUI-01400 

FUI-2090B F-FUI-01405 

FUI-2090B F-FOS-00420 

FUI-2090B F-FUI-01415 

FUI-2090B F-FUI-01445 

FUI-2090B F-FUI-01410 

FUI-2090B F-FUI-01435 

FUI-2100B F-FUI-01150 

FUI-2100B F-FUI-01100 

FUI-2100B F-FUI-01105 

FUI-2100B F-FUI-01110 

FUI-2100B F-FUI-01115 

FUI-2100B F-FUI-01120 

C-21
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

FUI-2100B F-FUI-01125 

FUI-2100B F-FUI-01130 

FUI-2100B F-FUI-01135 

FUI-2100B F-FUI-01145 

FUI-2100B F-FUI-01155 

FUI-2100B F-FUI-01160 

FUI-2100B F-FUI-01165 

FUI-2100B F-FUI-01170 

FUI-2100B F-FUI-01175 

FUI-2100B F-FUI-01180 

FUI-2100B F-FUI-01140 

FUI-2110B F-FUI-03105 

FUI-2110B F-FUI-02610 

FUI-2110B F-FUI-02605 

FUI-2110B F-FUI-02600 

FUI-2110B F-FUI-02635 

FUI-2110B F-FUI-02640 

FUI-2110B F-FUI-07300 

FUI-2110B F-FUI-07350 

FUI-2110B F-FUI-07355 

FUI-2110B F-FUI-07315 

FUI-2110B F-FUI-07360 

FUI-2110B F-FUI-07365 

FUI-2110B F-FUI-07370 

FUI-2110B F-FUI-07310 

FUI-2110B F-FUI-07325 

FUI-2110B F-FUI-07380 

FUI-2110B F-FUI-07385 

FUI-2110B F-FUI-07345 

FUI-2110B F-FUI-07388 

FUI-2110B F-FUI-07375 

FUI-2110B F-FUI-07390 

FUI-2110B F-FUI-07391 

FUI-2110B F-FUI-02630 

FUI-2110B F-FUI-07392 

FUI-2110B F-FUI-07394 

FUI-2110B F-FUI-07396 

FUI-2110B F-FUI-07398 

FUI-2110B F-FUI-07400 

FUI-2110B F-FUI-07410 

FUI-2110B F-FUI-07415 

FUI-2110B F-FUI-07425 
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 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

FUI-2110B F-FUI-07305 

FUI-2110B F-FUI-07330 

FUI-2110B F-FUI-07320 

FUI-2110B F-FUI-07340 

FUI-2110B F-FUI-07335 

FUI-2115B F-FUI-07515 

FUI-2115B F-FUI-07510 

FUI-2115B F-FUI-07505 

FUI-2115B F-FUI-02610 

FUI-2115B F-FUI-07525 

FUI-2115B F-FUI-07520 

FUI-2115B F-FUI-07370 

FUI-2115B F-FUI-07500 

FUI-2120B F-FUI-02435 

FUI-2120B F-FUI-02425 

FUI-2120B F-FUI-02415 

FUI-2120B F-FUI-02410 

FUI-2120B F-FUI-02400 

FUI-2120B F-DMS-01480 

FUI-2120B F-FUI-02430 

FUI-2120B F-DMS-01475 

FUI-2120B F-FUI-02440 

FUI-2120B F-FUI-02445 

FUI-2120B F-FUI-02420 

FUI-2120B F-FUI-02450 

FUI-2130B F-FUI-02505 

FUI-2130B F-FUI-02550 

FUI-2130B F-FUI-02540 

FUI-2130B F-FUI-02535 

FUI-2130B F-FUI-02530 

FUI-2130B F-FUI-02525 

FUI-2130B F-FUI-02520 

FUI-2130B F-FUI-02515 

FUI-2130B F-FUI-02510 

FUI-2130B F-FUI-02500 

FUI-2130B F-FUI-02545 

FUI-2140B F-FUI-02110 

FUI-2140B F-FUI-02100 

FUI-2150B F-FUI-02720 

FUI-2150B F-FUI-02700 

FUI-2150B F-FUI-02705 

FUI-2150B F-FUI-02710 

C-23
 322-CD-100-001/ 
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Test Case Level 4 ID 

FUI-2150B F-FUI-02715 

FUI-2150B F-FUI-02725 

FUI-3000FPB F-FOS-10270 

HRD-2000B F-FOS-00460 

HRD-2000B F-FOS-00455 

HRD-2000B F-FOS-00450 

HRD-2000B F-HRD-00005 

HRD-2000B F-HRD-00020 

HRD-2000B F-HRD-03015 

HRD-2000B F-HRD-00010 

HRD-2000B F-HRD-04005 

HRD-2000B F-HRD-03045 

HRD-2000B F-HRD-03040 

HRD-2000B F-HRD-03035 

HRD-2000B F-HRD-03030 

HRD-2000B F-HRD-04015 

HRD-2000B F-HRD-03020 

HRD-2000B F-HRD-04020 

HRD-2000B F-HRD-03010 

HRD-2000B F-HRD-03005 

HRD-2000B F-HRD-02105 

HRD-2000B F-HRD-02100 

HRD-2000B F-HRD-02095 

HRD-2000B F-HRD-02080 

HRD-2000B F-HRD-02075 

HRD-2000B F-HRD-03025 

HRD-2000B F-HRD-06005 

HRD-2000B F-HRD-07025 

HRD-2000B F-HRD-07020 

HRD-2000B F-HRD-07017 

HRD-2000B F-HRD-07015 

HRD-2000B F-HRD-07010 

HRD-2000B F-HRD-07005 

HRD-2000B F-HRD-04010 

HRD-2000B F-HRD-06010 

HRD-2000B F-HRD-02060 

HRD-2000B F-HRD-05025 

HRD-2000B F-HRD-05020 

HRD-2000B F-HRD-05015 

HRD-2000B F-HRD-05010 

HRD-2000B F-HRD-05005 

HRD-2000B F-HRD-04030 
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 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

HRD-2000B F-HRD-04025 

HRD-2000B F-HRD-06015 

HRD-2000B F-HRD-00055 

HRD-2000B F-HRD-01005 

HRD-2000B F-HRD-00100 

HRD-2000B F-HRD-00095 

HRD-2000B F-HRD-00090 

HRD-2000B F-HRD-00075 

HRD-2000B F-HRD-00070 

HRD-2000B F-HRD-02070 

HRD-2000B F-HRD-00060 

HRD-2000B F-HRD-01020 

HRD-2000B F-HRD-00050 

HRD-2000B F-HRD-00045 

HRD-2000B F-HRD-00040 

HRD-2000B F-HRD-00035 

HRD-2000B F-HRD-00030 

HRD-2000B F-HRD-00025 

HRD-2000B F-HRD-01025 

HRD-2000B F-HRD-00065 

HRD-2000B F-HRD-02015 

HRD-2000B F-HRD-00015 

HRD-2000B F-HRD-02055 

HRD-2000B F-HRD-02050 

HRD-2000B F-HRD-02045 

HRD-2000B F-HRD-02040 

HRD-2000B F-HRD-02035 

HRD-2000B F-HRD-02030 

HRD-2000B F-HRD-01010 

HRD-2000B F-HRD-02020 

HRD-2000B F-HRD-01015 

HRD-2000B F-HRD-02010 

HRD-2000B F-HRD-02005 

HRD-2000B F-HRD-01045 

HRD-2000B F-HRD-01040 

HRD-2000B F-HRD-01035 

HRD-2000B F-HRD-01030 

HRD-2000B F-HRD-02065 

HRD-2000B F-HRD-02025 

IST-2000B F-FOS-10220 

IST-2000B F-FOS-00175 

IST-2000B F-FOS-00605 
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Test Case Level 4 ID 

IST-2000B F-FOS-00180 

IST-2000B F-FOS-10215 

IST-2000B F-FOS-10225 

IST-2000B F-FOS-10230 

IST-2000B F-FOS-10210 

IST-2010B F-FUI-05500 

IST-2010B F-FUI-03050 

IST-2010B F-FUI-03045 

IST-2010B F-TLM-01640 

IST-2010B F-FUI-03040 

IST-2010B F-FUI-03035 

IST-2010B F-FUI-05205 

IST-2010B F-FUI-03030 

IST-2010B F-FUI-05315 

IST-2010B F-CMS-11510 

IST-2010B F-FUI-02990 

IST-2010B F-FUI-05400 

IST-2010B F-FUI-02991 

IST-2010B F-DMS-00220 

IST-2010B F-FUI-05725 

IST-2010B F-FUI-03060 

IST-2010B F-DMS-00215 

IST-2010B F-FUI-04100 

IST-2010B F-FUI-03005 

IST-2010B F-FUI-05605 

IST-2010B F-FUI-03000 

IST-2010B F-FUI-02995 

IST-2010B F-DMS-00205 

IST-2010B F-FUI-05705 

IST-2010B F-FUI-05340 

IST-2010B F-CMS-01825 

IST-2010B F-PAS-00105 

IST-2010B F-CMS-01430 

IST-2010B F-DMS-00210 

IST-2010B F-PAS-00103 

IST-2010B F-FUI-02325 

IST-2010B F-CMS-01460 

IST-2010B F-CMS-01505 

IST-2010B F-CMS-01725 

IST-2010B F-CMS-01730 

IST-2010B F-FUI-04090 

IST-2010B F-FUI-03055 
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 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

IST-2010B F-CMS-01820 

IST-2010B F-TLM-01635 

IST-2010B F-FUI-04130 

IST-2010B F-FUI-04140 

IST-2010B F-FUI-04280 

IST-2010B F-FUI-05105 

IST-2010B F-CMS-10510 

IST-2010B F-FUI-05200 

IST-2010B F-FUI-03061 

IST-2010B F-FUI-06115 

IST-2010B F-CMS-10750 

IST-2010B F-DMS-00225 

IST-2010B F-FUI-04050 

IST-2010B F-FUI-09375 

IST-2010B F-FUI-05730 

IST-2010B F-FUI-09655 

IST-2010B F-FUI-09650 

IST-2010B F-FUI-09645 

IST-2010B F-FUI-09640 

IST-2010B F-FUI-09600 

IST-2010B F-FUI-09530 

IST-2010B F-FUI-09515 

IST-2010B F-FUI-09510 

IST-2010B F-FUI-09500 

IST-2010B F-TLM-01150 

IST-2010B F-FUI-09663 

IST-2010B F-FUI-09410 

IST-2010B F-FUI-09665 

IST-2010B F-FUI-09370 

IST-2010B F-DMS-01290 

IST-2010B F-FUI-09365 

IST-2010B F-TLM-01155 

IST-2010B F-FUI-09363 

IST-2010B F-DMS-01400 

IST-2010B F-FUI-09360 

IST-2010B F-FUI-09355 

IST-2010B F-FUI-09350 

IST-2010B F-FUI-09315 

IST-2010B F-TLM-01210 

IST-2010B F-FUI-06225 

IST-2010B F-FUI-09415 

IST-2010B F-FUI-06205 

C-27
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

IST-2010B F-DMS-00230 

IST-2010B F-CMS-01360 

IST-2010B F-FUI-02980 

IST-2010B F-FUI-06120 

IST-2010B F-DMS-00235 

IST-2010B F-DMS-00240 

IST-2010B F-DMS-00245 

IST-2010B F-FUI-06130 

IST-2010B F-DMS-00250 

IST-2010B F-FUI-06135 

IST-2010B F-DMS-00255 

IST-2010B F-FUI-09660 

IST-2010B F-DMS-00260 

IST-2010B F-FUI-09310 

IST-2010B F-FUI-06210 

IST-2010B F-FUI-06215 

IST-2010B F-FUI-02960 

IST-2010B F-FUI-06220 

IST-2010B F-FUI-02955 

IST-2010B F-FUI-02950 

IST-2010B F-FUI-02920 

IST-2010B F-FUI-17265 

IST-2010B F-FUI-14005 

IST-2010B F-FUI-12310 

IST-2010B F-FUI-09705 

IST-2010B F-FUI-09700 

IST-2010B F-FUI-06200 

IST-2010B F-ANA-06040 

IST-2010B F-TLM-00925 

IST-2010B F-TLM-00920 

IST-2010B F-ANA-04310 

IST-2010B F-TLM-10560 

IST-2010B F-ANA-04360 

IST-2010B F-TLM-10540 

IST-2010B F-TLM-10535 

IST-2010B F-TLM-00540 

IST-2010B F-TLM-00535 

IST-2010B F-ANA-06020 

IST-2010B F-ANA-06021 

IST-2010B F-CMD-02215 

IST-2010B F-ANA-06023 

IST-2010B F-TLM-10580 

C-28
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

IST-2010B F-ANA-06050 

IST-2010B F-TLM-10125 

IST-2010B F-ANA-08060 

IST-2010B F-TLM-01145 

IST-2010B F-RMS-03060 

IST-2010B F-RMS-00170 

IST-2010B F-RMS-00160 

IST-2010B F-RMS-00150 

IST-2010B F-RMS-00140 

IST-2010B F-RMS-00130 

IST-2010B F-PAS-10705 

IST-2010B F-CMS-01410 

IST-2010B F-ANA-06022 

IST-2010B F-TLM-01020 

IST-2010B F-ANA-01025 

IST-2010B F-ANA-01030 

IST-2010B F-TLM-01130 

IST-2010B F-TLM-01120 

IST-2010B F-ANA-02030 

IST-2010B F-ANA-02050 

IST-2010B F-TLM-01035 

IST-2010B F-ANA-03100 

IST-2010B F-TLM-01030 

IST-2010B F-ANA-03110 

IST-2010B F-ANA-03120 

IST-2010B F-TLM-01025 

IST-2010B F-ANA-04120 

IST-2010B F-ANA-03130 

IST-2010B F-TLM-10570 

IST-2010B F-TLM-00990 

IST-2010B F-ANA-03180 

IST-2010B F-ANA-03190 

IST-2010B F-TLM-00985 

IST-2010B F-ANA-03200 

IST-2010B F-ANA-03210 

IST-2010B F-TLM-11320 

IST-2010B F-ANA-04020 

IST-2010B F-TLM-00970 

IST-2010B F-ANA-04040 

IST-2010B F-ANA-04050 

IST-2010B F-PAS-10625 

IST-2010B F-ANA-03125 

C-29
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

IST-2010B F-PAS-00180 

IST-2010B F-CMS-00729 

IST-2010B F-CMS-00730 

IST-2010B F-PAS-00365 

IST-2010B F-PAS-00355 

IST-2010B F-PAS-00340 

IST-2010B F-PAS-00335 

IST-2010B F-CMS-00850 

IST-2010B F-CMS-00915 

IST-2010B F-CMS-00930 

IST-2010B F-CMS-00950 

IST-2010B F-PAS-00195 

IST-2010B F-PAS-10700 

IST-2010B F-PAS-00185 

IST-2010B F-CMS-00720 

IST-2010B F-PAS-00175 

IST-2010B F-PAS-00170 

IST-2010B F-CMS-01150 

IST-2010B F-PAS-00165 

IST-2010B F-PAS-00160 

IST-2010B F-CMS-01215 

IST-2010B F-CMS-01225 

IST-2010B F-CMS-01305 

IST-2010B F-PAS-00140 

IST-2010B F-PAS-00138 

IST-2010B F-CMS-01330 

IST-2010B F-PAS-00100 

IST-2010B F-CMS-01025 

IST-2010B F-CMD-05310 

IST-2010B F-PAS-10623 

IST-2010B F-PAS-10605 

IST-2010B F-PAS-10565 

IST-2010B F-PAS-10560 

IST-2010B F-PAS-10305 

IST-2010B F-PAS-10009 

IST-2010B F-PAS-01310 

IST-2010B F-PAS-01305 

IST-2010B F-PAS-01300 

IST-2010B F-PAS-01220 

IST-2010B F-PAS-01215 

IST-2010B F-PAS-01210 

IST-2010B F-CMS-00728 

C-30
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

IST-2010B F-PAS-01200 

IST-2010B F-CMS-00725 

IST-2010B F-CMD-05410 

IST-2010B F-PAS-00950 

IST-2010B F-PAS-00945 

IST-2010B F-PAS-00940 

IST-2010B F-PAS-00925 

IST-2010B F-PAS-00910 

IST-2010B F-PAS-00905 

IST-2010B F-PAS-00900 

IST-2010B F-PAS-00510 

IST-2010B F-PAS-00425 

IST-2010B F-PAS-00420 

IST-2010B F-CMS-01405 

IST-2010B F-PAS-01205 

IST-2010B F-TLM-01310 

IST-2010B F-FUI-09115 

IST-2010B F-FOS-00317 

IST-2010B F-FOS-00318 

IST-2010B F-FUI-01180 

IST-2010B F-FUI-07220 

IST-2010B F-TLM-01355 

IST-2010B F-FUI-07605 

IST-2010B F-FUI-01175 

IST-2010B F-FUI-02860 

IST-2010B F-FUI-01150 

IST-2010B F-FUI-01120 

IST-2010B F-FUI-01340 

IST-2010B F-FUI-07394 

IST-2010B F-FUI-07360 

IST-2010B F-FUI-01125 

IST-2010B F-FUI-09160 

IST-2010B F-FUI-01440 

IST-2010B F-FUI-01430 

IST-2010B F-FUI-07250 

IST-2010B F-FUI-01420 

IST-2010B F-FUI-01415 

IST-2010B F-FUI-07100 

IST-2010B F-FUI-09305 

IST-2010B F-FUI-01405 

IST-2010B F-FUI-01580 

IST-2010B F-FUI-01400 

C-31
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

IST-2010B F-FUI-09150 

IST-2010B F-FUI-09112 

IST-2010B F-FUI-09140 

IST-2010B F-FUI-01225 

IST-2010B F-TLM-01315 

IST-2010B F-FUI-07245 

IST-2010B F-TLM-01320 

IST-2010B F-FUI-07310 

IST-2010B F-FUI-07370 

IST-2010B F-FUI-07415 

IST-2010B F-FUI-07396 

IST-2010B F-FUI-07720 

IST-2010B F-FUI-07125 

IST-2010B F-FUI-01215 

IST-2010B F-FUI-01565 

IST-2010B F-FUI-07400 

IST-2010B F-FUI-01230 

IST-2010B F-FUI-02840 

IST-2010B F-FUI-01220 

IST-2010B F-FUI-07375 

IST-2010B F-FUI-07388 

IST-2010B F-FUI-03025 

IST-2010B F-FOS-00465 

IST-2010B F-FUI-01170 

IST-2010B F-FUI-07305 

IST-2010B F-FUI-07425 

IST-2010B F-FUI-01200 

IST-2010B F-FOS-00430 

IST-2010B F-FUI-06230 

IST-2010B F-FUI-07311 

IST-2010B F-FUI-06330 

IST-2010B F-FUI-07365 

IST-2010B F-FOS-00470 

IST-2010B F-FOS-00475 

IST-2010B F-FOS-00480 

IST-2010B F-FUI-07215 

IST-2010B F-FUI-01205 

IST-2010B F-FUI-09145 

IST-2010B F-FUI-06235 

IST-2010B F-FUI-09215 

IST-2010B F-FUI-07330 

IST-2010B F-FUI-01610 

C-32
 322-CD-100-001/ 
411-CD-100-001 



Test Case Level 4 ID 

IST-2010B F-FUI-07120 

IST-2010B F-FUI-07345 

IST-2010B F-FUI-01615 

IST-2010B F-FUI-02100 

IST-2010B F-FUI-09210 

IST-2010B F-FUI-07255 

IST-2010B F-FUI-02240 

IST-2010B F-FUI-07130 

IST-2010B F-FUI-01605 

IST-2010B F-FUI-02335 

IST-2010B F-FUI-01620 

IST-2010B F-FUI-07600 

IST-2010B F-TLM-01425 

IST-2010B F-FUI-02230 

IST-2010B F-FUI-02202 

IST-2010B F-FUI-02205 

IST-2010B F-FUI-02330 

IST-2010B F-FUI-02210 

IST-2010B F-FUI-09200 

IST-2010B F-FUI-02215 

IST-2010B F-FUI-02220 

IST-2010B F-FUI-02235 

IST-2010B F-FUI-07325 

IST-2010B F-FUI-02600 

IST-2010B F-TLM-01415 

IST-2010B F-FUI-07200 

IST-2010B F-FUI-09225 

IST-2010B F-FUI-02315 

IST-2010B F-FUI-07300 

IST-2010B F-FUI-09220 

IST-2010B F-FUI-01600 

IST-2010B F-FUI-09300 

IST-2010B F-TLM-01215 

IST-2010B F-FUI-02320 

IST-2010B F-FUI-07320 

IST-2010B F-TLM-01220 

IST-2010B F-FUI-07315 

NCC-2020B F-RMS-04120 

NCC-2020B F-RMS-04020 

NCC-2020B F-FOS-00340 

NCC-2020B F-RMS-04090 

NCC-2020B F-RMS-04100 
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Test Case Level 4 ID 

NCC-2020B F-RMS-04110 

NCC-2020B F-FOS-00320 

NCC-2030B F-RMS-04010 

NCC-2030B F-RMS-04085 

NCC-2030B F-FOS-00335 

NCC-2030B F-FOS-00320 

NCC-2030B F-FOS-00340 

NCC-2040B F-ANA-03012 

NCC-2040B F-RMS-05020 

NCC-2040B F-ANA-01015 

NCC-2040B F-RMS-05030 

NCC-2040B F-RMS-05040 

NCC-2040B F-ANA-01050 

NCC-2040B F-ANA-07020 

NCC-2040B F-ANA-07030 

NCC-2040B F-RMS-05010 

NCC-2040B F-ANA-07010 

NCC-2040B F-ANA-04035 

OPR-2000B F-FOS-00510 

OPR-2000B F-FOS-00520 

OPR-2000B F-FOS-00505 

OPR-2000B F-FOS-00500 

OPR-2000B F-FOS-00515 

OPR-2000B F-FOS-00165 

OPR-2000B F-FOS-00145 

OPR-2000B F-PAS-10410 

OPR-2000B F-FOS-00140 

OPR-2000B F-FOS-00225 

OPR-2000B F-FOS-00130 

OPR-2000B F-FOS-00125 

OPR-2000B F-ANA-04060 

OPR-2000B F-FOS-00160 

OPR-2000B F-FOS-00040 

OPR-2000B F-FOS-00155 

OPR-2000B F-FOS-00220 

OPR-2000B F-FOS-00120 

OPR-2000B F-PAS-10415 

OPR-2000B F-FOS-00300 

OPR-2000B F-FOS-00110 

OPR-2000B F-FOS-00095 

OPR-2000B F-DMS-01150 

OPR-2000B F-FOS-00090 
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Test Case Level 4 ID 

OPR-2000B F-FOS-00085 

OPR-2000B F-FOS-00080 

OPR-2000B F-FOS-00075 

OPR-2000B F-FOS-00045 

OPR-2000B F-FOS-00115 

PAS-2000B F-PAS-00330 

PAS-2000B F-PAS-00220 

PAS-2000B F-PAS-00210 

PAS-2000B F-PAS-00205 

PAS-2000B F-PAS-00200 

PAS-2000B F-PAS-00215 

PAS-2000B F-DMS-00330 

PAS-2000B F-DMS-00245 

PAS-2000B F-DMS-00240 

PAS-2000B F-DMS-00160 

PAS-2000B F-DMS-00150 

PAS-2000B F-DMS-00235 

PAS-2000B F-PAS-00415 

PAS-2000B F-PAS-00400 

PAS-2010B F-PAS-00500 

PAS-2010B F-PAS-00503 

PAS-2010B F-PAS-00505 

PAS-2020B F-PAS-00510 

PAS-2020B F-PAS-00150 

PAS-2020B F-PAS-01000 

PAS-2020B F-PAS-00140 

PAS-2020B F-PAS-00105 

PAS-2020B F-PAS-00340 

PAS-2020B F-PAS-00335 

PAS-2020B F-PAS-00355 

PAS-2020B F-PAS-00115 

PAS-2020B F-PAS-00135 

PAS-2020B F-PAS-00405 

PAS-2020B F-PAS-00360 

PAS-2020B F-PAS-00365 

PAS-2020B F-PAS-00315 

PAS-2020B F-PAS-00310 

PAS-2020B F-PAS-00350 

PAS-2020B F-PAS-00425 

PAS-2020B F-PAS-00420 

PAS-2020B F-PAS-00300 

PAS-2020B F-PAS-00410 
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Test Case Level 4 ID 

PAS-2020B F-PAS-00153 

PAS-2030B F-PAS-00605 

PAS-2030B F-PAS-00610 

PAS-2030B F-PAS-00820 

PAS-2030B F-PAS-00920 

PAS-2030B F-FUI-04030 

PAS-2030B F-PAS-00100 

PAS-2030B F-PAS-01300 

PAS-2030B F-PAS-01305 

PAS-2030B F-PAS-01310 

PAS-2030B F-PAS-00915 

PAS-2030B F-FUI-04020 

PAS-2030B F-PAS-00025 

PAS-2030B F-PAS-00020 

PAS-2030B F-PAS-00035 

PAS-2030B F-FUI-04080 

PAS-2030B F-FUI-04070 

PAS-2030B F-FUI-04290 

PAS-2030B F-PAS-00030 

PAS-2030B F-PAS-00925 

PAS-2030B F-FUI-04060 

PAS-2030B F-FUI-04010 

PAS-2030B F-FUI-04000 

PAS-2030B F-FUI-04120 

PAS-2030B F-FUI-04140 

PAS-2030B F-FUI-04300 

PAS-2030B F-FUI-04280 

PAS-2030B F-FUI-04040 

PAS-2035B F-PAS-10625 

PAS-2035B F-FUI-04050 

PAS-2035B F-PAS-00940 

PAS-2035B F-PAS-10623 

PAS-2035B F-PAS-10605 

PAS-2035B F-PAS-00103 

PAS-2035B F-PAS-00120 

PAS-2035B F-DMS-01021 

PAS-2035B F-PAS-10535 

PAS-2040B F-PAS-10447 

PAS-2040B F-PAS-10436 

PAS-2040B F-FOS-10150 

PAS-2040B F-PAS-10505 

PAS-2040B F-FOS-00320 
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Test Case Level 4 ID 

PAS-2040B F-PAS-00705 

PAS-2040B F-PAS-00700 

PAS-2040B F-FOS-00340 

PAS-2040B F-PAS-10515 

PAS-2040B F-PAS-10510 

PAS-2040B F-PAS-10437 

PAS-2040B F-PAS-10445 

PAS-2040B F-PAS-10448 

PAS-2040B F-PAS-01125 

PAS-2040B F-PAS-10500 

PAS-2040B F-PAS-10405 

PAS-2040B F-PAS-01120 

PAS-2040B F-PAS-10400 

PAS-2040B F-PAS-01040 

PAS-2050B F-PAS-00910 

PAS-2050B F-PAS-00905 

PAS-2050B F-PAS-00945 

PAS-2050B F-FUI-04100 

PAS-2050B F-PAS-00950 

PAS-2050B F-PAS-00900 

PAS-2110B F-PAS-01205 

PAS-2110B F-CMS-00305 

PAS-2110B F-PAS-10705 

PAS-2110B F-FUI-05700 

PAS-2110B F-CMS-00405 

PAS-2110B F-PAS-01210 

PAS-2110B F-PAS-01215 

PAS-2110B F-PAS-01220 

PAS-2110B F-PAS-01200 

PAS-2110B F-FUI-04130 

PAS-2110B F-PAS-10700 

PAS-2110B F-CMS-00660 

PAS-2180B F-CMS-10240 

PAS-2180B F-CMS-01630 

PAS-2180B F-CMS-00235 

PAS-2180B F-PAS-10455 

PAS-2190B F-PAS-00160 

PAS-2190B F-PAS-00165 

PAS-2190B F-PAS-00170 

PAS-2190B F-PAS-00175 

PAS-2190B F-PAS-00180 

PAS-2190B F-PAS-00185 
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Test Case Level 4 ID 

PAS-2190B F-PAS-00195 

PAS-2190B F-FUI-04110 

PAS-2200B F-PAS-00840 

PAS-2200B F-CMS-00105 

PAS-2200B F-CMS-01505 

PAS-2200B F-FUI-04090 

PAS-2200B F-CMS-01610 

PAS-2200B F-PAS-01035 

PAS-2200B F-CMS-00635 

PAS-2200B F-PAS-00835 

PAS-2200B F-PAS-00815 

PAS-2200B F-CMS-00610 

PAS-2200B F-PAS-00810 

PAS-2200B F-PAS-00805 

PAS-2200B F-PAS-00800 

PAS-2200B F-CMS-00670 

PAS-2200B F-CMS-00615 

PAS-2200B F-CMS-00620 

PAS-2200B F-CMS-00625 

PAS-2200B F-CMS-00630 

PAS-2200B F-CMS-00675 

POST-B F-TLM-02291 

POST-B F-ANA-01070 

POST-B F-TLM-02295 

POST-B F-ANA-01080 

POST-B F-TLM-02296 

POST-B F-ANA-09010 

POST-B F-ANA-04150 

POST-B F-TLM-02298 

POST-B F-TLM-02299 

POST-B F-ANA-04140 

POST-B F-ANA-09020 

POST-B F-RMS-00010 

POST-B F-CMD-01140 

POST-B F-FUI-07311 

POST-B F-ANA-09060 

POST-B F-ANA-09050 

POST-B F-PAS-10441 

POST-B F-ANA-09040 

POST-B F-PAS-10442 

POST-B F-ANA-07550 

POST-B F-PAS-10630 
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Test Case Level 4 ID 

POST-B F-TLM-02290 

POST-B F-PAS-10440 

POST-B F-TLM-02286 

POST-B F-ANA-07540 

POST-B F-ANA-07530 

POST-B F-PAS-10620 

POST-B F-ANA-07520 

POST-B F-ANA-07510 

POST-B F-ANA-07500 

POST-B F-PAS-10610 

POST-B F-ANA-09030 

POST-B F-DMS-01140 

POST-B F-DMS-01285 

POST-B F-TLM-02218 

POST-B F-TLM-02217 

POST-B F-FOS-00321 

POST-B F-FOS-10245 

POST-B F-PAS-00155 

POST-B F-FOS-00560 

POST-B F-FOS-10240 

POST-B F-FOS-00550 

POST-B F-DMS-01130 

POST-B F-DMS-01120 

POST-B F-FOS-00345 

POST-B F-DMS-01110 

POST-B F-DMS-01022 

POST-B F-FOS-00327 

POST-B F-FOS-00017 

POST-B F-DMS-01295 

POST-B F-TLM-02280 

POST-B F-TLM-02281 

POST-B F-FUI-02926 

POST-B F-DMS-01410 

POST-B F-DMS-00960 

POST-B F-DMS-01460 

POST-B F-DMS-00950 

POST-B F-PAS-00860 

POST-B F-DMS-01430 

POST-B F-PAS-00930 

POST-B F-TLM-02285 

POST-B F-PAS-00935 

POST-B F-DMS-01435 
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Test Case Level 4 ID 

SAS-2000B F-FOS-10305 

SAS-2000B F-FOS-00308 

SAS-2000B F-FOS-00322 

SYS-2000B F-FOS-00570 

SYS-2000B F-FOS-00490 

SYS-2000B F-FOS-00070 

SYS-2020B F-RMS-00060 

SYS-2020B F-RMS-01070 

SYS-2020B F-RMS-01060 

SYS-2020B F-FOS-00035 

SYS-2020B F-RMS-00040 

SYS-2020B F-FUI-08100 

SYS-2020B F-FUI-07720 

SYS-2020B F-RMS-00020 

SYS-2020B F-RMS-00050 

SYS-2020B F-RMS-00030 

SYS-2030B F-RMS-03030 

SYS-2030B F-RMS-03040 

SYS-2030B F-RMS-03010 

SYS-2030B F-RMS-03070 

SYS-2030B F-RMS-03080 

SYS-2030B F-RMS-03240 

SYS-2030B F-FOS-00098 

SYS-2030B F-FUI-08105 

SYS-2030B F-FUI-08110 

SYS-2030B F-FUI-08115 

SYS-2030B F-RMS-03090 

SYS-2030B F-FOS-00510 

SYS-2030B F-RMS-02010 

SYS-2030B F-RMS-02020 

SYS-2030B F-RMS-03050 

SYS-2030B F-FOS-00490 

SYS-2030B F-DMS-01280 

SYS-2030B F-DMS-01270 

SYS-3060FPB F-FOS-00700 

SYS-3060FPB F-FOS-00705 

SYS-3060FPB F-FOS-00715 

SYS-3060FPB F-FOS-00720 

SYS-3060FPB F-FOS-00725 

SYS-3060FPB F-FOS-00730 

SYS-3060FPB F-FOS-00735 

TLM-2000B F-FUI-17700 
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Test Case Level 4 ID 

TLM-2000B F-TLM-10525 

TLM-2000B F-TLM-00135 

TLM-2000B F-TLM-00410 

TLM-2000B F-FUI-07330 

TLM-2000B F-FUI-07425 

TLM-2000B F-TLM-00220 

TLM-2000B F-TLM-00115 

TLM-2000B F-FOS-00020 

TLM-2000B F-FUI-17200 

TLM-2000B F-TLM-00440 

TLM-2000B F-TLM-01430 

TLM-2000B F-TLM-10410 

TLM-2000B F-TLM-10470 

TLM-2000B F-TLM-10420 

TLM-2000B F-TLM-10425 

TLM-2000B F-TLM-10430 

TLM-2000B F-TLM-10435 

TLM-2000B F-TLM-10440 

TLM-2000B F-TLM-10465 

TLM-2000B F-TLM-00215 

TLM-2000B F-TLM-10490 

TLM-2000B F-TLM-00210 

TLM-2000B F-TLM-01410 

TLM-2000B F-RMS-00090 

TLM-2000B F-TLM-10550 

TLM-2000B F-RMS-00070 

TLM-2000B F-TLM-10560 

TLM-2000B F-TLM-10555 

TLM-2000B F-TLM-00635 

TLM-2000B F-TLM-10575 

TLM-2000B F-TLM-00610 

TLM-2000B F-FOS-00320 

TLM-2000B F-TLM-10475 

TLM-2000B F-TLM-00490 

TLM-2000B F-TLM-10580 

TLM-2000B F-TLM-00450 

TLM-2000B F-TLM-10570 

TLM-2010B F-TLM-10490 

TLM-2010B F-TLM-10460 

TLM-2010B F-TLM-10535 

TLM-2010B F-TLM-10540 

TLM-2010B F-TLM-00210 
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Test Case Level 4 ID 

TLM-2010B F-TLM-00215 

TLM-2010B F-TLM-00220 

TLM-2010B F-TLM-00530 

TLM-2010B F-TLM-00410 

TLM-2010B F-TLM-01430 

TLM-2010B F-TLM-00440 

TLM-2010B F-TLM-00515 

TLM-2010B F-FUI-07330 

TLM-2010B F-TLM-10525 

TLM-2010B F-TLM-00510 

TLM-2010B F-FOS-00020 

TLM-2010B F-TLM-00490 

TLM-2010B F-TLM-00450 

TLM-2010B F-TLM-00525 

TLM-2010B F-TLM-10415 

TLM-2010B F-TLM-00115 

TLM-2010B F-TLM-00110 

TLM-2010B F-TLM-00135 

TLM-2010B F-TLM-10440 

TLM-2010B F-FUI-07425 

TLM-2010B F-FOS-00320 

TLM-2010B F-TLM-10455 

TLM-2010B F-FOS-00350 

TLM-2020B F-TLM-00920 

TLM-2020B F-TLM-00635 

TLM-2020B F-RMS-00130 

TLM-2020B F-RMS-00070 

TLM-2020B F-TLM-00610 

TLM-2020B F-TLM-00820 

TLM-2020B F-TLM-00810 

TLM-2020B F-DMS-10110 

TLM-2020B F-TLM-00815 

TLM-2020B F-TLM-10810 

TLM-2020B F-TLM-01410 

TLM-2030B F-TLM-10955 

TLM-2030B F-TLM-00960 

TLM-2030B F-TLM-00525 

TLM-2030B F-TLM-00985 

TLM-2030B F-TLM-00935 

TLM-2030B F-TLM-00990 

TLM-2030B F-TLM-01420 

TLM-2030B F-TLM-00530 
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Test Case Level 4 ID 

TLM-2030B F-TLM-00910 

TLM-2030B F-TLM-00945 

TLM-2040B F-RMS-00100 

TLM-2040B F-TLM-00925 

TLM-2040B F-TLM-00970 

TLM-2040B F-TLM-00915 

TLM-2050B F-TLM-00710 

TLM-2050B F-TLM-00720 

TLM-2050B F-TLM-00725 

TLM-2050B F-TLM-00735 

TLM-2050B F-TLM-00635 

TLM-2050B F-TLM-00730 

TLM-2050B F-TLM-00715 

TLM-2060B F-TLM-01320 

TLM-2060B F-TLM-11320 

TLM-2060B F-TLM-00315 

TLM-2060B F-TLM-01330 

TLM-2060B F-TLM-01415 

TLM-2060B F-TLM-01325 

TLM-2060B F-TLM-01335 

TLM-2060B F-TLM-01315 

TLM-2060B F-TLM-01350 

TLM-2060B F-TLM-01355 

TLM-2060B F-TLM-01425 

TLM-2060B F-TLM-01235 

TLM-2060B F-TLM-01310 

TLM-2060B F-TLM-01365 

TLM-2060B F-TLM-01035 

TLM-2060B F-TLM-01360 

TLM-2060B F-TLM-01050 

TLM-2060B F-TLM-01345 

TLM-2070B F-FUI-07425 

TLM-2070B F-TLM-00310 

TLM-2070B F-RMS-00110 

TLM-2070B F-TLM-00315 

TLM-2070B F-FUI-07200 

TLM-2070B F-FUI-07330 

TLM-2080B F-TLM-01140 

TLM-2080B F-TLM-01015 

TLM-2080B F-TLM-01010 

TLM-2080B F-TLM-01150 

TLM-2080B F-TLM-01210 
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TLM-2080B F-TLM-01155 

TLM-2080B F-TLM-01130 

TLM-2080B F-TLM-01125 

TLM-2080B F-TLM-01220 

TLM-2080B F-TLM-01040 

TLM-2080B F-TLM-01035 

TLM-2080B F-TLM-01050 

TLM-2080B F-TLM-01230 

TLM-2080B F-TLM-01055 

TLM-2080B F-TLM-01225 

TLM-2080B F-TLM-01115 

TLM-2080B F-TLM-01030 

TLM-2080B F-TLM-01160 

TLM-2080B F-TLM-01165 

TLM-2080B F-TLM-01025 

TLM-2080B F-TLM-01110 

TLM-2080B F-TLM-01135 

TLM-2080B F-TLM-01020 

TLM-2080B F-FUI-07200 

TLM-2080B F-TLM-01145 

TLM-2090B F-TLM-01130 

TLM-2090B F-TLM-01120 

TLM-2090B F-FUI-07200 

TLM-2090B F-TLM-01055 

TLM-2090B F-TLM-01050 

TLM-2090B F-TLM-01045 

TLM-2090B F-TLM-01165 

TLM-2090B F-TLM-01145 

TLM-2090B F-TLM-01150 

TLM-2090B F-TLM-01225 

TLM-2100B F-FUI-17600 

TLM-2100B F-FUI-07600 

TLM-2100B F-FUI-07605 

TLM-2100B F-FUI-07700 

TLM-2100B F-TLM-01215 

TLM-2100B F-FUI-07710 

TLM-2100B F-FUI-07200 

TLM-2150B F-TLM-00625 

TLM-2150B F-TLM-00620 

TLM-2150B F-TLM-10445 

TLM-2150B F-TLM-00445 

TLM-2160B F-DMS-00830 
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Test Case Level 4 ID 

TLM-2160B F-DMS-00710 

TLM-2160B F-TLM-00120 

TLM-2160B F-DMS-00820 

TLM-2160B F-TLM-00115 

TLM-2160B F-DMS-00720 

TLM-2160B F-TLM-01545 

TLM-2160B F-TLM-01510 

TLM-2160B F-TLM-11515 

TLM-2160B F-DMS-00810 

TLM-2160B F-DMS-00730 

TLM-2170B F-DMS-00610 

TLM-2170B F-FOS-00350 

TLM-2170B F-TLM-10125 

TLM-2170B F-TLM-10130 

TLM-2170B F-FOS-00310 

TLM-2190B F-FUI-12310 

TLM-2190B F-FUI-02315 

TLM-2190B F-FUI-02320 

TLM-2190B F-FUI-02325 

TLM-2190B F-FUI-02305 

TLM-2190B F-FUI-07330 

TLM-2190B F-FUI-02330 

TLM-2190B F-DMS-00780 

TLM-2190B F-FUI-02335 

TLM-2190B F-RMS-00035 

TLM-2190B F-TLM-01640 

TLM-2190B F-RMS-00080 

TLM-2190B F-FUI-08100 

TLM-2190B F-TLM-01610 

TLM-2190B F-TLM-01625 

TLM-2190B F-FUI-02310 

TLM-2190B F-TLM-01630 

TLM-2190B F-FUI-07425 

TLM-2190B F-TLM-01635 

TLM-2190B F-FUI-02300 
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Appendix D. Release B RBRs to Test Case Matrix


The following matrix delineates each Release B RBR to the associated Thread and End-to-End 
test case that verifies the RBR. 

RBR ID Test Case 

AM1-0020#B CMD-2001B 

AM1-0020#B ETE-2010B 

AM1-0030#B ETE-2010B 

AM1-0050#B CMD-2001B 

AM1-0050#B TLM-2010B 

AM1-0070#B ANA-2100B 

AM1-0070#B TLM-2160B 

AM1-0090#B CMD-2001B 

AM1-0090#B CMS-2000B 

AM1-0090#B IST-2010B 

AM1-0090#B TLM-2000B 

AM1-0090#B TLM-2010B 

AM1-0120#B CMD-2001B 

AM1-0120#B ETE-2010B 

AM1-0120#B OPR-2000B 

AM1-0120#B SYS-2020B 

AM1-0125#B CMD-2001B 

AM1-0125#B OPR-2000B 

AM1-0125#B SYS-2020B 

AM1-0125#B TLM-2010B 

AM1-0130#B ANA-2100B 

AM1-0130#B OPR-2000B 

AM1-0130#B SYS-2020B 

AM1-0130#B TLM-2160B 

AM1-0135#B OPR-2000B 

AM1-0135#B SYS-2020B 

AM1-0135#B TLM-2000B 

AM1-0135#B TLM-2010B 

AM1-0140#B IST-2010B 

AM1-0140#B TLM-2000B 

AM1-0140#B TLM-2010B 

AM1-0150#B CMD-2001B 

AM1-0160#B CMD-2001B 

AM1-0160#B TLM-2000B 

AM1-0160#B TLM-2010B 
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RBR ID Test Case 

AM1-0160#B TLM-2160B 

AM1-0200#B CMS-2000B 

AM1-0200#B IST-2010B 

AM1-0200#B OPR-2000B 

AM1-0200#B TLM-2000B 

AM1-0200#B TLM-2010B 

AM1-0200#B TLM-2160B 

AM1-0215#B DBS-2000B 

AM1-0220#B IST-2000B 

AM1-0225#B ANA-2000B 

AM1-0225#B FUI-2025B 

AM1-0225#B IST-2010B 

AM1-0230#B DBS-2000B 

AM1-0230#B PAS-2000B 

AM1-0240#B ANA-2000B 

AM1-0240#B ANA-2090B 

AM1-0240#B FUI-2025B 

AM1-0240#B IST-2010B 

AM1-0270#B FDF-2000B 

AM1-0270#B IST-2010B 

AM1-0280#B IST-2010B 

AM1-0340#B ANA-2110B 

AM1-1000#B OPR-2000B 

AM1-1010#B OPR-2000B 

AM1-1020#B OPR-2000B 

AM1-1050#B CMD-2070B 

AM1-1060#B ANA-2100B 

AM1-1060#B IST-2010B 

AM1-1060#B TLM-2170B 

AM1-1080#B ANA-2100B 

AM1-1090#B CMD-2001B 

AM1-1090#B CMD-2070B 

AM1-1100#B IST-2010B 

AM1-1100#B TLM-2000B 

AM1-1100#B TLM-2170B 

AM1-1110#B IST-2010B 

AM1-1110#B TLM-2000B 

AM1-1110#B TLM-2010B 

AM1-1110#B TLM-2160B 

AM1-1120#B TLM-2000B 

AM1-1120#B TLM-2010B 

AM1-1120#B TLM-2160B 

D-2
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

AM1-1150#B ANA-2110B 

AM1-1150#B ETE-2000B 

ASTER-0050#B DBS-2000B 

ASTER-0050#B DBS-2020B 

ASTER-0050#B DBS-2030B 

ASTER-0050#B FUI-2025B 

ASTER-0050#B IST-2010B 

ASTER-0050#B OPR-2000B 

ASTER-0050#B PAS-2000B 

ASTER-0060#B DBS-2020B 

ASTER-0200#B FDF-2000B 

ASTER-0210#B ASTR-2000B 

ASTER-0220#B IST-2010B 

ASTER-0230#B ASTR-2000B 

ASTER-0230#B IST-2010B 

ASTER-0240#B ASTR-2000B 

ASTER-0240#B PAS-2180B 

ASTER-0250#B ASTR-2000B 

ASTER-0250#B IST-2010B 

ASTER-0260#B ASTR-2000B 

ASTER-0260#B IST-2010B 

ASTER-0300#B FUI-2025B 

ASTER-0300#B FUI-2130B 

ASTER-0300#B IST-2010B 

ASTER-0310#B FUI-2025B 

ASTER-0310#B FUI-2130B 

ASTER-0310#B IST-2010B 

ASTER-0340#B ASTR-2000B 

ASTER-0340#B IST-2010B 

ASTER-0340#B PAS-2190B 

ASTER-0350#B ASTR-2000B 

ASTER-0350#B IST-2010B 

ASTER-0350#B PAS-2190B 

ASTER-0410#B IST-2010B 

ASTER-0410#B IST-2010B 

ASTER-0520#B IST-2010B 

ASTER-0530#B IST-2010B 

ASTER-0540#B IST-2010B 

ASTER-0550#B IST-2010B 

ASTER-0570#B FUI-2025B 

ASTER-0570#B FUI-2130B 

ASTER-0570#B IST-2010B 

D-3
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ASTER-0580#B FUI-2025B 

ASTER-0580#B FUI-2130B 

ASTER-0580#B IST-2010B 

ASTER-0590#B FUI-2025B 

ASTER-0590#B FUI-2130B 

ASTER-0590#B IST-2010B 

ASTER-1080#B FUI-2090B 

ASTER-1080#B HRD-2000B 

ASTER-1080#B IST-2010B 

ASTER-2000#B OPR-2000B 

ASTER-2030#B OPR-2000B 

ASTER-2040#B OPR-2000B 

EDOS-4.1.1.1#B EDOS-2000B 

EDOS-4.1.1.1#B EDOS-2010B 

EDOS-4.1.1.1#B POST-B 

EDOS-4.1.1.15#B POST-B 

EDOS-4.1.1.16#B POST-B 

EDOS-4.1.1.17#B EDOS-2002B 

EDOS-4.1.1.17#B IST-2010B 

EDOS-4.1.1.18#B EDOS-2030B 

EDOS-4.1.1.18#B TLM-2010B 

EDOS-4.1.1.18#B TLM-2170B 

EDOS-4.1.1.2#B CMD-2030B 

EDOS-4.1.1.2#B CMD-2070B 

EDOS-4.1.1.2#B ETE-2010B 

EDOS-4.1.1.3#B TLM-2000B 

EDOS-4.1.1.3#B TLM-2010B 

EDOS-4.1.1.4#B CMD-2001B 

EDOS-4.1.1.6#B EDOS-2000B 

EDOS-4.1.1.7#B EDOS-2010B 

EDOS-4.1.1.8#B TLM-2010B 

EDOS-4.1.1.8#B TLM-2170B 

EDOS-4.2.1.3#B EDOS-2010B 

EDOS-4.2.1.4#B IST-2010B 

EDOS-4.2.1.4#B TLM-2170B 

EDOS-4.2.1.5#B CMD-2070B 

EDOS-4.2.1.6#B ANA-2100B 

EDOS-4.2.1.7#B EDOS-2000B 

EDOS-4.3.1.4#B POST-B 

EDOS-4.6.1.1#B ANA-2100B 

EDOS-4.6.1.1#B EDOS-2000B 

EDOS-4.6.1.1#B EDOS-2010B 
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EDOS-4.6.1.1#B ETE-2010B 

EDOS-4.6.1.2#B TLM-2000B 

EDOS-4.6.1.2#B TLM-2010B 

EDOS-4.6.1.3#B ETE-2010B 

EDOS-4.6.1.4#B EDOS-2002B 

EDOS-4.6.1.5#B TLM-2000B 

EDOS-4.6.1.5#B TLM-2010B 

EDOS-4.6.1.6#B TLM-2000B 

EDOS-4.6.1.6#B TLM-2010B 

EDOS-4.6.1.7#B POST-B 

EDOS-4.6.1.8#B ANA-2100B 

EOC-0030#B FUI-2120B 

EOC-0040#B CMD-2070B 

EOC-0040#B POST-B 

EOC-0040#B TLM-2000B 

EOC-0040#B TLM-2010B 

EOC-0040#B TLM-2170B 

EOC-1005#B CMS-2000B 

EOC-2010#B FDF-2000B 

EOC-2010#B IST-2010B 

EOC-2010#B PAS-2030B 

EOC-2010#B POST-B 

EOC-2020#B FUI-2120B 

EOC-2020#B IST-2010B 

EOC-2020#B PAS-2020B 

EOC-2020#B PAS-2030B 

EOC-2020#B PAS-2035B 

EOC-2030#B EDOS-2010B 

EOC-2030#B FUI-2120B 

EOC-2030#B IST-2010B 

EOC-2030#B PAS-2000B 

EOC-2030#B PAS-2010B 

EOC-2030#B PAS-2020B 

EOC-2030#B PAS-2030B 

EOC-2030#B PAS-2035B 

EOC-2030#B PAS-2040B 

EOC-2030#B POST-B 

EOC-2030#B SYS-2030B 

EOC-2040#B ASTR-2000B 

EOC-2040#B ETE-2010B 

EOC-2040#B FDF-2000B 

EOC-2040#B IST-2010B 
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EOC-2040#B PAS-2020B 

EOC-2040#B PAS-2030B 

EOC-2040#B PAS-2035B 

EOC-2040#B PAS-2050B 

EOC-2040#B PAS-2110B 

EOC-2040#B PAS-2190B 

EOC-2040#B PAS-2200B 

EOC-2045#B ASTR-2000B 

EOC-2045#B FDF-2000B 

EOC-2045#B IST-2010B 

EOC-2045#B PAS-2020B 

EOC-2045#B PAS-2030B 

EOC-2045#B PAS-2035B 

EOC-2045#B PAS-2040B 

EOC-2045#B PAS-2050B 

EOC-2045#B PAS-2050B 

EOC-2045#B PAS-2110B 

EOC-2045#B PAS-2190B 

EOC-2045#B PAS-2200B 

EOC-2070#B IST-2010B 

EOC-2070#B PAS-2000B 

EOC-2070#B PAS-2020B 

EOC-2070#B PAS-2030B 

EOC-2070#B PAS-2040B 

EOC-2070#B PAS-2110B 

EOC-2160#B CMD-2001B 

EOC-2160#B POST-B 

EOC-2160#B SYS-2000B 

EOC-2170#B CONT-2030B 

EOC-2170#B IST-2010B 

EOC-2170#B PAS-2000B 

EOC-2170#B PAS-2020B 

EOC-2170#B PAS-2035B 

EOC-2170#B PAS-2040B 

EOC-2170#B PAS-2200B 

EOC-2180#B IST-2010B 

EOC-2180#B PAS-2000B 

EOC-2180#B PAS-2020B 

EOC-2180#B PAS-2035B 

EOC-2180#B PAS-2040B 

EOC-2190#B CONT-2010B 

EOC-2190#B IST-2010B 
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EOC-2190#B NCC-2020B 

EOC-2190#B PAS-2020B 

EOC-2200#B CONT-2030B 

EOC-2200#B IST-2010B 

EOC-2200#B OPR-2000B 

EOC-2200#B PAS-2000B 

EOC-2200#B PAS-2020B 

EOC-2200#B PAS-2030B 

EOC-2200#B PAS-2035B 

EOC-2200#B PAS-2040B 

EOC-2210#B ASTR-2000B 

EOC-2210#B IST-2010B 

EOC-2210#B PAS-2030B 

EOC-2210#B PAS-2110B 

EOC-2210#B PAS-2190B 

EOC-2210#B PAS-2200B 

EOC-2220#B CONT-2030B 

EOC-2220#B IST-2010B 

EOC-2220#B PAS-2000B 

EOC-2220#B PAS-2020B 

EOC-2220#B PAS-2030B 

EOC-2220#B PAS-2035B 

EOC-2220#B PAS-2050B 

EOC-2220#B PAS-2110B 

EOC-2220#B PAS-2190B 

EOC-2220#B PAS-2200B 

EOC-2230#B CONT-2030B 

EOC-2230#B OPR-2000B 

EOC-2230#B PAS-2200B 

EOC-2240#B ETE-2000B 

EOC-2240#B IST-2010B 

EOC-2240#B PAS-2020B 

EOC-2250#B ASTR-2000B 

EOC-2250#B IST-2010B 

EOC-2250#B PAS-2020B 

EOC-2250#B PAS-2035B 

EOC-2260#B ASTR-2000B 

EOC-2260#B IST-2010B 

EOC-2260#B PAS-2020B 

EOC-2260#B PAS-2050B 

EOC-2260#B PAS-2190B 

EOC-2260#B PAS-2200B 
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EOC-2270#B ASTR-2000B 

EOC-2270#B IST-2010B 

EOC-2270#B PAS-2000B 

EOC-2270#B PAS-2020B 

EOC-2272#B IST-2010B 

EOC-2272#B OPR-2000B 

EOC-2272#B PAS-2000B 

EOC-2272#B PAS-2020B 

EOC-2280#B ASTR-2000B 

EOC-2280#B IST-2010B 

EOC-2280#B PAS-2020B 

EOC-2280#B PAS-2035B 

EOC-2290#B ASTR-2000B 

EOC-2290#B DBS-2000B 

EOC-2290#B IST-2010B 

EOC-2290#B PAS-2000B 

EOC-2290#B PAS-2020B 

EOC-2290#B PAS-2030B 

EOC-2290#B PAS-2035B 

EOC-2290#B PAS-2050B 

EOC-2300#B CONT-2030B 

EOC-2300#B IST-2010B 

EOC-2300#B PAS-2020B 

EOC-2300#B PAS-2030B 

EOC-2300#B PAS-2035B 

EOC-2300#B PAS-2050B 

EOC-2310#B CONT-2030B 

EOC-2310#B IST-2010B 

EOC-2310#B PAS-2020B 

EOC-2310#B PAS-2030B 

EOC-2310#B PAS-2035B 

EOC-2310#B PAS-2050B 

EOC-2320#B ASTR-2000B 

EOC-2320#B CMS-2170B 

EOC-2320#B CONT-2030B 

EOC-2320#B IST-2010B 

EOC-2320#B PAS-2020B 

EOC-2320#B PAS-2030B 

EOC-2320#B PAS-2035B 

EOC-2320#B PAS-2040B 

EOC-2320#B PAS-2050B 

EOC-2320#B PAS-2190B 
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EOC-2350#B ASTR-2000B 

EOC-2350#B IST-2010B 

EOC-2350#B PAS-2030B 

EOC-2370#B IST-2010B 

EOC-2370#B OPR-2000B 

EOC-2370#B PAS-2040B 

EOC-2370#B SYS-2020B 

EOC-2400#B PAS-2040B 

EOC-2405#B PAS-2040B 

EOC-2410#B PAS-2040B 

EOC-2420#B PAS-2020B 

EOC-2430#B ASTR-2000B 

EOC-2430#B FUI-2130B 

EOC-2430#B PAS-2020B 

EOC-2430#B PAS-2200B 

EOC-2460#B IST-2010B 

EOC-2460#B PAS-2020B 

EOC-2460#B PAS-2030B 

EOC-2460#B PAS-2040B 

EOC-2480#B ASTR-2000B 

EOC-2480#B PAS-2020B 

EOC-2480#B PAS-2180B 

EOC-2482#B IST-2010B 

EOC-2482#B PAS-2020B 

EOC-2490#B ETE-2010B 

EOC-2490#B IST-2010B 

EOC-2490#B PAS-2020B 

EOC-2490#B PAS-2035B 

EOC-2510#B CONT-2030B 

EOC-2510#B IST-2010B 

EOC-2510#B PAS-2020B 

EOC-2510#B PAS-2030B 

EOC-2510#B PAS-2035B 

EOC-2520#B PAS-2040B 

EOC-2530#B CONT-2030B 

EOC-2530#B FUI-2050B 

EOC-2530#B PAS-2020B 

EOC-2530#B PAS-2040B 

EOC-2535#B IST-2010B 

EOC-2535#B OPR-2000B 

EOC-2535#B PAS-2020B 

EOC-2535#B PAS-2035B 
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EOC-2535#B PAS-2040B 

EOC-2540#B ASTR-2000B 

EOC-2540#B IST-2010B 

EOC-2540#B PAS-2000B 

EOC-2540#B PAS-2020B 

EOC-2540#B PAS-2035B 

EOC-2540#B PAS-2050B 

EOC-2540#B PAS-2180B 

EOC-2540#B PAS-2200B 

EOC-2550#B ASTR-2000B 

EOC-2550#B CONT-2030B 

EOC-2550#B IST-2010B 

EOC-2550#B PAS-2020B 

EOC-2550#B PAS-2030B 

EOC-2550#B PAS-2035B 

EOC-2550#B PAS-2040B 

EOC-2555#B CONT-2030B 

EOC-2555#B IST-2010B 

EOC-2555#B PAS-2030B 

EOC-2555#B PAS-2050B 

EOC-2555#B PAS-2200B 

EOC-2570#B ASTR-2000B 

EOC-2570#B IST-2010B 

EOC-2570#B PAS-2020B 

EOC-2590#B ASTR-2000B 

EOC-2590#B IST-2010B 

EOC-2590#B PAS-2020B 

EOC-2620#B ASTR-2000B 

EOC-2620#B IST-2010B 

EOC-2620#B PAS-2030B 

EOC-2620#B PAS-2180B 

EOC-2630#B ASTR-2000B 

EOC-2630#B PAS-2020B 

EOC-2630#B PAS-2200B 

EOC-3015#B CMS-2060B 

EOC-3015#B FDF-2000B 

EOC-3015#B IST-2010B 

EOC-3017#B FDF-2000B 

EOC-3020#B CMS-2040B 

EOC-3020#B CMS-2060B 

EOC-3020#B CMS-2090B 

EOC-3020#B CMS-2170B 
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EOC-3020#B IST-2010B 

EOC-3020#B PAS-2020B 

EOC-3020#B PAS-2110B 

EOC-3024#B CMS-2040B 

EOC-3024#B CMS-2090B 

EOC-3024#B CMS-2100B 

EOC-3024#B CMS-2170B 

EOC-3024#B CONT-2030B 

EOC-3024#B FUI-2050B 

EOC-3024#B IST-2010B 

EOC-3024#B PAS-2200B 

EOC-3030#B CMS-2180B 

EOC-3030#B FDF-2000B 

EOC-3030#B IST-2010B 

OC-3030#B OPR-2000B 

EOC-3030#B PAS-2180B 

EOC-3050#B CMS-2040B 

EOC-3050#B CMS-2060B 

EOC-3050#B CMS-2090B 

EOC-3050#B CMS-2170B 

EOC-3050#B CMS-2180B 

EOC-3050#B FDF-2000B 

EOC-3050#B IST-2010B 

EOC-3050#B PAS-2110B 

EOC-3050#B PAS-2180B 

EOC-3050#B PAS-2200B 

EOC-3080#B FUI-2050B 

EOC-3080#B IST-2010B 

EOC-3086#B CMS-2100B 

EOC-3086#B CMS-2180B 

EOC-3086#B IST-2010B 

EOC-3090#B CMS-2090B 

EOC-3090#B CMS-2100B 

EOC-3090#B CMS-2170B 

EOC-3090#B DBS-2000B 

EOC-3090#B FDF-2000B 

EOC-3090#B IST-2010B 

EOC-3090#B PAS-2110B 

EOC-3090#B PAS-2180B 

EOC-3090#B PAS-2200B 

EOC-3160#B ANA-2100B 

EOC-3160#B CMS-2000B 
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EOC-3160#B CMS-2040B 

EOC-3160#B CMS-2060B 

EOC-3160#B CMS-2090B 

EOC-3160#B CMS-2100B 

EOC-3160#B CMS-2170B 

EOC-3160#B CMS-2180B 

EOC-3160#B DBS-2000B 

EOC-3160#B IST-2010B 

EOC-3160#B PAS-2110B 

EOC-3160#B PAS-2180B 

EOC-3160#B PAS-2200B 

EOC-3200#B IST-2010B 

EOC-3200#B OPR-2000B 

EOC-3210#B FUI-2050B 

EOC-3210#B IST-2010B 

EOC-3225#B PAS-2180B 

EOC-3238#B CMD-2010B 

EOC-3240#B PAS-2200B 

EOC-4005#B CMD-2001B 

EOC-4005#B CMD-2070B 

EOC-4005#B ETE-2010B 

EOC-4008#B ETE-2010B 

EOC-4010#B CMD-2001B 

EOC-4010#B CMD-2030B 

EOC-4010#B CMD-2070B 

EOC-4010#B CONT-2010B 

EOC-4010#B CONT-2020B 

EOC-4010#B IST-2010B 

EOC-4010#B POST-B 

EOC-4015#B CMD-2001B 

EOC-4015#B CMD-2030B 

EOC-4015#B CMD-2050B 

EOC-4015#B CMD-2070B 

EOC-4015#B CMD-2080B 

EOC-4015#B CMS-2040B 

EOC-4015#B CMS-2060B 

EOC-4015#B CMS-2170B 

EOC-4015#B CONT-2010B 

EOC-4015#B FUI-2050B 

EOC-4015#B IST-2010B 

EOC-4015#B POST-B 

EOC-4018#B CMD-2015B 
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EOC-4018#B CMD-2030B 

EOC-4018#B FUI-2050B 

EOC-4018#B IST-2010B 

EOC-4020#B CMD-2010B 

EOC-4020#B CMD-2030B 

EOC-4020#B CMD-2070B 

EOC-4020#B CONT-2010B 

EOC-4020#B CONT-2020B 

EOC-4020#B FUI-2050B 

EOC-4020#B HRD-2000B 

EOC-4020#B IST-2000B 

EOC-4020#B OPR-2000B 

EOC-4020#B POST-B 

EOC-4020#B SYS-2000B 

EOC-4020#B SYS-2020B 

EOC-4020#B SYS-2030B 

EOC-4060#B ANA-2030B 

EOC-4060#B ETE-2010B 

EOC-4060#B NCC-2020B 

EOC-4060#B NCC-2030B 

EOC-4100#B CMD-2001B 

EOC-4100#B CMD-2030B 

EOC-4100#B FUI-2050B 

EOC-4100#B FUI-2060B 

EOC-4100#B IST-2010B 

EOC-4120#B CMD-2010B 

EOC-4120#B CMD-2015B 

EOC-4120#B CMD-2030B 

EOC-4120#B CMD-2070B 

EOC-4120#B CMD-2080B 

EOC-4120#B IST-2010B 

EOC-4125#B CMD-2010B 

EOC-4125#B CMD-2015B 

EOC-4125#B CMD-2030B 

EOC-4125#B CMD-2050B 

EOC-4125#B CMD-2080B 

EOC-4125#B CMS-2170B 

EOC-4125#B CONT-2040B 

EOC-4125#B IST-2010B 

EOC-4130#B CMD-2001B 

EOC-4140#B CMD-2010B 

EOC-4140#B CMD-2030B 
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EOC-4140#B CMD-2050B 

EOC-4140#B CMD-2070B 

EOC-4140#B IST-2010B 

EOC-4160#B CMD-2010B 

EOC-4160#B CMD-2050B 

EOC-4160#B CMD-2080B 

EOC-4160#B IST-2010B 

EOC-4200#B CMD-2070B 

EOC-4200#B CONT-2010B 

EOC-4210#B ETE-2000B 

EOC-5010#B IST-2010B 

EOC-5010#B TLM-2000B 

EOC-5010#B TLM-2010B 

EOC-5010#B TLM-2020B 

EOC-5010#B TLM-2050B 

EOC-5012#B ANA-2090B 

EOC-5012#B ANA-2100B 

EOC-5012#B TLM-2190B 

EOC-5015#B IST-2010B 

EOC-5015#B TLM-2070B 

EOC-5015#B TLM-2170B 

EOC-5020#B IST-2010B 

EOC-5020#B TLM-2000B 

EOC-5020#B TLM-2010B 

EOC-5020#B TLM-2170B 

EOC-5030#B ANA-2030B 

EOC-5030#B EDOS-2000B 

EOC-5030#B EDOS-2001B 

EOC-5030#B EDOS-2010B 

EOC-5030#B NCC-2020B 

EOC-5030#B NCC-2030B 

EOC-5030#B NCC-2040B 

EOC-5030#B POST-B 

EOC-5030#B SYS-2030B 

EOC-5045#B IST-2010B 

EOC-5045#B TLM-2000B 

EOC-5045#B TLM-2010B 

EOC-5050#B TLM-2060B 

EOC-5050#B TLM-2070B 

EOC-5070#B TLM-2000B 

EOC-5070#B TLM-2020B 

EOC-5070#B TLM-2050B 
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EOC-5070#B TLM-2150B 

EOC-5080#B IST-2010B 

EOC-5080#B TLM-2000B 

EOC-5080#B TLM-2010B 

EOC-5080#B TLM-2020B 

EOC-5080#B TLM-2030B 

EOC-5080#B TLM-2050B 

EOC-5090#B CMD-2030B 

EOC-5090#B CONT-2040B 

EOC-5090#B IST-2010B 

EOC-5090#B POST-B 

EOC-5090#B TLM-2000B 

EOC-5090#B TLM-2010B 

EOC-5090#B TLM-2020B 

EOC-5090#B TLM-2030B 

EOC-5090#B TLM-2040B 

EOC-5090#B TLM-2050B 

EOC-5090#B TLM-2060B 

EOC-5090#B TLM-2080B 

EOC-5090#B TLM-2090B 

EOC-5090#B TLM-2150B 

EOC-5100#B IST-2010B 

EOC-5100#B TLM-2000B 

EOC-5100#B TLM-2020B 

EOC-5100#B TLM-2030B 

EOC-5100#B TLM-2060B 

EOC-5100#B TLM-2080B 

EOC-5100#B TLM-2090B 

EOC-5105#B IST-2010B 

EOC-5105#B TLM-2080B 

EOC-5110#B IST-2010B 

EOC-5110#B TLM-2080B 

EOC-5110#B TLM-2090B 

EOC-5120#B IST-2010B 

EOC-5120#B TLM-2060B 

EOC-5120#B TLM-2080B 

EOC-5120#B TLM-2090B 

EOC-5120#B TLM-2100B 

EOC-5130#B CMS-2000B 

EOC-5180#B ANA-2000B 

EOC-5180#B CONT-2040B 

EOC-5180#B FDF-2000B 
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EOC-5180#B IST-2010B 

EOC-5185#B CONT-2040B 

EOC-5185#B FDF-2000B 

EOC-5187#B ANA-2020B 

EOC-5187#B ANA-2030B 

EOC-5187#B ANA-2030B 

EOC-5187#B ANA-2060B 

EOC-5187#B ANA-2120B 

EOC-5187#B CONT-2010B 

EOC-5187#B CONT-2020B 

EOC-5187#B POST-B 

EOC-5190#B TLM-2160B 

EOC-5200#B CMS-2180B 

EOC-5200#B EDOS-2001B 

EOC-5200#B FDF-2000B 

EOC-5200#B IST-2010B 

EOC-5200#B TLM-2190B 

EOC-5220#B IST-2010B 

EOC-5220#B TLM-2000B 

EOC-5220#B TLM-2010B 

EOC-5220#B TLM-2020B 

EOC-5230#B ANA-2100B 

EOC-5230#B TLM-2150B 

EOC-5240#B CONT-2020B 

EOC-5240#B EDOS-2001B 

EOC-5240#B IST-2010B 

EOC-5240#B TLM-2020B 

EOC-5240#B TLM-2190B 

EOC-6010#B ANA-2000B 

EOC-6010#B ANA-2060B 

EOC-6010#B ANA-2070B 

EOC-6010#B ANA-2090B 

EOC-6010#B ANA-2100B 

EOC-6010#B ANA-2110B 

EOC-6010#B ANA-2120B 

EOC-6010#B CONT-2010B 

EOC-6010#B CONT-2020B 

EOC-6010#B CONT-2030B 

EOC-6010#B EDOS-2001B 

EOC-6010#B FDF-2000B 

EOC-6010#B IST-2000B 

EOC-6010#B IST-2010B 
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RBR ID Test Case 

EOC-6010#B NCC-2040B 

EOC-6010#B OPR-2000B 

EOC-6010#B POST-B 

EOC-6010#B TLM-2190B 

EOC-6020#B FUI-2130B 

EOC-6050#B ANA-2000B 

EOC-6050#B ANA-2060B 

EOC-6050#B ANA-2070B 

EOC-6050#B ANA-2100B 

EOC-6050#B CONT-2010B 

EOC-6050#B FDF-2000B 

EOC-6050#B IST-2010B 

EOC-6050#B OPR-2000B 

EOC-6050#B POST-B 

EOC-6060#B ANA-2060B 

EOC-6060#B FUI-2110B 

EOC-6060#B IST-2010B 

EOC-6060#B TLM-2000B 

EOC-6060#B TLM-2010B 

EOC-6060#B TLM-2070B 

EOC-6060#B TLM-2190B 

EOC-6070#B ANA-2000B 

EOC-6070#B ANA-2060B 

EOC-6070#B ANA-2100B 

EOC-6070#B CONT-2010B 

EOC-6070#B FUI-2110B 

EOC-6070#B IST-2010B 

EOC-6070#B TLM-2000B 

EOC-6070#B TLM-2010B 

EOC-6070#B TLM-2070B 

EOC-6070#B TLM-2190B 

EOC-6080#B FUI-2050B 

EOC-6080#B IST-2010B 

EOC-6100#B ANA-2000B 

EOC-6100#B ANA-2040B 

EOC-6100#B ANA-2060B 

EOC-6100#B ANA-2070B 

EOC-6100#B ANA-2090B 

EOC-6100#B ANA-2100B 

EOC-6100#B ANA-2120B 

EOC-6100#B IST-2010B 

EOC-6100#B POST-B 
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RBR ID Test Case 

EOC-6110#B ANA-2040B 

EOC-6110#B ANA-2060B 

EOC-6110#B ANA-2070B 

EOC-6110#B ANA-2120B 

EOC-6110#B CONT-2010B 

EOC-6110#B CONT-2020B 

EOC-6110#B CONT-2030B 

EOC-6110#B IST-2010B 

EOC-6110#B PAS-2200B 

EOC-6110#B POST-B 

EOC-6130#B CONT-2010B 

EOC-6135#B CONT-2030B 

EOC-6140#B CONT-2010B 

EOC-6140#B PAS-2200B 

EOC-6150#B ANA-2110B 

EOC-6150#B CMS-2000B 

EOC-6150#B CMS-2100B 

EOC-6150#B CMS-2170B 

EOC-6150#B CMS-2180B 

EOC-6150#B IST-2010B 

EOC-6160#B CMS-2000B 

EOC-6160#B CMS-2170B 

EOC-6160#B IST-2010B 

EOC-6195#B ANA-2070B 

EOC-6195#B CONT-2010B 

EOC-6195#B CONT-2020B 

EOC-6195#B EVT-2000B 

EOC-6195#B EVT-2020B 

EOC-6195#B EVT-2030B 

EOC-6195#B FUI-2115B 

EOC-6195#B IST-2010B 

EOC-6195#B POST-B 

EOC-6200#B ANA-2070B 

EOC-6200#B ANA-2120B 

EOC-6200#B CMD-2030B 

EOC-6200#B CONT-2010B 

EOC-6200#B CONT-2020B 

EOC-6200#B EDOS-2001B 

EOC-6200#B IST-2010B 

EOC-6200#B NCC-2030B 

EOC-6200#B NCC-2040B 

EOC-6200#B OPR-2000B 
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RBR ID Test Case 

EOC-6200#B POST-B 

EOC-6200#B TLM-2000B 

EOC-6200#B TLM-2010B 

EOC-6210#B CONT-2010B 

EOC-6210#B CONT-2030B 

EOC-7010#B ANA-2060B 

EOC-7010#B CMD-2030B 

EOC-7010#B CMS-2090B 

EOC-7010#B CMS-2170B 

EOC-7010#B CMS-2180B 

EOC-7010#B CONT-2020B 

EOC-7010#B CONT-2030B 

EOC-7010#B DBS-2000B 

EOC-7010#B FUI-2030B 

EOC-7010#B FUI-2110B 

EOC-7010#B FUI-2115B 

EOC-7010#B IST-2010B 

EOC-7010#B PAS-2000B 

EOC-7010#B PAS-2010B 

EOC-7010#B PAS-2035B 

EOC-7010#B PAS-2050B 

EOC-7010#B PAS-2180B 

EOC-7010#B PAS-2200B 

EOC-7010#B TLM-2000B 

EOC-7010#B TLM-2010B 

EOC-7010#B TLM-2070B 

EOC-7010#B TLM-2080B 

EOC-7010#B TLM-2090B 

EOC-7010#B TLM-2100B 

EOC-7010#B TLM-2190B 

EOC-7015#B DBS-2000B 

EOC-7015#B PAS-2000B 

EOC-7015#B PAS-2010B 

EOC-7020#B CMS-2170B 

EOC-7020#B DBS-2010B 

EOC-7020#B IST-2010B 

EOC-7020#B PAS-2110B 

EOC-7020#B PAS-2180B 

EOC-7025#B CONT-2030B 

EOC-7025#B DBS-2000B 

EOC-7025#B DBS-2030B 

EOC-7025#B IST-2010B 
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RBR ID Test Case 

EOC-7025#B PAS-2000B 

EOC-7025#B PAS-2010B 

EOC-7030#B DBS-2000B 

EOC-7030#B PAS-2000B 

EOC-7030#B PAS-2010B 

EOC-7030#B PAS-2110B 

EOC-7040#B DBS-2000B 

EOC-7045#B DBS-2020B 

EOC-7045#B DBS-2030B 

EOC-7060#B ANA-2100B 

EOC-7060#B EVT-2000B 

EOC-7060#B SYS-2030B 

EOC-7060#B TLM-2160B 

EOC-7110#B PAS-2200B 

EOC-7110#B POST-B 

EOC-7115#B POST-B 

EOC-7116#B POST-B 

EOC-7120#B ANA-2100B 

EOC-7120#B EVT-2000B 

EOC-7120#B EVT-2010B 

EOC-7120#B EVT-2020B 

EOC-7120#B OPR-2000B 

EOC-7120#B POST-B 

EOC-7130#B EVT-2000B 

EOC-7130#B EVT-2020B 

EOC-7130#B EVT-2030B 

EOC-7130#B IST-2010B 

EOC-7140#B FUI-2120B 

EOC-7140#B FUI-2150B 

EOC-7140#B TLM-2100B 

EOC-7150#B FUI-2120B 

EOC-7150#B FUI-2150B 

EOC-7160#B FUI-2120B 

EOC-7160#B IST-2010B 

EOC-7160#B OPR-2000B 

EOC-7160#B TLM-2160B 

EOC-8010#B OPR-2000B 

EOC-8010#B POST-B 

EOC-8010#B SYS-2020B 

EOC-8020#B OPR-2000B 

EOC-8090#B ANA-2090B 

EOC-8090#B IST-2000B 
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RBR ID Test Case 

EOC-8090#B POST-B 

EOC-8090#B SYS-2020B 

EOC-8090#B TLM-2190B 

EOC-8100#B NCC-2020B 

EOC-8110#B SYS-2030B 

EOC-8130#B CMD-2030B 

EOC-8130#B SYS-2020B 

EOC-8130#B SYS-2030B 

EOC-8140#B EVT-2010B 

EOC-8140#B POST-B 

EOC-8140#B SYS-2000B 

EOC-8140#B SYS-2020B 

EOC-8140#B SYS-2030B 

EOC-8150#B EVT-2010B 

EOC-8150#B SYS-2030B 

EOC-8160#B FUI-2115B 

EOC-8160#B IST-2010B 

EOC-8160#B SYS-2030B 

EOC-8220#B EVT-2000B 

EOC-8220#B SYS-2030B 

EOC-8230#B SYS-2030B 

EOC-8240#B SYS-2020B 

EOC-8240#B SYS-2030B 

EOC-8250#B OPR-2000B 

EOC-8250#B SYS-2030B 

EOC-8260#B OPR-2000B 

EOC-8260#B SYS-2020B 

EOC-8270#B OPR-2000B 

EOC-8285#B DBS-2000B 

EOC-8285#B ETE-2010B 

EOC-8285#B IST-2010B 

EOC-8285#B OPR-2000B 

EOC-8285#B TLM-2000B 

EOC-8285#B TLM-2010B 

EOC-8285#B TLM-2020B 

EOC-8290#B IST-2010B 

EOC-8290#B OPR-2000B 

EOC-8290#B TLM-2000B 

EOC-8290#B TLM-2030B 

EOC-8320#B OPR-2000B 

EOC-8330#B SYS-2030B 

EOC-8370#B OPR-2000B 
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RBR ID Test Case 

EOC-8372#B ANA-2060B 

EOC-8372#B IST-2010B 

EOC-8375#B OPR-2000B 

EOC-8380#B EVT-2010B 

EOC-8380#B OPR-2000B 

EOC-9010#B CMD-2000B 

EOC-9010#B EVT-2000B 

EOC-9010#B EVT-2010B 

EOC-9010#B FUI-2000B 

EOC-9010#B FUI-2150B 

EOC-9010#B IST-2010B 

EOC-9010#B OPR-2000B 

EOC-9010#B SYS-2000B 

EOC-9010#B SYS-2020B 

EOC-9010#B TLM-2000B 

EOC-9010#B TLM-2020B 

EOC-9010#B TLM-2040B 

EOC-9020#B ANA-2000B 

EOC-9020#B ANA-2060B 

EOC-9020#B ANA-2090B 

EOC-9020#B CMS-2040B 

EOC-9020#B CMS-2060B 

EOC-9020#B CMS-2090B 

EOC-9020#B CMS-2170B 

EOC-9020#B CMS-2180B 

EOC-9020#B CONT-2020B 

EOC-9020#B EVT-2030B 

EOC-9020#B FUI-2000B 

EOC-9020#B FUI-2020B 

EOC-9020#B FUI-2025B 

EOC-9020#B FUI-2030B 

EOC-9020#B FUI-2050B 

EOC-9020#B FUI-2110B 

EOC-9020#B IST-2010B 

EOC-9020#B PAS-2030B 

EOC-9020#B PAS-2035B 

EOC-9020#B PAS-2050B 

EOC-9020#B PAS-2110B 

EOC-9020#B PAS-2190B 

EOC-9020#B PAS-2200B 

EOC-9020#B SYS-2030B 

EOC-9020#B TLM-2000B 
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RBR ID Test Case 

EOC-9020#B TLM-2010B 

EOC-9020#B TLM-2070B 

EOC-9020#B TLM-2080B 

EOC-9020#B TLM-2090B 

EOC-9020#B TLM-2100B 

EOC-9020#B TLM-2190B 

EOC-9025#B CMD-2030B 

EOC-9025#B CMS-2170B 

EOC-9025#B CONT-2020B 

EOC-9025#B EVT-2000B 

EOC-9025#B EVT-2010B 

EOC-9025#B EVT-2020B 

EOC-9025#B EVT-2030B 

EOC-9025#B IST-2010B 

EOC-9025#B PAS-2030B 

EOC-9025#B SYS-2030B 

EOC-9040#B ANA-2000B 

EOC-9040#B ANA-2110B 

EOC-9040#B CMD-2070B 

EOC-9040#B CMS-2100B 

EOC-9040#B CMS-2170B 

EOC-9040#B DBS-2000B 

EOC-9040#B FUI-2040B 

EOC-9040#B FUI-2050B 

EOC-9040#B FUI-2060B 

EOC-9040#B IST-2010B 

EOC-9040#B OPR-2000B 

EOC-9040#B PAS-2200B 

EOC-9080#B CMS-2170B 

EOC-9080#B FUI-2050B 

EOC-9080#B IST-2010B 

EOC-9080#B OPR-2000B 

EOC-9090#B ANA-2060B 

EOC-9090#B ANA-2090B 

EOC-9090#B CMS-2180B 

EOC-9090#B CONT-2020B 

EOC-9090#B ETE-2000B 

EOC-9090#B EVT-2000B 

EOC-9090#B FUI-2020B 

EOC-9090#B FUI-2030B 

EOC-9090#B FUI-2110B 

EOC-9090#B IST-2010B 
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RBR ID Test Case 

EOC-9090#B OPR-2000B 

EOC-9090#B PAS-2030B 

EOC-9090#B PAS-2050B 

EOC-9090#B PAS-2110B 

EOC-9090#B PAS-2190B 

EOC-9090#B PAS-2200B 

EOC-9090#B SYS-2000B 

EOC-9090#B TLM-2000B 

EOC-9090#B TLM-2010B 

EOC-9090#B TLM-2070B 

EOC-9090#B TLM-2080B 

EOC-9090#B TLM-2090B 

EOC-9090#B TLM-2100B 

EOC-9090#B TLM-2190B 

EOC-9110#B EVT-2010B 

EOC-9110#B FUI-2040B 

EOC-9130#B EVT-2000B 

EOC-9130#B EVT-2010B 

EOC-9130#B FUI-2030B 

EOC-9130#B IST-2010B 

EOC-9510#B OPR-2000B 

EOC-9570#B ETE-2000B 

EOC-9570#B OPR-2000B 

EOC-9570#B SYS-2020B 

EOC-9580#B IST-2000B 

EOSD0010#B CMD-2070B 

EOSD0010#B ETE-2010B 

EOSD0010#B FUI-2090B 

EOSD0010#B IST-2000B 

EOSD0010#B IST-2010B 

EOSD0010#B OPR-2000B 

EOSD0010#B PAS-2040B 

EOSD0010#B SYS-2000B 

EOSD0010#B SYS-2020B 

EOSD0010#B SYS-2030B 

EOSD0010#B TLM-2000B 

EOSD0010#B TLM-2010B 

EOSD0015#B ETE-2010B 

EOSD0015#B OPR-2000B 

EOSD0020#B ETE-2010B 

EOSD0020#B FUI-2050B 

EOSD0025#B CMD-2070B 
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RBR ID Test Case 

EOSD0025#B ETE-2010B 

EOSD0025#B FDF-2000B 

EOSD0025#B NCC-2020B 

EOSD0025#B NCC-2030B 

EOSD0025#B PAS-2040B 

EOSD0025#B TLM-2000B 

EOSD0025#B TLM-2010B 

EOSD0500#B CMD-2070B 

EOSD0500#B ETE-2000B 

EOSD0500#B ETE-2010B 

EOSD0500#B OPR-2000B 

EOSD0500#B PAS-2020B 

EOSD0500#B SYS-2030B 

EOSD0500#B TLM-2010B 

EOSD0502#B IST-2000B 

EOSD0510#B OPR-2000B 

EOSD0510#B SYS-2020B 

EOSD0545#B CMS-2090B 

EOSD0545#B CMS-2090B 

EOSD0545#B HRD-2000B 

EOSD0545#B POST-B 

EOSD0560#B OPR-2000B 

EOSD0630#B CMS-2090B 

EOSD0630#B HRD-2000B 

EOSD0630#B OPR-2000B 

EOSD0630#B PAS-2180B 

EOSD0630#B SYS-2020B 

EOSD0700#B OPR-2000B 

EOSD0720#B ETE-2000B 

EOSD0720#B OPR-2000B 

EOSD0740#B SYS-2020B 

EOSD0750#B OPR-2000B 

EOSD0750#B SYS-2020B 

EOSD0760#B OPR-2000B 

EOSD0760#B SYS-2020B 

EOSD0780#B SYS-2030B 

EOSD0800#B OPR-2000B 

EOSD0800#B SYS-2020B 

EOSD1000#B ETE-2000B 

EOSD1010#B OPR-2000B 

EOSD1010#B POST-B 

EOSD1480#B FUI-2120B 
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RBR ID Test Case 

EOSD1490#B OPR-2000B 

EOSD1500#B ETE-2000B 

EOSD1502#B CMD-2070B 

EOSD1502#B ETE-2010B 

EOSD1502#B FDF-2000B 

EOSD1502#B NCC-2020B 

EOSD1502#B NCC-2030B 

EOSD1502#B PAS-2040B 

EOSD1502#B TLM-2000B 

EOSD1502#B TLM-2010B 

EOSD1505#B FDF-2000B 

EOSD1505#B OPR-2000B 

EOSD1510#B FDF-2000B 

EOSD1520#B NCC-2030B 

EOSD1520#B PAS-2040B 

EOSD1530#B NCC-2020B 

EOSD1530#B NCC-2030B 

EOSD1530#B PAS-2040B 

EOSD1600#B EDOS-2000B 

EOSD1600#B EDOS-2010B 

EOSD1600#B POST-B 

EOSD1605#B ETE-2010B 

EOSD1605#B TLM-2000B 

EOSD1605#B TLM-2010B 

EOSD1605#B TLM-2170B 

EOSD1680#B CMS-2040B 

EOSD1680#B CMS-2060B 

EOSD1680#B CMS-2090B 

EOSD1680#B CMS-2100B 

EOSD1680#B CMS-2170B 

EOSD1680#B IST-2010B 

EOSD1680#B OPR-2000B 

EOSD1680#B SYS-2020B 

EOSD1680#B TLM-2000B 

EOSD1680#B TLM-2010B 

EOSD1680#B TLM-2160B 

EOSD1690#B CMD-2001B 

EOSD1690#B CMD-2030B 

EOSD1770#B ASTR-2000B 

EOSD1770#B IST-2010B 

EOSD1990#B FUI-2090B 

EOSD1990#B HRD-2000B 
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RBR ID Test Case 

EOSD1990#B IST-2010B 

EOSD2100#B FUI-2090B 

EOSD2100#B HRD-2000B 

EOSD2100#B IST-2010B 

EOSD2200#B HRD-2000B 

EOSD2400#B FUI-2050B 

EOSD2400#B HRD-2000B 

EOSD2400#B IST-2010B 

EOSD2430#B FUI-2090B 

EOSD2430#B HRD-2000B 

EOSD2430#B IST-2010B 

EOSD2440#B HRD-2000B 

EOSD2550#B FUI-2090B 

EOSD2550#B IST-2010B 

EOSD2990#B SYS-2000B 

EOSD2990#B SYS-2030B 

EOSD3000#B SYS-2000B 

EOSD3000#B SYS-2030B 

EOSD3200#B HRD-2000B 

EOSD3490#B OPR-2000B 

EOSD3490#B SYS-2030B 

EOSD3700#B OPR-2000B 

EOSD3710#B NCC-2020B 

EOSD3710#B NCC-2030B 

EOSD3710#B PAS-2040B 

EOSD3710#B SYS-2030B 

EOSD3710#B TLM-2190B 

EOSD3800#B FUI-2050B 

EOSD3800#B OPR-2000B 

EOSD3810#B FUI-2050B 

EOSD3810#B HRD-2000B 

EOSD3810#B OPR-2000B 

EOSD3820#B OPR-2000B 

EOSD4100#B SYS-2020B 

EOSD5410#B IST-2000B 

ESN-1367#B IST-2010B 

FOS-0020#B SYS-2020B 

FOS-0025#B SYS-2020B 

FOS-0030#B FDF-2000B 

FOS-0030#B IST-2010B 

FOS-0030#B PAS-2020B 

FOS-0030#B PAS-2030B 
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RBR ID Test Case 

FOS-0030#B PAS-2035B 

FOS-0030#B PAS-2050B 

FOS-0030#B PAS-2110B 

FOS-0030#B PAS-2190B 

FOS-0030#B PAS-2200B 

FOS-0040#B ANA-2000B 

FOS-0040#B ANA-2040B 

FOS-0040#B ANA-2060B 

FOS-0040#B ANA-2100B 

FOS-0040#B ANA-2110B 

FOS-0040#B ASTR-2000B 

FOS-0040#B CMD-2070B 

FOS-0040#B CMS-2000B 

FOS-0040#B CMS-2040B 

FOS-0040#B CMS-2090B 

FOS-0040#B CMS-2100B 

FOS-0040#B CMS-2170B 

FOS-0040#B CMS-2180B 

FOS-0040#B CONT-2030B 

FOS-0040#B ETE-2000B 

FOS-0040#B ETE-2010B 

FOS-0040#B EVT-2000B 

FOS-0040#B EVT-2020B 

FOS-0040#B EVT-2030B 

FOS-0040#B FDF-2000B 

FOS-0040#B FUI-2000B 

FOS-0040#B FUI-2030B 

FOS-0040#B FUI-2050B 

FOS-0040#B FUI-2090B 

FOS-0040#B FUI-2110B 

FOS-0040#B HRD-2000B 

FOS-0040#B IST-2000B 

FOS-0040#B IST-2010B 

FOS-0040#B NCC-2020B 

FOS-0040#B NCC-2030B 

FOS-0040#B OPR-2000B 

FOS-0040#B PAS-2020B 

FOS-0040#B PAS-2030B 

FOS-0040#B PAS-2035B 

FOS-0040#B PAS-2040B 

FOS-0040#B PAS-2110B 

FOS-0040#B PAS-2180B 

D-28
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

FOS-0040#B PAS-2200B 

FOS-0040#B POST-B 

FOS-0040#B SYS-2000B 

FOS-0040#B SYS-2020B 

FOS-0040#B SYS-2030B 

FOS-1010#B CMS-2000B 

FOS-1010#B CMS-2170B 

FOS-1010#B DBS-2000B 

FOS-1010#B EDOS-2030B 

FOS-1020#B CONT-2020B 

FOS-1020#B ETE-2010B 

FOS-1020#B SYS-2000B 

FOS-1030#B OPR-2000B 

FOS-1030#B POST-B 

FOS-1040#B EDOS-2010B 

FOS-1040#B ETE-2000B 

FOS-1040#B ETE-2010B 

FOS-1040#B OPR-2000B 

FOS-1040#B PAS-2035B 

FOS-1050#B OPR-2000B 

FOS-1050#B POST-B 

FOS-1060#B POST-B 

FOS-1070#B ANA-2100B 

FOS-1070#B FDF-2000B 

FOS-1070#B IST-2010B 

FOS-1070#B POST-B 

FOS-1070#B TLM-2020B 

FOS-1070#B TLM-2050B 

FOS-1080#B POST-B 

FOS-1080#B SYS-2020B 

FOS-1080#B TLM-2010B 

FOS-1080#B TLM-2030B 

FOS-1090#B ANA-2060B 

FOS-1090#B ANA-2120B 

FOS-1090#B CMS-2170B 

FOS-1090#B EDOS-2010B 

FOS-1090#B PAS-2035B 

FOS-1130#B CMD-2030B 

FOS-1130#B CMS-2170B 

FOS-1130#B IST-2010B 

FOS-1130#B PAS-2200B 

FOS-1130#B SYS-2020B 

D-29
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

FOS-1140#B ETE-2010B 

FOS-1140#B FDF-2000B 

FOS-1140#B OPR-2000B 

ICC-0010#B CONT-2030B 

ICC-0010#B IST-2010B 

ICC-0010#B PAS-2030B 

ICC-0010#B PAS-2035B 

ICC-0010#B PAS-2040B 

ICC-0010#B PAS-2110B 

ICC-0020#B IST-2000B 

ICC-0020#B IST-2010B 

ICC-0020#B OPR-2000B 

ICC-0030#B CONT-2010B 

ICC-0030#B CONT-2030B 

ICC-0030#B IST-2010B 

ICC-0030#B PAS-2020B 

ICC-0030#B PAS-2035B 

ICC-0030#B PAS-2050B 

ICC-0030#B PAS-2200B 

ICC-0040#B FUI-2120B 

ICC-0050#B FUI-2130B 

ICC-0055#B CMD-2070B 

ICC-0055#B POST-B 

ICC-0055#B TLM-2000B 

ICC-0055#B TLM-2010B 

ICC-0055#B TLM-2170B 

ICC-0070#B ANA-2000B 

ICC-0070#B IST-2010B 

ICC-0070#B PAS-2020B 

ICC-1130#B ASTR-2000B 

ICC-1130#B PAS-2020B 

ICC-1130#B PAS-2200B 

ICC-2010#B ASTR-2000B 

ICC-2010#B FDF-2000B 

ICC-2010#B IST-2010B 

ICC-2010#B PAS-2020B 

ICC-2010#B PAS-2030B 

ICC-2010#B PAS-2035B 

ICC-2010#B PAS-2040B 

ICC-2010#B PAS-2050B 

ICC-2010#B PAS-2110B 

ICC-2010#B PAS-2190B 

D-30
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-2010#B PAS-2200B 

ICC-2015#B IST-2010B 

ICC-2015#B PAS-2020B 

ICC-2015#B PAS-2050B 

ICC-2015#B PAS-2190B 

ICC-2020#B ASTR-2000B 

ICC-2020#B FDF-2000B 

ICC-2020#B FUI-2120B 

ICC-2020#B IST-2010B 

ICC-2020#B PAS-2020B 

ICC-2020#B PAS-2030B 

ICC-2020#B PAS-2050B 

ICC-2020#B PAS-2110B 

ICC-2020#B PAS-2190B 

ICC-2020#B PAS-2200B 

ICC-2050#B CONT-2030B 

ICC-2050#B IST-2010B 

ICC-2050#B PAS-2000B 

ICC-2050#B PAS-2020B 

ICC-2050#B PAS-2035B 

ICC-2050#B PAS-2050B 

ICC-2050#B PAS-2200B 

ICC-2052#B IST-2010B 

ICC-2052#B PAS-2000B 

ICC-2052#B PAS-2010B 

ICC-2052#B PAS-2020B 

ICC-2060#B IST-2010B 

ICC-2060#B PAS-2020B 

ICC-2110#B PAS-2000B 

ICC-2110#B PAS-2020B 

ICC-2115#B IST-2010B 

ICC-2115#B PAS-2000B 

ICC-2115#B PAS-2020B 

ICC-2115#B PAS-2110B 

ICC-2120#B IST-2010B 

ICC-2120#B PAS-2020B 

ICC-2140#B IST-2010B 

ICC-2140#B PAS-2000B 

ICC-2140#B PAS-2020B 

ICC-2140#B TLM-2080B 

ICC-2150#B CONT-2030B 

ICC-2150#B IST-2010B 

D-31
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-2150#B PAS-2000B 

ICC-2150#B PAS-2020B 

ICC-2150#B PAS-2035B 

ICC-2150#B PAS-2050B 

ICC-2170#B IST-2010B 

ICC-2170#B PAS-2020B 

ICC-2170#B PAS-2050B 

ICC-2180#B IST-2010B 

ICC-2180#B PAS-2020B 

ICC-2180#B PAS-2030B 

ICC-2180#B PAS-2050B 

ICC-2180#B PAS-2180B 

ICC-2190#B CONT-2030B 

ICC-2190#B IST-2010B 

ICC-2190#B PAS-2000B 

ICC-2190#B PAS-2020B 

ICC-2190#B PAS-2050B 

ICC-2210#B CONT-2030B 

ICC-2210#B IST-2010B 

ICC-2210#B PAS-2020B 

ICC-2210#B PAS-2030B 

ICC-2210#B PAS-2050B 

ICC-2220#B IST-2010B 

ICC-2220#B PAS-2030B 

ICC-2220#B PAS-2050B 

ICC-2220#B PAS-2200B 

ICC-2230#B IST-2010B 

ICC-2230#B PAS-2000B 

ICC-2230#B PAS-2020B 

ICC-2250#B IST-2010B 

ICC-2250#B PAS-2030B 

ICC-2250#B PAS-2200B 

ICC-2250#B TLM-2050B 

ICC-2270#B IST-2010B 

ICC-2270#B OPR-2000B 

ICC-2270#B PAS-2020B 

ICC-2280#B IST-2010B 

ICC-2280#B PAS-2020B 

ICC-2280#B PAS-2030B 

ICC-2280#B PAS-2050B 

ICC-2290#B IST-2010B 

ICC-2290#B PAS-2020B 

D-32
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-2290#B PAS-2030B 

ICC-2300#B IST-2010B 

ICC-2300#B PAS-2000B 

ICC-2300#B PAS-2020B 

ICC-2300#B PAS-2035B 

ICC-2300#B PAS-2050B 

ICC-2300#B PAS-2200B 

ICC-2350#B IST-2010B 

ICC-2350#B PAS-2020B 

ICC-2350#B PAS-2200B 

ICC-2370#B IST-2010B 

ICC-2370#B PAS-2020B 

ICC-2380#B IST-2010B 

ICC-2380#B PAS-2020B 

ICC-2400#B IST-2010B 

ICC-2400#B PAS-2020B 

ICC-2420#B IST-2010B 

ICC-2420#B OPR-2000B 

ICC-2420#B PAS-2030B 

ICC-2430#B IST-2010B 

ICC-2430#B PAS-2000B 

ICC-2430#B PAS-2020B 

ICC-2430#B PAS-2035B 

ICC-2430#B PAS-2050B 

ICC-2430#B PAS-2200B 

ICC-2450#B IST-2010B 

ICC-2450#B OPR-2000B 

ICC-2450#B PAS-2020B 

ICC-3010#B CMS-2040B 

ICC-3010#B CMS-2090B 

ICC-3010#B CMS-2100B 

ICC-3010#B CMS-2170B 

ICC-3010#B FUI-2050B 

ICC-3010#B IST-2010B 

ICC-3020#B PAS-2030B 

ICC-3020#B PAS-2200B 

ICC-3040#B CMS-2040B 

ICC-3040#B CMS-2090B 

ICC-3040#B CMS-2170B 

ICC-3040#B IST-2010B 

ICC-3040#B PAS-2200B 

ICC-3050#B CMS-2100B 

D-33
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-3050#B CMS-2180B 

ICC-3050#B IST-2010B 

ICC-3060#B PAS-2200B 

ICC-3070#B OPR-2000B 

ICC-3070#B PAS-2180B 

ICC-3070#B PAS-2200B 

ICC-3071#B PAS-2180B 

ICC-3085#B PAS-2180B 

ICC-3090#B FUI-2050B 

ICC-3090#B IST-2010B 

ICC-3100#B FUI-2050B 

ICC-3100#B IST-2010B 

ICC-3110#B FUI-2050B 

ICC-3110#B IST-2010B 

ICC-3160#B CMD-2010B 

ICC-3160#B IST-2010B 

ICC-3160#B PAS-2030B 

ICC-3210#B IST-2010B 

ICC-3210#B PAS-2110B 

ICC-3220#B IST-2010B 

ICC-3230#B IST-2010B 

ICC-3240#B CMD-2030B 

ICC-3240#B IST-2010B 

ICC-3270#B FUI-2050B 

ICC-3270#B IST-2010B 

ICC-3270#B OPR-2000B 

ICC-3370#B CMD-2010B 

ICC-3370#B CMD-2015B 

ICC-3370#B IST-2010B 

ICC-3370#B TLM-2050B 

ICC-3380#B ANA-2100B 

ICC-3380#B CMD-2010B 

ICC-3380#B CMD-2030B 

ICC-3380#B CMD-2080B 

ICC-3380#B CONT-2010B 

ICC-3380#B IST-2010B 

ICC-3380#B PAS-2180B 

ICC-3400#B CMD-2010B 

ICC-3400#B CMD-2080B 

ICC-3400#B IST-2010B 

ICC-4010#B TLM-2010B 

ICC-4010#B TLM-2020B 

D-34
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-4010#B TLM-2060B 

ICC-4020#B TLM-2000B 

ICC-4020#B TLM-2010B 

ICC-4040#B IST-2010B 

ICC-4040#B TLM-2070B 

ICC-4040#B TLM-2170B 

ICC-4045#B TLM-2010B 

ICC-4045#B TLM-2050B 

ICC-4070#B TLM-2060B 

ICC-4070#B TLM-2070B 

ICC-4090#B TLM-2000B 

ICC-4090#B TLM-2020B 

ICC-4090#B TLM-2050B 

ICC-4090#B TLM-2150B 

ICC-4095#B EDOS-2000B 

ICC-4095#B EDOS-2001B 

ICC-4095#B EDOS-2010B 

ICC-4095#B POST-B 

ICC-4100#B IST-2010B 

ICC-4100#B TLM-2000B 

ICC-4100#B TLM-2010B 

ICC-4100#B TLM-2020B 

ICC-4100#B TLM-2030B 

ICC-4100#B TLM-2040B 

ICC-4100#B TLM-2050B 

ICC-4100#B TLM-2060B 

ICC-4100#B TLM-2080B 

ICC-4100#B TLM-2090B 

ICC-4110#B IST-2010B 

ICC-4110#B TLM-2080B 

ICC-4120#B IST-2010B 

ICC-4120#B TLM-2060B 

ICC-4120#B TLM-2080B 

ICC-4120#B TLM-2090B 

ICC-4120#B TLM-2100B 

ICC-4150#B IST-2010B 

ICC-4150#B TLM-2080B 

ICC-4150#B TLM-2090B 

ICC-4170#B CMS-2000B 

ICC-4180#B TLM-2190B 

ICC-4190#B ANA-2100B 

ICC-4200#B EDOS-2001B 

D-35
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-4200#B IST-2010B 

ICC-4200#B TLM-2190B 

ICC-4230#B ANA-2100B 

ICC-4410#B ANA-2000B 

ICC-4410#B ANA-2060B 

ICC-4410#B ANA-2120B 

ICC-4410#B EDOS-2001B 

ICC-4410#B IST-2010B 

ICC-4410#B NCC-2020B 

ICC-4410#B NCC-2040B 

ICC-4420#B FUI-2130B 

ICC-4420#B TLM-2100B 

ICC-4440#B ANA-2070B 

ICC-4440#B ANA-2100B 

ICC-4440#B ANA-2120B 

ICC-4440#B IST-2010B 

ICC-4450#B ANA-2060B 

ICC-4450#B ANA-2120B 

ICC-4450#B ETE-2000B 

ICC-4450#B FUI-2110B 

ICC-4450#B IST-2010B 

ICC-4450#B POST-B 

ICC-4450#B TLM-2000B 

ICC-4450#B TLM-2010B 

ICC-4450#B TLM-2070B 

ICC-4450#B TLM-2190B 

ICC-4460#B ANA-2000B 

ICC-4460#B ANA-2060B 

ICC-4460#B ANA-2120B 

ICC-4460#B FUI-2110B 

ICC-4460#B IST-2000B 

ICC-4460#B PAS-2030B 

ICC-4460#B POST-B 

ICC-4460#B TLM-2000B 

ICC-4460#B TLM-2010B 

ICC-4460#B TLM-2070B 

ICC-4460#B TLM-2190B 

ICC-4470#B FUI-2050B 

ICC-4470#B IST-2010B 

ICC-4470#B OPR-2000B 

ICC-4470#B POST-B 

ICC-4480#B ANA-2100B 

D-36
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-4480#B ANA-2110B 

ICC-4480#B ANA-2120B 

ICC-4480#B CONT-2010B 

ICC-4480#B IST-2010B 

ICC-4490#B ANA-2070B 

ICC-4490#B ANA-2100B 

ICC-4490#B IST-2010B 

ICC-4500#B ANA-2100B 

ICC-4500#B ANA-2120B 

ICC-4500#B CONT-2010B 

ICC-4500#B IST-2010B 

ICC-4510#B ANA-2070B 

ICC-4510#B CONT-2010B 

ICC-4545#B CONT-2030B 

ICC-4550#B ANA-2060B 

ICC-4550#B ANA-2070B 

ICC-4550#B CONT-2040B 

ICC-4550#B FUI-2110B 

ICC-4550#B IST-2010B 

ICC-4550#B POST-B 

ICC-4550#B TLM-2080B 

ICC-4560#B ANA-2110B 

ICC-4560#B CONT-2010B 

ICC-4560#B TLM-2160B 

ICC-4580#B CMS-2000B 

ICC-4590#B ANA-2070B 

ICC-4600#B FUI-2025B 

ICC-4600#B FUI-2130B 

ICC-4600#B IST-2000B 

ICC-4610#B ANA-2000B 

ICC-4610#B ANA-2100B 

ICC-4610#B IST-2010B 

ICC-4710#B ANA-2000B 

ICC-4710#B ANA-2040B 

ICC-4710#B ANA-2060B 

ICC-4710#B ANA-2090B 

ICC-4710#B DBS-2000B 

ICC-4710#B FUI-2030B 

ICC-4710#B FUI-2050B 

ICC-4710#B FUI-2110B 

ICC-4710#B FUI-2115B 

ICC-4710#B IST-2010B 

D-37
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-4710#B PAS-2000B 

ICC-4710#B TLM-2070B 

ICC-4710#B TLM-2080B 

ICC-4710#B TLM-2090B 

ICC-4710#B TLM-2100B 

ICC-4720#B DBS-2010B 

ICC-4730#B DBS-2030B 

ICC-4730#B IST-2010B 

ICC-4730#B PAS-2000B 

ICC-4730#B PAS-2010B 

ICC-4740#B DBS-2000B 

ICC-4740#B PAS-2000B 

ICC-4740#B PAS-2010B 

ICC-4750#B DBS-2000B 

ICC-4760#B DBS-2000B 

ICC-4765#B DBS-2020B 

ICC-4770#B DBS-2000B 

ICC-4770#B PAS-2000B 

ICC-4770#B PAS-2010B 

ICC-4775#B DBS-2000B 

ICC-4775#B PAS-2010B 

ICC-4780#B ANA-2100B 

ICC-4780#B ANA-2110B 

ICC-4780#B EVT-2000B 

ICC-4780#B EVT-2010B 

ICC-4780#B EVT-2020B 

ICC-4780#B SYS-2030B 

ICC-4780#B TLM-2160B 

ICC-4790#B ANA-2100B 

ICC-4790#B ANA-2110B 

ICC-4790#B EVT-2020B 

ICC-4800#B POST-B 

ICC-4810#B POST-B 

ICC-4820#B POST-B 

ICC-4830#B ANA-2110B 

ICC-6005#B OPR-2000B 

ICC-6005#B POST-B 

ICC-6005#B SYS-2020B 

ICC-6010#B OPR-2000B 

ICC-6020#B ANA-2090B 

ICC-6020#B IST-2000B 

ICC-6020#B POST-B 

D-38
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-6020#B SYS-2020B 

ICC-6020#B TLM-2190B 

ICC-6030#B NCC-2020B 

ICC-6040#B SYS-2030B 

ICC-6060#B CMD-2030B 

ICC-6060#B SYS-2020B 

ICC-6060#B SYS-2030B 

ICC-6070#B SYS-2000B 

ICC-6070#B SYS-2020B 

ICC-6080#B EVT-2010B 

ICC-6080#B SYS-2030B 

ICC-6090#B FUI-2115B 

ICC-6090#B FUI-2115B 

ICC-6090#B SYS-2030B 

ICC-6110#B EVT-2000B 

ICC-6110#B SYS-2020B 

ICC-6110#B SYS-2030B 

ICC-6130#B SYS-2030B 

ICC-6135#B OPR-2000B 

ICC-6135#B SYS-2030B 

ICC-6140#B OPR-2000B 

ICC-6140#B SYS-2020B 

ICC-6145#B OPR-2000B 

ICC-6195#B SYS-2030B 

ICC-6200#B OPR-2000B 

ICC-6205#B OPR-2000B 

ICC-6210#B OPR-2000B 

ICC-6510#B CMD-2000B 

ICC-6510#B EVT-2010B 

ICC-6510#B FUI-2000B 

ICC-6510#B FUI-2150B 

ICC-6510#B IST-2010B 

ICC-6510#B IST-2010B 

ICC-6510#B SYS-2020B 

ICC-6510#B TLM-2040B 

ICC-6520#B ANA-2060B 

ICC-6520#B ANA-2090B 

ICC-6520#B FUI-2020B 

ICC-6520#B FUI-2025B 

ICC-6520#B IST-2010B 

ICC-6520#B PAS-2030B 

ICC-6520#B PAS-2035B 

D-39
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-6520#B PAS-2050B 

ICC-6520#B PAS-2110B 

ICC-6520#B PAS-2190B 

ICC-6520#B PAS-2200B 

ICC-6520#B SYS-2030B 

ICC-6525#B EVT-2000B 

ICC-6525#B EVT-2010B 

ICC-6525#B EVT-2020B 

ICC-6525#B EVT-2030B 

ICC-6525#B FUI-2030B 

ICC-6525#B IST-2010B 

ICC-6525#B PAS-2030B 

ICC-6525#B SYS-2030B 

ICC-6525#B TLM-2070B 

ICC-6525#B TLM-2080B 

ICC-6525#B TLM-2090B 

ICC-6525#B TLM-2100B 

ICC-6540#B FUI-2040B 

ICC-6540#B FUI-2050B 

ICC-6540#B FUI-2060B 

ICC-6540#B IST-2010B 

ICC-6580#B ANA-2090B 

ICC-6580#B FUI-2050B 

ICC-6580#B IST-2010B 

ICC-6580#B IST-2010B 

ICC-6580#B IST-2010B 

ICC-6580#B IST-2010B 

ICC-6590#B ANA-2060B 

ICC-6590#B CMS-2180B 

ICC-6590#B CONT-2020B 

ICC-6590#B EVT-2000B 

ICC-6590#B FUI-2020B 

ICC-6590#B FUI-2030B 

ICC-6590#B FUI-2050B 

ICC-6590#B FUI-2110B 

ICC-6590#B HRD-2000B 

ICC-6590#B IST-2010B 

ICC-6590#B OPR-2000B 

ICC-6590#B PAS-2030B 

ICC-6590#B PAS-2050B 

ICC-6590#B PAS-2110B 

ICC-6590#B PAS-2190B 

D-40
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-6590#B PAS-2200B 

ICC-6590#B SYS-2000B 

ICC-6590#B SYS-2030B 

ICC-6590#B TLM-2000B 

ICC-6590#B TLM-2010B 

ICC-6590#B TLM-2070B 

ICC-6590#B TLM-2190B 

ICC-6600#B EVT-2010B 

ICC-6600#B FUI-2040B 

ICC-6620#B EVT-2000B 

ICC-6620#B EVT-2010B 

ICC-6620#B FUI-2030B 

ICC-6620#B IST-2010B 

ICC-7005#B CMD-2070B 

ICC-7005#B IST-2000B 

ICC-7005#B OPR-2000B 

ICC-7010#B CONT-2010B 

ICC-7010#B IST-2010B 

ICC-7010#B PAS-2000B 

ICC-7010#B PAS-2020B 

ICC-7010#B PAS-2035B 

ICC-7010#B PAS-2050B 

ICC-7030#B FUI-2025B 

ICC-7030#B IST-2010B 

ICC-7030#B OPR-2000B 

ICC-7050#B DBS-2000B 

ICC-7050#B IST-2010B 

ICC-7050#B PAS-2000B 

ICC-7050#B PAS-2010B 

ICC-7060#B DBS-2030B 

ICC-7060#B FUI-2025B 

ICC-7060#B IST-2010B 

ICC-7060#B PAS-2000B 

ICC-7065#B CMS-2000B 

ICC-7065#B FDF-2000B 

ICC-7065#B IST-2000B 

ICC-7065#B IST-2010B 

ICC-7070#B ANA-2000B 

ICC-7070#B ANA-2100B 

ICC-7070#B ANA-2120B 

ICC-7070#B FUI-2025B 

ICC-7070#B IST-2010B 

D-41
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-7075#B ANA-2000B 

ICC-7075#B ANA-2060B 

ICC-7075#B ANA-2070B 

ICC-7075#B ANA-2120B 

ICC-7075#B IST-2010B 

ICC-7210#B PAS-2020B 

ICC-7214#B PAS-2030B 

ICC-7220#B FDF-2000B 

ICC-7220#B FUI-2120B 

ICC-7220#B IST-2010B 

ICC-7220#B PAS-2030B 

ICC-7220#B PAS-2050B 

ICC-7220#B PAS-2110B 

ICC-7220#B PAS-2190B 

ICC-7220#B PAS-2200B 

ICC-7230#B CMS-2180B 

ICC-7230#B IST-2010B 

ICC-7230#B PAS-2000B 

ICC-7230#B PAS-2020B 

ICC-7230#B PAS-2190B 

ICC-7240#B IST-2010B 

ICC-7240#B PAS-2020B 

ICC-7240#B PAS-2030B 

ICC-7240#B PAS-2050B 

ICC-7250#B IST-2010B 

ICC-7250#B PAS-2000B 

ICC-7250#B PAS-2020B 

ICC-7250#B PAS-2035B 

ICC-7250#B PAS-2050B 

ICC-7270#B IST-2010B 

ICC-7270#B PAS-2190B 

ICC-7290#B CMD-2010B 

ICC-7290#B CMD-2080B 

ICC-7290#B CMS-2040B 

ICC-7290#B CMS-2060B 

ICC-7290#B CMS-2090B 

ICC-7290#B CMS-2100B 

ICC-7290#B IST-2010B 

ICC-7290#B PAS-2030B 

ICC-7330#B CMS-2090B 

ICC-7330#B CMS-2170B 

ICC-7330#B IST-2010B 

D-42
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

ICC-7370#B CMD-2010B 

ICC-7370#B IST-2010B 

ICC-7390#B FUI-2025B 

ICC-7390#B IST-2010B 

ICC-7430#B ANA-2100B 

ICC-7430#B ANA-2120B 

ICC-7430#B FUI-2025B 

ICC-7430#B IST-2010B 

ICC-7430#B TLM-2020B 

ICC-7430#B TLM-2060B 

ICC-7460#B ANA-2060B 

ICC-7460#B FUI-2030B 

ICC-7460#B FUI-2110B 

ICC-7460#B IST-2010B 

ICC-7460#B TLM-2000B 

ICC-7460#B TLM-2010B 

ICC-7460#B TLM-2070B 

ICC-7460#B TLM-2190B 

ICC-7500#B ANA-2000B 

ICC-7500#B ANA-2100B 

ICC-7500#B DBS-2010B 

ICC-7510#B ANA-2100B 

ICC-7510#B ANA-2110B 

ICC-7510#B EVT-2020B 

ICC-7550#B CMS-2000B 

ICC-7550#B CMS-2170B 

ICC-7550#B FUI-2130B 

ICC-7550#B IST-2010B 

ICC-8010#B OPR-2000B 

ICC-8040#B ETE-2000B 

ICC-8050#B IST-2000B 

NI-0010#B CMD-2070B 

NI-0010#B ETE-2010B 

NI-0010#B FDF-2000B 

NI-0010#B NCC-2020B 

NI-0010#B NCC-2030B 

NI-0010#B PAS-2040B 

NI-0010#B TLM-2000B 

NI-0010#B TLM-2010B 

NI-0020#B ETE-2010B 

NI-0030#B TLM-2000B 

NI-0030#B TLM-2010B 

D-43
 322-CD-100-001/ 
411-CD-100-001 



RBR ID Test Case 

NI-0110#B CMD-2070B 

NI-0110#B ETE-2010B 

NI-0110#B FDF-2000B 

NI-0110#B NCC-2020B 

NI-0110#B NCC-2030B 

NI-0110#B PAS-2040B 

NI-0110#B TLM-2000B 

NI-0110#B TLM-2010B 

NI-0120#B PAS-2040B 

NI-0130#B PAS-2040B 

NI-0150#B NCC-2020B 

NI-0150#B NCC-2030B 

NI-0160#B ANA-2030B 

NI-0160#B NCC-2020B 

NI-0160#B NCC-2030B 

NI-0170#B OPR-2000B 

NI-0210#B ETE-2010B 

NI-0210#B TLM-2010B 

NI-0220#B ETE-2010B 

NI-0230#B ETE-2010B 

NI-0230#B TLM-2000B 

NI-0230#B TLM-2010B 

NI-0240#B ETE-2010B 

NI-0310#B CMD-2070B 

NI-0310#B ETE-2010B 

NI-0310#B FDF-2000B 

NI-0310#B NCC-2020B 

NI-0310#B NCC-2030B 

NI-0310#B PAS-2040B 

NI-0310#B TLM-2000B 

NI-0310#B TLM-2010B 

NI-0330#B ANA-2000B 

NI-0330#B FDF-2000B 

NI-0330#B FUI-2025B 

NI-0330#B IST-2010B 

NI-0330#B IST-2010B 

NI-0340#B FDF-2000B 

NI-0350#B FDF-2000B 

NI-1000#B OPR-2000B 

NI-1010#B OPR-2000B 

NI-1030#B OPR-2000B 

NI-1060#B ETE-2000B 

D-44
 322-CD-100-001/ 
411-CD-100-001 



Appendix E. Test Case to Release B RBRs Matrix


The following matrix delineates each Thread and End to End Test Case to the associated Release 
B RBR or set of RBRs verified by the test. 

Test Case RBR ID 

ANA-2000B AM1-0225#B 

ANA-2000B AM1-0240#B 

ANA-2000B EOC-5180#B 

ANA-2000B EOC-6010#B 

ANA-2000B EOC-6050#B 

ANA-2000B EOC-6070#B 

ANA-2000B EOC-6100#B 

ANA-2000B EOC-9020#B 

ANA-2000B EOC-9040#B 

ANA-2000B FOS-0040#B 

ANA-2000B ICC-0070#B 

ANA-2000B ICC-4410#B 

ANA-2000B ICC-4460#B 

ANA-2000B ICC-4610#B 

ANA-2000B ICC-4710#B 

ANA-2000B ICC-7070#B 

ANA-2000B ICC-7075#B 

ANA-2000B ICC-7500#B 

ANA-2000B NI-0330#B 

ANA-2020B EOC-5187#B 

ANA-2030B EOC-4060#B 

ANA-2030B EOC-5030#B 

ANA-2030B EOC-5187#B 

ANA-2030B EOC-5187#B 

ANA-2030B NI-0160#B 

ANA-2040B EOC-6100#B 

ANA-2040B EOC-6110#B 

ANA-2040B FOS-0040#B 

ANA-2040B ICC-4710#B 

ANA-2060B EOC-5187#B 

ANA-2060B EOC-6010#B 

ANA-2060B EOC-6050#B 

ANA-2060B EOC-6060#B 

ANA-2060B EOC-6070#B 

E-1
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

ANA-2060B EOC-6100#B 

ANA-2060B EOC-6110#B 

ANA-2060B EOC-7010#B 

ANA-2060B EOC-8372#B 

ANA-2060B EOC-9020#B 

ANA-2060B EOC-9090#B 

ANA-2060B FOS-0040#B 

ANA-2060B FOS-1090#B 

ANA-2060B ICC-4410#B 

ANA-2060B ICC-4450#B 

ANA-2060B ICC-4460#B 

ANA-2060B ICC-4550#B 

ANA-2060B ICC-4710#B 

ANA-2060B ICC-6520#B 

ANA-2060B ICC-6590#B 

ANA-2060B ICC-7075#B 

ANA-2060B ICC-7460#B 

ANA-2070B EOC-6010#B 

ANA-2070B EOC-6050#B 

ANA-2070B EOC-6100#B 

ANA-2070B EOC-6110#B 

ANA-2070B EOC-6195#B 

ANA-2070B EOC-6200#B 

ANA-2070B ICC-4440#B 

ANA-2070B ICC-4490#B 

ANA-2070B ICC-4510#B 

ANA-2070B ICC-4550#B 

ANA-2070B ICC-4590#B 

ANA-2070B ICC-7075#B 

ANA-2090B AM1-0240#B 

ANA-2090B EOC-5012#B 

ANA-2090B EOC-6010#B 

ANA-2090B EOC-6100#B 

ANA-2090B EOC-8090#B 

ANA-2090B EOC-9020#B 

ANA-2090B EOC-9090#B 

ANA-2090B ICC-4710#B 

ANA-2090B ICC-6020#B 

ANA-2090B ICC-6520#B 

ANA-2090B ICC-6580#B 

ANA-2100B AM1-0070#B 

ANA-2100B AM1-0130#B 

E-2
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

ANA-2100B AM1-1060#B 

ANA-2100B AM1-1080#B 

ANA-2100B EDOS-4.2.1.6#B 

ANA-2100B EDOS-4.6.1.1#B 

ANA-2100B EDOS-4.6.1.8#B 

ANA-2100B EOC-3160#B 

ANA-2100B EOC-5012#B 

ANA-2100B EOC-5230#B 

ANA-2100B EOC-6010#B 

ANA-2100B EOC-6050#B 

ANA-2100B EOC-6070#B 

ANA-2100B EOC-6100#B 

ANA-2100B EOC-7060#B 

ANA-2100B EOC-7120#B 

ANA-2100B FOS-0040#B 

ANA-2100B FOS-1070#B 

ANA-2100B ICC-3380#B 

ANA-2100B ICC-4190#B 

ANA-2100B ICC-4230#B 

ANA-2100B ICC-4440#B 

ANA-2100B ICC-4480#B 

ANA-2100B ICC-4490#B 

ANA-2100B ICC-4500#B 

ANA-2100B ICC-4610#B 

ANA-2100B ICC-4780#B 

ANA-2100B ICC-4790#B 

ANA-2100B ICC-7070#B 

ANA-2100B ICC-7430#B 

ANA-2100B ICC-7500#B 

ANA-2100B ICC-7510#B 

ANA-2110B AM1-0340#B 

ANA-2110B AM1-1150#B 

ANA-2110B EOC-6010#B 

ANA-2110B EOC-6150#B 

ANA-2110B EOC-9040#B 

ANA-2110B FOS-0040#B 

ANA-2110B ICC-4480#B 

ANA-2110B ICC-4560#B 

ANA-2110B ICC-4780#B 

ANA-2110B ICC-4790#B 

ANA-2110B ICC-4830#B 

ANA-2110B ICC-7510#B 

E-3
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

ANA-2120B EOC-5187#B 

ANA-2120B EOC-6010#B 

ANA-2120B EOC-6100#B 

ANA-2120B EOC-6110#B 

ANA-2120B EOC-6200#B 

ANA-2120B FOS-1090#B 

ANA-2120B ICC-4410#B 

ANA-2120B ICC-4440#B 

ANA-2120B ICC-4450#B 

ANA-2120B ICC-4460#B 

ANA-2120B ICC-4480#B 

ANA-2120B ICC-4500#B 

ANA-2120B ICC-7070#B 

ANA-2120B ICC-7075#B 

ANA-2120B ICC-7430#B 

ASTR-2000B ASTER-0210#B 

ASTR-2000B ASTER-0230#B 

ASTR-2000B ASTER-0240#B 

ASTR-2000B ASTER-0250#B 

ASTR-2000B ASTER-0260#B 

ASTR-2000B ASTER-0340#B 

ASTR-2000B ASTER-0350#B 

ASTR-2000B EOC-2040#B 

ASTR-2000B EOC-2045#B 

ASTR-2000B EOC-2210#B 

ASTR-2000B EOC-2250#B 

ASTR-2000B EOC-2260#B 

ASTR-2000B EOC-2270#B 

ASTR-2000B EOC-2280#B 

ASTR-2000B EOC-2290#B 

ASTR-2000B EOC-2320#B 

ASTR-2000B EOC-2350#B 

ASTR-2000B EOC-2430#B 

ASTR-2000B EOC-2480#B 

ASTR-2000B EOC-2540#B 

ASTR-2000B EOC-2550#B 

ASTR-2000B EOC-2570#B 

ASTR-2000B EOC-2590#B 

ASTR-2000B EOC-2620#B 

ASTR-2000B EOC-2630#B 

ASTR-2000B EOSD1770#B 

ASTR-2000B FOS-0040#B 

E-4
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

ASTR-2000B ICC-1130#B 

ASTR-2000B ICC-2010#B 

ASTR-2000B ICC-2020#B 

CMD-2000B EOC-9010#B 

CMD-2000B ICC-6510#B 

CMD-2001B AM1-0050#B 

CMD-2001B AM1-0090#B 

CMD-2001B AM1-0120#B 

CMD-2001B AM1-0125#B 

CMD-2001B AM1-0150#B 

CMD-2001B AM1-0160#B 

CMD-2001B AM1-1090#B 

CMD-2001B EDOS-4.1.1.4#B 

CMD-2001B EOC-2160#B 

CMD-2001B EOC-4005#B 

CMD-2001B EOC-4010#B 

CMD-2001B EOC-4015#B 

CMD-2001B EOC-4100#B 

CMD-2001B EOC-4130#B 

CMD-2001B EOSD1690#B 

CMD-2001B AM1-0020#B 

CMD-2010B EOC-3238#B 

CMD-2010B EOC-4020#B 

CMD-2010B EOC-4120#B 

CMD-2010B EOC-4125#B 

CMD-2010B EOC-4140#B 

CMD-2010B EOC-4160#B 

CMD-2010B ICC-3160#B 

CMD-2010B ICC-3370#B 

CMD-2010B ICC-3380#B 

CMD-2010B ICC-3400#B 

CMD-2010B ICC-7290#B 

CMD-2010B ICC-7370#B 

CMD-2015B EOC-4018#B 

CMD-2015B EOC-4120#B 

CMD-2015B EOC-4125#B 

CMD-2015B ICC-3370#B 

CMD-2030B EDOS-4.1.1.2#B 

CMD-2030B EOC-4010#B 

CMD-2030B EOC-4015#B 

CMD-2030B EOC-4018#B 

CMD-2030B EOC-4020#B 

E-5
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

CMD-2030B EOC-4100#B 

CMD-2030B EOC-4120#B 

CMD-2030B EOC-4125#B 

CMD-2030B EOC-4140#B 

CMD-2030B EOC-5090#B 

CMD-2030B EOC-6200#B 

CMD-2030B EOC-7010#B 

CMD-2030B EOC-8130#B 

CMD-2030B EOC-9025#B 

CMD-2030B EOSD1690#B 

CMD-2030B FOS-1130#B 

CMD-2030B ICC-3240#B 

CMD-2030B ICC-3380#B 

CMD-2030B ICC-6060#B 

CMD-2050B EOC-4015#B 

CMD-2050B EOC-4125#B 

CMD-2050B EOC-4140#B 

CMD-2050B EOC-4160#B 

CMD-2070B AM1-1050#B 

CMD-2070B AM1-1090#B 

CMD-2070B EDOS-4.1.1.2#B 

CMD-2070B EDOS-4.2.1.5#B 

CMD-2070B EOC-0040#B 

CMD-2070B EOC-4005#B 

CMD-2070B EOC-4010#B 

CMD-2070B EOC-4015#B 

CMD-2070B EOC-4020#B 

CMD-2070B EOC-4120#B 

CMD-2070B EOC-4140#B 

CMD-2070B EOC-4200#B 

CMD-2070B EOC-9040#B 

CMD-2070B EOSD0010#B 

CMD-2070B EOSD0025#B 

CMD-2070B EOSD0500#B 

CMD-2070B EOSD1502#B 

CMD-2070B FOS-0040#B 

CMD-2070B ICC-0055#B 

CMD-2070B ICC-7005#B 

CMD-2070B NI-0010#B 

CMD-2070B NI-0110#B 

CMD-2070B NI-0310#B 

CMD-2080B EOC-4015#B 

E-6
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

CMD-2080B EOC-4120#B 

CMD-2080B EOC-4125#B 

CMD-2080B EOC-4160#B 

CMD-2080B ICC-3380#B 

CMD-2080B ICC-3400#B 

CMD-2080B ICC-7290#B 

CMS-2000B AM1-0090#B 

CMS-2000B AM1-0200#B 

CMS-2000B EOC-1005#B 

CMS-2000B EOC-3160#B 

CMS-2000B EOC-5130#B 

CMS-2000B EOC-6150#B 

CMS-2000B EOC-6160#B 

CMS-2000B FOS-0040#B 

CMS-2000B FOS-1010#B 

CMS-2000B ICC-4170#B 

CMS-2000B ICC-4580#B 

CMS-2000B ICC-7065#B 

CMS-2000B ICC-7550#B 

CMS-2040B EOC-3020#B 

CMS-2040B EOC-3024#B 

CMS-2040B EOC-3050#B 

CMS-2040B EOC-3160#B 

CMS-2040B EOC-4015#B 

CMS-2040B EOC-9020#B 

CMS-2040B EOSD1680#B 

CMS-2040B FOS-0040#B 

CMS-2040B ICC-3010#B 

CMS-2040B ICC-3040#B 

CMS-2040B ICC-7290#B 

CMS-2060B EOC-3015#B 

CMS-2060B EOC-3020#B 

CMS-2060B EOC-3050#B 

CMS-2060B EOC-3160#B 

CMS-2060B EOC-4015#B 

CMS-2060B EOC-9020#B 

CMS-2060B EOSD1680#B 

CMS-2060B ICC-7290#B 

CMS-2090B EOC-3020#B 

CMS-2090B EOC-3024#B 

CMS-2090B EOC-3050#B 

CMS-2090B EOC-3090#B 

E-7
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

CMS-2090B EOC-3160#B 

CMS-2090B EOC-7010#B 

CMS-2090B EOC-9020#B 

CMS-2090B EOSD0545#B 

CMS-2090B EOSD0545#B 

CMS-2090B EOSD0630#B 

CMS-2090B EOSD1680#B 

CMS-2090B FOS-0040#B 

CMS-2090B ICC-3010#B 

CMS-2090B ICC-3040#B 

CMS-2090B ICC-7290#B 

CMS-2090B ICC-7330#B 

CMS-2100B EOC-3024#B 

CMS-2100B EOC-3086#B 

CMS-2100B EOC-3090#B 

CMS-2100B EOC-3160#B 

CMS-2100B EOC-6150#B 

CMS-2100B EOC-9040#B 

CMS-2100B EOSD1680#B 

CMS-2100B FOS-0040#B 

CMS-2100B ICC-3010#B 

CMS-2100B ICC-3050#B 

CMS-2100B ICC-7290#B 

CMS-2170B EOC-2320#B 

CMS-2170B EOC-3020#B 

CMS-2170B EOC-3024#B 

CMS-2170B EOC-3050#B 

CMS-2170B EOC-3090#B 

CMS-2170B EOC-3160#B 

CMS-2170B EOC-4015#B 

CMS-2170B EOC-4125#B 

CMS-2170B EOC-6150#B 

CMS-2170B EOC-6160#B 

CMS-2170B EOC-7010#B 

CMS-2170B EOC-7020#B 

CMS-2170B EOC-9020#B 

CMS-2170B EOC-9025#B 

CMS-2170B EOC-9040#B 

CMS-2170B EOC-9080#B 

CMS-2170B EOSD1680#B 

CMS-2170B FOS-0040#B 

CMS-2170B FOS-1010#B 

E-8
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

CMS-2170B FOS-1090#B 

CMS-2170B FOS-1130#B 

CMS-2170B ICC-3010#B 

CMS-2170B ICC-3040#B 

CMS-2170B ICC-7330#B 

CMS-2170B ICC-7550#B 

CMS-2180B EOC-3030#B 

CMS-2180B EOC-3050#B 

CMS-2180B EOC-3086#B 

CMS-2180B EOC-3160#B 

CMS-2180B EOC-5200#B 

CMS-2180B EOC-6150#B 

CMS-2180B EOC-7010#B 

CMS-2180B EOC-9020#B 

CMS-2180B EOC-9090#B 

CMS-2180B FOS-0040#B 

CMS-2180B ICC-3050#B 

CMS-2180B ICC-6590#B 

CMS-2180B ICC-7230#B 

CONT-2010B EOC-2190#B 

CONT-2010B EOC-4010#B 

CONT-2010B EOC-4015#B 

CONT-2010B EOC-4020#B 

CONT-2010B EOC-4200#B 

CONT-2010B EOC-5187#B 

CONT-2010B EOC-6010#B 

CONT-2010B EOC-6050#B 

CONT-2010B EOC-6070#B 

CONT-2010B EOC-6110#B 

CONT-2010B EOC-6130#B 

CONT-2010B EOC-6140#B 

CONT-2010B EOC-6195#B 

CONT-2010B EOC-6200#B 

CONT-2010B EOC-6210#B 

CONT-2010B ICC-0030#B 

CONT-2010B ICC-3380#B 

CONT-2010B ICC-4480#B 

CONT-2010B ICC-4500#B 

CONT-2010B ICC-4510#B 

CONT-2010B ICC-4560#B 

CONT-2010B ICC-7010#B 

CONT-2020B EOC-4010#B 

E-9
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

CONT-2020B EOC-4020#B 

CONT-2020B EOC-5187#B 

CONT-2020B EOC-5240#B 

CONT-2020B EOC-6010#B 

CONT-2020B EOC-6110#B 

CONT-2020B EOC-6195#B 

CONT-2020B EOC-6200#B 

CONT-2020B EOC-7010#B 

CONT-2020B EOC-9020#B 

CONT-2020B EOC-9025#B 

CONT-2020B EOC-9090#B 

CONT-2020B FOS-1020#B 

CONT-2020B ICC-6590#B 

CONT-2030B EOC-2170#B 

CONT-2030B EOC-2200#B 

CONT-2030B EOC-2220#B 

CONT-2030B EOC-2230#B 

CONT-2030B EOC-2300#B 

CONT-2030B EOC-2310#B 

CONT-2030B EOC-2320#B 

CONT-2030B EOC-2510#B 

CONT-2030B EOC-2530#B 

CONT-2030B EOC-2550#B 

CONT-2030B EOC-2555#B 

CONT-2030B EOC-3024#B 

CONT-2030B EOC-6010#B 

CONT-2030B EOC-6110#B 

CONT-2030B EOC-6135#B 

CONT-2030B EOC-6210#B 

CONT-2030B EOC-7010#B 

CONT-2030B EOC-7025#B 

CONT-2030B FOS-0040#B 

CONT-2030B ICC-0010#B 

CONT-2030B ICC-0030#B 

CONT-2030B ICC-2050#B 

CONT-2030B ICC-2150#B 

CONT-2030B ICC-2190#B 

CONT-2030B ICC-2210#B 

CONT-2030B ICC-4545#B 

CONT-2040B EOC-4125#B 

CONT-2040B EOC-5090#B 

CONT-2040B EOC-5180#B 

E-10
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

CONT-2040B EOC-5185#B 

CONT-2040B ICC-4550#B 

DBS-2000B AM1-0215#B 

DBS-2000B AM1-0230#B 

DBS-2000B ASTER-0050#B 

DBS-2000B EOC-2290#B 

DBS-2000B EOC-3090#B 

DBS-2000B EOC-3160#B 

DBS-2000B EOC-7010#B 

DBS-2000B EOC-7015#B 

DBS-2000B EOC-7025#B 

DBS-2000B EOC-7030#B 

DBS-2000B EOC-7040#B 

DBS-2000B EOC-8285#B 

DBS-2000B EOC-9040#B 

DBS-2000B FOS-1010#B 

DBS-2000B ICC-4710#B 

DBS-2000B ICC-4740#B 

DBS-2000B ICC-4750#B 

DBS-2000B ICC-4760#B 

DBS-2000B ICC-4770#B 

DBS-2000B ICC-4775#B 

DBS-2000B ICC-7050#B 

DBS-2010B EOC-7020#B 

DBS-2010B ICC-4720#B 

DBS-2010B ICC-7500#B 

DBS-2020B ASTER-0050#B 

DBS-2020B ASTER-0060#B 

DBS-2020B EOC-7045#B 

DBS-2020B ICC-4765#B 

DBS-2030B ASTER-0050#B 

DBS-2030B EOC-7025#B 

DBS-2030B EOC-7045#B 

DBS-2030B ICC-4730#B 

DBS-2030B ICC-7060#B 

EDOS-2000B EDOS-4.1.1.1#B 

EDOS-2000B EDOS-4.1.1.6#B 

EDOS-2000B EDOS-4.2.1.7#B 

EDOS-2000B EDOS-4.6.1.1#B 

EDOS-2000B EOC-5030#B 

EDOS-2000B EOSD1600#B 

EDOS-2000B ICC-4095#B 

E-11
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

EDOS-2001B EOC-5030#B 

EDOS-2001B EOC-5200#B 

EDOS-2001B EOC-5240#B 

EDOS-2001B EOC-6010#B 

EDOS-2001B EOC-6200#B 

EDOS-2001B ICC-4095#B 

EDOS-2001B ICC-4200#B 

EDOS-2001B ICC-4410#B 

EDOS-2002B EDOS-4.6.1.4#B 

EDOS-2002B EDOS-4.1.1.17#B 

EDOS-2010B EDOS-4.1.1.1#B 

EDOS-2010B EDOS-4.1.1.7#B 

EDOS-2010B EDOS-4.2.1.3#B 

EDOS-2010B EDOS-4.6.1.1#B 

EDOS-2010B EOC-2030#B 

EDOS-2010B EOC-5030#B 

EDOS-2010B EOSD1600#B 

EDOS-2010B FOS-1040#B 

EDOS-2010B FOS-1090#B 

EDOS-2010B ICC-4095#B 

EDOS-2030B FOS-1010#B 

EDOS-2030B EDOS-4.1.1.18#B 

ETE-2000B AM1-1150#B 

ETE-2000B EOC-2240#B 

ETE-2000B EOC-4210#B 

ETE-2000B EOC-9090#B 

ETE-2000B EOC-9570#B 

ETE-2000B EOSD0500#B 

ETE-2000B EOSD0720#B 

ETE-2000B EOSD1000#B 

ETE-2000B EOSD1500#B 

ETE-2000B FOS-0040#B 

ETE-2000B FOS-1040#B 

ETE-2000B ICC-4450#B 

ETE-2000B ICC-8040#B 

ETE-2000B NI-1060#B 

ETE-2010B AM1-0120#B 

ETE-2010B EDOS-4.1.1.2#B 

ETE-2010B EDOS-4.6.1.1#B 

ETE-2010B EDOS-4.6.1.3#B 

ETE-2010B EOC-2040#B 

ETE-2010B EOC-2490#B 

E-12
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

ETE-2010B EOC-4005#B 

ETE-2010B EOC-4008#B 

ETE-2010B EOC-4060#B 

ETE-2010B EOC-8285#B 

ETE-2010B EOSD0010#B 

ETE-2010B EOSD0015#B 

ETE-2010B EOSD0020#B 

ETE-2010B EOSD0025#B 

ETE-2010B EOSD0500#B 

ETE-2010B EOSD1502#B 

ETE-2010B EOSD1605#B 

ETE-2010B FOS-0040#B 

ETE-2010B FOS-1020#B 

ETE-2010B FOS-1040#B 

ETE-2010B FOS-1140#B 

ETE-2010B NI-0010#B 

ETE-2010B NI-0020#B 

ETE-2010B NI-0110#B 

ETE-2010B NI-0210#B 

ETE-2010B NI-0220#B 

ETE-2010B NI-0230#B 

ETE-2010B NI-0240#B 

ETE-2010B NI-0310#B 

ETE-2010B AM1-0020#B 

ETE-2010B AM1-0030#B 

EVT-2000B EOC-6195#B 

EVT-2000B EOC-7060#B 

EVT-2000B EOC-7120#B 

EVT-2000B EOC-7130#B 

EVT-2000B EOC-8220#B 

EVT-2000B EOC-9010#B 

EVT-2000B EOC-9025#B 

EVT-2000B EOC-9090#B 

EVT-2000B EOC-9130#B 

EVT-2000B FOS-0040#B 

EVT-2000B ICC-4780#B 

EVT-2000B ICC-6110#B 

EVT-2000B ICC-6525#B 

EVT-2000B ICC-6590#B 

EVT-2000B ICC-6620#B 

EVT-2010B EOC-7120#B 

EVT-2010B EOC-8140#B 

E-13
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

EVT-2010B EOC-8150#B 

EVT-2010B EOC-8380#B 

EVT-2010B EOC-9010#B 

EVT-2010B EOC-9025#B 

EVT-2010B EOC-9110#B 

EVT-2010B EOC-9130#B 

EVT-2010B ICC-4780#B 

EVT-2010B ICC-6080#B 

EVT-2010B ICC-6510#B 

EVT-2010B ICC-6525#B 

EVT-2010B ICC-6600#B 

EVT-2010B ICC-6620#B 

EVT-2020B EOC-6195#B 

EVT-2020B EOC-7120#B 

EVT-2020B EOC-7130#B 

EVT-2020B EOC-9025#B 

EVT-2020B FOS-0040#B 

EVT-2020B ICC-4780#B 

EVT-2020B ICC-4790#B 

EVT-2020B ICC-6525#B 

EVT-2020B ICC-7510#B 

EVT-2030B EOC-6195#B 

EVT-2030B EOC-7130#B 

EVT-2030B EOC-9020#B 

EVT-2030B EOC-9025#B 

EVT-2030B FOS-0040#B 

EVT-2030B ICC-6525#B 

FDF-2000B AM1-0270#B 

FDF-2000B ASTER-0200#B 

FDF-2000B EOC-2010#B 

FDF-2000B EOC-2040#B 

FDF-2000B EOC-2045#B 

FDF-2000B EOC-3015#B 

FDF-2000B EOC-3017#B 

FDF-2000B EOC-3030#B 

FDF-2000B EOC-3050#B 

FDF-2000B EOC-3090#B 

FDF-2000B EOC-5180#B 

FDF-2000B EOC-5185#B 

FDF-2000B EOC-5200#B 

FDF-2000B EOC-6010#B 

FDF-2000B EOC-6050#B 

E-14
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

FDF-2000B EOSD0025#B 

FDF-2000B EOSD1502#B 

FDF-2000B EOSD1505#B 

FDF-2000B EOSD1510#B 

FDF-2000B FOS-0030#B 

FDF-2000B FOS-0040#B 

FDF-2000B FOS-1070#B 

FDF-2000B FOS-1140#B 

FDF-2000B ICC-2010#B 

FDF-2000B ICC-2020#B 

FDF-2000B ICC-7065#B 

FDF-2000B ICC-7220#B 

FDF-2000B NI-0010#B 

FDF-2000B NI-0110#B 

FDF-2000B NI-0310#B 

FDF-2000B NI-0330#B 

FDF-2000B NI-0340#B 

FDF-2000B NI-0350#B 

FUI-2000B EOC-9010#B 

FUI-2000B EOC-9020#B 

FUI-2000B FOS-0040#B 

FUI-2000B ICC-6510#B 

FUI-2020B EOC-9020#B 

FUI-2020B EOC-9090#B 

FUI-2020B ICC-6520#B 

FUI-2020B ICC-6590#B 

FUI-2025B AM1-0225#B 

FUI-2025B AM1-0240#B 

FUI-2025B ASTER-0050#B 

FUI-2025B ASTER-0300#B 

FUI-2025B ASTER-0310#B 

FUI-2025B ASTER-0570#B 

FUI-2025B ASTER-0580#B 

FUI-2025B ASTER-0590#B 

FUI-2025B EOC-9020#B 

FUI-2025B ICC-4600#B 

FUI-2025B ICC-6520#B 

FUI-2025B ICC-7030#B 

FUI-2025B ICC-7060#B 

FUI-2025B ICC-7070#B 

FUI-2025B ICC-7390#B 

FUI-2025B ICC-7430#B 

E-15
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

FUI-2025B NI-0330#B 

FUI-2030B EOC-7010#B 

FUI-2030B EOC-9020#B 

FUI-2030B EOC-9090#B 

FUI-2030B EOC-9130#B 

FUI-2030B FOS-0040#B 

FUI-2030B ICC-4710#B 

FUI-2030B ICC-6525#B 

FUI-2030B ICC-6590#B 

FUI-2030B ICC-6620#B 

FUI-2030B ICC-7460#B 

FUI-2040B EOC-9040#B 

FUI-2040B EOC-9110#B 

FUI-2040B ICC-6540#B 

FUI-2040B ICC-6600#B 

FUI-2050B EOC-2530#B 

FUI-2050B EOC-3024#B 

FUI-2050B EOC-3080#B 

FUI-2050B EOC-3210#B 

FUI-2050B EOC-4015#B 

FUI-2050B EOC-4018#B 

FUI-2050B EOC-4020#B 

FUI-2050B EOC-4100#B 

FUI-2050B EOC-6080#B 

FUI-2050B EOC-9020#B 

FUI-2050B EOC-9040#B 

FUI-2050B EOC-9080#B 

FUI-2050B EOSD0020#B 

FUI-2050B EOSD2400#B 

FUI-2050B EOSD3800#B 

FUI-2050B EOSD3810#B 

FUI-2050B FOS-0040#B 

FUI-2050B ICC-3010#B 

FUI-2050B ICC-3090#B 

FUI-2050B ICC-3100#B 

FUI-2050B ICC-3110#B 

FUI-2050B ICC-3270#B 

FUI-2050B ICC-4470#B 

FUI-2050B ICC-4710#B 

FUI-2050B ICC-6540#B 

FUI-2050B ICC-6580#B 

FUI-2050B ICC-6590#B 

E-16
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

FUI-2060B EOC-4100#B 

FUI-2060B EOC-9040#B 

FUI-2060B ICC-6540#B 

FUI-2090B ASTER-1080#B 

FUI-2090B EOSD0010#B 

FUI-2090B EOSD1990#B 

FUI-2090B EOSD2100#B 

FUI-2090B EOSD2430#B 

FUI-2090B EOSD2550#B 

FUI-2090B FOS-0040#B 

FUI-2110B EOC-6060#B 

FUI-2110B EOC-6070#B 

FUI-2110B EOC-7010#B 

FUI-2110B EOC-9020#B 

FUI-2110B EOC-9090#B 

FUI-2110B FOS-0040#B 

FUI-2110B ICC-4450#B 

FUI-2110B ICC-4460#B 

FUI-2110B ICC-4550#B 

FUI-2110B ICC-4710#B 

FUI-2110B ICC-6590#B 

FUI-2110B ICC-7460#B 

FUI-2115B EOC-6195#B 

FUI-2115B EOC-7010#B 

FUI-2115B EOC-8160#B 

FUI-2115B ICC-4710#B 

FUI-2115B ICC-6090#B 

FUI-2115B ICC-6090#B 

FUI-2120B EOC-0030#B 

FUI-2120B EOC-2020#B 

FUI-2120B EOC-2030#B 

FUI-2120B EOC-7140#B 

FUI-2120B EOC-7150#B 

FUI-2120B EOC-7160#B 

FUI-2120B EOSD1480#B 

FUI-2120B ICC-0040#B 

FUI-2120B ICC-2020#B 

FUI-2120B ICC-7220#B 

FUI-2130B ASTER-0300#B 

FUI-2130B ASTER-0310#B 

FUI-2130B ASTER-0570#B 

FUI-2130B ASTER-0580#B 

E-17
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

FUI-2130B ASTER-0590#B 

FUI-2130B EOC-2430#B 

FUI-2130B EOC-6020#B 

FUI-2130B ICC-0050#B 

FUI-2130B ICC-4420#B 

FUI-2130B ICC-4600#B 

FUI-2130B ICC-7550#B 

FUI-2150B EOC-7140#B 

FUI-2150B EOC-7150#B 

FUI-2150B EOC-9010#B 

FUI-2150B ICC-6510#B 

HRD-2000B ASTER-1080#B 

HRD-2000B EOC-4020#B 

HRD-2000B EOSD0545#B 

HRD-2000B EOSD0630#B 

HRD-2000B EOSD1990#B 

HRD-2000B EOSD2100#B 

HRD-2000B EOSD2200#B 

HRD-2000B EOSD2400#B 

HRD-2000B EOSD2430#B 

HRD-2000B EOSD2440#B 

HRD-2000B EOSD3200#B 

HRD-2000B EOSD3810#B 

HRD-2000B FOS-0040#B 

HRD-2000B ICC-6590#B 

IST-2000B AM1-0220#B 

IST-2000B EOC-4020#B 

IST-2000B EOC-6010#B 

IST-2000B EOC-8090#B 

IST-2000B EOC-9580#B 

IST-2000B EOSD0010#B 

IST-2000B EOSD0502#B 

IST-2000B EOSD5410#B 

IST-2000B FOS-0040#B 

IST-2000B ICC-0020#B 

IST-2000B ICC-4460#B 

IST-2000B ICC-4600#B 

IST-2000B ICC-6020#B 

IST-2000B ICC-7005#B 

IST-2000B ICC-7065#B 

IST-2000B ICC-8050#B 

IST-2010B AM1-0090#B 

E-18
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

IST-2010B AM1-0140#B 

IST-2010B AM1-0200#B 

IST-2010B AM1-0225#B 

IST-2010B AM1-0240#B 

IST-2010B AM1-0270#B 

IST-2010B AM1-0280#B 

IST-2010B AM1-1060#B 

IST-2010B AM1-1100#B 

IST-2010B AM1-1110#B 

IST-2010B ASTER-0050#B 

IST-2010B ASTER-0220#B 

IST-2010B ASTER-0230#B 

IST-2010B ASTER-0250#B 

IST-2010B ASTER-0260#B 

IST-2010B ASTER-0300#B 

IST-2010B ASTER-0310#B 

IST-2010B ASTER-0340#B 

IST-2010B ASTER-0350#B 

IST-2010B ASTER-0410#B 

IST-2010B ASTER-0410#B 

IST-2010B ASTER-0520#B 

IST-2010B ASTER-0530#B 

IST-2010B ASTER-0540#B 

IST-2010B ASTER-0550#B 

IST-2010B ASTER-0570#B 

IST-2010B ASTER-0580#B 

IST-2010B ASTER-0590#B 

IST-2010B ASTER-1080#B 

IST-2010B EDOS-4.2.1.4#B 

IST-2010B EOC-2010#B 

IST-2010B EOC-2020#B 

IST-2010B EOC-2030#B 

IST-2010B EOC-2040#B 

IST-2010B EOC-2045#B 

IST-2010B EOC-2070#B 

IST-2010B EOC-2170#B 

IST-2010B EOC-2180#B 

IST-2010B EOC-2190#B 

IST-2010B EOC-2200#B 

IST-2010B EOC-2210#B 

IST-2010B EOC-2220#B 

IST-2010B EOC-2240#B 

E-19
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

IST-2010B EOC-2250#B 

IST-2010B EOC-2260#B 

IST-2010B EOC-2270#B 

IST-2010B EOC-2272#B 

IST-2010B EOC-2280#B 

IST-2010B EOC-2290#B 

IST-2010B EOC-2300#B 

IST-2010B EOC-2310#B 

IST-2010B EOC-2320#B 

IST-2010B EOC-2350#B 

IST-2010B EOC-2370#B 

IST-2010B EOC-2460#B 

IST-2010B EOC-2482#B 

IST-2010B EOC-2490#B 

IST-2010B EOC-2510#B 

IST-2010B EOC-2535#B 

IST-2010B EOC-2540#B 

IST-2010B EOC-2550#B 

IST-2010B EOC-2555#B 

IST-2010B EOC-2570#B 

IST-2010B EOC-2590#B 

IST-2010B EOC-2620#B 

IST-2010B EOC-3015#B 

IST-2010B EOC-3020#B 

IST-2010B EOC-3024#B 

IST-2010B EOC-3030#B 

IST-2010B EOC-3050#B 

IST-2010B EOC-3080#B 

IST-2010B EOC-3086#B 

IST-2010B EOC-3090#B 

IST-2010B EOC-3160#B 

IST-2010B EOC-3200#B 

IST-2010B EOC-3210#B 

IST-2010B EOC-4010#B 

IST-2010B EOC-4015#B 

IST-2010B EOC-4018#B 

IST-2010B EOC-4100#B 

IST-2010B EOC-4120#B 

IST-2010B EOC-4125#B 

IST-2010B EOC-4140#B 

IST-2010B EOC-4160#B 

IST-2010B EOC-5010#B 

E-20
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

IST-2010B EOC-5015#B 

IST-2010B EOC-5020#B 

IST-2010B EOC-5045#B 

IST-2010B EOC-5080#B 

IST-2010B EOC-5090#B 

IST-2010B EOC-5100#B 

IST-2010B EOC-5105#B 

IST-2010B EOC-5110#B 

IST-2010B EOC-5120#B 

IST-2010B EOC-5180#B 

IST-2010B EOC-5200#B 

IST-2010B EOC-5220#B 

IST-2010B EOC-5240#B 

IST-2010B EOC-6010#B 

IST-2010B EOC-6050#B 

IST-2010B EOC-6060#B 

IST-2010B EOC-6070#B 

IST-2010B EOC-6080#B 

IST-2010B EOC-6100#B 

IST-2010B EOC-6110#B 

IST-2010B EOC-6150#B 

IST-2010B EOC-6160#B 

IST-2010B EOC-6195#B 

IST-2010B EOC-6200#B 

IST-2010B EOC-7010#B 

IST-2010B EOC-7020#B 

IST-2010B EOC-7025#B 

IST-2010B EOC-7130#B 

IST-2010B EOC-7160#B 

IST-2010B EOC-8160#B 

IST-2010B EOC-8285#B 

IST-2010B EOC-8290#B 

IST-2010B EOC-8372#B 

IST-2010B EOC-9010#B 

IST-2010B EOC-9020#B 

IST-2010B EOC-9025#B 

IST-2010B EOC-9040#B 

IST-2010B EOC-9080#B 

IST-2010B EOC-9090#B 

IST-2010B EOC-9130#B 

IST-2010B EOSD0010#B 

IST-2010B EOSD1680#B 

E-21
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

IST-2010B EOSD1770#B 

IST-2010B EOSD1990#B 

IST-2010B EOSD2100#B 

IST-2010B EOSD2400#B 

IST-2010B EOSD2430#B 

IST-2010B EOSD2550#B 

IST-2010B ESN-1367#B 

IST-2010B FOS-0030#B 

IST-2010B FOS-0040#B 

IST-2010B FOS-1070#B 

IST-2010B FOS-1130#B 

IST-2010B ICC-0010#B 

IST-2010B ICC-0020#B 

IST-2010B ICC-0030#B 

IST-2010B ICC-0070#B 

IST-2010B ICC-2010#B 

IST-2010B ICC-2015#B 

IST-2010B ICC-2020#B 

IST-2010B ICC-2050#B 

IST-2010B ICC-2052#B 

IST-2010B ICC-2060#B 

IST-2010B ICC-2115#B 

IST-2010B ICC-2120#B 

IST-2010B ICC-2140#B 

IST-2010B ICC-2150#B 

IST-2010B ICC-2170#B 

IST-2010B ICC-2180#B 

IST-2010B ICC-2190#B 

IST-2010B ICC-2210#B 

IST-2010B ICC-2220#B 

IST-2010B ICC-2230#B 

IST-2010B ICC-2250#B 

IST-2010B ICC-2270#B 

IST-2010B ICC-2280#B 

IST-2010B ICC-2290#B 

IST-2010B ICC-2300#B 

IST-2010B ICC-2350#B 

IST-2010B ICC-2370#B 

IST-2010B ICC-2380#B 

IST-2010B ICC-2400#B 

IST-2010B ICC-2420#B 

IST-2010B ICC-2430#B 

E-22
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

IST-2010B ICC-2450#B 

IST-2010B ICC-3010#B 

IST-2010B ICC-3040#B 

IST-2010B ICC-3050#B 

IST-2010B ICC-3090#B 

IST-2010B ICC-3100#B 

IST-2010B ICC-3110#B 

IST-2010B ICC-3160#B 

IST-2010B ICC-3210#B 

IST-2010B ICC-3220#B 

IST-2010B ICC-3230#B 

IST-2010B ICC-3240#B 

IST-2010B ICC-3270#B 

IST-2010B ICC-3370#B 

IST-2010B ICC-3380#B 

IST-2010B ICC-3400#B 

IST-2010B ICC-4040#B 

IST-2010B ICC-4100#B 

IST-2010B ICC-4110#B 

IST-2010B ICC-4120#B 

IST-2010B ICC-4150#B 

IST-2010B ICC-4200#B 

IST-2010B ICC-4410#B 

IST-2010B ICC-4440#B 

IST-2010B ICC-4450#B 

IST-2010B ICC-4470#B 

IST-2010B ICC-4480#B 

IST-2010B ICC-4490#B 

IST-2010B ICC-4500#B 

IST-2010B ICC-4550#B 

IST-2010B ICC-4610#B 

IST-2010B ICC-4710#B 

IST-2010B ICC-4730#B 

IST-2010B ICC-6510#B 

IST-2010B ICC-6510#B 

IST-2010B ICC-6520#B 

IST-2010B ICC-6525#B 

IST-2010B ICC-6540#B 

IST-2010B ICC-6580#B 

IST-2010B ICC-6580#B 

IST-2010B ICC-6580#B 

IST-2010B ICC-6580#B 

E-23
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

IST-2010B ICC-6590#B 

IST-2010B ICC-6620#B 

IST-2010B ICC-7010#B 

IST-2010B ICC-7030#B 

IST-2010B ICC-7050#B 

IST-2010B ICC-7060#B 

IST-2010B ICC-7065#B 

IST-2010B ICC-7070#B 

IST-2010B ICC-7075#B 

IST-2010B ICC-7220#B 

IST-2010B ICC-7230#B 

IST-2010B ICC-7240#B 

IST-2010B ICC-7250#B 

IST-2010B ICC-7270#B 

IST-2010B ICC-7290#B 

IST-2010B ICC-7330#B 

IST-2010B ICC-7370#B 

IST-2010B ICC-7390#B 

IST-2010B ICC-7430#B 

IST-2010B ICC-7460#B 

IST-2010B ICC-7550#B 

IST-2010B NI-0330#B 

IST-2010B NI-0330#B 

IST-2010B EDOS-4.1.1.17#B 

NCC-2020B EOC-2190#B 

NCC-2020B EOC-4060#B 

NCC-2020B EOC-5030#B 

NCC-2020B EOC-8100#B 

NCC-2020B EOSD0025#B 

NCC-2020B EOSD1502#B 

NCC-2020B EOSD1530#B 

NCC-2020B EOSD3710#B 

NCC-2020B FOS-0040#B 

NCC-2020B ICC-4410#B 

NCC-2020B ICC-6030#B 

NCC-2020B NI-0010#B 

NCC-2020B NI-0110#B 

NCC-2020B NI-0150#B 

NCC-2020B NI-0160#B 

NCC-2020B NI-0310#B 

NCC-2030B EOC-4060#B 

NCC-2030B EOC-5030#B 

E-24
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

NCC-2030B EOC-6200#B 

NCC-2030B EOSD0025#B 

NCC-2030B EOSD1502#B 

NCC-2030B EOSD1520#B 

NCC-2030B EOSD1530#B 

NCC-2030B EOSD3710#B 

NCC-2030B FOS-0040#B 

NCC-2030B NI-0010#B 

NCC-2030B NI-0110#B 

NCC-2030B NI-0150#B 

NCC-2030B NI-0160#B 

NCC-2030B NI-0310#B 

NCC-2040B EOC-5030#B 

NCC-2040B EOC-6010#B 

NCC-2040B EOC-6200#B 

NCC-2040B ICC-4410#B 

OPR-2000B AM1-0120#B 

OPR-2000B AM1-0125#B 

OPR-2000B AM1-0130#B 

OPR-2000B AM1-0135#B 

OPR-2000B AM1-0200#B 

OPR-2000B AM1-1000#B 

OPR-2000B AM1-1010#B 

OPR-2000B AM1-1020#B 

OPR-2000B ASTER-0050#B 

OPR-2000B ASTER-2000#B 

OPR-2000B ASTER-2030#B 

OPR-2000B ASTER-2040#B 

OPR-2000B EOC-2200#B 

OPR-2000B EOC-2230#B 

OPR-2000B EOC-2272#B 

OPR-2000B EOC-2370#B 

OPR-2000B EOC-2535#B 

OPR-2000B OC-3030#B 

OPR-2000B EOC-3200#B 

OPR-2000B EOC-4020#B 

OPR-2000B EOC-6010#B 

OPR-2000B EOC-6050#B 

OPR-2000B EOC-6200#B 

OPR-2000B EOC-7120#B 

OPR-2000B EOC-7160#B 

OPR-2000B EOC-8010#B 

E-25
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

OPR-2000B EOC-8020#B 

OPR-2000B EOC-8250#B 

OPR-2000B EOC-8260#B 

OPR-2000B EOC-8270#B 

OPR-2000B EOC-8285#B 

OPR-2000B EOC-8290#B 

OPR-2000B EOC-8320#B 

OPR-2000B EOC-8370#B 

OPR-2000B EOC-8375#B 

OPR-2000B EOC-8380#B 

OPR-2000B EOC-9010#B 

OPR-2000B EOC-9040#B 

OPR-2000B EOC-9080#B 

OPR-2000B EOC-9090#B 

OPR-2000B EOC-9510#B 

OPR-2000B EOC-9570#B 

OPR-2000B EOSD0010#B 

OPR-2000B EOSD0015#B 

OPR-2000B EOSD0500#B 

OPR-2000B EOSD0510#B 

OPR-2000B EOSD0560#B 

OPR-2000B EOSD0630#B 

OPR-2000B EOSD0700#B 

OPR-2000B EOSD0720#B 

OPR-2000B EOSD0750#B 

OPR-2000B EOSD0760#B 

OPR-2000B EOSD0800#B 

OPR-2000B EOSD1010#B 

OPR-2000B EOSD1490#B 

OPR-2000B EOSD1505#B 

OPR-2000B EOSD1680#B 

OPR-2000B EOSD3490#B 

OPR-2000B EOSD3700#B 

OPR-2000B EOSD3800#B 

OPR-2000B EOSD3810#B 

OPR-2000B EOSD3820#B 

OPR-2000B FOS-0040#B 

OPR-2000B FOS-1030#B 

OPR-2000B FOS-1040#B 

OPR-2000B FOS-1050#B 

OPR-2000B FOS-1140#B 

OPR-2000B ICC-0020#B 

E-26
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

OPR-2000B ICC-2270#B 

OPR-2000B ICC-2420#B 

OPR-2000B ICC-2450#B 

OPR-2000B ICC-3070#B 

OPR-2000B ICC-3270#B 

OPR-2000B ICC-4470#B 

OPR-2000B ICC-6005#B 

OPR-2000B ICC-6010#B 

OPR-2000B ICC-6135#B 

OPR-2000B ICC-6140#B 

OPR-2000B ICC-6145#B 

OPR-2000B ICC-6200#B 

OPR-2000B ICC-6205#B 

OPR-2000B ICC-6210#B 

OPR-2000B ICC-6590#B 

OPR-2000B ICC-7005#B 

OPR-2000B ICC-7030#B 

OPR-2000B ICC-8010#B 

OPR-2000B NI-0170#B 

OPR-2000B NI-1000#B 

OPR-2000B NI-1010#B 

OPR-2000B NI-1030#B 

PAS-2000B AM1-0230#B 

PAS-2000B ASTER-0050#B 

PAS-2000B EOC-2030#B 

PAS-2000B EOC-2070#B 

PAS-2000B EOC-2170#B 

PAS-2000B EOC-2180#B 

PAS-2000B EOC-2200#B 

PAS-2000B EOC-2220#B 

PAS-2000B EOC-2270#B 

PAS-2000B EOC-2272#B 

PAS-2000B EOC-2290#B 

PAS-2000B EOC-2540#B 

PAS-2000B EOC-7010#B 

PAS-2000B EOC-7015#B 

PAS-2000B EOC-7025#B 

PAS-2000B EOC-7030#B 

PAS-2000B ICC-2050#B 

PAS-2000B ICC-2052#B 

PAS-2000B ICC-2110#B 

PAS-2000B ICC-2115#B 

E-27
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

PAS-2000B ICC-2140#B 

PAS-2000B ICC-2150#B 

PAS-2000B ICC-2190#B 

PAS-2000B ICC-2230#B 

PAS-2000B ICC-2300#B 

PAS-2000B ICC-2430#B 

PAS-2000B ICC-4710#B 

PAS-2000B ICC-4730#B 

PAS-2000B ICC-4740#B 

PAS-2000B ICC-4770#B 

PAS-2000B ICC-7010#B 

PAS-2000B ICC-7050#B 

PAS-2000B ICC-7060#B 

PAS-2000B ICC-7230#B 

PAS-2000B ICC-7250#B 

PAS-2010B EOC-2030#B 

PAS-2010B EOC-7010#B 

PAS-2010B EOC-7015#B 

PAS-2010B EOC-7025#B 

PAS-2010B EOC-7030#B 

PAS-2010B ICC-2052#B 

PAS-2010B ICC-4730#B 

PAS-2010B ICC-4740#B 

PAS-2010B ICC-4770#B 

PAS-2010B ICC-4775#B 

PAS-2010B ICC-7050#B 

PAS-2020B EOC-2020#B 

PAS-2020B EOC-2030#B 

PAS-2020B EOC-2040#B 

PAS-2020B EOC-2045#B 

PAS-2020B EOC-2070#B 

PAS-2020B EOC-2170#B 

PAS-2020B EOC-2180#B 

PAS-2020B EOC-2190#B 

PAS-2020B EOC-2200#B 

PAS-2020B EOC-2220#B 

PAS-2020B EOC-2240#B 

PAS-2020B EOC-2250#B 

PAS-2020B EOC-2260#B 

PAS-2020B EOC-2270#B 

PAS-2020B EOC-2272#B 

PAS-2020B EOC-2280#B 

E-28
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

PAS-2020B EOC-2290#B 

PAS-2020B EOC-2300#B 

PAS-2020B EOC-2310#B 

PAS-2020B EOC-2320#B 

PAS-2020B EOC-2420#B 

PAS-2020B EOC-2430#B 

PAS-2020B EOC-2460#B 

PAS-2020B EOC-2480#B 

PAS-2020B EOC-2482#B 

PAS-2020B EOC-2490#B 

PAS-2020B EOC-2510#B 

PAS-2020B EOC-2530#B 

PAS-2020B EOC-2535#B 

PAS-2020B EOC-2540#B 

PAS-2020B EOC-2550#B 

PAS-2020B EOC-2570#B 

PAS-2020B EOC-2590#B 

PAS-2020B EOC-2630#B 

PAS-2020B EOC-3020#B 

PAS-2020B EOSD0500#B 

PAS-2020B FOS-0030#B 

PAS-2020B FOS-0040#B 

PAS-2020B ICC-0030#B 

PAS-2020B ICC-0070#B 

PAS-2020B ICC-1130#B 

PAS-2020B ICC-2010#B 

PAS-2020B ICC-2015#B 

PAS-2020B ICC-2020#B 

PAS-2020B ICC-2050#B 

PAS-2020B ICC-2052#B 

PAS-2020B ICC-2060#B 

PAS-2020B ICC-2110#B 

PAS-2020B ICC-2115#B 

PAS-2020B ICC-2120#B 

PAS-2020B ICC-2140#B 

PAS-2020B ICC-2150#B 

PAS-2020B ICC-2170#B 

PAS-2020B ICC-2180#B 

PAS-2020B ICC-2190#B 

PAS-2020B ICC-2210#B 

PAS-2020B ICC-2230#B 

PAS-2020B ICC-2270#B 

E-29
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

PAS-2020B ICC-2280#B 

PAS-2020B ICC-2290#B 

PAS-2020B ICC-2300#B 

PAS-2020B ICC-2350#B 

PAS-2020B ICC-2370#B 

PAS-2020B ICC-2380#B 

PAS-2020B ICC-2400#B 

PAS-2020B ICC-2430#B 

PAS-2020B ICC-2450#B 

PAS-2020B ICC-7010#B 

PAS-2020B ICC-7210#B 

PAS-2020B ICC-7230#B 

PAS-2020B ICC-7240#B 

PAS-2020B ICC-7250#B 

PAS-2030B EOC-2010#B 

PAS-2030B EOC-2020#B 

PAS-2030B EOC-2030#B 

PAS-2030B EOC-2040#B 

PAS-2030B EOC-2045#B 

PAS-2030B EOC-2070#B 

PAS-2030B EOC-2200#B 

PAS-2030B EOC-2210#B 

PAS-2030B EOC-2220#B 

PAS-2030B EOC-2290#B 

PAS-2030B EOC-2300#B 

PAS-2030B EOC-2310#B 

PAS-2030B EOC-2320#B 

PAS-2030B EOC-2350#B 

PAS-2030B EOC-2460#B 

PAS-2030B EOC-2510#B 

PAS-2030B EOC-2550#B 

PAS-2030B EOC-2555#B 

PAS-2030B EOC-2620#B 

PAS-2030B EOC-9020#B 

PAS-2030B EOC-9025#B 

PAS-2030B EOC-9090#B 

PAS-2030B FOS-0030#B 

PAS-2030B FOS-0040#B 

PAS-2030B ICC-0010#B 

PAS-2030B ICC-2010#B 

PAS-2030B ICC-2020#B 

PAS-2030B ICC-2180#B 

E-30
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

PAS-2030B ICC-2210#B 

PAS-2030B ICC-2220#B 

PAS-2030B ICC-2250#B 

PAS-2030B ICC-2280#B 

PAS-2030B ICC-2290#B 

PAS-2030B ICC-2420#B 

PAS-2030B ICC-3020#B 

PAS-2030B ICC-3160#B 

PAS-2030B ICC-4460#B 

PAS-2030B ICC-6520#B 

PAS-2030B ICC-6525#B 

PAS-2030B ICC-6590#B 

PAS-2030B ICC-7214#B 

PAS-2030B ICC-7220#B 

PAS-2030B ICC-7240#B 

PAS-2030B ICC-7290#B 

PAS-2035B EOC-2020#B 

PAS-2035B EOC-2030#B 

PAS-2035B EOC-2040#B 

PAS-2035B EOC-2045#B 

PAS-2035B EOC-2170#B 

PAS-2035B EOC-2180#B 

PAS-2035B EOC-2200#B 

PAS-2035B EOC-2220#B 

PAS-2035B EOC-2250#B 

PAS-2035B EOC-2280#B 

PAS-2035B EOC-2290#B 

PAS-2035B EOC-2300#B 

PAS-2035B EOC-2310#B 

PAS-2035B EOC-2320#B 

PAS-2035B EOC-2490#B 

PAS-2035B EOC-2510#B 

PAS-2035B EOC-2535#B 

PAS-2035B EOC-2540#B 

PAS-2035B EOC-2550#B 

PAS-2035B EOC-7010#B 

PAS-2035B EOC-9020#B 

PAS-2035B FOS-0030#B 

PAS-2035B FOS-0040#B 

PAS-2035B FOS-1040#B 

PAS-2035B FOS-1090#B 

PAS-2035B ICC-0010#B 

E-31
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

PAS-2035B ICC-0030#B 

PAS-2035B ICC-2010#B 

PAS-2035B ICC-2050#B 

PAS-2035B ICC-2150#B 

PAS-2035B ICC-2300#B 

PAS-2035B ICC-2430#B 

PAS-2035B ICC-6520#B 

PAS-2035B ICC-7010#B 

PAS-2035B ICC-7250#B 

PAS-2040B EOC-2030#B 

PAS-2040B EOC-2045#B 

PAS-2040B EOC-2070#B 

PAS-2040B EOC-2170#B 

PAS-2040B EOC-2180#B 

PAS-2040B EOC-2200#B 

PAS-2040B EOC-2320#B 

PAS-2040B EOC-2370#B 

PAS-2040B EOC-2400#B 

PAS-2040B EOC-2405#B 

PAS-2040B EOC-2410#B 

PAS-2040B EOC-2460#B 

PAS-2040B EOC-2520#B 

PAS-2040B EOC-2530#B 

PAS-2040B EOC-2535#B 

PAS-2040B EOC-2550#B 

PAS-2040B EOSD0010#B 

PAS-2040B EOSD0025#B 

PAS-2040B EOSD1502#B 

PAS-2040B EOSD1520#B 

PAS-2040B EOSD1530#B 

PAS-2040B EOSD3710#B 

PAS-2040B FOS-0040#B 

PAS-2040B ICC-0010#B 

PAS-2040B ICC-2010#B 

PAS-2040B NI-0010#B 

PAS-2040B NI-0110#B 

PAS-2040B NI-0120#B 

PAS-2040B NI-0130#B 

PAS-2040B NI-0310#B 

PAS-2050B EOC-2040#B 

PAS-2050B EOC-2045#B 

PAS-2050B EOC-2045#B 

E-32
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

PAS-2050B EOC-2220#B 

PAS-2050B EOC-2260#B 

PAS-2050B EOC-2290#B 

PAS-2050B EOC-2300#B 

PAS-2050B EOC-2310#B 

PAS-2050B EOC-2320#B 

PAS-2050B EOC-2540#B 

PAS-2050B EOC-2555#B 

PAS-2050B EOC-7010#B 

PAS-2050B EOC-9020#B 

PAS-2050B EOC-9090#B 

PAS-2050B FOS-0030#B 

PAS-2050B ICC-0030#B 

PAS-2050B ICC-2010#B 

PAS-2050B ICC-2015#B 

PAS-2050B ICC-2020#B 

PAS-2050B ICC-2050#B 

PAS-2050B ICC-2150#B 

PAS-2050B ICC-2170#B 

PAS-2050B ICC-2180#B 

PAS-2050B ICC-2190#B 

PAS-2050B ICC-2210#B 

PAS-2050B ICC-2220#B 

PAS-2050B ICC-2280#B 

PAS-2050B ICC-2300#B 

PAS-2050B ICC-2430#B 

PAS-2050B ICC-6520#B 

PAS-2050B ICC-6590#B 

PAS-2050B ICC-7010#B 

PAS-2050B ICC-7220#B 

PAS-2050B ICC-7240#B 

PAS-2050B ICC-7250#B 

PAS-2110B EOC-2040#B 

PAS-2110B EOC-2045#B 

PAS-2110B EOC-2070#B 

PAS-2110B EOC-2210#B 

PAS-2110B EOC-2220#B 

PAS-2110B EOC-3020#B 

PAS-2110B EOC-3050#B 

PAS-2110B EOC-3090#B 

PAS-2110B EOC-3160#B 

PAS-2110B EOC-7020#B 

E-33
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

PAS-2110B EOC-7030#B 

PAS-2110B EOC-9020#B 

PAS-2110B EOC-9090#B 

PAS-2110B FOS-0030#B 

PAS-2110B FOS-0040#B 

PAS-2110B ICC-0010#B 

PAS-2110B ICC-2010#B 

PAS-2110B ICC-2020#B 

PAS-2110B ICC-2115#B 

PAS-2110B ICC-3210#B 

PAS-2110B ICC-6520#B 

PAS-2110B ICC-6590#B 

PAS-2110B ICC-7220#B 

PAS-2180B ASTER-0240#B 

PAS-2180B EOC-2480#B 

PAS-2180B EOC-2540#B 

PAS-2180B EOC-2620#B 

PAS-2180B EOC-3030#B 

PAS-2180B EOC-3050#B 

PAS-2180B EOC-3090#B 

PAS-2180B EOC-3160#B 

PAS-2180B EOC-3225#B 

PAS-2180B EOC-7010#B 

PAS-2180B EOC-7020#B 

PAS-2180B EOSD0630#B 

PAS-2180B FOS-0040#B 

PAS-2180B ICC-2180#B 

PAS-2180B ICC-3070#B 

PAS-2180B ICC-3071#B 

PAS-2180B ICC-3085#B 

PAS-2180B ICC-3380#B 

PAS-2190B ASTER-0340#B 

PAS-2190B ASTER-0350#B 

PAS-2190B EOC-2040#B 

PAS-2190B EOC-2045#B 

PAS-2190B EOC-2210#B 

PAS-2190B EOC-2220#B 

PAS-2190B EOC-2260#B 

PAS-2190B EOC-2320#B 

PAS-2190B EOC-9020#B 

PAS-2190B EOC-9090#B 

PAS-2190B FOS-0030#B 

E-34
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

PAS-2190B ICC-2010#B 

PAS-2190B ICC-2015#B 

PAS-2190B ICC-2020#B 

PAS-2190B ICC-6520#B 

PAS-2190B ICC-6590#B 

PAS-2190B ICC-7220#B 

PAS-2190B ICC-7230#B 

PAS-2190B ICC-7270#B 

PAS-2200B EOC-2040#B 

PAS-2200B EOC-2045#B 

PAS-2200B EOC-2170#B 

PAS-2200B EOC-2210#B 

PAS-2200B EOC-2220#B 

PAS-2200B EOC-2230#B 

PAS-2200B EOC-2260#B 

PAS-2200B EOC-2430#B 

PAS-2200B EOC-2540#B 

PAS-2200B EOC-2555#B 

PAS-2200B EOC-2630#B 

PAS-2200B EOC-3024#B 

PAS-2200B EOC-3050#B 

PAS-2200B EOC-3090#B 

PAS-2200B EOC-3160#B 

PAS-2200B EOC-3240#B 

PAS-2200B EOC-6110#B 

PAS-2200B EOC-6140#B 

PAS-2200B EOC-7010#B 

PAS-2200B EOC-7110#B 

PAS-2200B EOC-9020#B 

PAS-2200B EOC-9040#B 

PAS-2200B EOC-9090#B 

PAS-2200B FOS-0030#B 

PAS-2200B FOS-0040#B 

PAS-2200B FOS-1130#B 

PAS-2200B ICC-0030#B 

PAS-2200B ICC-1130#B 

PAS-2200B ICC-2010#B 

PAS-2200B ICC-2020#B 

PAS-2200B ICC-2050#B 

PAS-2200B ICC-2220#B 

PAS-2200B ICC-2250#B 

PAS-2200B ICC-2300#B 

E-35
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

PAS-2200B ICC-2350#B 

PAS-2200B ICC-2430#B 

PAS-2200B ICC-3020#B 

PAS-2200B ICC-3040#B 

PAS-2200B ICC-3060#B 

PAS-2200B ICC-3070#B 

PAS-2200B ICC-6520#B 

PAS-2200B ICC-6590#B 

PAS-2200B ICC-7220#B 

POST-B EDOS-4.1.1.1#B 

POST-B EDOS-4.3.1.4#B 

POST-B EDOS-4.6.1.7#B 

POST-B EOC-0040#B 

POST-B EOC-2010#B 

POST-B EOC-2030#B 

POST-B EOC-2160#B 

POST-B EOC-4010#B 

POST-B EOC-4015#B 

POST-B EOC-4020#B 

POST-B EOC-5030#B 

POST-B EOC-5090#B 

POST-B EOC-5187#B 

POST-B EOC-6010#B 

POST-B EOC-6050#B 

POST-B EOC-6100#B 

POST-B EOC-6110#B 

POST-B EOC-6195#B 

POST-B EOC-6200#B 

POST-B EOC-7110#B 

POST-B EOC-7115#B 

POST-B EOC-7116#B 

POST-B EOC-7120#B 

POST-B EOC-8010#B 

POST-B EOC-8090#B 

POST-B EOC-8140#B 

POST-B EOSD0545#B 

POST-B EOSD1010#B 

POST-B EOSD1600#B 

POST-B FOS-0040#B 

POST-B FOS-1030#B 

POST-B FOS-1050#B 

POST-B FOS-1060#B 

E-36
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

POST-B FOS-1070#B 

POST-B FOS-1080#B 

POST-B ICC-0055#B 

POST-B ICC-4095#B 

POST-B ICC-4450#B 

POST-B ICC-4460#B 

POST-B ICC-4470#B 

POST-B ICC-4550#B 

POST-B ICC-4800#B 

POST-B ICC-4810#B 

POST-B ICC-4820#B 

POST-B ICC-6005#B 

POST-B ICC-6020#B 

POST-B EDOS-4.1.1.15#B 

POST-B EDOS-4.1.1.16#B 

SYS-2000B EOC-2160#B 

SYS-2000B EOC-4020#B 

SYS-2000B EOC-8140#B 

SYS-2000B EOC-9010#B 

SYS-2000B EOC-9090#B 

SYS-2000B EOSD0010#B 

SYS-2000B EOSD2990#B 

SYS-2000B EOSD3000#B 

SYS-2000B FOS-0040#B 

SYS-2000B FOS-1020#B 

SYS-2000B ICC-6070#B 

SYS-2000B ICC-6590#B 

SYS-2020B AM1-0120#B 

SYS-2020B AM1-0125#B 

SYS-2020B AM1-0130#B 

SYS-2020B AM1-0135#B 

SYS-2020B EOC-2370#B 

SYS-2020B EOC-4020#B 

SYS-2020B EOC-8010#B 

SYS-2020B EOC-8090#B 

SYS-2020B EOC-8130#B 

SYS-2020B EOC-8140#B 

SYS-2020B EOC-8240#B 

SYS-2020B EOC-8260#B 

SYS-2020B EOC-9010#B 

SYS-2020B EOC-9570#B 

SYS-2020B EOSD0010#B 

E-37
 322-CD-100-001/ 
411-CD-100-001 



Test Case RBR ID 

SYS-2020B EOSD0510#B 

SYS-2020B EOSD0630#B 

SYS-2020B EOSD0740#B 

SYS-2020B EOSD0750#B 

SYS-2020B EOSD0760#B 

SYS-2020B EOSD0800#B 

SYS-2020B EOSD1680#B 

SYS-2020B EOSD4100#B 

SYS-2020B FOS-0020#B 

SYS-2020B FOS-0025#B 

SYS-2020B FOS-0040#B 

SYS-2020B FOS-1080#B 

SYS-2020B FOS-1130#B 

SYS-2020B ICC-6005#B 

SYS-2020B ICC-6020#B 

SYS-2020B ICC-6060#B 

SYS-2020B ICC-6070#B 

SYS-2020B ICC-6110#B 

SYS-2020B ICC-6140#B 

SYS-2020B ICC-6510#B 

SYS-2030B EOC-2030#B 

SYS-2030B EOC-4020#B 

SYS-2030B EOC-5030#B 

SYS-2030B EOC-7060#B 

SYS-2030B EOC-8110#B 

SYS-2030B EOC-8130#B 

SYS-2030B EOC-8140#B 

SYS-2030B EOC-8150#B 

SYS-2030B EOC-8160#B 

SYS-2030B EOC-8220#B 

SYS-2030B EOC-8230#B 

SYS-2030B EOC-8240#B 

SYS-2030B EOC-8250#B 

SYS-2030B EOC-8330#B 

SYS-2030B EOC-9020#B 

SYS-2030B EOC-9025#B 

SYS-2030B EOSD0010#B 

SYS-2030B EOSD0500#B 

SYS-2030B EOSD0780#B 

SYS-2030B EOSD2990#B 

SYS-2030B EOSD3000#B 

SYS-2030B EOSD3490#B 
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Test Case RBR ID 

SYS-2030B EOSD3710#B 

SYS-2030B FOS-0040#B 

SYS-2030B ICC-4780#B 

SYS-2030B ICC-6040#B 

SYS-2030B ICC-6060#B 

SYS-2030B ICC-6080#B 

SYS-2030B ICC-6090#B 

SYS-2030B ICC-6110#B 

SYS-2030B ICC-6130#B 

SYS-2030B ICC-6135#B 

SYS-2030B ICC-6195#B 

SYS-2030B ICC-6520#B 

SYS-2030B ICC-6525#B 

SYS-2030B ICC-6590#B 

TLM-2000B AM1-0090#B 

TLM-2000B AM1-0135#B 

TLM-2000B AM1-0140#B 

TLM-2000B AM1-0160#B 

TLM-2000B AM1-0200#B 

TLM-2000B AM1-1100#B 

TLM-2000B AM1-1110#B 

TLM-2000B AM1-1120#B 

TLM-2000B EDOS-4.1.1.3#B 

TLM-2000B EDOS-4.6.1.2#B 

TLM-2000B EDOS-4.6.1.5#B 

TLM-2000B EDOS-4.6.1.6#B 

TLM-2000B EOC-0040#B 

TLM-2000B EOC-5010#B 

TLM-2000B EOC-5020#B 

TLM-2000B EOC-5045#B 

TLM-2000B EOC-5070#B 

TLM-2000B EOC-5080#B 

TLM-2000B EOC-5090#B 

TLM-2000B EOC-5100#B 

TLM-2000B EOC-5220#B 

TLM-2000B EOC-6060#B 

TLM-2000B EOC-6070#B 

TLM-2000B EOC-6200#B 

TLM-2000B EOC-7010#B 

TLM-2000B EOC-8285#B 

TLM-2000B EOC-8290#B 

TLM-2000B EOC-9010#B 
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Test Case RBR ID 

TLM-2000B EOC-9020#B 

TLM-2000B EOC-9090#B 

TLM-2000B EOSD0010#B 

TLM-2000B EOSD0025#B 

TLM-2000B EOSD1502#B 

TLM-2000B EOSD1605#B 

TLM-2000B EOSD1680#B 

TLM-2000B ICC-0055#B 

TLM-2000B ICC-4020#B 

TLM-2000B ICC-4090#B 

TLM-2000B ICC-4100#B 

TLM-2000B ICC-4450#B 

TLM-2000B ICC-4460#B 

TLM-2000B ICC-6590#B 

TLM-2000B ICC-7460#B 

TLM-2000B NI-0010#B 

TLM-2000B NI-0030#B 

TLM-2000B NI-0110#B 

TLM-2000B NI-0230#B 

TLM-2000B NI-0310#B 

TLM-2010B AM1-0050#B 

TLM-2010B AM1-0090#B 

TLM-2010B AM1-0125#B 

TLM-2010B AM1-0135#B 

TLM-2010B AM1-0140#B 

TLM-2010B AM1-0160#B 

TLM-2010B AM1-0200#B 

TLM-2010B AM1-1110#B 

TLM-2010B AM1-1120#B 

TLM-2010B EDOS-4.1.1.3#B 

TLM-2010B EDOS-4.1.1.8#B 

TLM-2010B EDOS-4.6.1.2#B 

TLM-2010B EDOS-4.6.1.5#B 

TLM-2010B EDOS-4.6.1.6#B 

TLM-2010B EOC-0040#B 

TLM-2010B EOC-5010#B 

TLM-2010B EOC-5020#B 

TLM-2010B EOC-5045#B 

TLM-2010B EOC-5080#B 

TLM-2010B EOC-5090#B 

TLM-2010B EOC-5220#B 

TLM-2010B EOC-6060#B 
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Test Case RBR ID 

TLM-2010B EOC-6070#B 

TLM-2010B EOC-6200#B 

TLM-2010B EOC-7010#B 

TLM-2010B EOC-8285#B 

TLM-2010B EOC-9020#B 

TLM-2010B EOC-9090#B 

TLM-2010B EOSD0010#B 

TLM-2010B EOSD0025#B 

TLM-2010B EOSD0500#B 

TLM-2010B EOSD1502#B 

TLM-2010B EOSD1605#B 

TLM-2010B EOSD1680#B 

TLM-2010B FOS-1080#B 

TLM-2010B ICC-0055#B 

TLM-2010B ICC-4010#B 

TLM-2010B ICC-4020#B 

TLM-2010B ICC-4045#B 

TLM-2010B ICC-4100#B 

TLM-2010B ICC-4450#B 

TLM-2010B ICC-4460#B 

TLM-2010B ICC-6590#B 

TLM-2010B ICC-7460#B 

TLM-2010B NI-0010#B 

TLM-2010B NI-0030#B 

TLM-2010B NI-0110#B 

TLM-2010B NI-0210#B 

TLM-2010B NI-0230#B 

TLM-2010B NI-0310#B 

TLM-2010B EDOS-4.1.1.18#B 

TLM-2020B EOC-5010#B 

TLM-2020B EOC-5070#B 

TLM-2020B EOC-5080#B 

TLM-2020B EOC-5090#B 

TLM-2020B EOC-5100#B 

TLM-2020B EOC-5220#B 

TLM-2020B EOC-5240#B 

TLM-2020B EOC-8285#B 

TLM-2020B EOC-9010#B 

TLM-2020B FOS-1070#B 

TLM-2020B ICC-4010#B 

TLM-2020B ICC-4090#B 

TLM-2020B ICC-4100#B 
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Test Case RBR ID 

TLM-2020B ICC-7430#B 

TLM-2030B EOC-5080#B 

TLM-2030B EOC-5090#B 

TLM-2030B EOC-5100#B 

TLM-2030B EOC-8290#B 

TLM-2030B FOS-1080#B 

TLM-2030B ICC-4100#B 

TLM-2040B EOC-5090#B 

TLM-2040B EOC-9010#B 

TLM-2040B ICC-4100#B 

TLM-2040B ICC-6510#B 

TLM-2050B EOC-5010#B 

TLM-2050B EOC-5070#B 

TLM-2050B EOC-5080#B 

TLM-2050B EOC-5090#B 

TLM-2050B FOS-1070#B 

TLM-2050B ICC-2250#B 

TLM-2050B ICC-3370#B 

TLM-2050B ICC-4045#B 

TLM-2050B ICC-4090#B 

TLM-2050B ICC-4100#B 

TLM-2060B EOC-5050#B 

TLM-2060B EOC-5090#B 

TLM-2060B EOC-5100#B 

TLM-2060B EOC-5120#B 

TLM-2060B ICC-4010#B 

TLM-2060B ICC-4070#B 

TLM-2060B ICC-4100#B 

TLM-2060B ICC-4120#B 

TLM-2060B ICC-7430#B 

TLM-2070B EOC-5015#B 

TLM-2070B EOC-5050#B 

TLM-2070B EOC-6060#B 

TLM-2070B EOC-6070#B 

TLM-2070B EOC-7010#B 

TLM-2070B EOC-9020#B 

TLM-2070B EOC-9090#B 

TLM-2070B ICC-4040#B 

TLM-2070B ICC-4070#B 

TLM-2070B ICC-4450#B 

TLM-2070B ICC-4460#B 

TLM-2070B ICC-4710#B 
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Test Case RBR ID 

TLM-2070B ICC-6525#B 

TLM-2070B ICC-6590#B 

TLM-2070B ICC-7460#B 

TLM-2080B EOC-5090#B 

TLM-2080B EOC-5100#B 

TLM-2080B EOC-5105#B 

TLM-2080B EOC-5110#B 

TLM-2080B EOC-5120#B 

TLM-2080B EOC-7010#B 

TLM-2080B EOC-9020#B 

TLM-2080B EOC-9090#B 

TLM-2080B ICC-2140#B 

TLM-2080B ICC-4100#B 

TLM-2080B ICC-4110#B 

TLM-2080B ICC-4120#B 

TLM-2080B ICC-4150#B 

TLM-2080B ICC-4550#B 

TLM-2080B ICC-4710#B 

TLM-2080B ICC-6525#B 

TLM-2090B EOC-5090#B 

TLM-2090B EOC-5100#B 

TLM-2090B EOC-5110#B 

TLM-2090B EOC-5120#B 

TLM-2090B EOC-7010#B 

TLM-2090B EOC-9020#B 

TLM-2090B EOC-9090#B 

TLM-2090B ICC-4100#B 

TLM-2090B ICC-4120#B 

TLM-2090B ICC-4150#B 

TLM-2090B ICC-4710#B 

TLM-2090B ICC-6525#B 

TLM-2100B EOC-5120#B 

TLM-2100B EOC-7010#B 

TLM-2100B EOC-7140#B 

TLM-2100B EOC-9020#B 

TLM-2100B EOC-9090#B 

TLM-2100B ICC-4120#B 

TLM-2100B ICC-4420#B 

TLM-2100B ICC-4710#B 

TLM-2100B ICC-6525#B 

TLM-2150B EOC-5070#B 

TLM-2150B EOC-5090#B 
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Test Case RBR ID 

TLM-2150B EOC-5230#B 

TLM-2150B ICC-4090#B 

TLM-2160B AM1-0070#B 

TLM-2160B AM1-0130#B 

TLM-2160B AM1-0160#B 

TLM-2160B AM1-0200#B 

TLM-2160B AM1-1110#B 

TLM-2160B AM1-1120#B 

TLM-2160B EOC-5190#B 

TLM-2160B EOC-7060#B 

TLM-2160B EOC-7160#B 

TLM-2160B EOSD1680#B 

TLM-2160B ICC-4560#B 

TLM-2160B ICC-4780#B 

TLM-2170B AM1-1060#B 

TLM-2170B AM1-1100#B 

TLM-2170B EDOS-4.1.1.8#B 

TLM-2170B EDOS-4.2.1.4#B 

TLM-2170B EOC-0040#B 

TLM-2170B EOC-5015#B 

TLM-2170B EOC-5020#B 

TLM-2170B EOSD1605#B 

TLM-2170B ICC-0055#B 

TLM-2170B ICC-4040#B 

TLM-2170B EDOS-4.1.1.18#B 

TLM-2190B EOC-5012#B 

TLM-2190B EOC-5200#B 

TLM-2190B EOC-5240#B 

TLM-2190B EOC-6010#B 

TLM-2190B EOC-6060#B 

TLM-2190B EOC-6070#B 

TLM-2190B EOC-7010#B 

TLM-2190B EOC-8090#B 

TLM-2190B EOC-9020#B 

TLM-2190B EOC-9090#B 

TLM-2190B EOSD3710#B 

TLM-2190B ICC-4180#B 

TLM-2190B ICC-4200#B 

TLM-2190B ICC-4450#B 

TLM-2190B ICC-4460#B 

TLM-2190B ICC-6020#B 

TLM-2190B ICC-6590#B 
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Test Case RBR ID 

TLM-2190B ICC-7460#B 
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Appendix F. Test Configuration Tables


Applicable software and associated version number for all supported hardware platforms under 
test in the EOC at GSFC are listed in the Flight Operations Segment (FOS) Release B Version 
2.1.0 Description Document (VDD) for the ECS Project dated December 1997 (Document 
Number 814-RD-010-003) . 
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Abbreviations and Acronyms


AGS Aster Ground System 

AM Morning (ante meridiem) --see EOS AM 

ANA Analysis 

AOS Acquisition of Signal 

ASTER
 Advanced Spaceborne Thermal Emission and Reflection Radiometer (formerly 
ITIR) 

ATC Absolute Time Command 

ATO Acceptance Test Organization 

BAP Baseline Activity Profile 

CAC Command Activity Controller 

CCB Configuration Control Board 

CCR Configuration Change Request 

CCSDS Consultative Committee for Space Data Systems 

CERES Clouds and Earth’s Radiant Energy System 

CI Configuration item 

CLCW Command Link Control Words 

CM Configuration Management 

CMD Command 

CMS Command Management System 

COTS Commercial Off-The-Shelf 

CSCI Computer software configuration item 

CSMS Communications and System Management Segment 

CSR Consent to Ship Review 

CSS Communications Subsystem (CSMS) 

CTIU Command and Telemetry Interface Unit 

DAR Data Acquisition Request 

DAS Detailed Activity Schedule 
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DB DatabaseÄ

DBA Database AdministratorÄ

DBMS Database Management SystemÄ

DDTS Distributed Defect Tracking SystemÄ

DFCD Data Format Control DocumentÄ

DID Data item description; data ingest/distributionÄ

DM Data ManagementÄ

DMS Data Management SubsystemÄ

DSN Deep Space NetworkÄ

DSS Decision Support SystemÄ

EASE Expert Advisor State EquationÄ

ECL ECS Command LanguageÄ

ECOM EOS CommunicationsÄ

ECS EOSDIS Core SystemÄ

EDF ECS Development FacilityÄ

EDOS EOS Data and Operations SystemÄ

EDU EDOS Data UnitÄ

EOC EOS Operations CenterÄ

EOS Earth Observing SystemÄ

EOSDIS EOS Data and Information SystemÄ

ETS EOSDIS Test SystemÄ

EU Engineering UnitÄ

EVT EventÄ

FDF Flight Dynamics FacilityÄ

FIFO First In - First OutÄ

FMG File ManagementÄ

FOS Flight Operations Segment (ECS)Ä

FOT Flight Operations TeamÄ

FUI FOS User InterfaceÄ
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GCMR Ground Configuration Message RequestÄ

GSFC Goddard Space Flight CenterÄ

HGA High Gain AntennaÄ

I&T Integration and TestÄ

ICC Instrument Control CenterÄ

INCR Internal Non-Conformance ReportÄ

IP International PartnersÄ

IRD Interface requirements documentÄ

IST Instrument Support ToolkitÄ

JPL Jet Propulsion LaboratoryÄ

LAN Local Area NetworkÄ

LaRC Langley Research CenterÄ

LMC Lockheed Martin CorporationÄ

LOS Loss of SignalÄ

LSM Local System ManagerÄ

LTIP Long Term Instrument PlanÄ

LTSP Long Term Science PlanÄ

M&O Maintenance & OperationsÄ

MISR Multi-Angle Imaging SpectroRadiometerÄ

MO&DSD Mission Operations and Data System Directorate (GSFC Code 500)Ä

MODIS Moderate Resolution Imaging SpectrometerÄ

MOPITT Measurements of Pollution in the TroposphereÄ

MSS Management and Subsystem (part of CSMS)Ä

MTPE Mission to Planet EarthÄ

NASA National Aeronautics and Space AdministrationÄ

Nascom NASA Communications NetworkÄ

NASDA National Space Development Agency (Japan)Ä

NCC Network Control CenterÄ

NCR Non-Conformance ReportÄ
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NOAA National Oceanic and Atmospheric AdministrationÄ

OASIS Operations and Science Instrument SupportÄ

ODB Operational DatabaseÄ

ODM Operational Data MessageÄ

PAS Planning and SchedulingÄ

PDB Project Data BaseÄ

PI Principal InvestigatorÄ

PI/TL Principal Investigator/Team LeaderÄ

PROC ProcedureÄ

QA Quality AssuranceÄ

RBR Requirement by ReleaseÄ

RCM Real-Time Contact ManagementÄ

RCTD Return Channel Time DelayÄ

RMA Reliability, Maintainability, AvailabilityÄ

RRR Release Readiness ReviewÄ

RTCS Relative Time Command SequenceÄ

RTM Requirements and Traceability ManagementÄ

RTS Relative Time SequenceÄ

SCDO Science and Communications Development OrganizationÄ

SCC Spacecraft Controls ComputerÄ

SCF Science Computing FacilityÄ

SCT Spacecraft TimeÄ

SDVF SMC Service Management CenterÄ

SDPS Science Data Processing SystemÄ

SN Space NetworkÄ

SSIM Spacecraft SimulatorÄ

SSR Solid State RecorderÄ

STF Software Turnover FormÄ

TD Target DayÄ
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TDRS Tracking and Data Relay SatelliteÄ

TDRSS Tracking and Data Relay Satellite SystemÄ

TL Team LeaderÄ

TLM TelemetryÄ

TOO Target of OpportunityÄ

TRR Test Readiness ReviewÄ

TTM Time Transfer MessageÄ

TW Target WeekÄ

USCCS User Spacecraft Clock Calibration SystemÄ

UPS User Planning SystemÄ

UTC Universal Time CoordinatedÄ

UI User InterfaceÄ

WAN Wide Area NetworkÄ

WOTS Wallops Orbital Tracking SystemÄ
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